Material Requirements Planning (PP-MRP)

Release 4.6C
## Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Caution Icon" /></td>
<td>Caution</td>
</tr>
<tr>
<td><img src="image" alt="Example Icon" /></td>
<td>Example</td>
</tr>
<tr>
<td><img src="image" alt="Note Icon" /></td>
<td>Note</td>
</tr>
<tr>
<td><img src="image" alt="Recommendation Icon" /></td>
<td>Recommendation</td>
</tr>
<tr>
<td><img src="image" alt="Syntax Icon" /></td>
<td>Syntax</td>
</tr>
</tbody>
</table>
Contents

Material Requirements Planning (PP-MRP) ................................................................. 11
Material Requirements Planning in the Logistics Chain .................................................. 13
Transaction Codes for MRP (PP-MRP) ................................................................. 15
MRP Procedures ........................................................................................................... 17
Material Requirements Planning.................................................................................... 18
  Material Requirements Planning Procedure .......................................................... 19
Master Production Scheduling (PP-MP-MPS) ............................................................. 20
  Master Production Scheduling Procedure ............................................................. 22
Consumption-Based Planning ...................................................................................... 24
  Reorder Point Planning ......................................................................................... 25
    Reorder Point Planning Procedure ................................................................. 26
    Reorder Point Planning with External Requirements ........................................ 28
  Forecast-Based Planning ....................................................................................... 29
    Forecast-Based Planning Procedure ................................................................. 31
  Time-Phased Planning ......................................................................................... 32
    Time-Phased Planning Procedure ................................................................. 33
    Range of Coverage Profile in Time-Phased Planning ....................................... 35
    Time-phased Planning Process with Delivery Cycle ......................................... 37
    Time-phased Planning Process with Reorder Point Planning ......................... 39
Master Data (PP-MRP-BD) .......................................................................................... 40
  Planning Calendar .................................................................................................. 41
    Creating Planning Calendars with Calculation Rule ....................................... 42
    Creating Planning Calendars without Calculation Rule ................................... 44
    Changing the Planning Calendar ................................................................. 45
Quota Arrangements .................................................................................................. 46
  Allocation Quota Arrangement ........................................................................... 48
    Example for Allocation Quota Arrangement ............................................... 49
  Splitting Quota Arrangement ............................................................................ 50
    Example for Splitting Quota Arrangement .................................................. 51
  Lot Size and Rounding Profile in Quota Arrangement ....................................... 52
    Example for Maximum Lot Size ................................................................. 54
  Priority and Maximum Release Quantity per Period .................................. 55
    Example for Priority and Maximum Release Quantity ............................. 56
    Maintaining the Quota File .............................................................................. 57
BOM Explosion Number (Fixed Key Date) ................................................................... 58
  Creating BOM Explosion Numbers ............................................................... 61
  Changing BOM Explosion Numbers ............................................................. 62
  Assigning a New Key to the BOM Explosion Number .................................. 63
Assign New Project Account Assignment to Material Components ................. 64
Planning Process ....................................................................................................... 65
  Checking the Planning File ................................................................. 67
    Individual Customer Planning File Entries ............................................... 68
    Planning Run Type ......................................................................................... 69
    Planning Mode ............................................................................................... 71
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculating Low-Level Codes</td>
<td>73</td>
</tr>
<tr>
<td>Displaying the Planning File</td>
<td>74</td>
</tr>
<tr>
<td>Setting Up the Planning File</td>
<td>75</td>
</tr>
<tr>
<td>Creating Entries in the Planning File Manually</td>
<td>76</td>
</tr>
<tr>
<td>Check the Consistency of the Planning File</td>
<td>77</td>
</tr>
<tr>
<td><strong>Net Requirements Calculation</strong></td>
<td>78</td>
</tr>
<tr>
<td>Net Requirements Calculation for MRP</td>
<td>79</td>
</tr>
<tr>
<td>Net Requirements Calculation for Reorder Point Planning</td>
<td>80</td>
</tr>
<tr>
<td>Net Requirements Calculation for Forecast-Based Planning</td>
<td>81</td>
</tr>
<tr>
<td>Gross Requirements Planning</td>
<td>82</td>
</tr>
<tr>
<td><strong>Calculating Procurement Quantity</strong></td>
<td>83</td>
</tr>
<tr>
<td>Lot-Sizing Procedures</td>
<td>84</td>
</tr>
<tr>
<td>Static Lot-Sizing Procedures</td>
<td>85</td>
</tr>
<tr>
<td>Lot-for-Lot Order Quantity</td>
<td>86</td>
</tr>
<tr>
<td>Fixed Lot Size</td>
<td>87</td>
</tr>
<tr>
<td>Replenishment up to Maximum Stock Level</td>
<td>88</td>
</tr>
<tr>
<td>Period Lot-Sizing Procedures</td>
<td>91</td>
</tr>
<tr>
<td>Availability Date for Period Lot-Sizing Procedure</td>
<td>92</td>
</tr>
<tr>
<td>Example for Determination of Availability Date</td>
<td>93</td>
</tr>
<tr>
<td>Delivery Date Instead of Availability Date</td>
<td>94</td>
</tr>
<tr>
<td>Example for Delivery Date Instead of Availability Date</td>
<td>95</td>
</tr>
<tr>
<td>Optimum Lot-Sizing Procedures</td>
<td>96</td>
</tr>
<tr>
<td>Part Period Balancing</td>
<td>97</td>
</tr>
<tr>
<td>Least Unit Cost Procedure</td>
<td>98</td>
</tr>
<tr>
<td>Dynamic Lot Size Creation</td>
<td>99</td>
</tr>
<tr>
<td>Groff Reorder Procedure</td>
<td>100</td>
</tr>
<tr>
<td>Lot Sizes with Splitting and Overlapping</td>
<td>101</td>
</tr>
<tr>
<td>Short-Term and Long-Term Lot Size</td>
<td>102</td>
</tr>
<tr>
<td>Lot-for-Lot Remaining Order Quantity</td>
<td>103</td>
</tr>
<tr>
<td>Calculating Scrap</td>
<td>104</td>
</tr>
<tr>
<td>Assembly Scrap</td>
<td>105</td>
</tr>
<tr>
<td>Component Scrap</td>
<td>106</td>
</tr>
<tr>
<td>Operation Scrap</td>
<td>107</td>
</tr>
<tr>
<td>Rounding</td>
<td>109</td>
</tr>
<tr>
<td>Rounding Profile</td>
<td>110</td>
</tr>
<tr>
<td>Examples for Calculating Procurement Quantities and Yields</td>
<td>112</td>
</tr>
<tr>
<td><strong>Scheduling</strong></td>
<td>114</td>
</tr>
<tr>
<td>Scheduling: In-House Production</td>
<td>115</td>
</tr>
<tr>
<td>Calculating Basic Dates</td>
<td>116</td>
</tr>
<tr>
<td>In-House Production Time: Independent of Lot Size</td>
<td>117</td>
</tr>
<tr>
<td>In-House Production Time: Dependent on Lot Size</td>
<td>118</td>
</tr>
<tr>
<td>Backward Scheduling for In-House Production</td>
<td>119</td>
</tr>
<tr>
<td>Example of Backward Scheduling for In-House Production</td>
<td>120</td>
</tr>
<tr>
<td>Forward Scheduling for External Procurement</td>
<td>121</td>
</tr>
<tr>
<td>Calculating Production Dates (Lead Time Scheduling)</td>
<td>122</td>
</tr>
<tr>
<td>Levels of Scheduling</td>
<td>124</td>
</tr>
<tr>
<td>Determining Capacity Requirements</td>
<td>125</td>
</tr>
</tbody>
</table>
Material Requirements Planning (PP-MRP)
Material Requirements Planning (PP-MRP)

Implementation Options

The main function of material requirements planning is to guarantee material availability, that is, it is used to procure or produce the requirement quantities on time both for internal purposes and for sales and distribution. This process involves the monitoring of stocks and, in particular, the automatic creation of procurement proposals for purchasing and production.

In doing so, MRP tries to strike the best balance possible between

- optimizing the service level and
- minimizing costs and capital lockup.

The MRP component (PP-MRP) assists and relieves MRP controllers in their area of responsibility. The MRP controller is responsible for all activities related to specifying the type, quantity, and time of the requirements, in addition to calculating when and for what quantity an order proposal has to be created to cover these requirements. The MRP controller needs all the information on stocks, stock reservations, and stocks on order to calculate quantities, and also needs information on lead times and procurement times to calculate dates. The MRP controller defines a suitable MRP and lot-sizing procedure for each material to determine procurement proposals.

Integration

You must first create the master data to be able to work with the MRP component. To do this, you require the following components:

- material master (LO-MD-MM)
- bills of material (LO-MD-BOM)

When you use MRP for in-house production, you also need the following components if you want to determine production dates:

- work center (PP-BD-WKC)
- routings (PP-BD-RTG)

You also need the following components:

- demand management (PP-MD-DEM)

  You need the Demand Management component to define requirement quantities and requirements dates for finished products and important assemblies. Demand Management also determines the strategy you are to use for planning, procuring, or producing a certain finished product.

- sales and distribution, if necessary

Features

MRP at Plant or MRP Area Level

You can plan material requirements at plant level or for different MRP areas. With MRP at plant level, the system adds together stocks from all of the individual storage locations, with the exception of individual customer stock, to determine total plant stock. The requirements are
combined in the planning run and procurement elements are created for these pegged requirements with unknown sources. Individual storage locations can be planned separately or be excluded from planning.

In the case of material requirements planning on an MRP area level, only the stocks from the storage locations or subcontractor assigned to the respective MRP area are taken into account. Only the requirements in this MRP area are combined and procurement elements are created for them. This enables you to plan material requirements specifically for certain areas.

**Lot-Sizing and MRP Procedures**

The most common lot-sizing procedures are available in the system and you can easily integrate user-defined formulas.

You can use MRP or consumption-based planning as the materials planning procedure.

**Automatic Planning Run**

The automatic planning run in MRP determines any shortages and creates the appropriate procurement elements. The system generates messages for critical parts and unusual situations so that you can rework the planning results in the specific area with problems.
Material Requirements Planning in the Logistics Chain

Implementation Options

The main function of material requirements planning is to guarantee material availability, that is, it is used to procure or produce the requirement quantities on time both for internal purposes and for sales and distribution. This process involves the monitoring of stocks and, in particular, the automatic creation of procurement proposals for purchasing and production.

Process Flow

1. Sales and Distribution take requirements as concrete customer requirements from the market.
2. In Demand Management, sales are planned in advance via a sales forecast. The result is the independent requirement, that is, the requirement for the finished product, tradable assemblies, trading goods and replacement parts. This result triggers material requirements planning.
3. In order to cover these requirements, MRP calculates procurement quantities and dates as well as plans the corresponding procurement elements. The procurement element in the planning run is the planned order or, for external procurement, the purchase requisition. Both procurement elements are internal planning elements that can be changed, rescheduled or deleted at any time.
4. If a material is produced in-house, the system also calculates the dependent requirements, that is, the quantity of components required to produce the finished product or the assembly, by exploding the BOM. If a material shortage exists, planned orders are created at every BOM level to cover requirements.
5. The system then converts these planned procurement elements into exact procurement elements: production orders for in-house production and purchase orders for external procurement.
6. The progress of the order for materials produced in-house is controlled by using the production order. The production order contains its own scheduling procedures, capacity planning and status management. Cost accounting is also carried out via the individual production order.
7. Materials that are procured externally trigger the purchasing procedure. In this case, you must have chosen suitable vendors or you must have drawn up outline agreements.
8. The quantities made available by production or by external procurement are placed in stock and are managed by Inventory Management.

Various functions in the SAP System are planned, controlled and coordinated centrally for several areas.
Material Requirements Planning (PP-MRP)

Material Requirements Planning in the Logistics Chain

14 April 2001
# Transaction Codes for MRP (PP-MRP)

<table>
<thead>
<tr>
<th>Menu Nodes</th>
<th>Transaction</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Master Data</strong></td>
<td>MD25</td>
<td>Create planning calendar</td>
</tr>
<tr>
<td></td>
<td>MD26</td>
<td>Change planning calendar</td>
</tr>
<tr>
<td></td>
<td>MD27</td>
<td>Display planning calendar</td>
</tr>
<tr>
<td></td>
<td>MDSA</td>
<td>Display BOM explosion number</td>
</tr>
<tr>
<td></td>
<td>MDSP</td>
<td>Edit BOM explosion number</td>
</tr>
<tr>
<td></td>
<td>MEQ1</td>
<td>Maintain quota file</td>
</tr>
<tr>
<td></td>
<td>OPPP</td>
<td>Explode BOM by date</td>
</tr>
<tr>
<td></td>
<td>MDUS</td>
<td>Display project assignment</td>
</tr>
<tr>
<td></td>
<td>MDUP</td>
<td>Process project assignment</td>
</tr>
<tr>
<td></td>
<td>MDL1</td>
<td>Create production lot</td>
</tr>
<tr>
<td></td>
<td>MDL2</td>
<td>Change production lot</td>
</tr>
<tr>
<td></td>
<td>MDL3</td>
<td>Display production lot</td>
</tr>
<tr>
<td><strong>Planning</strong></td>
<td>MD20</td>
<td>Create planning file entry</td>
</tr>
<tr>
<td></td>
<td>MD21</td>
<td>Display planning file entry</td>
</tr>
<tr>
<td></td>
<td>MDAB</td>
<td>Set up planning file entry in background</td>
</tr>
<tr>
<td></td>
<td>MDRE</td>
<td>Check planning file entry</td>
</tr>
<tr>
<td></td>
<td>MD01</td>
<td>Total planning online</td>
</tr>
<tr>
<td></td>
<td>MDBT</td>
<td>Total planning in background</td>
</tr>
<tr>
<td></td>
<td>MD03</td>
<td>Single-item, single-level planning</td>
</tr>
<tr>
<td></td>
<td>MD02</td>
<td>Single-item, multi-level planning</td>
</tr>
<tr>
<td></td>
<td>MD43</td>
<td>Interactive single-item planning</td>
</tr>
<tr>
<td></td>
<td>MD50</td>
<td>Multi-level, make-to-order planning</td>
</tr>
<tr>
<td></td>
<td>MD51</td>
<td>Multi-level project planning</td>
</tr>
<tr>
<td></td>
<td>MF52</td>
<td>Display planning table</td>
</tr>
<tr>
<td></td>
<td>MF50</td>
<td>Change planning table</td>
</tr>
<tr>
<td></td>
<td>MF57</td>
<td>Planning table by MRP lists</td>
</tr>
<tr>
<td></td>
<td>MF51</td>
<td>Planning table by production list</td>
</tr>
<tr>
<td><strong>Evaluations</strong></td>
<td>MD04</td>
<td>Stock/requirements list</td>
</tr>
<tr>
<td></td>
<td>MD07</td>
<td>Collective access of stock/requirements lists</td>
</tr>
<tr>
<td></td>
<td>MD05</td>
<td>MRP list</td>
</tr>
</tbody>
</table>
### Transaction Codes for MRP (PP-MRP)

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD06</td>
<td>Collective access of MRP lists</td>
</tr>
<tr>
<td>MDLD</td>
<td>Collect Development of MRP list</td>
</tr>
<tr>
<td>MD45</td>
<td>Planning result</td>
</tr>
<tr>
<td>MD46</td>
<td>Collective access of planning result</td>
</tr>
<tr>
<td>MD44</td>
<td>Planning situation for a material</td>
</tr>
<tr>
<td>MD47</td>
<td>Planning situation for a product group</td>
</tr>
<tr>
<td>MD48</td>
<td>Cross-plant planning situation</td>
</tr>
<tr>
<td>MD4C</td>
<td>Order report</td>
</tr>
<tr>
<td>MD09</td>
<td>Pegged requirements</td>
</tr>
<tr>
<td>CO46</td>
<td>Order progress</td>
</tr>
<tr>
<td>MD11</td>
<td>Create planned order</td>
</tr>
<tr>
<td>MD12</td>
<td>Change planned order</td>
</tr>
<tr>
<td>MD13</td>
<td>Individual access of planned order</td>
</tr>
<tr>
<td>MD16</td>
<td>Collective access of planned orders</td>
</tr>
<tr>
<td>MD14</td>
<td>Individual conversion of planned order into purchase requisition</td>
</tr>
<tr>
<td>MD15</td>
<td>Collective conversion of planned orders into purchase requisitions</td>
</tr>
<tr>
<td>MDUM</td>
<td>Convert planned order into purchase requisition in background</td>
</tr>
<tr>
<td>CO40</td>
<td>Convert individual planned order into production order</td>
</tr>
<tr>
<td>CO41</td>
<td>Collective conversion of planned orders into production orders</td>
</tr>
<tr>
<td>CO48</td>
<td>Partial conversion of planned order into production order</td>
</tr>
<tr>
<td>COR7</td>
<td>Individual conversion of planned order into process order</td>
</tr>
<tr>
<td>COR7_PC</td>
<td>Collective conversion of planned orders into process orders</td>
</tr>
<tr>
<td>COR8</td>
<td>Partial conversion of planned order into process order</td>
</tr>
<tr>
<td>MDVP</td>
<td>Collective availability check</td>
</tr>
<tr>
<td>MDAC</td>
<td>Execute action for planned order</td>
</tr>
</tbody>
</table>
MRP Procedures

Use

The aim of material requirements planning is to tailor available capacities and receipts on time to suit requirements quantities. You can use MRP or consumption-based planning for this. A special form of MRP is master production scheduling.

Features

- Material requirements planning [Page 18] is carried out using current and future sales figures. The planned and the exact requirements quantities trigger the net requirements calculation.

- In Master production scheduling [Page 20], finished products and important assemblies, so-called master schedule items, are planned separately and with extra attention. Only the master schedule items are planned in this planning run. The system creates dependent requirements for the BOM level directly below the planning level. It does not, however, plan levels below this.

- Consumption-Based Planning [Page 24] uses past consumption data (historical data) to calculate future requirements with the help of the material forecast or statistical planning procedures. The net requirements calculation is not hereby triggered by an independent or dependent requirement, but is triggered either when stock levels fall below a reorder point or by forecast requirements.
Material Requirements Planning

Use

MRP is carried out using current and future sales figures. The planned and the exact requirement quantities trigger the net requirements calculation. The requirement elements of this calculation include sales orders, planned independent requirements, material reservations, dependent requirements received from BOM explosion, and so on. The net requirements calculation can give the exact requirements for each day.

As you require exact requirement quantities for MRP, this means that you can work with particularly low safety stocks.

Integration

The forecast can be used in MRP to calculate the total requirement quantity or the unplanned requirement quantity.
Material Requirements Planning Procedure

Prerequisites

You have set an *MRP type* for MRP in the material master (*MRP 1 view*).

You define MRP types in Customizing for MRP in the IMG activity *Check MRP types.*

Process Flow

1. The system *calculates net requirements* for all the requirement quantities that are to be planned. The system thereby compares available warehouse stock or the scheduled receipts from Purchasing and Production with planned independent requirements, material reservations and incoming sales orders. In the case of a *material shortage*, that is, if the available stock (including firmed receipts) is smaller than the quantity required, the system creates procurement proposals.

2. The system calculates the quantity recorded in the procurement proposal according to the *lot-sizing procedure* that you specified in the material master. Various lot-sizing procedures are supported by the system. You can define a lot-sizing procedure for each individual material.

3. The procurement proposal is also scheduled which means that, for materials procured externally, the delivery and release dates are determined, and for materials produced in-house, the production dates are calculated.

4. For materials produced in-house, the *dependent requirements* of the components are determined during the BOM explosion. For each component, the dependent requirements date is displaced by the in-house production time of the higher-level material.

5. *Additional requirements* (unplanned goods issues, excess consumption of components in production, and so on) can be covered by using the materials forecast within MRP. The historical values of unplanned requirements form the basis of the forecast. These requirements are then taken into account along with the exact requirement quantities.
Master Production Scheduling (PP-MP-MPS)

Implementation Options

You can use the MPS component (PP-MP-MPS) to flag materials, which greatly influence company profits or which take up critical resources, as master schedule items and to check and plan them separately with a series of special tools.

MPS is executed using the same principles as MRP.

The aim of MPS is to reduce storage costs and to increase planning stability. This is useful in the following cases:

- To ensure that there is good material availability, various floats and a safety stock are entered, which inevitably lead to high stock levels. Thus, high storage costs are incurred, especially for valuable materials.
- The master plan of these materials greatly influences the entire production process: The planning of the dependent parts depends on the planning result of the finished products and main assemblies, even if the finished products represent a small share of all the materials to be planned. Frequent changes at finished product level can render the complete MRP run unstable.

Integration

In order to be able to work with the MPS component, you require the MRP component (PP-MRP) as well as all further components that are required for MRP.

Features

Separate Planning Run for Master Schedule Items

The system does not plan master schedule items in the normal MRP runs. This ensures that these materials can be planned independently from the other planning.

In the MPS menu there is a separate single-level planning run, which can be executed as single-item planning or total planning. This planning run only includes the master schedule items. Dependent requirements are created for the BOM level directly below the planning level. Levels below this, however, are not planned.

This means that the MRP controller can authorize any changes to the master plan before they affect the various BOM levels.

Planning Time Fence

You can protect the master plan from any automatic changes to master schedule items in the near future by using a planning time fence. Within the planning time fence, the system does not automatically schedule or change the procurement proposals. Therefore, the MRP controller has time to plan the master schedule items manually. However, to support the MRP controller, the system can create necessary procurement proposals and schedule them for the end of the planning time fence. You can then schedule these procurement proposals manually as you wish.

Processing the Planning Result Interactively

With interactive planning, you can check the results of the automatic planning run for master schedule items with simple and easy-to-use tools and simulate changes and regenerative
planning. The system does not save the planning data in the database until you save the interactive planning.

Interactive planning is especially useful for adjusting dates of planned orders falling within the planning time fence.

**Evaluating the MPS Run**

With the help of the user-friendly structure of the planning results, you can react quickly and efficiently to any problems that may occur. A series of *standard evaluations* are available within MPS to achieve this. You can also generate *individual evaluations* according to your specific needs.
Master Production Scheduling Procedure

Prerequisites

- You have set an **MRP type** for master production scheduling in the material master (MRP 1 view).

  You define MRP types in Customizing for MRP in the IMG activity *Check MRP types*.

- You have entered a planning time fence.
  - You can define a planning time fence per material or you can also use the MRP group in the material master to assign a planning time fence to a material. The planning time fence that you assign manually has priority over the planning time fence in the MRP group.
  - The firming type, which you have defined in Customizing, determines whether the system is to create procurement proposals for material shortage in the planning time fence and how these procurement proposals are to be scheduled.

Process Flow

1. You start the **total planning run for master schedule items or single-item planning for master schedule items**.

   In contrast to the MRP run, this planning run only plans the master schedule item level. The system creates dependent requirements for the BOM level directly below the planning level. However, this level and lower levels are not planned.

   Depending on the settings of the MRP type, any changes to be made to the master plan are only proposed within the planning time fence. Outside of the planning time fence, procurement proposals are created as usual.

2. You use **interactive planning** to check the **planning result** and finely tune the master plan for the master schedule items. You hereby pay particular attention to planning and scheduling the procurement proposals that are required to cover shortages within the planning time fence.

3. Once the master plan has been finely tuned for the master schedule items, you start the **total planning run** for all dependent parts. Various options exist here:

   - You can start the planning run for all BOM levels directly from the total planning run for MPS. To do this, you set the indicator *Process MRP materials* in the initial screen of the total planning run for MPS. The system will only plan the other BOM levels if this indicator is set.
   
   - If you want to plan the total BOM structure for individual master schedule items only, you can work with the single-item, multi-level planning in the menu for MPS.

4. You evaluate the planning result using **standard evaluations or user-specific evaluations**.

See also:

*Planning Time Fence [Page 442]*

*Firming Type [Page 446]*
Interactive Planning [Page 310]
Carrying Out the Planning Run [Page 284]
Planning Result and Planning Situation [Page 380]
Consumption-Based Planning

Use
As the name suggests, consumption-based planning procedures use past consumption data (historical data) to calculate future requirements with the help of the material forecast or static planning procedures. Consumption-based planning procedures have no reference to the master plan. This means that the net requirements calculation is not triggered by an independent or a dependent requirement. Instead, the net requirements calculation is triggered when stock levels fall below a reorder point or by forecast requirements calculated from past consumption data.

The advantage of this type of planning is that it is easy to use and you do not require extensive data.

Prerequisites
- The material consumption is consistent with only a few fluctuations.
- You have an efficient and current inventory management.

Features
The MRP procedures supported in consumption-based planning are:
- Reorder Point Planning
- Forecast-Based Planning
- Time-phased planning

See also:
Forecast Parameters [Ext.]
Significance of the Material Forecast for Materials Planning [Ext.]
Reorder Point Planning

Use
In reorder point planning, procurement is triggered when the sum of plant stock and firmed receipts falls below the reorder point.

Features
The reorder point should cover the average material requirements expected during the replenishment lead time.

The safety stock exists to cover both excess material consumption within the replenishment lead time and any additional requirements that may occur due to delivery delays. Therefore, the safety stock is included in the reorder level.

The following values are important for defining the reorder point:
- Safety stock
- Average consumption
- Replenishment lead time

The following values are important for defining the safety stock:
- Past consumption values (historical data) or future requirements
- Vendor/production delivery timelines
- Service level to be achieved
- Forecast error, that is, the deviation from the expected requirements

Manual Reorder Point Planning
In manual reorder point planning, you define both the reorder level and the safety stock level manually in the appropriate material master.

Automatic Reorder Point Planning
In automatic reorder point planning, both the reorder level and the safety stock level are determined by the integrated forecasting program.

The system uses past consumption data (historical data) to forecast future requirements. The system then uses these forecast values to calculate the reorder level and the safety stock level, taking the service level, which is specified by the MRP controller, and the material's replenishment lead time into account, and transfers them to the material master.

Since the forecast is carried out at regular intervals, the reorder level and the safety stock level are continually adapted to the current consumption and delivery situation. This means that a contribution is made towards keeping stock levels low.
Prerequisites

- You have set an MRP type for reorder point planning in the material master (MRP 1 view).

  You define MRP types in Customizing for MRP in the IMG activity Check MRP types.

- In the material master, you have entered or let the system automatically calculate and enter the values for the reorder point (MRP 1 view) and for the safety stock (MRP 2 view).

Process Flow

1. The continuous monitoring of available warehouse stock within reorder point planning is carried out in Inventory Management.

   Every time a material is withdrawn from the warehouse, the system checks whether this withdrawal has caused stock levels to fall below the reorder level. If this is the case, the system makes an entry in the planning file for the next planning run (see also Checking the Planning File [Page 67]).

   If a material is returned to the warehouse, the system checks in exactly the same way whether the available warehouse stock exceeds the reorder level again. If this is the case, an entry is made in the planning file, which acts as an indicator for the planning run to delete any unnecessary procurement proposals.

   If planned receipts are no longer required due to material returns, for example, then the system will suggest that these receipts should be cancelled. In this case, the MRP controller in cooperation with Purchasing or Production must check whether the purchase order or the production order can be cancelled.

2. The system then calculates the net requirements. The system compares the available stock at plant level (including safety stock) plus the firmed receipts that have already been planned (purchase orders, production orders, firmed purchase requisitions and so on) with the reorder point. If the sum of the stock plus receipts is less than the reorder point, a material shortage exists.
3. The system then calculates the **procurement quantity** according to the **lot-sizing procedure** defined in the material master.

   For reorder point planning, the system supports the *Fixed lot size* and *Replenish up to maximum stock level* lot-sizing procedures.

   You can also use period or optimum lot-sizing procedures for reorder point materials. In this case, you must calculate future requirements using the forecasting functions. The forecast values are then interpreted as requirements.

4. The system then **schedules** the procurement proposal, that is, the system calculates the dates on which the purchase order has to be sent, or when production has to begin and the date on which the vendor has to deliver the goods or by which production has to have the goods ready.
Reorder Point Planning with External Requirements

Use

In reorder point planning, an entry is only created in the planning file and the net requirements calculation is only carried out if stock levels fall below the reorder point. To avoid overplanning, sales orders, dependent requirements, reservations and so on are not usually included in the net requirements calculation as these future requirements are already planned with the reorder level. However, to guarantee that the MRP controller is informed of current issues, the system displays sales orders, dependent and manual reservations and so on.

In certain circumstances, however, it is necessary to include such external requirements in the net requirements calculation for reorder point materials.

Integration

The indicator for taking external requirements into account is set in Customizing in the IMG activity Check MRP type for the individual time-phased MRP procedure.

Features

Sales orders and manual reservations are included in planning during the replenishment lead time. In Customizing you can also enter settings for the respective MRP type, so that

- sales orders and manual reservations are included in planning not just during the replenishment lead time but during the whole horizon.
- alongside sales orders and manual reservations various other requirements are taken into account in the material requirements planning.
Forecast-Based Planning

Use
Forecast-based planning is also based on material consumption. Like reorder point planning, forecast-based planning operates using historical values and forecast values and future requirements are determined via the integrated forecasting program. However, in contrast to reorder point planning, these values then form the basis of the planning run. The forecast values therefore have a direct effect in MRP as forecast requirements.

Features
The forecast, which calculates future requirements using historical data, is carried out at regular intervals. This offers the advantage that requirements, which are automatically determined, are continually adapted to suit current consumption needs. The forecast requirement is reduced by the material withdrawal so that the forecast requirement quantity that has already been produced is not included in the planning run again.

Reducing Forecast Requirements

- **Reducing forecast requirements** by consumption
  If consumption is higher than the forecast requirements in the current month, then the system also reduces future forecast requirements.

- **Reducing current forecast requirements** by consumption
  If consumption is higher than the forecast requirements in the current month, then the system does not reduce future forecast requirements.

- **Average reduction** of the forecast requirements
  The reduction of the forecast requirements is based on average daily consumption. Actual consumption data is not relevant.
  The system calculates the average daily requirement first using the formula forecast requirement/number of workdays in the forecast period.
  The forecast requirements are then reduced by the quantity resulting from the following formula: number of workdays worked x average daily requirements.

Period Pattern and Forecast Periods

You can specify the period pattern for the forecast (daily, weekly, monthly or per accounting period) and the number of periods to be included in the forecast individually for each material. It is possible, however, that the forecast period pattern is not specific enough for planning purposes. In this case, you can define per material that the forecast requirements should be divided according to a finer period pattern for planning. You can also define how many forecast periods are to be taken into account during requirements planning. The splitting indicator is defined in Customizing for MRP per plant and per period unit and is assigned to the material in the material master.

For a monthly forecast, the requirements date would be set on the first workday of the month because, for planning, it is assumed that the total requirement must be
Forecast-Based Planning

available at the beginning of the period. You can then divide this monthly requirement into either daily or weekly requirements.
Forecast-Based Planning Procedure

Prerequisites

You have set an *MRP type* for forecast-based planning in the material master (*MRP 1 view*).

You define MRP types in Customizing for MRP in the IMG activity *Check MRP types*.

Process Flow

1. The system copies the requirements quantities that it has forecast in the requirements planning run and *calculates net requirements*. During this calculation, every period is checked to make sure that the forecast requirements are covered either by available stock, by planned receipts from purchasing or by production. If a material shortage occurs, the system generates a procurement proposal.

2. The system calculates the *quantity* recorded in the procurement proposal according to the *lot-sizing procedure* that you specified in the material master. Depending on the lot-sizing procedure, several forecast requirements are grouped together into one lot.

3. For every procurement proposal, the system calculates the date on which it must be converted into a purchase order or a production order.
Time-Phased Planning

Use

If a vendor always delivers a material on a particular day of the week, it makes sense to plan this material according to the same cycle, in which it is delivered.

Features

Materials that are planned using the time-phased planning technique are provided with an **MRP date** in the planning file. This date is set when creating a material master and is re-set after each planning run. It represents the date on which the material is to be planned again and is calculated on the basis of the planning cycle entered in the material master.

The net change planning indicator and the net change planning horizon indicator are irrelevant for materials planned using the time-phased planning procedure. The system does not therefore set these if changes are made in the planning run.

If you want to plan a material earlier than the specified MRP date, you can enter an MRP date during the planning run. For example, if the planning run is set for Monday, you can bring it forward to Saturday instead.

If you use the SAP Retail System, the system proposes the planning cycle from the vendor sub-range when you create a material master record. The vendor sub-range contains all the goods of a particular vendor that, from a logistical view, can be planned similarly.

Time-phased planning can be executed using consumption-based planning or MRP:

- If you want to carry out time-phased planning using **consumption-based planning** techniques, the requirements have to be created using the material forecast. If you use consumption-based planning, only the forecast requirements are included in the net requirements calculation. For reducing the forecast requirements, you can choose the same settings in Customizing as used for forecast-based planning.

- If you want to carry out time-phased planning using MRP, all the requirements that are relevant to MRP are included in the net requirements calculation. For this purpose, the indicator **Time-phased with requirements** must have been selected in the MRP type. The forecast requirements can also be taken into account in this process.
Time-Phased Planning Procedure

Prerequisites

In the material master:

- You have entered an *MRP type* for time-phased planning and the *planning cycle* in the form of a planning calendar (*MRP 1 view*).
- You have defined a *planned delivery time* (*MRP 2 view*).
- You have entered *lot-for-lot order quantity* as the MRP lot size (*MRP 1 view*).

You can also use the optimum lot-sizing procedures for time-phased planning. They are used here in the same way as in reorder point planning.

You define MRP types in Customizing for MRP in the IMG activity *Check MRP types*.

Process Flow

1. When you start the planning run, the system uses the MRP date recorded in the planning file to check which materials are actually to be planned. The planning date is calculated using the planning cycle.

2. The system calculates *requirements*. It also then determines a time interval. This *time interval* must take into account that the material has to cover all requirements up to the next MRP date including the delivery time.

   The requirements are calculated according to the following formula:

   Forecast requirements - or other requirements in the interval (interval = planning cycle + purchasing processing time + planned delivery time + goods receipt processing time) + safety stock
The requirements of the periods that completely lie within the interval in question are taken into account when calculating the requirements. If a requirement does not completely lie within the interval, the system only takes part of it into account.

The planned delivery time is calculated according to calendar days and the purchasing processing time and the goods receipt processing time are calculated in workdays.

3. In the net requirements calculation, the system reduces the requirements calculated in the interval by stock and firmed receipts. The remaining quantity is equal to the **shortage quantity**.

4. If you use the lot-for-lot, the system creates a **procurement proposal** for the amount of the shortage quantity. If you have selected another lot-sizing procedure, the quantity in the order proposal depends on the lot-sizing procedure.

During the calculation, the system takes for granted that the firmed receipts lie in the interval in question. It does not matter whether the firmed receipts are available at the beginning or not until the end of the interval. This means that a temporary shortage may exist, however, this is accepted.
Range of Coverage Profile in Time-Phased Planning

Use

Using the range of coverage profile, you can determine a safety stock level based on current requirements. This safety stock level is calculated using the average daily requirements quantity.

Prerequisites

You have a range of coverage profile in the material master (MRP 2 view).

💡 You define range of coverage profiles in Customizing for MRP in the IMG activity Define range of coverage profile (dynamic safety stock).

Features

Example

For example, a material that has a planned delivery time of 2 days is always planned on Tuesdays. In the net requirements calculation during the planning run, the system uses the interval between the MRP date and the availability date of the next MRP date. In this particular case, the interval starts on Tuesday and ends on Thursday of the following week (8 workdays).

- Requirements calculation without entering a range of coverage profile

  The system calculates a requirement of 160 pieces using the information from the forecast that was carried out previously. If the system does not take a range of coverage into account, it simply creates a procurement proposal for 160 pieces, if the stock level is equal to zero and no firmed receipts exist.

- Requirements calculation when the following range of coverage is entered

<table>
<thead>
<tr>
<th>Minimum range of coverage</th>
<th>3 days</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic minimum safety stock</td>
<td>60 pieces</td>
</tr>
<tr>
<td>Target range of coverage</td>
<td>5 days</td>
</tr>
<tr>
<td>Dynamic target safety stock</td>
<td>100 pieces</td>
</tr>
<tr>
<td>Maximum range of coverage</td>
<td>12 days</td>
</tr>
<tr>
<td>Dynamic maximum safety stock</td>
<td>240 pieces</td>
</tr>
</tbody>
</table>

  - If warehouse stock is equal to zero, the system adds a further 100 pieces to the procurement proposal for 160 pieces mentioned above as the incoming quantity has to cover an extra 5 days. This means that the system creates a procurement proposal for 260 pieces.
  
  - If warehouse stock is equal to 200 pieces, the system creates a procurement proposal for 60 pieces as the remaining 40 pieces would only cover a further 2 days and the stock should cover at least another 3 days. If the minimum safety stock level is not fulfilled, the system replenishes up to the target safety stock level.
  
  - If warehouse stock is equal to 220 pieces, the system creates no procurement proposal, as the remaining 60 pieces will still cover the next 3 days requirements.
Range of Coverage Profile in Time-Phased Planning

- If warehouse stock is equal to 410 pieces, the system creates an exception message in the planning run to the effect that excess stock exists - the stock will last longer than 12 days \((160 + 12 \times 20 = 400)\). Moreover, the system also indicates that the stock level of 150 pieces is too high. The target stock level is 260 pieces \((\text{requirements} + \text{target safety stock})\).

See also:

Calculating the Statistical Range of Coverage [Page 181]
Time-phased Planning Process with Delivery Cycle

Use

If you have to deal with more complex situations, you can define a delivery cycle in addition to the planning cycle. In so doing, you define the days on which the vendor delivers the goods.

You enter a delivery cycle if the delivery date (or the goods receipt date) depends on the day on which you order the goods. For example, you execute the planning run and place your orders on Mondays and Tuesdays. If you place the order on Monday, the delivery is made on Wednesday. If you place the order on Tuesday, the delivery is not made until Friday.

If you use the SAP Retail System, the system proposes the delivery cycle from the vendor sub-range when you create a material master. The vendor sub-range contains all the goods of a particular vendor that, from a logistical view, can be planned similarly.

Prerequisites

In the material master (Planning calendar field in the MRP 2 view), you have defined a delivery cycle in the form of a planning calendar in addition to the planning cycle.

Features

If you start the planning run, the system uses the MRP date recorded in the planning file to check which materials are actually to be planned. The system calculates requirements independently from that, whether you have entered a delivery cycle or not. The system uses the time interval between the MRP date and the availability date for the next MRP date as a basis for calculating the requirements quantity. It also takes for granted that the vendor requires at least the planned delivery time before he can deliver his goods. This means the following (if no goods receipt processing time has been maintained):

- If the MRP date is a Monday, the interval used for the calculation is from Monday to Friday, as the Friday is the goods receipt date of the next MRP date (Tuesday).
Time-phased Planning Process with Delivery Cycle

- If the MRP date is a Tuesday, the interval used for the calculation is from Tuesday to the Wednesday of the following week, as the Wednesday is the goods receipt date of the next MRP date (Monday).

The material's stocks (stock plus firmed receipts in the interval) must cover this interval. If a material shortage occurs, the system creates a new procurement proposal.

The system interprets the planned delivery time as the ‘minimum delivery time’. That is, it takes at least this number of days for the goods to be delivered from the time that the order was placed. Thus, the system recognizes in the example above that if the planning run is carried out on Tuesday, the material will not be delivered until Friday and not on Wednesday.

💡

The processing time required for the Purchasing department is taken into account. The planned delivery time plus the purchasing processing time must be smaller than the period between the date of the next planning run and the corresponding goods receipt date.
Time-phased Planning Process with Reorder Point Planning

Use
You can combine time-phased planning with reorder point planning.

Prerequisites
- You have set the MRP type for time-phased planning in the material master (MRP 1 view).
- You have defined a reorder point or a forecast has calculated it automatically and you have entered it in the material master (MRP 1 view).

Features
The material is not only planned up to the MRP date recorded in the planning file, but it is also planned if stock falls below the reorder level due to a goods issue. When the stock level falls below the reorder level, the system automatically sets the net change planning indicator in the planning file, which means that the material will be included in the next planning run.

It calculates the interval that starts from the moment that stocks fall below the reorder level to the availability date of the next regular MRP date and uses this for the requirements calculation. The ordered quantity must cover this interval. On the following MRP date, the material is planned as usual.
Master Data (PP-MRP-BD)

Implementation Options

The Master Data component (PP-MRP-BD) forms the basis for MRP. You cannot execute MRP without maintaining the master data.

Features

The master data for MRP, which can be maintained over the MRP menu, includes:

- planning calendar
- quota arrangements
- BOM explosion number (fixed key date)

Further master data, which can only be maintained in Customizing for MRP, includes:

- MRP controller key
- special procurement type
- lot-sizing procedure
- MRP type
- MRP area
Planning Calendar

Definition
Planning calendars define flexible period lengths for material requirements planning at plant level.

Use
- Using the planning calendar, you can define flexible periods for a period lot-sizing procedure in master production scheduling and in MRP. The system groups together the purchase order proposals, which fall within the period defined in the planning calendar, to form a lot. You allocate this special lot-sizing procedure to the material in the material master together with the planning calendar (see Period Lot-Sizing Procedures [Page 91]).

- You can also use the periods in the planning calendar for the period totals display in the stock/requirements list. If a planning calendar is valid for a particular material or if a planning calendar is entered at plant level in Customizing, the receipts and issues in the period totals display can also be grouped together according to the periods of the planning calendar (see Display of Period Totals [Page 339]).

- Finally, you can also use it to define flexible splitting periods for demand management. The total planned independent requirements quantity for a certain period (for example, for one year) is then divided up according to the period defaults in the planning calendar.
Creating Planning Calendars with Calculation Rule

1. Starting from the MRP menu choose Master data → Planning calendar → Create periods.
   The initial screen for planning calendar maintenance now appears.

2. Enter the plant for which the planning calendar is to be valid.

3. Enter a combination of numbers or letters of up to three digits in length for identifying the calendar and choose ✔️. This entry is alphanumeric.
   The screen used for maintaining the planning calendar now appears.

4. Enter a short description of the planning calendar.

5. Enter the minimum period.
   The minimum period is used as a time limit for maintenance of a calendar that is no longer valid. You use the minimum period to define the period necessary for reprocessing the calendar. If the time limit is exceeded, the system displays the calendar for processing (see Changing the Planning Calendar [Page 45]), even when the Valid to date has not been reached yet. You should therefore define the minimum period so that, in the future, the system displays the planning calendar for processing on time in the future.
   You define the validity period of the calendar after you have defined the planning rule.

6. Specify how the system should proceed if the period start happens to fall on a day that is not defined as a workday in the factory calendar.

7. Choose ✔️.
   The system displays the Select calculation rule dialog box. The calculation rule determines the calculation of the periods for the planning calendar.

8. Choose the calculation rule you require:
   - **weeks (weekdays)**
     Example: period start on Monday and Wednesday every week
   - **months (weekdays)**
     Example: period start on every second Wednesday of the month
   - **months (workdays)**
     Example: period start on every fifth workday of the month
     You can specify the workday/workdays of the planning calendar according to the workdays defined in the factory calendar.
   - **years (workdays)**
     Example: period start on every fifth workday of the year
     You can specify the workday/workdays of the planning calendar according to the workdays defined in the factory calendar.
   - **workdays**
     Example: period start on every fifth workday from a particular start date
You can specify the workday/workdays of the planning calendar according to the workdays defined in the factory calendar.

- **weekdays**
  
  Example: period start on every second Wednesday from a particular start date

9. Choose ✔.

   In the screen area *Calculation rule for period specification*, the system asks you to specify the parameters of the corresponding calculation rule.

10. Enter data as required.

11. Choose ✗ *Calculate periods*.

   The system displays the *New dates* dialog box.

   The system displays a start date in the *Valid from* field. You can change the date here, if necessary.

   In the *Valid to* field, the time period that results from the minimum period is displayed. Here, you enter the date up until which the system is to calculate the periods.

12. Choose ✔.

   The system then displays the calculated periods.

   ✔️

   The number of the displayed periods is used in the stock/requirements list for the period totals display, if the display is set according to a planning calendar.

13. Save your entries.
Creating Planning Calendars without Calculation Rule

1. Proceed as described in Creating Planning Calendars with Calculation Rule [Page 42] under points 1 to 7.
2. Choose ‏_periods‏.
3. Enter the start and finish dates as well as the number of periods.
   - If you enter only start dates, the finish dates are automatically calculated by the system (except for the last finish date).
   - If you only enter finish dates, the system will automatically calculate the start dates.
4. Save your entries.
Changing the Planning Calendar

1. Starting from the MRP menu choose Master data → Planning calendar → Change periods.
   The initial screen for planning calendar maintenance now appears.

2. Enter the plant for which the planning calendar is to be valid.

3. Choose Calendar overview or Calendar no longer valid.
   - *Calendar overview:* the system displays all the planning calendars available in the system.
   - *Calendar no longer valid:* the system displays all calendars, for which the minimum period independent of the Valid to date has been exceeded, and suggests them for reprocessing.

4. Select one or more planning calendars and choose ✓.
   The first selected planning calendar now appears. Here, you can carry out the necessary changes.

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu path</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculating new periods</td>
<td><em>Change calculation rule</em></td>
<td>Proceed as described in [Creating Planning Calendars with Calculation Rule](Page 42)</td>
</tr>
<tr>
<td>Adding periods</td>
<td>Periods</td>
<td>Choose <em>New entries</em>.</td>
</tr>
<tr>
<td>Inserting periods</td>
<td>Periods</td>
<td>Position the cursor on the line where you want to insert a new period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Choose <em>Edit → Insert</em> and enter a new period end and a new period start.</td>
</tr>
<tr>
<td>Changing periods</td>
<td>Periods</td>
<td>Overwrite the From date or the To date.</td>
</tr>
<tr>
<td>Deleting periods</td>
<td>Periods</td>
<td>Position the cursor on the period that you want to delete.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Choose <em>Edit → Delete</em>.</td>
</tr>
<tr>
<td>Fixing periods</td>
<td>Periods</td>
<td>Select the <em>fixing indicator</em> for the period(s) to be protected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fixed periods are not changed if you instruct the system to automatically calculate new periods.</td>
</tr>
</tbody>
</table>

5. Save your entries.
   If you selected several calendars in the overview, the system now automatically displays the next planning calendar that you selected.
Quota Arrangements

Use

If a material can be obtained from various sources of supply, each individual source of supply can be allocated a quota arrangement. The quota arrangement is valid for a certain period of time and specifies exactly how the receipts are to be distributed amongst each source of supply.

You can set the quota arrangement for in-house production as well as for external procurement. Sources of supply can be:

- an individual vendor or outline agreement
- another plant, from which material should be procured
- a production version

Prerequisites

- You have maintained the quota arrangement usage for the respective material in the material master (MRP 2 view).

  The quota arrangement usage determines whether a material is included in a quota arrangement and which operations lead to a quota arrangement. You can define, for example, that only purchase orders are included in quota arrangements or that procurement proposals created by the system in the planning run are also included.

  You define the quota arrangement usage in Customizing for Purchasing in the IMG activity Define quota arrangement usage.

- You have maintained the quota file for the material.

  You define the sequence of the sources of supply, the quotas per source of supply and numerous other parameters in the quota file.

Features

During the planning run, the system determines the sources of supply according to the quota file and assigns the procurement proposals to the sources of supply.

In external procurement, the procurement proposal is allocated to the appropriate vendor. This vendor is copied to the purchase requisition.

For every procurement proposal with a quota arrangement, the system updates the quota file, so that the quota arrangement is always based on the current situation.

Two procedures are available:

- **Allocation quota arrangement**: every lot is assigned to a source of supply
- **Splitting quota arrangement**: a lot is split among various sources of supply

Further functions are also available for controlling quota arrangements. For example, you can set a maximum release order quantity that defines the maximum delivery capacity of one particular vendor.
Allocation Quota Arrangement

Use

Using this procedure, you assign an exact source of supply to every lot, if you have not entered a maximum lot size or maximum release quantity in the quota file.

Features

The assignment is determined using the quota rating. The system calculates the quota rating using the following formula:

Quota rating = Quota-allocated quantity (+ quota base quantity) / Quota

The quota-allocated quantity is thereby the total quantity, which has been procured for the relevant source of supply up until then.

You can control the quota arrangement using the quota base quantity without having to change the quota, if, for example, a new source of supply is to be added to the quota arrangement.

The quota is the percentage rate that defines which part of an occurring requirement is to be taken from a source of supply.

The source of supply, which has the lowest quota rating, receives the complete lot. The quota rating determines the sequence according to which the sources of supply are chosen.
Example for Allocation Quota Arrangement

\[
\text{Quota rating} = \frac{\text{Quota-allocated quantity} + \text{Quota base quantity}}{\text{Quota}}
\]

<table>
<thead>
<tr>
<th>Reqmt 1: 1000 pieces</th>
<th>Source of supply</th>
<th>Quota</th>
<th>Quota-allocated quantity</th>
<th>Quota base quantity</th>
<th>Quota rating</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>25</td>
<td>500</td>
<td>--</td>
<td></td>
<td>20</td>
</tr>
<tr>
<td>2</td>
<td>75</td>
<td>3000</td>
<td>--</td>
<td></td>
<td>40</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reqmt 2: 1000 pieces</th>
<th>Source of supply</th>
<th>Quota</th>
<th>Quota-allocated quantity</th>
<th>Quota base quantity</th>
<th>Quota rating</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>25</td>
<td>1500</td>
<td>--</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td>2</td>
<td>75</td>
<td>3000</td>
<td>--</td>
<td></td>
<td>40</td>
</tr>
</tbody>
</table>

The first procurement proposal is allocated to item 1, and the second procurement proposal to item 2.
Splitting Quota Arrangement

Use

You can use the splitting quota arrangement to distribute a procurement proposal among various sources of supply, that is, split them up.

Prerequisites

In the material master (MRP 1 view), you have assigned a lot-sizing procedure with splitting quotas for the materials to be included in this procedure.

This quota arrangement logic with the splitting quota is set in Customizing per lot-sizing procedure.

Features

Order Quantity Calculation

The order quantity is calculated according to the following formula:

\[(\text{Quota source of supply } X \times \text{ Requirement quantity}) / \text{Total of all quotas}\]

The quota-allocated quantity of a source of supply or the quota rating is not relevant for the splitting quota.

The system splits the requirements according to the sequence that is defined by the quota, that is, the vendor with the highest quota is selected first. The sequence defined by the quotas can be overruled by priorities. This means that vendors that have been allocated priorities are always selected first. The quantity, however, is always calculated according to the formula above using the quotas.

Determining a Minimum Quantity for Splitting

The minimum quantity for the splitting quota determines that the lot has to amount to the minimum quantity (at least) before it can be split.

If a requirement is smaller than the minimum quantity, the system only selects the vendor whose turn it is according to the quota arrangement calculation, that is, it is processed on the basis of the allocation quota arrangement procedure and is not split.

If a requirement quantity has already been split and the remaining quantity causes a lot that is smaller than the minimum quantity, the system does not further split this quantity. The remaining quantity is assigned to the source of supply with the lowest quota rating.

See also:

Lot-Sizing Procedures [Page 84]
Example for Splitting Quota Arrangement

Example Data

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum quantity</td>
<td>400</td>
</tr>
<tr>
<td>Requirement</td>
<td>1000</td>
</tr>
<tr>
<td>Lot size</td>
<td>Lot-for-lot order quantity</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Quota</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor A</td>
<td>40</td>
</tr>
<tr>
<td>Vendor B</td>
<td>30</td>
</tr>
<tr>
<td>Vendor C</td>
<td>20</td>
</tr>
<tr>
<td>Vendor D</td>
<td>10</td>
</tr>
</tbody>
</table>

Order Quantity Calculation

Vendor A receives the first order due to having the highest quota. The quantity results from the above-mentioned formula with $\frac{40 \times 1000}{100}$ as 400 pieces.

There is a remaining quantity of 600 pieces. Vendor B receives the next order with the quantity $\frac{30 \times 600}{60}$ as 300 pieces. As A has already been used, that quota is not taken into account.

There is a remaining quantity of 300 pieces. As the value is smaller than the minimum quantity, the system does not split it further. The system assigns the complete remaining quantity to vendor D, as this vendor has the lowest quota rating.
Lot Size and Rounding Profile in Quota Arrangement

Use
You can maintain a minimum lot size, a maximum lot size and a rounding profile for each quota item.

Integration
The minimum lot size, maximum lot size or rounding profile that you have maintained in the quota item override the entries in the material master and are valid for the assigned sources of supply. If you have maintained the minimum or maximum lot size in the material master, the values that you have entered there are valid for all sources of supply.

Features

Minimum Lot Size
The minimum lot size defines a minimum quantity for the procurement proposal. If a source of supply is determined on the basis of the quota arrangement logic, for which a minimum lot size has been entered and if the requirement quantity is smaller, the system creates the procurement proposal for the amount of the minimum quantity.

Maximum Lot Size
The maximum lot size determines the largest possible quantity for the procurement quantity. If a requirement exceeds the maximum lot size recorded for the quota item, then several procurement proposals are created for the maximum lot size until the total requirement is covered. If there is a remaining quantity that is smaller than the maximum lot size, the last procurement proposal is created to cover the amount of this rest quantity.

After each procurement proposal is created, the quota arrangement is restarted, that is, the quota rating is recalculated to check which source of supply is to be used next. If the quota of a source of supply is high, then it can be used, if necessary, to create several procurement proposals for the maximum lot size.

"Only Once" Indicator
To avoid a situation where more than one order proposal is created per requirement for a source of supply, with the maximum lot size, you can set the Only once indicator for this particular source of supply. This source of supply is then only used once per requirement.

It only makes sense to use the Only once indicator in combination with the maximum lot size.

Rounding Profile
If a quota item with a rounding profile is selected, then the quantity of the procurement proposal is adjusted according to the rounding profile.
Example for Maximum Lot Size

Example Data

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Lot size</th>
<th>1000 pieces</th>
<th>Period lot size with weekly grouping</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Quota</th>
<th>Maximum lot size</th>
<th>Previous quota-allocated quantity</th>
<th>Only once indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor A</td>
<td>80</td>
<td>200</td>
<td>200</td>
<td>X</td>
</tr>
<tr>
<td>Vendor B</td>
<td>15</td>
<td></td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>Vendor C</td>
<td>5</td>
<td></td>
<td>200</td>
<td></td>
</tr>
</tbody>
</table>

Order Quantity Calculation

The quota rating of vendor A is the lowest. Therefore, vendor A receives a procurement proposal for 200 pieces due to the maximum lot size.

The quota rating is then recalculated. Although the quota-allocated quantity has increased to 400 for vendor A, the quota rating for this vendor is still smaller than for the other two vendors. According to this, the next procurement proposal (200 pieces) would go to vendor A again. However, as the Only once indicator is set, vendor A cannot be used a second time. The system assigns the next procurement proposal to vendor B, as this vendor has the next lowest quota rating. Therefore, the next procurement proposal is made for vendor B for 800 pieces as no maximum lot size has been set for this vendor.

With the Only once indicator, you achieve a situation where vendor A only receives one procurement proposal per week (due to the weekly grouping of the period lot size) for a maximum of 200 pieces (for example, due to limited capacity). With this type of capacity monitoring, quantities that have already been released are not taken into consideration.
Priority and Maximum Release Quantity per Period

Features

Priority
Using the priority function, you can define the sequence of sources of supply irrespective of the quota rating and thus, irrespective of the quota-allocated quantity. If several sources of supply have priorities, then the source of supply with the smallest number in the priority field is selected first. Only once all the sources of supply with priorities have been selected, does the system then select the sources of supply with no priorities. Then, the system implements the normal logic for quota arrangements using the quota rating (see Allocation Quota Arrangement [Page 48]).

Maximum Release Quantity
The maximum release quantity defines the maximum available capacity of a source of supply and thus makes it possible to monitor capacities.

The maximum release quantity is defined for a certain period of time. In addition, you enter the number of periods for which the release quantity is valid, for example, a quantity of 200 pieces per week. The system checks whether the there are firmed receipts (firmed purchase requisitions and planned orders, firmed schedule lines, production orders, purchase orders) in the specified period that have already been scheduled or allocated and compares this quantity with the maximum release quantity.

If more firmed receipts are scheduled in a certain period than the maximum release quantity allows, then this source of supply is no longer used. Here, the system always checks using the availability date of the MRP element. For newly created procurement proposals, the system uses the requirement date of the source requirement.

If a certain percentage of the maximum release quantity has already been used for a source of supply and a further requirement occurs that exceeds the remaining quantity, then the system splits the requirement quantity. Another procurement proposal is created for this source of supply for the difference between the release quantity and the order proposal quantity. The rest of the requirement quantity is allocated to the next vendor whose turn it is according to the quota rating logic.
Example for Priority and Maximum Release Quantity

This example only applies to the allocation quota arrangement, that is, a splitting quota arrangement is not defined. You thus allocate every lot to one source of supply.

Example Data

In the procurement procedure for a particular material, you have a preferred vendor A that is always to be selected first. However, this vendor can only deliver 100 pieces per week. If you require more than 100 pieces, then the remaining quantity is to be procured from vendor B. However, this vendor also has a limited capacity and can only deliver 200 pieces per week. If you require more than 300 pieces in a week, the remaining quantity is to be divided between vendors C and D in the ratio 70 : 30.

The sources of supply are maintained as follows:

<table>
<thead>
<tr>
<th>Quota</th>
<th>Priority</th>
<th>Maximum release quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor A</td>
<td>1</td>
<td>100</td>
</tr>
<tr>
<td>Vendor B</td>
<td>2</td>
<td>200</td>
</tr>
<tr>
<td>Vendor C</td>
<td>70</td>
<td></td>
</tr>
<tr>
<td>Vendor D</td>
<td>30</td>
<td></td>
</tr>
</tbody>
</table>

Allocation Quantity Calculation

The requirement quantity amounts to 1000 pieces.

The system selects vendor A first. However, due to the limited capacity situation, he only receives a procurement proposal for 100 pieces. Vendor B is then used. He receives an order proposal for 200 pieces. The remaining 700 pieces are supplied by either vendor C or D, depending on whose quota rating is the lowest.

This represents the typical procedure unless other purchase orders or firmed receipts already exist for vendors A or B in the week that the new procurement proposals are created. If, for example, a purchase order already exists for vendor A in this week for 100 pieces, then this vendor is no longer taken into account. If a purchase order for 40 pieces already exists, then he receives another order proposal for 60 pieces. The remaining quantity is distributed further.
Maintaining the Quota File

You can maintain the quota file in Purchasing or MRP. In this section, a description is given of how to maintain this file from Material Requirements Planning.

1. Starting from the MRP menu, choose Master data → Quota maintenance.
   The initial screen for maintaining quota appears.

2. Enter the material number and the plant for the material that you want to use to maintain the quota file and choose ✓.
   The header screen for maintaining quotas appears.

3. Enter the Valid to date for the quota arrangement item.
   You can only define continuous validity periods for one material. In the first interval, the system sets the current date in the Valid from field. The Valid from dates of the other intervals are set continuously so that the day after the end date of the last quota item is set as the start date for the next item.

4. If you want to work with splitting quota arrangements, enter a minimum quantity here.

5. Double-click on the item that you want to process.
   The item screen now appears.

6. Define the source of supply and other control parameters per item.
   Allocating the source of supply to the quota item determines the procurement type that the procurement proposal receives. Therefore, you can specify via the quota arrangement that, for example, 60% of a material is produced in-house and the other 40% is procured externally.

7. Save your entries.
Material Requirements Planning (PP-MRP)

BOM Explosion Number (Fixed Key Date)

**BOM Explosion Number (Fixed Key Date)**

**Use**

The system explodes the BOM that is valid on this date.

For multi-level BOM structures, larger time intervals may exist between the explosion dates of the individual assemblies. If BOMs (or alternative BOMs) have been changed in the meantime (for example, exchanging individual components due to new technical drawings, changed production techniques, due to parts to be discontinued etc.) a situation may exist whereby an assembly that is used repeatedly is produced with different BOM structures.

If you want to ensure that for a certain production unit, the BOM structure is always exploded **with the same date**, you can allocate a BOM explosion number to the planned order (or for make-to-order production it can be directly allocated to the sales order).

**Prerequisites**

- You have created a BOM explosion number.
- You have entered the BOM explosion number in the sales order, or entered it when creating the planned independent requirements or when manually creating/changing planned orders.

  The system can automatically specify the BOM explosion number when entering planned independent requirements or customer independent requirements or when entering the sales order.

**Features**

By means of the BOM explosion number, you can define a common explosion date (fixed key date) for all BOM levels. BOM explosion is then carried out with this fixed key date for all levels.
BOM Explosion Without Fixed Key Date

BOM Explosion with Fixed Key Date

See also:
Assigning a New Key to the BOM Explosion Number [Page 63]
Creating BOM Explosion Numbers

1. Starting from the MRP menu, choose Master data → BOM explosion number → Edit.
   The system displays the initial screen for maintaining the BOM explosion number.

2. Choose 📋.
   The screen for maintaining the BOM explosion numbers now appears.

3. Choose New entries.
   A screen now appears where you can enter new BOM explosion numbers.

4. Enter data as required.

   - **BOM explosion number**
     The BOM explosion number is the object for which the following data is maintained.
     It can be entered alphanumerically.

   - **Fixed key date**
     The fixed key date determines which bill of material is exploded.

   - **Plant**
     You can also specify a BOM explosion number for a specific plant. Enter the appropriate plant in this case.

   - **Material**
     You can specify a BOM explosion number for a specific material. Enter the appropriate material in this case.

   - **Status**
     You can set the BOM explosion number to active or inactive using the status field.
     Only active BOM explosion numbers are used in the planning run.

5. Save your entries.
Changing BOM Explosion Numbers

1. Starting from the MRP menu, choose Master data → BOM explosion number → Edit. The system displays the initial screen for maintaining the BOM explosion number.

2. If necessary, enter certain restrictions for the selection of existing BOM explosion numbers:
   - if you want to maintain a specific BOM explosion number, enter it in the From BOM explosion number field. This BOM explosion number is then displayed first.
   - if you want to maintain all the BOM explosion numbers for a specific interval, enter the appropriate BOM explosion numbers in the From BOM explosion number and To BOM explosion number fields.
   - enter the maximum number of BOM explosion numbers to be selected in the Maximum number for selection field.
   - if you only want to maintain the BOM explosion numbers of a certain plant, enter the appropriate plant in the Plant field.
   - if you only want to select the BOM explosion numbers of a specific material, enter this material in the Material field.

3. Choose . The screen for maintaining the BOM explosion numbers now appears.

4. Select the BOM explosion number(s) that you want to change and choose . The selected BOM explosion numbers are now made ready for input.

5. Change the corresponding data.

6. Save your entries.
Assigning a New Key to the BOM Explosion Number

Use

The BOM explosion number is transferred to the planned order of the finished product or of the main assembly during the planning run and copied to the planned orders for the main assemblies on all BOM levels when determining dependent requirements.

If you want an individual assembly within the BOM structure to be exploded with a different date, you can assign a new key to the BOM explosion number, that is, assign a different BOM explosion number to the main assembly.

This is also the case, when a main assembly is used in several BOMs and various BOM explosion numbers have been maintained for the higher levels. The new key assignment then determines that the main assembly is always produced with one standard BOM explosion number.

Procedure

1. Proceed as described in Changing BOM Explosion Numbers [Page 62] under points 1 to 3.
2. Select the BOM explosion numbers that you want to assign a new key to.
3. Choose Maintain new key assignment.
   The screen for maintaining new key assignments now appears.
4. Enter the following data:
   - Plant for the material that you want to assign a new key to.
   - Material number for the material that you want to assign a new key to.
   - BOM explosion number, that is, the new BOM explosion number that the material should receive.
5. Choose ✔.
   The system displays the fixed key date, the short description of the reassigned BOM explosion number, and the short text of the material.
6. Save your entries.
Assign New Project Account Assignment to Material Components

Use

In Sales Order Management, the sales order is assigned to a WBS element account. In the planning run, procurement proposals for all dependent materials that are included in the project structure are assigned to the WBS account to which the sales order is assigned.

If you want to assign certain assemblies and material components to the account of a sub-project of the project structure, you can use this function to assign the material numbers to the WBS elements of the sub-project.

In the planning run, the material component determined here and all materials dependent on this material are assigned to the sub-project account.

Prerequisites

You have assigned a WBS element to the sales order.

Procedure

1. Starting from the MRP menu, choose Master data → Project assignment → Edit.
   
   The system displays the Process project allocation screen.

2. Enter the sales order and the sales order item and choose ✓.

3. Enter the plant, the material number and the WBS element of the sub-project.

4. Save your entries.
Planning Process

This section deals with the business and technical procedures of material requirements planning.

Process Flow

The system carries out the following processes in the planning run:

1. The system checks the **planning file**. During this process, the system checks whether a material is to be planned due to a change relevant to MRP, and how to proceed if there are already existing procurement proposals (see Checking the Planning File [Page 67]).

2. The system calculates **net requirements** for every material. For this calculation, the system checks whether the requirements are covered by the warehouse stock and dispatched receipts from Purchasing or Production. If the requirements cannot be covered, the system creates a **procurement proposal** (see Net Requirements Calculation [Page 78]). If a material has been assigned a range of coverage profile, the **dynamic safety stock** is also calculated during the planning run using the **range of coverage profile**. This ensures sufficient material availability even for unplanned additional requirements (see Calculating the Statistical Range of Coverage Using the Range of Coverage Profile [Page 181]).

3. The system calculates **procurement quantities**. When doing this, the system takes into account the selected **lot-sizing procedure** and, if necessary, **scrap** and **rounding** values (see Calculating Procurement Quantities [Page 83]).

4. The system carries out the scheduling in order to calculate the start and finish dates for the procurement proposals (see Scheduling [Page 114]).

5. The system determines the type of **procurement proposal**. Dependent upon the defined setting, planned orders, purchase requisitions or delivery schedules are created by the system for a material (see Determining the Procurement Proposal [Page 134]). If you have maintained the necessary entries for quota arrangements, the system also determines the **source of supply** and allocates this to the procurement proposal (see Quota Arrangements [Page 137]).

6. For every procurement proposal of an assembly, the system explodes the BOM and determines the dependent requirements (see BOM Explosion and Determining Dependent Requirements [Page 145]).

7. During the planning run, the system recognizes **critical situations** that have to be assessed manually in the planning result by the work scheduler. The system creates exception messages and, if necessary, checks rescheduling (see Creation of Exception Messages [Page 177], Rescheduling Check [Page 178]). The system also calculates the **actual range of coverage** and the **days’ supply and receipt days’ supply** (see Days’ Supply and Receipt Days’ Supply [Page 192], Actual Range of Coverage [Page 194]).

The planning run is usually carried out at plant level. In addition, the following are also possible:

- **Storage Location MRP** [Page 213]
- **Planning with MRP Areas** [Page 220]
- **Multi-Plant/Site Planning** [Page 251]
Planning Process

**Result**

After the planning run, the MRP controller can check and edit the generated procurement proposals. Various evaluations are supported by the system.

**See also:**
- Special Planning Processes [Page 195]
- Evaluating the Planning Result [Page 312]
Checking the Planning File

Implementation Options

The first process in MRP is the checking of the planning file.

The planning run and the scope of the planning run (which materials are planned in which planning run) are controlled by the planning file.

The planning file contains a list of all materials relevant to the planning run. As soon as a material master record is created with MRP data and a valid MRP type, this material is then automatically included in the planning file.

Prerequisites

The planning file has been set up and includes all materials relevant to MRP.

Process Flow

1. The system checks whether the material to be planned is included in the planning file, that is, whether the material number is in the planning file and whether the NETCH or NETPL indicator has been set for net change planning or net change planning in the planning horizon (see also Planning Run Types and Scope of Planning [Page 69]).

2. The system reads the low-level code. The low-level code defines the sequence in which the materials are to be planned. The system plans materials with the low-level code 000 first and then those with 001, and so on. (See also Calculating Low-Level Codes [Page 73]).

3. The system checks whether the BOM is to be re-explored due to existing procurement proposals. The system re-explodes the BOM if an X has been entered in the BOM explosion column of the planning file.

4. The system checks whether procurement proposals existing since the last planning run for a material are to be deleted and recreated. The system does this if an X has been entered in the Reset Order Proposals column (see also Planning Mode [Page 71]).

5. The system reads the MRP date in addition to the planning file entry if time-phased planning or MRP combined with time-phased planning is used. The MRP date is copied from the planning calendar and determines when planning is to be carried out for the material.

6. The system checks whether the material is a master schedule item. The system does this if an X has been entered in the MPS Item column of the planning file. This indicator is set if the material has an MRP type for master production scheduling.
Individual Customer Planning File Entries

Use

If you create or change the configuration or the sales order BOM for a sales order, the system then creates an individual customer planning file entry. In the planning run, only the planned orders for the changed sales orders are re-exploded, that is to say, not all the planned orders for all the sales orders. System performance is thus improved.

Integration

The individual customer planning file entries have their own individual customer planning file. This file differs from the planning file only due to the additional fields: sales order number and sales order item.

💡

You cannot display individual customer planning file entries.

Features

The system checks whether an individual customer planning file entry exists for a material that is to be planned. If this is the case, only the planned orders that belong to the changed sales order are re-exploded. This also applies for the subordinate components.

After the planning run has been carried out, the individual customer planning file entries are deleted.
Planning Run Type

Use
The planning run type determines which materials are to be planned:

- **Regenerative planning (NEUPL)**
  The system plans all the materials that are contained in the planning file.

- **Net change planning (NETCH)** or **Net change planning in the planning horizon (NETPL)**
  The system only plans materials that have undergone a change relevant to MRP since the last planning run.

You choose the required planning run type in the initial screen of the planning run (see **Planning Run Type in Initial Screen** [Page 286]).

Features

Net Change Planning (NETCH)
In net change planning only those materials are planned for which the net change planning indicator in the planning file has been set as a **planning file entry**. The system usually sets the indicator automatically as soon as a change is made to the material that is relevant to MRP.

The following changes cause an entry in the planning file to be made:

- Changes to stock, if these change the stock/requirements situation of the material
- Creation of purchase requisitions, purchase orders, planned orders, sales requirements, forecast requirements, dependent requirements or reservations
- Changing to fields that are relevant to the planning run for these receipts and issues or in the material master
- Deleting receipt or issue quantities

⚠️
If you have changed the settings of an MRP type, a lot-sizing procedure or a purchasing department processing time in Customizing, the materials that are affected by these changes thus have no planning file entry and are not included automatically in the net change planning. To enable the changes made to take effect, you choose **regenerative planning** in the initial screen of the planning run or make an entry manually in the planning file.

Net change planning in the planning horizon (NETPL)
You can also use a **planning horizon** to further limit the scope of the planning run. In "net change planning in the planning horizon", the system only plans materials that have undergone a change that is relevant to the planning run within the period which you defined as the planning horizon. The system sets the **net change planning horizon**

Activities
- During the planning run, the system checks every entry for a material in the planning file:
Planning Run Type

- In a **regenerative planning run**, the system plans all materials which are included in the planning file irrespective of all indicators.

- In a **net change planning run**, the system only plans those materials which are provided with the net change planning indicator.

- In **net change planning in the planning horizon**, the system only plans those materials provided with the net change planning horizon indicator.

- On completion of the planning run, the appropriate indicator is automatically deleted in the planning file:
  - The system deletes the net change planning indicator and the net change planning horizon indicator for a regenerative planning run and a net change planning run.
  - The system only deletes the net change planning horizon indicator for a net change planning run in the planning horizon

![Tip]

If a termination occurs when planning a material, the indicators for this material remain in the planning file so that the material is planned again in the following net change planning run. However, depending on the error, you can manually delete the indicators in Customizing for MRP in the IMG activity Define Error Processing in the Planning Run if necessary (for example, if a certain material is not available in the planning plant). This means that you can avoid a situation where materials are pointlessly planned again and again.
Planning Mode

Use

The planning mode controls how the system is to deal with procurement proposals (planned orders, purchase requisitions, scheduling agreement lines) from the last planning run, which are not yet firmed, in the next planning run.

Usually, the master plan is adjusted in the planning run to adapt it to either new dates or quantities. If a requirements quantity was increased, the system automatically adjusts the quantity of the corresponding procurement proposal. If changes are made in the BOM or material master, the planning mode controls whether or not these changes will have an effect in planning.

Features

The planning mode is set automatically in the planning file. However, you can overwrite it in the initial screen of each planning run.

Planning Mode in the Planning File

- **Planning Mode 1**
  
  Planning mode 1 is if you have only set the planning file entries (net change planning indicator and net change planning horizon indicator) in the planning file for a material (see Planning Run Type [Page 69]).

  In the planning run in planning mode 1 the system reactivates the existing planning data, that is, procurement proposals that are not firmed remain on the database and are only then adapted, if the dates and quantities do not suit the new planning situation. The system only re-explodes the BOM for adjusted procurement proposals. System performance is thus improved.

  Example of changes that cause planning mode 1 to be set:
  - Changes in date and quantity
  - Requirement changes
  - Changes in the lot-sizing procedure or MRP type

- **Planning Mode 2**
  
  Planning mode 2 is if a material has planning file entries and the Re-explode BOM indicator is also set in the planning file.

  In the planning run in planning mode 2, the system re-explodes the BOMs for all existing procurement proposals that are not firmed and also for those, for which the dates and quantities do not have to be adjusted.

  Example of changes that cause planning mode 2 to be set:
  - Changes to the material BOM
  - Changes to the sales order BOM
  - Changes to the phantom assembly BOM
  - Changes to references assigned within BOM
  - Changes to material classification
Planning Mode

- Change of production version in material master or planned order
- Change or conversion of BOM explosion number

**Planning Mode 3**

Planning mode 3 is if a material has planning file entries and the *Reset order proposals* indicator is also set in the planning file.

In planning mode 3 existing procurement proposals that are not firmed are completely deleted from the database and recreated. The system then re-explodes the BOMs.

Example of changes that cause planning mode 3 to be set:

- In-house production time
- Planned delivery time
- Scheduling margin key
- MRP controller

**No Planning File Entry**

The following types of changes do not cause a planning file entry:

- **Customizing**, such as changes in purchasing department processing time in the plant parameters
- **MRP-relevant changes to the routing**, such as change in the standard time

**Planning Mode in Initial Screen of the Planning Run**

The planning mode set in the planning file for a material can be overruled by the planning mode in the initial screen of the planning run. For more information, see *Planning Mode in the Initial Screen* [Page 290].
Calculating Low-Level Codes

Implementation Options

Materials may appear in several products and in several production levels of a product. The low-level code represents the lowest level of usage of a material within all product structures. It determines the sequence in which the materials are planned. The system plans materials with the low-level code 0 first and then those with 1 and so on. The lower the low-level code is, the higher the number assigned to the level.

Prerequisites

You have created BOMs for the materials that you want to plan.

Process Flow

<table>
<thead>
<tr>
<th>Explosion level</th>
<th>Product FERT-01</th>
<th>Product FERT-02</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>FERT-01</td>
<td>FERT-02</td>
</tr>
<tr>
<td>1</td>
<td>HALB-01</td>
<td>HALB-02</td>
</tr>
<tr>
<td>2</td>
<td>HALB-03</td>
<td>ROH-03 ROH-04</td>
</tr>
<tr>
<td>3</td>
<td>ROH-01 ROH-02</td>
<td>ROH-03 ROH-04</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Low-level-code</th>
<th>Product FERT-01</th>
<th>Product FERT-02</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>FERT-01</td>
<td>Fert-02</td>
</tr>
<tr>
<td>1</td>
<td>HALB-01</td>
<td>HALB-04</td>
</tr>
<tr>
<td>2</td>
<td>HALB-03</td>
<td>HALB-02 ROH-05 ROH-06</td>
</tr>
<tr>
<td>3</td>
<td>ROH-01 ROH-02</td>
<td>ROH-03 ROH-04</td>
</tr>
</tbody>
</table>

Result

The low-level code is stored in the BOM management program in the material master (Additional data, 1) and is entered in the planning file.
Displaying the Planning File

1. Starting from the MRP menu choose Planning → Planning file entry → Display.

   The initial screen for displaying planning file entries now appears.

2. Enter your selection criteria:

   If you leave the material, MRP area, plant and low-level code fields blank, the system selects all materials in all MRP areas and all plants.

3. Choose 🗿.

   The system displays a list of all the materials that fulfill your selection criteria.

   - The record type of the planning file entry is given in column RT. MRP materials are automatically provided with a B and phantom assemblies with a D.

   - In the low-level code column, you can see the respective low-level code of the material. In the material master record, each material is allocated one low-level code (field L.Lvl Code) which is determined by the bill of material (BOM) management program. You can also display the low-level code in the material master (Additional data, 📑).

   - If a material does not appear in a bill of material, the system will automatically allocate the highest level (999).

   - In the MPS item column, the indicator for a master schedule item is set.

   - If the Net change planning indicator is set for a material then it is included in the net change planning run.

   - If the Net change planning horizon indicator is set for a material then this material is included in the net change planning in the planning horizon.

   - If you set the BOM explosion indicator, then available planned orders are taken over but the BOM is re-exploled and the routing re-released.

   - If you set the Reset order proposal indicator, then planning dates that may be available are always deleted and recreated.


   A window with statistical data appears. Here you see how many materials have been selected in total and how many of these exist for each of the indicators mentioned above.
Setting Up the Planning File

Use

If a material was created before the planning run was activated for a plant, you must generate an entry in the planning file for all materials in this plant that are to be included in the planning run.

This function can only be carried out in background mode.

Procedure

1. Starting from the MRP menu choose Planning → Planning file entry → Set up in background.
   The initial screen for the setting up of planning file entries appears.
2. You can use a selection variant to plan the creation of planning file entries at a later date, or you can start the process immediately.
3. Once you have started the process, the system checks each material in this plant to see whether it is relevant for MRP. If a material fulfills the appropriate prerequisites, it is included in the planning file and either the net change planning indicator or the net change planning horizon indicator is set.

Result

These materials are then included in the following MRP run.
Creating Entries in the Planning File Manually

Use
Planning file entries are usually set automatically by the system. In some exceptional cases, however, you may find it necessary to make an entry in the planning file manually.

Procedure
1. Starting from the MRP menu choose Planning → Planning file entry → Create.
   The screen for creating a planning file entries now appears.
2. Enter the material number and plant or MRP area as well as, if required, further planning indicators.
3. Choose ✓.

Result
The system checks the relevancy of the entered material for MRP and confirms the successful entry in the planning file.
Check the Consistency of the Planning File

Use
Since the entries in the planning file are permanent, you must check their MRP relevancy regularly. If, for example, a plant is subsequently excluded from material requirements planning, its materials will still be included in the planning file. The same applies for materials that are subsequently flagged with the MRP type *No MRP* and are thus excluded from MRP. In such cases, you should delete the entries in the planning file.

Procedure
1. Starting from the MRP menu choose *Planning → Planning file entry → Consistency check.*
   The initial screen for checking consistency now appears.
2. By using a selection variant, you can either plan the consistency check of the planning file entries to take place at a later date or you can start the process immediately.
3. Once the consistency check has started, the system checks each entry for the following information:
   - Does the material still exist, that is, does a material master record still exist for the material?
   - Is material requirements planning activated for the plant?
   - Does the material have a valid MRP type in the material master?
   - Does the low-level code still match the one in the material master?

Result
If one of these criteria no longer applies, the respective entry is deleted from the planning file.
If the low-level code no longer corresponds to the one in the material master record, the entry is deleted from the planning file and a new one is created with the current low-level code.
Net Requirements Calculation

The net requirements calculation is carried out in MRP in the planning run after the planning file check and at plant level. The system checks whether it is possible to cover requirements with the plant stock and fixed receipts already planned. In the case of a shortage the system creates a procurement proposal.

Process Flow

1. The system calculates **plant stock**. For all storage locations which belong to this plant and which are not excluded from materials planning or are planned separately, the following stocks are grouped together to form plant stock:
   - Unrestricted-use stock
   - Stock in quality inspection
   - Unrestricted-use consignment stock
   - Consignment warehouse stock in quality inspection

   In Customizing for MRP in the IMG activity *Availability of Stock in Transfer/Blocked Stock/Restricted Stock*, you can also determine whether stock in transfer, blocked stock and restricted-use stock are included in the plant.

2. The system also takes into account all the **goods issues and receipts** for a material. Receipts are, for example, planned orders or purchase requisitions and issues are, for example, customer requirements, planned independent requirements, or reservations.

3. Therefore, the system checks to make sure that for each issue date, the requirement is covered by one or several receipts or by warehouse stock. If this is not the case, the system then calculates the shortage quantity and creates a procurement proposal. The lot-sizing procedure, scrap and rounding determine the quantity in the procurement proposal (see *Calculating Procurement Quantity [Page 83]*).

   The net requirements calculation supports the following types of planning: Reorder point planning, forecast-based planning, material requirements planning (MRP). In each procedure, the system calculates the available stock differently.
Net Requirements Calculation for MRP

Use

In MRP, requirement quantities are maintained in the system as planned independent requirements, customer requirements, dependent requirements, material reservations as well as forecast requirements. The system checks every exact requirement and every forecast requirement to determine whether they are covered by available warehouse stock and/or receipts (purchase orders, firmed procurement proposals, production orders, and so on).

Prerequisites

You have set an MRP type in the MRP Type field in the material master (View MRP 1) to MRP for the material.

Features

Available stock is calculated as follows:

<table>
<thead>
<tr>
<th>Plant stock</th>
<th>Safety stock</th>
<th>Receipts (purchase orders, firmed procurement proposals, production orders)</th>
<th>Requirements quantity (for example, planned independent and customer requirements, material reservations, forecast requirements for unplanned additional requirements)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Available stock = Plant stock - Safety stock + Receipts - Requirements quantity

A shortage occurs if available stock is negative, that is, the requirement quantities are greater than expected receipts and stock quantity.

The system specifies the date of the issue (for example, customer requirement, planned independent requirement, reservation, forecast requirement) as the requirements date.
Net Requirements Calculation for Reorder Point Planning

Use
In **reorder point planning**, the net requirements calculation is only carried out once **the stock level has fallen below the reorder level**. Issue elements, such as, customer requirements, planned independent requirements, or reservations are only displayed and are not included in the net requirements calculation.

Prerequisites
You have set an MRP type for the material in the **MRP Type** field in the material master (View **MRP 1**) to **Reorder point planning**, for example **VB** or **VM**.

Features
Available warehouse stock is calculated as follows:

\[ \text{Plant stock} + \text{Open order quantity (purchase orders, firmed planned orders, firmed purchase requisitions)} = \text{Available stock} \]

If available warehouse stock falls short of the reorder level then the shortage quantity is the difference between these two.

The system specifies the date of the planning run as the requirements date.

💡
Safety stock is ignored when calculating the shortage quantity. However, if stock should fall below the safety stock level, the MRP controller receives an exception message.
Net Requirements Calculation for Forecast-Based Planning

Use

The basis of forecast-based planning is the forecast of the total requirements. The system only considers the forecast requirement quantities as issues. Other issue elements, such as, customer requirements, planned independent requirements, or reservations are only displayed and are not included in the net requirements calculation. The system checks every forecast requirement to determine whether it is covered by available warehouse stock and/or receipts (purchase orders, firmed procurement proposals).

Prerequisites

You have set an MRP type for the material in the MRP Type field in the material master (View MRP 1) to forecast-based planning.

Features

Available stock is calculated as follows:

<table>
<thead>
<tr>
<th>Plant stock</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety stock</td>
</tr>
<tr>
<td>Receipts (purchase orders, firmed purchase orders)</td>
</tr>
<tr>
<td>Requirements quantity (forecast requirements)</td>
</tr>
<tr>
<td>---------------------------------</td>
</tr>
<tr>
<td>Available stock</td>
</tr>
</tbody>
</table>

A shortage occurs if available stock is negative, that is, the requirements quantity is greater than expected receipts.

The system specifies the forecast requirements date as the requirements date. In this case, it assumes that forecast requirements are needed at the beginning of the period. This means that the requirements date is the first workday of the respective period.

💡 If the requirements of a particular period are not to be set on the first workday, but are to be evenly distributed over the period instead, select the splitting function of the forecast requirements (see Define Splitting of Forecast Requirements for MRP in the documentation for Consumption-Based Planning.)
Gross Requirements Planning

Use

Gross requirements planning is initiated by planning with the planning strategy Make-to-stock prod./gross reqmts plng. Planned independent requirements, created using this requirements type, are not compared with warehouse stock in material requirements planning. The system only checks against the expected receipt quantity (from planned orders, purchase requisitions, and so on). This means that a mandatory master plan can be stored in the system.

💡

The gross requirements plan is displayed in a separate segment in the MRP list as well as in the stock/requirements list.

Prerequisites

- You have assigned the planning strategy Make-to-stock prod./gross reqmts planning to the material in the field Strategy group in the material master (MRP 3 view).
- You have set the indicator for gross requirements planning for the material in the Mixed MRP field in the material master (MRP 31 view).

Features

Available stock is calculated as follows:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum stock level</td>
<td>+</td>
</tr>
<tr>
<td>Total requirements</td>
<td></td>
</tr>
<tr>
<td>Current plant stock</td>
<td>-</td>
</tr>
<tr>
<td>Existing firmed receipt elements</td>
<td>=</td>
</tr>
<tr>
<td>Lot size</td>
<td></td>
</tr>
</tbody>
</table>

A shortage occurs if available stock is negative, that is, the requirement quantity is greater than expected receipts.

The system specifies the date of the issue (for example, customer requirement, planned independent requirement, reservation, forecast requirement) as the requirements date.
Calculating Procurement Quantity

Implementation Options

The system calculates procurement quantities in MRP. The system determines material shortages for requirement dates in the net requirements calculation. Receipts must now cover these shortage quantities. The system calculates the receipt quantity in the lot-size calculation, which is carried out during the procurement quantity calculation.

Prerequisites

- You have defined the required lot-sizing procedure in Customizing for MRP in the IMG activity Check lot-sizing procedure.
- You have assigned the required lot-sizing procedure to the material in the material master (MRP 1 view) and, if necessary, have specified additional restrictions:
  - Minimum lot size (minimum procurement quantity pro lot)
  - Maximum lot size (maximum procurement quantity pro lot)
  - Rounding value (The procurement quantity must be a multiple of this value)
  - Rounding profile (staggered rounding values)
- You have entered values for calculating scrap in the material master or the BOM.

Process Flow

1. The system adjusts the determined shortage quantities to match the parameters of the required lot-sizing procedure and thus determines the lot size.
2. If you have made an entry for scrap, the system calculates the scrap quantity and settles this against the lot size.
3. If you have defined a rounding value or rounding profile, the system rounds up the lot size and thus calculates the procurement quantity.
4. If you have made an entry for scrap, the system calculates the scrap quantity again and settles this against the lot size in order to determine the yield.

Result

The system uses the result of the procurement quantity calculation as the quantity for production or procurement of the material. This is made up of the estimated yield and scrap. You can display and change the procurement quantity in the procurement proposal. The estimated yield and scrap are displayed in the MRP list and the stock/requirements list.

See also:

Examples for Calculating Procurement Quantities and Yields [Page 112]
Lot-Sizing Procedures

Use

Lot-sizing procedures serve to calculate the procurement quantities, that is, the purchase order and production quantities.

Integration

- You define lot-sizing procedures in Customizing for MRP in the IMG activity Check lot-sizing procedure.
- You assign the required lot-sizing procedure to the material in the Lot size field in the material master (MRP 1 view).

Features

Three groups of lot-sizing procedures are available:

- Static lot-sizing procedures
- Period lot-sizing procedures
- Optimum lot-sizing procedures

You can also use the short-term and long-term lot size to divide the planning period for the lot-size calculation into a short-term and a long-term area. Therefore, it is also possible to use a different lot-sizing procedure for calculating the lot size in each of these areas.

The last lot can be planned exactly, independent of the selected lot-sizing procedure.
Static Lot-Sizing Procedures

Use
In static lot-sizing procedures, the procurement quantity is calculated exclusively by means of the quantity specifications entered in the material master.

Features
The following static lot-sizing procedures are available:

- Lot-for-lot order quantity
- Fixed lot size
- Fixed lot size with splitting and overlapping (see Lot Sizes with Splitting and Overlapping [Page 101])
- Replenishment up to maximum stock level
Lot-for-Lot Order Quantity

Use
You plan using lot-for-lot order quantity, when you want to procure the exact lot size again. This procedure is also referred to as the lot-for-lot procedure.

Prerequisites
You have set the indicator EX for lot-for-lot order quantity in the Lot size field in the material master (MRP 1 view) for the material.

Features
When planning using lot-for-lot order quantity, the system uses the exact shortage quantity (requirement minus available stock) as the order quantity in the case of a material shortage. At the time of the requirements date, the planned plant stock is zero.

Planning is carried out daily. The system groups requirement quantities from the same day together in one procurement proposal.
Fixed Lot Size

Use

It is useful to select a fixed lot size for a material, if it is only delivered, for example, in pallets of a certain quantity or in tanks of a certain size.

Prerequisites

You have set the indicator FX and entered the fixed lot-size quantity in the Lot size field in the material master (MRP 1 view) for the material.

Features

When planning using fixed lot size, the system will use the fixed order quantity recorded in the material master for the lot-size calculation if a material shortage exists. If the fixed lot size is not sufficient to balance out the material shortage, then several lots are planned for the same date until the material shortage is eliminated.

You can specify a threshold value for the maximum number of order proposals for the fixed lot size in Customizing for MRP in the IMG activity Define error processing in the planning run. If this value is exceeded, that is, if too many procurement proposals are created for a date and for a material, the material is provided with a termination message.
Material Requirements Planning (PP-MRP)

Replenishment up to Maximum Stock Level

Replenishment up to Maximum Stock Level

Use

You use the lot-sizing procedure Replenishment up to maximum stock level if you want to fill the stock up to the highest possible level or if you can only store a certain quantity of a material due to the container size. This applies to a tank, for example. The capacity of the tank determines the maximum stock level.

Integration

You can use this lot-sizing procedure with reorder point planning or MRP.

Prerequisites

You have set the indicator HB in the Lot size field and the maximum quantity to stock in the Maximum stock level field in the material master (MRP 1 view) for the material.

Features

- In material requirements planning, the system creates an order quantity to bring the stock level up to the maximum stock level. If, however, the requirements for one day are greater than the maximum stock level the system creates an order quantity for the required quantity. In this case, a balanced stock/requirements situation is given higher priority than the lot-sizing procedure.

- In reorder point planning without taking external requirements into account you only use stocks. MRP then calculates the lot sizes as follows:

  - Maximum stock level
  - Current plant stock
  - Existing fixed receipt elements
  - Lot size

- In reorder point planning where external requirements are taken into account, where additional requirements are also included in the calculation, MRP tries to achieve two goals:
  - All requirements must be covered
  - Once requirements have been covered, the defined maximum stock level must not be exceeded, but also does not have to be reached

  The requirements dates are not taken into account. The system calculates the total of all requirements.

  The calculation of the lot size occurs in two steps using two formulas:

  Formula 1
Replenishment up to Maximum Stock Level

Formula 2

\[
\text{Reorder point} = \text{Total requirements} - \text{Current plant stock} - \text{Existing fixed receipt elements} = \text{Lot size}
\]

The system creates the order proposal using the greater of the two lot sizes calculated.

- For **reorder point planning where external requirements are taken into account** as well as MRP there is an additional option, whereby you can set the Maximum stock level variant 1 (Maximum stock level after covering requirement). The MRP thus tries to achieve the following two aims:
  - All requirements must be covered
  - The defined maximum stock level must be reached after covering the requirements

The system calculates the lot size using the following formula:

\[
\text{Reorder point} = \text{Total requirements} - \text{Current plant stock} - \text{Existing fixed receipt elements} = \text{Lot size}
\]

**Example**

**Example Data**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum stock level</td>
<td>5.000</td>
</tr>
<tr>
<td>Reorder point</td>
<td>2.000</td>
</tr>
<tr>
<td>Current plant stock</td>
<td>1.000</td>
</tr>
<tr>
<td>Replenishment up to Maximum Stock Level</td>
<td></td>
</tr>
<tr>
<td>----------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Existing fixed receipt elements</strong></td>
<td>None</td>
</tr>
<tr>
<td><strong>Total requirements</strong></td>
<td>4,000</td>
</tr>
</tbody>
</table>

**Lot-Size Calculation**

1. Reorder point planning without taking external requirements into account

   \[ 5,000 - 1,000 = \mathbf{4,000} \]

2. Reorder point planning where external requirements are taken into account

   Formula 1: \[ 5,000 - 1,000 = 4,000 \]
   Formula 2: \[ 2,000 + 4,000 - 1,000 = \mathbf{5,000} \] (this value is the larger and is copied over)

3. Reorder point planning where external requirements are taken into account or MRP, maximum stock level variant 1

   \[ 5,000 + 4,000 - 1,000 = \mathbf{8,000} \]
Period Lot-Sizing Procedures

Use
In period lot-sizing procedures, the system groups several requirements within a time interval together to form a lot.

Features
- You can define the following periods:
  - days
  - weeks
  - months
  - periods of flexible length equal to posting periods
  - freely definable periods according to a planning calendar
    The system can interpret the period start of the planning calendar as the availability date or as the delivery date.
- Splitting and overlapping are also possible for all period lot-sizing procedures (see Lot Sizes with Splitting and Overlapping [Page 101]).
- The system sets the availability date for period lot-sizing procedures to the first requirements date of the period. However, you can also define that the availability date is at the beginning or end of the period.
Availability Date for Period Lot-Sizing Procedure

Use

The system sets the availability date for period lot-sizing procedures to the first requirements date of the period. However, you can also define that the availability date is at the beginning or end of the period.

The availability date is the date by which the material must be available for production and includes the goods receipt processing time.

Integration

You define the availability date for period lot-sizing with the Scheduling indicator in Customizing.

Features

In the standard system, the availability date for period lot-sizing procedures is set to the first requirements date of the period. From this date, the system subtracts the goods receipt processing time to calculate the delivery date or order finish date for the procurement proposal. The requirements that lie between the period start and end are grouped together into a lot.

If the setting has been made in Customizing for the availability date to be at the beginning or end of the period, the basic dates of the planned order are rescheduled as well as the dependent requirements for the components.
Example for Determination of Availability Date

If you use **period lot sizing** in MRP and set the **availability date as the period start**, the system determines the availability date from the delivery date and the goods receipt processing time. The system then reschedules the availability date to the start of the next period that lies after the calculated availability date.

### Example Data

<table>
<thead>
<tr>
<th>MRP type</th>
<th>Material requirements planning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot size:</td>
<td></td>
</tr>
<tr>
<td>▪ Lot-sizing procedure</td>
<td>▪ P (period lot size)</td>
</tr>
<tr>
<td>▪ Lot size indicator</td>
<td>▪ M (monthly lot size)</td>
</tr>
<tr>
<td>▪ Scheduling</td>
<td>▪ 1 (Period start = availability date)</td>
</tr>
<tr>
<td>Procurement type</td>
<td>F (External procurement)</td>
</tr>
<tr>
<td>Planned Delivery Time</td>
<td>20 calendar days</td>
</tr>
<tr>
<td>Goods receipt processing time</td>
<td>1 working day</td>
</tr>
<tr>
<td>Dependent requirements</td>
<td>29 August, 30 September and 31 October</td>
</tr>
</tbody>
</table>

### Planning Result

The planning run was executed on 14 August. The system schedules the following dates:

<table>
<thead>
<tr>
<th>Date</th>
<th>Type</th>
<th>Requirements</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>29.08.</td>
<td>DepReq</td>
<td>2 individual</td>
<td>100,00-</td>
</tr>
<tr>
<td>30.09.</td>
<td>DepReq</td>
<td>5 individual</td>
<td>150,00-</td>
</tr>
<tr>
<td>01.10.</td>
<td>Pl.ord</td>
<td>0000001000</td>
<td>100,00</td>
</tr>
<tr>
<td>01.10.</td>
<td>Pl.ord</td>
<td>0000001001</td>
<td>150,00</td>
</tr>
<tr>
<td>01.10.</td>
<td>Pl.ord</td>
<td>0000001002</td>
<td>300,00</td>
</tr>
<tr>
<td>31.10.</td>
<td>DepReq</td>
<td>3 individual</td>
<td>300,00-</td>
</tr>
</tbody>
</table>

The system displaces the availability dates for planned orders 1000 and 1001 to the start of the next period possible (1 October) which lies after the date (4 September) determined by forward scheduling.

The date 4 September results from forward scheduling from 12 August + 20 calendar days + 1 day for goods receipt processing time.
Delivery Date Instead of Availability Date

Use

⚠️ You can only use this function with the lot-sizing procedure Period Lot Size According to Planning Calendar.

The system normally interprets the period start of the planning calendar as the availability date. You can, however, set it to be interpreted as the delivery date.

Prerequisites

You define the setting for the availability date or delivery date for period lot-sizes with the Interpretation of events indicator in Customizing.

Integration

⚠️ It is not possible to use the indicator for scheduling together with the interpretation of the planning delivery period as delivery date.

Features

If you set the appropriate indicator in Customizing, the system interprets the period start as the delivery date. The system subtracts the planned delivery time from this delivery date to calculate the release date and then it adds the goods receipt processing time to calculate the availability date. The availability date is thus displaced by the goods receipt processing time.

The grouping of the requirements is also displaced to guarantee that goods are available on time for all requirements. In this case, the requirements are not strictly grouped together within the defined period length, but within the availability dates resulting from displacing the goods receipt processing time.
Example for Delivery Date Instead of Availability Date

Example Data

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned delivery time</td>
<td>3 days</td>
</tr>
<tr>
<td>Goods receipt processing time</td>
<td>2 days</td>
</tr>
<tr>
<td>Planning calendar period 1</td>
<td>Tuesday 1 March until Monday 14 March</td>
</tr>
<tr>
<td>Planning calendar period 2</td>
<td>Tuesday 1 March until Monday 28 March</td>
</tr>
</tbody>
</table>

The vendor therefore delivers every two weeks on Tuesdays. The planned delivery time means that you must inform the vendor of the required quantity at least 3 days before the delivery date.

Requirements

<table>
<thead>
<tr>
<th>Planning calendar period 1</th>
<th>Requirement 1 on 3 March for 100 pieces</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Requirement 2 on the 8 March for 70 pieces</td>
</tr>
<tr>
<td>Planning calendar period 2</td>
<td>Requirement 1 on 14.03 March for 150 pieces</td>
</tr>
<tr>
<td></td>
<td>Requirement 2 on 16 March for 90 pieces</td>
</tr>
</tbody>
</table>

Example of Delivery Date

For the standard setting (availability date = start of period), the system groups all requirements in period 1 together and creates a procurement proposal for 170 pieces for the start of the period 1, that is for the 1 March.

The availability date of this procurement proposal is 1 March. Starting from here, the system schedules backwards, that is, the goods receipt processing time is subtracted, resulting in the delivery date 28 February. Then the system subtracts the planned delivery time of three days which results in the release date 24 February.

The requirements are grouped together between the period basic dates. This results in a lot of 170 pieces for the 1 March and another lot for 240 pieces for the 12 March.

Example of Delivery Date

With the setting Interpretation of the Planning Calendar Periods as Delivery Dates, the delivery date of the first period is 1 March and the delivery date of the second period is 15 March. This means that, including the goods receipt processing time, the requirement on the 15 March can no longer be completely covered, as the availability date of the procurement proposal in the second period is 17 February. Therefore, the requirement of the 15 March must be added to the period lot with the delivery date 1 March.

Thus, for the first period, three requirements are grouped together: the requirement of 3 March, of 8 March and of 15 March for 320 pieces. The procurement proposal for 15 March is created for 90 pieces.
Optimum Lot-Sizing Procedures

Use

In static and period lot-sizing procedures, the costs resulting from stockkeeping, from the setup procedures or from purchasing are not taken into consideration. The aim of optimum lot-sizing procedures, on the other hand, is to group shortages together in such a way that costs are minimized. These costs include lot size independent costs (setup or order costs) and storage costs.

Taking Purchasing as an example, the following problem hereby arises:

If you order often, you will have low storage costs but high order costs due to the high number of orders. If you only seldom place orders then you will find that your order costs remain very low, but your storage costs will be very high since warehouse stock must be large enough to cover requirements for a much longer period.

Features

The starting point for lot sizing is the first material shortage date that is determined during the net requirements calculation. The shortage quantity determined here represents the minimum order quantity. The system then adds successive shortage quantities to this lot size until, by means of the particular cost criterion, optimum costs have been established.

The only differences between the various optimum lot-sizing procedures are the cost criteria. The following procedures are available:

- Part Period Balancing
- Least Unit Cost Procedure
- Dynamic Lot Size Creation
- Groff Reorder Procedure
Part Period Balancing

Use

The part period balancing procedure adheres to the "classic" lot size formula for the minimum costs whereby variable costs (storage costs) are equal to the lot size independent costs.

Prerequisites

In the material master (MRP 1 view) for the material, you have set the indicator for SP for Part period balancing in the Lot size field and the Lot size independent costs and storage costs indicator.

Features

Starting from the shortage date, successive requirements are grouped together to form lots until the sum of the storage costs equals lot size independent costs. (In other words, this procedure involves an adjustment between costs independent of quantity and costs dependent of quantities and time.)

Example

<table>
<thead>
<tr>
<th>Requirements date</th>
<th>Reqmts. quantity</th>
<th>Lot size</th>
<th>Lot size ind. costs</th>
<th>Storage costs</th>
<th>Total storage costs</th>
</tr>
</thead>
<tbody>
<tr>
<td>06.07.</td>
<td>1000</td>
<td>1000</td>
<td>100</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>13.07.</td>
<td>1000</td>
<td>2000</td>
<td>100</td>
<td>38.36</td>
<td>38.36</td>
</tr>
<tr>
<td>20.07.</td>
<td>1000</td>
<td>3000</td>
<td>100</td>
<td>76.71</td>
<td>115.07</td>
</tr>
<tr>
<td>27.07.</td>
<td>1000</td>
<td>4000</td>
<td>100</td>
<td>115.07</td>
<td>230.14</td>
</tr>
</tbody>
</table>

Storage costs = \( \text{Reqmts.} \times \text{Price} \times \text{Storage.cst.pct.} \times \text{Time in storage} \)

\( \frac{100 \times 365}{20} \)

The most appropriate lot size is 2000 pieces because if further requirements were added to this lot, total storage costs would be larger than the lot size independent costs.
Least Unit Cost Procedure

Prerequisites

In the material master (MRP 1 view) for the material, you have set the indicator for WI for *Least unit cost procedure* in the *Lot size* field and the *Lot size independent costs* and *storage costs indicator*.

Features

Starting from the shortage date, successive requirements are grouped together to form lots until *total costs per unit* reach a minimum level. The total costs are equal to the sum of the lot size independent costs plus the total storage costs.

Example

<table>
<thead>
<tr>
<th>Requirements date</th>
<th>Reqmts. quantity</th>
<th>Lot size</th>
<th>Lot size ind. costs</th>
<th>Storage costs</th>
<th>Total costs</th>
<th>Unit costs</th>
</tr>
</thead>
<tbody>
<tr>
<td>06.07.</td>
<td>1000</td>
<td>1000</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>0.100</td>
</tr>
<tr>
<td>13.07.</td>
<td>1000</td>
<td>2000</td>
<td>100</td>
<td>38.36</td>
<td>138.36</td>
<td>0.069</td>
</tr>
<tr>
<td>20.07.</td>
<td>1000</td>
<td>3000</td>
<td></td>
<td>76.71</td>
<td>215.07</td>
<td>0.072</td>
</tr>
<tr>
<td>27.07.</td>
<td>1000</td>
<td>4000</td>
<td></td>
<td>115.07</td>
<td>330.14</td>
<td>0.083</td>
</tr>
</tbody>
</table>

Storage costs = $ \frac{\text{Reqmts.} \times \text{Price} \times \text{Storage.cst.pct.} \times \text{Time in storage}}{100 \times 365}$

The most appropriate lot size is 2000 pieces.
Dynamic Lot Size Creation

Prerequisites

In the material master (MRP 1 view) for the material, you have set the indicator for DY for Dynamic lot size creation in the Lot size field and the Lot size independent costs and storage costs indicator.

Features

Starting from the shortage date, successive requirements are grouped together to form lots until additional storage costs become greater than lot size independent costs.

Example

Price: $20
Lot size independent costs: $100
Storage cost percentage: 10%

<table>
<thead>
<tr>
<th>Requirements date</th>
<th>Reqmts. quantity</th>
<th>Lot size</th>
<th>Lot size-ind. costs</th>
<th>Storage-costs</th>
</tr>
</thead>
<tbody>
<tr>
<td>06.07.</td>
<td>1000</td>
<td>1000</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>13.07.</td>
<td>1000</td>
<td>2000</td>
<td>38,36</td>
<td>76,71</td>
</tr>
<tr>
<td>20.07.</td>
<td>1000</td>
<td>3000</td>
<td>115,07</td>
<td></td>
</tr>
<tr>
<td>27.07.</td>
<td>1000</td>
<td>4000</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Storage costs = \( \frac{\text{Reqmt. x Price x Storage.cst.pct. x Time in storage}}{100 \times 365} \)

The most appropriate lot size is 3000 pieces because an additional requirement of 1000 pieces for the 27 July would mean that the lot size independent costs would be exceeded.
Groff Reorder Procedure

Use
The Groff reorder procedure is based on the fact that additional storage costs are equal to the saving in lot size independent costs according to the classical lot sizing formula for the minimum costs. Additional storage costs resulting from an increase in the lot size are, therefore, compared with the resulting savings in lot size independent costs.

Prerequisites
In the material master (MRP 1 view) for the material, you have set the indicator for GR for Groff reorder procedure in the Lot size field and the Lot size independent costs and storage costs indicator.

Features
Starting from a certain period, the system keeps grouping requirements into a lot until the increase in the average storage costs per period is larger than the decrease in the lot size independent costs per period.

Example

<table>
<thead>
<tr>
<th>Price:</th>
<th>$ 20</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot size independent costs:</td>
<td>$ 100</td>
</tr>
<tr>
<td>Storage cost percentage:</td>
<td>10 %</td>
</tr>
</tbody>
</table>

Additional storage costs = \( \frac{Reqmt. \times Price \times Storage\_cst\_pct \times Time\_in\_storage}{100 \times 365 \times 2} \)

Savings in lot size ind. csts = \( \frac{Lot\_size\_independent\_costs}{Time\_in\_storage \times (Time\_in\_storage + 1)} \)

<table>
<thead>
<tr>
<th>Requirements date</th>
<th>Reqmts. quantity</th>
<th>Lot size</th>
<th>Lot size ind. costs</th>
<th>Savings in lot size ind. csts</th>
<th>Additional storage csts</th>
</tr>
</thead>
<tbody>
<tr>
<td>06.07.</td>
<td>1000</td>
<td>1000</td>
<td>100</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>13.07.</td>
<td>1000</td>
<td>2000</td>
<td></td>
<td>1.79</td>
<td>2.74</td>
</tr>
<tr>
<td>20.07.</td>
<td>1000</td>
<td>3000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27.07.</td>
<td>1000</td>
<td>4000</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Optimum

The most appropriate lot size is 1000 pieces because for a further requirement of 1000 pieces, additional storage costs would then exceed the savings in lot size independent costs.
Lot Sizes with Splitting and Overlapping

Use

You can determine whether a fixed or period lot size is divided into partial quantities and that these are to be produced at regular intervals that overlap each other.

This lot-sizing procedure is very useful if the actual requirement quantities that occur in the period or the quantity to be produced for a certain date are very large but production is only laid out for smaller quantities.

Integration

Splitting and overlapping are only possible for fixed lot sizes and period lot sizes.

Prerequisites

- In Customizing for MRP, you must determine in the IMG activity Check lot-sizing procedure whether the procurement proposals are to overlap in the future or in the past starting from the requirements date:

Fixed Lot Size with Splitting and Overlapping

- You have maintained the following fields in the material master (MRP 1 view):
  - Lot size field: FS indicator for fixed lot size with splitting and overlapping
  - Fixed lot size field: total order quantity
  - Rounding value field: Partial quantities, into which the total quantity is grouped. The fixed lot size must be a multiple of the rounding value.
  - Takt time field: The period of time that the procurement proposals are to overlap.

Period Lot Size with Splitting and Overlapping

- You have maintained the following fields in the material master (MRP 1 view):
  - Lot size field: FS indicator for period lot size with splitting and overlapping
  - Maximum lot size field: Partial quantities, into which the total quantity is grouped.
  - Takt time field: The period of time that the procurement proposals are to overlap.

Features

The system generates procurement proposals for the rounding value until the fixed lot size quantity has been reached. The in-house production times overlap by the takt time.
Short-Term and Long-Term Lot Size

Use

If you define a short-term and a long-term lot size for a material, you can split up the time axis for the material requirements planning into a short-term and a long-term area and thus carry out the procurement quantity calculation using two different lot-sizing procedures.

You can therefore, for example, group together requirements over a larger period in the long-term area to produce a rough picture of the future master plan and select a more precise lot size to suit your requirements in the short-term area.

Prerequisites

You have defined the settings for the short-term and long-term lot size in the IMG activity Check lot-sizing procedure in Customizing for MRP.

Features

During the planning run the system calculates the time axis for the validity of both lot-sizing procedures. The procurement quantities in the first, short-term area are calculated using the short-term lot size. From the valid from date of the long-term lot size the system switches to the long-term lot size.

If no long-term lot size has been specified for a lot-sizing procedure, the system plans the complete planning period using the short-term lot size.

Calculating the Long-Term Lot Size

The start of the effectivity period of the long-term lot size is determined using the number of periods specified in Customizing. The system always rounds up to the end of a period that has already started and then sets the valid from date to the beginning of the next complete period. The system normally offers period lot sizes for the long-term lot size. This ensures, that the period requirements grouping is always traceable within the defined period length of the period lot size.

The calculation of the date from which the long-term lot size is valid is 15 March. Four months have been entered for the periods for this calculation. The system calculates four months into the future (15 July) and then rounds up to the beginning of the next complete period. The long-term lot size is thus valid from 1 August.

You can also define a period for lot-for-lot order quantity in Customizing, which is set for the short-term and the long-term period. The system then always plans using lot-for-lot order quantity in this period, even if other lot-sizing procedures have been defined in the short-term and long-term period.
Lot-for-Lot Remaining Order Quantity

Use

You can determine in the lot-sizing procedure that the last lot of the planning run is always planned exactly. You thus prevent that the procurement quantities exceed the requirement quantities and, for example, cause remaining stock levels of discontinued materials with high scrap costs.

Integration

This function can be used for all lot-sizing procedures. It is valid for the whole planning horizon.

⚠️

You cannot use the function in reorder point planning and time-phased planning.

Prerequisites

You have assigned a lot-sizing procedure, for which lot-for-lot remaining order quantity has been defined, to the material in the material master.

💡

You set the Last lot exact indicator in Customizing for MRP in the IMG activity Check lot-sizing procedure, in order to define lot-for-lot remaining order quantity.

Features

The last lot is planned exactly in the net or gross planning segment of the MRP list and the current stock/requirements list. The available quantity at the end of these segments is thus equal to zero.
Calculating Scrap

Use
You can calculate and plan the scrap quantity that will result from production. These scrap quantities are then included in the planning run and in the calculation of production costs.

Prerequisites
Which calculation the system uses depends on the settings in the material master record or in the BOM.

Features
The scrap quantity is settled against the net requirements quantity.
Three calculation procedures are supported by the system:

- Assembly scrap
- Component scrap
- Operation scrap
Assembly Scrap

Use
You use this function to plan the scrap that results from the production of an assembly.

Prerequisites
You have maintained the assembly scrap in the material master (MRP 1 view) as a percentage in the Assembly scrap field for the assembly header material.

Features
The system automatically increases the quantity to be produced by the percentage of scrap.
However, the system always uses the estimate yield for the availability calculation for the assembly. Furthermore, the estimate yield of the assembly is always displayed in the MRP list or in the stock/requirements list.

💡
Assembly scrap increases the order quantity of the assembly and subsequently increases the order quantity for corresponding components. The dependent requirements of the material components are therefore increased correspondingly.

Example

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimate yield</td>
<td>200</td>
</tr>
<tr>
<td>Assembly scrap</td>
<td>10%</td>
</tr>
<tr>
<td>This results in a scrap quantity of</td>
<td>20 pieces</td>
</tr>
<tr>
<td>and a required quantity of</td>
<td>220 pieces</td>
</tr>
</tbody>
</table>
Component Scrap

Use
You use this function to plan the scrap of a component that may break during production of an assembly.

Prerequisites
You have entered values for calculating component scrap in the material master or the BOM:

• in the BOM on the Item Detail Screen: General Data (data block for quantity data). This component scrap is only relevant for the individual BOM.

• in the material master (view MRP 4) in the Component scrap field. This component scrap is relevant for all BOMs.

⚠️
The component scrap quantity maintained for a material component in the BOM has the higher priority.

Features

• Component scrap increases the dependent requirements quantity of the component.

• If a scrap quantity was planned for a higher-level assembly, assembly scrap and component scrap are added to the component level.

Example

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimate yield</td>
<td>200</td>
</tr>
<tr>
<td>Assembly scrap</td>
<td>10%</td>
</tr>
<tr>
<td>Component scrap</td>
<td>10%</td>
</tr>
<tr>
<td>This results in a scrap quantity of</td>
<td>42 pieces</td>
</tr>
<tr>
<td>and a required quantity of</td>
<td>242 pieces</td>
</tr>
</tbody>
</table>
Operation Scrap

Use

Before high-value components are built into an assembly, the system carries out a quality control check of the assembly, if necessary. Faulty materials that were taken into account in assembly scrap are not passed on to the next operation. They are removed.

Therefore, for a high-value component, you plan using operation scrap instead of general assembly scrap.

Prerequisites

You have maintained the operation scrap in the BOM, on the Items Detail Screen: General Data, under quantity data. You must also set the operations scrap net indicator at the same time.

Features

- This scrap quantity refers to the quantity of one component that is to be processed in an operation meaning that the planning run is more exact and you can determine service and quantity consumption more precisely.

- If the component is contained in an assembly, for which an assembly scrap quantity has been maintained, the system only takes the operation scrap into account.

- The net indicator instructs the system to calculate the component operation scrap without taking assembly scrap into account (net usage scrap).

You should also set the net indicator, if operation scrap has not been maintained and assembly scrap has been entered. The assembly scrap should not, however, be taken into account.

Example

<table>
<thead>
<tr>
<th>Quantity to be produced (required quantity)</th>
<th>1,000 pieces</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assembly scrap</td>
<td>10 %</td>
</tr>
</tbody>
</table>

Component 1

<table>
<thead>
<tr>
<th>Operation scrap</th>
<th>No entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net indicator</td>
<td>Not set =&gt; assembly scrap is taken into account</td>
</tr>
<tr>
<td>=&gt; Scrap quantity</td>
<td>100 pieces</td>
</tr>
</tbody>
</table>

Component 2

<table>
<thead>
<tr>
<th>Operation scrap</th>
<th>1%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net indicator</td>
<td>Set =&gt; assembly scrap is not taken into account</td>
</tr>
<tr>
<td>=&gt; Scrap quantity</td>
<td>10 pieces</td>
</tr>
</tbody>
</table>

Before component 2 is built into the assembly, the incorrect assemblies are rejected and the system only takes the smaller operation scrap quantity into account. Therefore, component
quantity of component 1 refers to 1,100 pieces to be produced; and the component quantity of component 2 refers to 1,010 pieces to be produced.
**Rounding**

**Use**
In rounding, you adapt the procurement quantities to the delivery, packaging or shipment units. This is useful, for example, if deliveries can only be made in lots of 10 pieces or if the quantity produced can only be packed and transported in full pallets.

**Integration**
The system evaluates the set lot-sizing procedure first, then it allocates possible scrap and rounds the determined quantity.

**Features**
Two rounding options are available:
- Rounding value (quantities must be a multiple of this value)
- Rounding profile (staggered rounding values)
**Rounding Profile**

**Use**
You use a rounding profile if you want to round the procurement quantity up to quantities, which can be delivered or transported.

**Prerequisites**
You have assigned a rounding profile to the material in the *Rounding profile* field in the material master (*MRP 1 view*).

You define rounding profiles in Customizing for MRP in the IMG activity *Define rounding profiles*.

**Features**
A rounding profile consists of threshold and rounding values, whereby every threshold value is assigned a rounding value. If the requirement lies below the first threshold value, the system copies the original requirement value unchanged. If the requirement exceeds the first threshold value, the system always rounds up.

**Example**
A material’s base unit of measure is 1 piece. The material is to be transported in layers (one layer corresponds to 5 pieces) or in pallets (one pallet corresponds to 8 layers which corresponds to 40 pieces).

You have defined the following rounding profile in Customizing:

\[ \begin{align*}
2 & \rightarrow 5 \\
32 & \rightarrow 40 \\
\end{align*} \]

From a requirement of 2 pieces, the system rounds up to 5 pieces, from a requirement of 32 pieces, it rounds up to 40 pieces.

The system then calculates the procurement quantities as follows:

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Procurement quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>10</td>
</tr>
<tr>
<td>7</td>
<td>10</td>
</tr>
<tr>
<td>21</td>
<td>25</td>
</tr>
<tr>
<td>31</td>
<td>35</td>
</tr>
<tr>
<td>32</td>
<td>40</td>
</tr>
<tr>
<td>41</td>
<td>45</td>
</tr>
<tr>
<td>74</td>
<td>80</td>
</tr>
</tbody>
</table>
For a requirement of 7 pieces, the system checks how many times 5 fits into 7. This results in a procurement quantity of 5 pieces \((1 \times 5 = 5)\). The system rounds up the remaining 2 pieces to 5 pieces. Thus, for a requirement of 7 pieces, one procurement proposal is created for 10 pieces.

For a requirement of 74 pieces, the system checks how many times 40 in fits into 74. This results in a procurement quantity of 40 pieces \((1 \times 40 = 40)\). The system rounds up the remaining 34 pieces to 40 pieces. Thus, for a requirement of 74 pieces, a procurement proposal is created for 80 pieces.
Examples for Calculating Procurement Quantities and Yields

Example 1

Example Data

<table>
<thead>
<tr>
<th>Net requirements</th>
<th>20 pieces</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot size</td>
<td>Lot-for-lot order quantity</td>
</tr>
<tr>
<td>Scrap</td>
<td>1%</td>
</tr>
</tbody>
</table>

Process Flow

1. Define lot size  | 20 pieces (estimated yield = receipt quantity in the stock/requirements list)
2. Define scrap quantity  | 0.2 pieces => rounded to 1 piece
3. Add scrap quantity to lot size  | 21 pieces (order quantity = order quantity of planned order)

Example 2

Example Data

<table>
<thead>
<tr>
<th>Net requirements</th>
<th>20 pieces</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot size</td>
<td>Lot-for-lot order quantity</td>
</tr>
<tr>
<td>Scrap</td>
<td>1%</td>
</tr>
<tr>
<td>Rounding value</td>
<td>40</td>
</tr>
</tbody>
</table>

Process Flow

1. Define lot size  | 20 pieces
2. Define scrap quantity  | 0.2 pieces => rounded to 1 piece
3. Add scrap quantity to lot size  | 21 pieces
4. Round lot size  | 40 pieces (procurement quantity = order quantity of planned order)
5. Redefine scrap  | 1 piece
6. Subtract scrap from rounded lot-size  | 39 pieces (estimated yield = receipt quantity in the stock/requirements list)

Example 3

Example Data

<table>
<thead>
<tr>
<th>Net requirements</th>
<th>20 pieces</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot size</td>
<td>Fixed lot size of 30 pieces</td>
</tr>
<tr>
<td>Scrap</td>
<td>1%</td>
</tr>
</tbody>
</table>
### Process Flow

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Define lot size</td>
<td>30 pieces (procurement quantity = order quantity of planned order)</td>
</tr>
<tr>
<td>2.</td>
<td>Define scrap quantity</td>
<td>0.3 pieces =&gt; rounded to 1 piece</td>
</tr>
<tr>
<td>3.</td>
<td>Subtract scrap quantity from lot-size</td>
<td>29 pieces (estimated yield = receipt quantity in the stock/requirements list)</td>
</tr>
</tbody>
</table>
Scheduling

Implementation Options

The system executes scheduling in MRP. During the net requirements calculation, the system determined the shortage quantities and material shortage dates. During the procurement quantity calculation, the system calculated the procurement quantities necessary for covering requirements.

During scheduling, the system determines start and finish dates for the procurement elements of materials that are produced in-house and for materials that are procured externally.

Process Flow

![Process Flow Diagram]

- **Calculation of delivery and release dates**
  - Using backward scheduling or forward scheduling

- **Calculation of basic dates for production**
  - Using backward scheduling or forward scheduling

- Lead time scheduling (Calculation of production dates)
Scheduling: In-House Production

Process Flow

1. The system calculates the basic dates for planned orders.
   
   The basic dates are the **order finish date** and the **order start date**. The order finish date determines the latest possible date by which production has to be finished and the order start date determines the earliest possible start of production.
   
   Basic dates are calculated automatically during every planning run.

2. The system calculates the exact production dates (lead time scheduling).

   The production dates are the **production start date** and the **production finish date**.
   
   Additionally, capacity requirements are created during lead time scheduling.
   
   Lead time scheduling is only carried out on request.
Calculating Basic Dates

Implementation Options

The basic dates determine the outermost time limits for production. During material requirements planning and forecast-based planning, the system calculates the order start and finish dates in addition to the order opening date of the planned order.

Prerequisites

- You have determined the **goods receipt processing time** (in workdays) in the material master (view MRP 2).
- You have defined a lot size dependent or independent in-house production time in workdays (see In-House Production Time: Independent of Lot Size [Page 117], In-House Production Time: Dependent on Lot Size [Page 118]).
- You have defined the **opening period** for each plant in Customizing for MRP in the IMG activity Define floats (scheduling margin key).

  The **opening period** is the time required by the MRP controller to convert the planned orders into purchase requisitions. It is only taken into account with backward scheduling.

Process Flow

1. The system always determines the basic dates for planned orders using backward scheduling.
2. The system automatically switches to **forward scheduling** if the determined start date lies in the past.

   ![Tip](image)

   If you do not want the system to switch to forward scheduling automatically, you can specify per plant in Customizing for MRP, in the IMG activity **Parameters for determining the basic dates** that the system is to continue the backward scheduling calculation even if the resulting start date lies in the past.
In-House Production Time: Independent of Lot Size

Use
You use lot size independent in-house production time, if the lot size independent times (for example, queue time, or setup time) control production to a greater extent than the lot size dependent processing time.

Prerequisites
You have entered the lot size independent in-house production time in the material master (Work scheduling or MRP 2 view).

Features
The basic dates are determined only by the value for the lot size independent in-house production time and independently from the order quantity.
In-House Production Time: Dependent on Lot Size

Use
You use lot size dependent in-house production time if the processing time controls production to a greater extent than the lot size independent times, for example, queue time or setup time.

Prerequisites
You have maintained the following times in the material master (Work scheduling view):
- Setup time
- Processing time
- Base quantity of the processing time
- Interoperation time

Features
- The setup time and the interoperation time are both independent of the lot size.
  
  The setup time is the number of days that are necessary to set up and tear down machines that are required to process the material.

  The interoperation time is the sum of the wait times, queue times and move times as well as the float before and after production.

- On the other hand, the processing time depends on the lot size and is adapted correspondingly to the lot size in the order. The base quantity is used as the basis for calculating the processing time dependent on the lot size. The processing time is generally made up of machine times and labor times.

The system determines the lot size dependent in-house production time from both times depending on the lot size in the order.

💡

The floats (for example, float before production, float after production) are not included in the calculation of the in-house production time, but actually form part of the in-house production time. The total floats are maintained through the interoperation time.
Backward Scheduling for In-House Production

Implementation Options

For materials that are planned according to the MRP and forecast-based planning procedures, the requirement dates in the future are known. Scheduling is always backward. The system automatically switches to forward scheduling only if the start date lies in the past.

Process Flow

1. The system calculates the goods receipt processing time backwards using the requirements date and thus determines the order finish date.
2. The system calculates the in-house production time backwards using the order finish date and thus determines the order start date.
3. The system calculates the opening period backwards using the order finish date and thus determines the order opening date.

See also:
Availability Date for Period Lot-Sizing Procedure [Page 92]
Example of Backward Scheduling for In-House Production

Example Data

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirements date</td>
<td>25.6. (Friday)</td>
</tr>
<tr>
<td>Goods receipt processing time</td>
<td>2 days (workdays)</td>
</tr>
<tr>
<td>In-house production time for the material:</td>
<td>6 days (workdays)</td>
</tr>
<tr>
<td>Opening period</td>
<td>6 days (workdays)</td>
</tr>
<tr>
<td>Workdays = Monday to Friday, no bank holiday</td>
<td></td>
</tr>
</tbody>
</table>

Scheduling

1. Requirements data minus goods receipt processing time = order finish date
   25.6. (Friday) minus 2 workdays = 23.6. (Wednesday)
2. Order finish date minus in-house production time = order start date
   23.6. (Wednesday) minus 6 workdays = 15.6. (Tuesday)
3. Order start date minus opening period = order opening date
   15.6. (Tuesday) minus 6 workdays = 7.6. (Monday)
Forward Scheduling for External Procurement

Implementation Options

- If an order start date which lies in the past is calculated by backward scheduling for either the MRP or the forecast-based planning procedure, the system automatically switches to forward scheduling in order to receive realistic scheduling data.
- Forward scheduling is always carried out for reorder point planning.

Process Flow

1. The current date is entered as the order start date. The system adds the in-house production time to the current date and thereby calculates the order finish date.
2. The system adds the goods receipt processing time to the order finish date and thereby calculates the availability date. On this date, the material is available.

The order reopening date does not exist.
Calculating Production Dates (Lead Time Scheduling)

Implementation Options

If the basic dates calculation is not exact enough for your needs, you activate the calculation of production dates using lead time scheduling.

Prerequisites

- You have created a **routing** for the material.
- You have assigned a **scheduling margin key** to the material in the material master.
  
  You can define the scheduling margin key in Customizing for MRP by choosing *Define floats (scheduling margin key).*
- You have maintained the following parameters for lead time scheduling in Customizing for MRP by choosing *Define scheduling parameters for planned orders:*
  
  - Scheduling levels - to differentiate between detailed, rough-cut, and rate-based scheduling
  - Parameters for determining the routing
  - Parameters that determine if and how scheduling is carried out
  - Parameters that determine if and how basic dates are to be adjusted

Process Flow

In lead time scheduling, the precise production times, that is, the **production start date** and the **production finish date**, are specified for materials that are produced in-house. Capacity requirements are also created during lead time scheduling and the date, on which the components must be provided, is also determined.

The **production dates** are determined using the routing. The system hereby uses the floats that are allocated to the material via the scheduling margin key in the material master. These floats include the float before production and the float after production, as well as the extra time factors specified in the routing such as the queue times, setup times, labor times, machine times, and so on.

The system normally executes the lead time scheduling with backwards scheduling and starts from the determined order finish date. The system only switches to forward scheduling and starts from the order start date, if the times in routing are substantially shorter than the times in the material master and the determined production start date is therefore further in the future than necessary.

1. The system calculates the **float after production** using the order finish date and thus determines the **production finish date**. Starting from the production finish date, the individual operations of the routing are then scheduled backwards. The starting date of the first operation is the **production start date**.

   The **float after production** is the number of workdays that are planned as a buffer between the production finish date and the order finish date. This serves to compensate for interruptions during production to avoid displacing the order finish date.
2. The system checks whether the production start date is later than the order start date. If you have determined that the order start dates are to be adjusted in lead time scheduling in Customizing for MRP (IMG activity Define scheduling parameters for planned orders), the system subtracts the float before production from the production start date to calculate the new order start date. If you do not want the system to adjust the order start date, the system will not change the old order start date.

   The float before production is the number of workdays that are planned as a buffer between the order start date and the production start date. By using this float, delays in material staging do not cause delays in starting production. Additionally, if there are capacity bottlenecks or delays in an incoming sales order, the production dates can be brought forward.

3. The system checks whether the production start date is earlier than the order start date and, if necessary, determines new production dates. To do this, you must determine a possible time reduction in two places:

   - To reduce the floats before and after production, you must define the reduction for the plant, the planning type and, if necessary, for a production scheduler in Customizing for MRP.
   - To reduce the times in the operation, you must assign a reduction strategy to the operation in the routing.

   The system must set an order finish date so that the material is available for the start of production. Therefore, the order finish date always lies after the production finish date. If you have not maintained a float after production, the order finish date always lies exactly one day after the production finish date.

   If the in-house production time is much less than a day and if you want the material to be available for the production finish date, then you maintain the in-house production time in the material master record with zero (the float after production likewise with zero). Then, the production date is the same as the order finish date.
Levels of Scheduling

Use
The scheduling level defines which scheduling data will be used for lead time scheduling.

Integration
You use rate-based scheduling in repetitive manufacturing.
You use rough-cut scheduling in demand planning and preliminary planning.

Features
You can carry out lead time scheduling at three different levels:

- **Detailed scheduling** uses the times recorded in the routing. The execution time is subdivided into the operation steps, setup, processing and tear down.
  
  You can also define additional parameters for detailed scheduling such as reduction, and the scheduling type (backward, forward) in Customizing for MRP.

- You use **rate-based scheduling** in repetitive manufacturing. This type of scheduling uses the times recorded in the rate routing.

- **Rough-cut scheduling** procedures usually use the scheduling data from the rough-cut planning profile. This type of scheduling is used for a higher level planning level (sales and operations planning) to gain an overview of the capacity situation. The rough-cut planning profile represents an overview of the total BOM structure.

  In **MRP**, you usually use the **detailed scheduling** procedure.
Determining Capacity Requirements

**Use**

In the second step of lead time scheduling, the capacity requirements for the order are calculated and scheduled.

**Prerequisites**

You have set the *Cap. reqmts* indicator in Customizing for MRP, in the IMG activity *Define scheduling parameters for planned orders*. This creates capacity requirements at the Levels of Scheduling [Page 124] with which you would like to carry out scheduling.

**Features**

The capacity requirements are calculated for an operation using the formulas that are maintained for the capacity categories on the capacity overview screen of the work center. The dates of calculated capacity requirements correspond to the dates of the operation.

For more information, see the R/3 Library <PP - Capacity Planning>. 
Starting Lead Time Scheduling

Use

You can execute lead time scheduling during the planning run in addition to the calculation of basic dates, in order to determine the production dates for planned orders. In contrast to the calculation of basic dates, the system does not automatically execute lead time scheduling.

Prerequisites

- See Calculating Production Dates (Lead Time Scheduling) [Page 122]
- The system must be able to determine routing for at least one scheduling level. In addition, scheduling must be allowed for this scheduling level.

Procedure

In the initial screen of the planning run, set the scheduling indicator to 2 for lead time scheduling.

Result

Lead time scheduling is executed with times from routing.

You can check the result of the lead time scheduling in the planned order. You find a tab index with corresponding scheduling information there for every scheduling level, for which lead time scheduling has been executed.
Calculating the Provision Date for Components

Implementation Options

The system also calculates the provision date of the material components during lead time scheduling.

Process Flow

The materials and required quantities are determined using the BOM explosion. The provision times are calculated as follows:

- When the **basic dates are calculated**, the dependent requirements date of the components is calculated from the order start date of the source planned order. If a lead-time offset has been maintained, the dependent requirements date is rescheduled accordingly (see Calculating the Dependent Requirements Date [Page 171]).

- In **lead time scheduling**, the dependent requirements date is based on the operation dates in the routing. The system uses the component assignment in the routing to determine the components that must be available at the operation start date.

In Customizing for the scheduling levels, you can also set that the dependent requirement dates can be scheduled to the order start date instead of the operation start date in lead time scheduling.
Calculating the Provision Date for Components
Scheduling for External Procurement

Implementation Options

Only the basic dates for procurement elements are determined for external procurement.

Prerequisites

- You have entered the purchasing processing time (workdays) in Customizing for MRP either in Plant parameters or in the IMG activity Define external procurement.
- You have determined the planned delivery time (calendar days) in the material master (view MRP 2).
- You have determined the goods receipt processing time (in workdays) in the material master (view MRP 2).

Process Flow

In the MRP and forecast-based planning procedures, backward scheduling is used to determine the basic dates. In reorder point planning, however, the basic dates are determined by forward scheduling.

- For the planned order this includes the order start date and the order finish date.
- For the purchase requisition, the following dates are determined:
  - The delivery date (which corresponds to the order finish date)
  - The release date (which corresponds to the order start date)
Backward Scheduling for External Procurement

Use

For materials that are planned according to the MRP and forecast-based planning procedures, the requirement dates in the future are known. The materials must be available by these dates. The release date for the purchasing department is calculated during scheduling, that is, the date by which the materials must be ordered so that they are available for the requirements date.

Process Flow

The system starts with the requirements date and then schedules backwards to determine the release date of the purchase requisition (order start date of planned order, which is to be procured externally).

In MRP and forecast-based planning, the system always uses backward scheduling procedures to calculate the basic dates. Only if the start date that is calculated in backward scheduling happens to lie in the past, will the system automatically switch to forward scheduling.

If you do not want the system to switch to forward scheduling automatically, you can specify per plant in Customizing for MRP, in the IMG activity Parameters for determining the basic dates that the system is to continue the backward scheduling calculation even if the resulting start date lies in the past.
Example of Backward Scheduling for External Procurement

Example Data

<table>
<thead>
<tr>
<th>Requirements date</th>
<th>31.10. (Monday)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned delivery time of the material</td>
<td>10 days (calendar days)</td>
</tr>
<tr>
<td>Processing time for purchasing</td>
<td>1 day (workdays)</td>
</tr>
<tr>
<td>Goods receipt processing time</td>
<td>2 days (workdays)</td>
</tr>
<tr>
<td>Opening period</td>
<td>10 days (workdays)</td>
</tr>
<tr>
<td>Workdays = Monday to Friday</td>
<td></td>
</tr>
</tbody>
</table>

Scheduling

1. Requirements data minus goods receipt processing time = order finish date (provision date for vendor)
   
   31.10. (Tuesday) minus 2 workdays = 27.10. (Friday)

2. Order finish date minus planned delivery time minus processing time for purchasing = release date for purchase requisition or order start date of planned order for external procurement.
   
   27.10. (Friday) minus 10 calendar days minus 1 workday = 16.10. (Monday)

3. Release date minus opening period for planned order = opening date of planned order
   
   16.10. (Monday) minus 10 workdays = 2.10. (Monday)
Forward Scheduling for External Procurement

Use

- For materials planned according to the **reorder point procedure**, the material shortage date is the date that the shortage was detected by the planning run. If the stock level should fall below the reorder level, then procurement must be arranged immediately.

- **Materials that are planned using MRP or forecast-based planning** are switched to forward scheduling if the start date calculated in backward scheduling was in the past.

Process Flow

The system determines the date by which the material will be available again, starting from the material shortage date.

*In forward scheduling, the opening date is of no significance as the ordering process is started immediately.*
Example of Forward Scheduling for External Procurement

Example Data

<table>
<thead>
<tr>
<th>Material shortage date</th>
<th>01.08 (Friday)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned delivery time of the material</td>
<td>10 days (calendar days)</td>
</tr>
<tr>
<td>Processing time for purchasing</td>
<td>1 day (workdays)</td>
</tr>
<tr>
<td>Goods receipt processing time</td>
<td>2 days (workdays)</td>
</tr>
<tr>
<td>Opening period</td>
<td>10 days (workdays)</td>
</tr>
<tr>
<td>Workdays = Monday to Friday, no bank holiday</td>
<td></td>
</tr>
</tbody>
</table>

Scheduling

4. Material shortage date plus processing time for purchasing plan plus planned delivery time = delivery date

   01.08. (Friday) plus 1 workday + 10 calendar days = 14.08. (Thursday)

5. Delivery date plus goods receipt processing time = availability date

   14.08. (Thursday) plus 2 workdays = 18.08. (Monday)
Determining the Procurement Proposal

Implementation Options

Procurement proposals are used to procure the shortage quantity. Procurement proposals are internal planning elements that can be changed, rescheduled or deleted at any time: purchase requisition and planned order. In contrast, delivery schedule lines are fixed elements, which must be followed, and are only part of the procurement proposals in a broader sense.

Process Flow

- In the case of in-house production, the system always creates planned orders. These planned orders are used to plan production quantities. Once the MRP controller is satisfied with the results of planning, these planned orders are converted into production orders and passed on to production. Production orders are fixed elements, which must be followed.

- In the case of external procurement, the system creates either planned orders or directly creates purchase requisitions. Procurement proposals for external procurement plan the external procurement quantity. Once the MRP controller is satisfied with the results of planning, the planned orders are converted into purchase requisitions or the purchase requisitions are converted into purchase orders and are passed on to the purchasing department. Purchase orders are also fixed elements, which must be followed.

If you create a planned order in external procurement first, this has the advantage that the MRP controller has more control over the procurement proposals. Only once the MRP controller has checked the planned orders and converted them into purchase requisitions can the purchasing department order the material. Otherwise, the purchase requisition is immediately available to the purchasing department, which then takes over responsibility for material availability and warehouse stocks.

- You use the creation indicator for purchase requisitions in the initial screen of the planning run to control whether the system is to create purchase requisitions immediately or whether it is to create planned orders first (see Creation Indicator [Page 287]).

- If a scheduling agreement exists for a material and if an entry exists in the source list that is relevant to MRP, you can then also instruct the system to create delivery schedules in the planning run. To do this, you set the creation indicator for delivery schedules in the initial screen of the planning run (see Creation Indicator [Page 287]).

For more information, refer to MM - Purchasing under:

Scheduling Agreement [Ext.]
Source List [Ext.]
Procurement Type and Special Procurement Type

Use
When the system determines the procurement element, it first asks whether procurement should take place via in-house production or external procurement.

Prerequisites
- You have defined whether in-house production, external procurement or both are allowed for the material, in the material master record, in the Procurement type field. The procurement type is preset by the material type in Customizing for the material master.
- If necessary, you have defined more precisely how the in-house production or external procurement is to be carried out, in the material master (MRP 2 view), in the Special procurement field.

You define special procurement keys in Customizing for MRP in the IMG activity Define special procurement type.

Features

Procurement Type
If both in-house production and external procurement are defined for the material via the material type (indicator X in Procurement type field), then you can set the procurement type as follows:
- By overwriting the indicator in the material master
- By converting the planned order either into a production order or a purchase requisition
- By using quota arrangements, in that you define that a certain percentage of the material is to be procured via in-house production and the rest via external procurement (see Quota Arrangements [Page 137]).

If you leave the indicator X for both procurement types in the material master record, and you have not maintained any quota arrangements, the system automatically switches to in-house production. The planned order therefore firstly creates planned orders, which you can then convert into production orders or purchase requisitions.

Special Procurement Type
The special procurement type is used to precisely define how in-house production and external procurement is to be carried out.

Special Procurement for In-House Production
- For a phantom assembly
- Production in alternative plant
- Withdrawal from an alternative plant
Procurement Type and Special Procurement Type

- Direct production

Special Procurement for External Procurement

- Consignment
- Subcontracting
- Stock transfer
- Direct Procurement

See also:
Special Planning Processes [Page 195]
Quota Arrangements

Use

If a material can be obtained from various sources of supply, each individual source of supply can be allocated a quota arrangement. The quota arrangement is valid for a certain period of time and specifies exactly how the receipts are to be distributed amongst each source of supply.

You can set the quota arrangement for in-house production as well as for external procurement. Sources of supply can be:
- an individual vendor or outline agreement
- another plant, from which material should be procured
- a production version

Prerequisites

- You have maintained the quota arrangement usage for the respective material in the material master (MRP 2 view).

  The quota arrangement usage determines whether a material is included in a quota arrangement and which operations lead to a quota arrangement. You can define, for example, that only purchase orders are included in quota arrangements or that procurement proposals created by the system in the planning run are also included.

  You define the quota arrangement usage in Customizing for Purchasing in the IMG activity Define quota arrangement usage.

- You have maintained the quota file for the material.

  You define the sequence of the sources of supply, the quotas per source of supply and numerous other parameters in the quota file.

Features

During the planning run, the system determines the sources of supply according to the quota file and assigns the procurement proposals to the sources of supply.

In external procurement, the procurement proposal is allocated to the appropriate vendor. This vendor is copied to the purchase requisition.

For every procurement proposal with a quota arrangement, the system updates the quota file, so that the quota arrangement is always based on the current situation.

Two procedures are available:
- **Allocation quota arrangement**: every lot is assigned to a source of supply
- **Splitting quota arrangement**: a lot is split among various sources of supply

Further functions are also available for controlling quota arrangements. For example, you can set a maximum release order quantity that defines the maximum delivery capacity of one particular vendor.
Determining Source of Supply for External Procurement

Use

For purchase requisitions or delivery schedules, which are created during the planning run, the system can determine the source of supply directly from the planning procedure.

Features

Determining the Source of Supply via the Source List

The system first checks whether a quota arrangement has been maintained for the material, which has a validity period that covers the requirements date of the purchase requisition.

It then checks whether only one entry exists in the source list that is relevant to MRP. The indicator for source list usage must therefore be set for a particular vendor so that purchase requisitions and delivery schedules, which are created during the planning run, are automatically assigned to this vendor. In the case of a delivery schedule, you must also have maintained a scheduling agreement for this entry.

If you have maintained all the entries correctly, the system creates a purchase requisition with the source of supply that is recorded in the source list.

Determining Source of Supply by Quota Arrangements and Source List

The system first checks to see whether a quota arrangement, which is valid for the delivery date of the purchase requisition, has been maintained in the quota file for the material. It also checks to see whether the indicator for quota arrangement usage has been correctly maintained in the material master. The system then calculates from which vendor the material should be procured, using the quotas specified for the vendors.

As the next step, the system checks whether an entry for the vendor that is relevant to MRP exists in the source list. For this, the indicator for source list usage must be set correspondingly. If this is the case, then all further data required for the purchase requisition or the delivery schedule is copied from the source list.

💡

You can maintain the source list in the Purchasing task level menu by choosing, Master data → Source list → Maintain.

Source of Supply Determination Using the Manufacturer Part Number

In the procurement process, you can use your firm's own material number as well as the manufacturer's material or part number.

You can also create purchasing info records for this material number. However, you create the source list and, if required, the quota arrangement for your firm's own material number. When determining the source of supply, the system finds the appropriate info record for the manufacturer's part number.

See also:

For more information, refer to MM - Purchasing under:

Scheduling Agreement [Ext.]
Determining Source of Supply for External Procurement

Source List [Ext.]
Manufacturer Part Number (MPN) [Ext.]
Manufacturer Part Number: Functions [Ext.]
Scheduling Agreements for Make-to-Order Production

Use

Material requirements planning can also generate scheduling agreements for make-to-order production.

This process is useful if a long-term supply relationship exists with a particular customer and if a finished product or a component, which is regularly procured externally from a particular vendor, is delivered to this customer.

This process can also be used for individual project planning.

Prerequisites

- You have created a SD scheduling agreement, which is assigned to the sales order item of the requirement.
- You have entered the scheduling agreement in the source list and set the indicator 2 for Record relevant to MRP. Sched. lines generated automatically as source list usage there.
- You have set the Schedule lines indicator in the initial screen of the planning run (see Creation indicator [Page 287]).

You can maintain the scheduling agreement in the Purchasing task level menu: Outline agreement → Scheduling agreement → Create or Change. You can maintain the source list in the Purchasing task level menu by choosing, Master data → Source list → Maintain.
Shipping Notification

Use

In Purchasing, you can maintain confirmations for purchase orders or scheduling agreements. The confirmations include, among other things, order acknowledgments, loading and transport confirmation and the actual shipping notification. These confirmations can serve purely for information purposes or the dates and quantities can be taken into account in material requirements planning.

All of these confirmations are collectively referred to as shipping notification in material requirements planning. The term shipping notification will therefore always be used in the following information.

Working with shipping notifications provides the planning department with a more exact planning procedure as more reliable information about the delivery to be received is available from the vendor between the order date and the desired delivery date.

Prerequisites

In Customizing for Purchasing in the IMG activity Set up confirmation control, you have defined the confirmation control key and determined whether the individual confirmations in the material requirements planning should be taken into account or not.

Features

Shipping Notification in the MRP List or Stock/Requirements List

In the MRP list or in the stock/requirements list, you can see which purchase order quantities have been either partially or completely reduced by more current shipping notification. The delivery quantity of the corresponding purchase order is reduced in the net requirements calculation by the notified quantity. If the total order quantity has been confirmed, only the shipping notification is displayed in the MRP list or in the stock/requirements list.

The shipping notification (MRP element, ShpgNt) has the same number as the corresponding purchase order.

Shipping Notification in Availability Check According to ATP Logic

In the availability check, the shipping notification is considered as an available quantity, if the shipping notification was added to the scope of the check of the checking rule.

You must distinguish between the following cases:

- If you only select the purchase order when determining the scope of the check, shipping notifications are automatically taken into account.
- If you only select the shipping notification, only notified quantities are taken into account in the availability check, whereas the purchase orders are not.
Activities

You can thus check the shipping notifications in the material requirements planning:

1. In the stock/requirements list: Position the cursor on the purchase order and choose 📝 or 🔍.
   The item screen of the selected purchase order appears.

2. Choose Item → Confirmations → Overview.
   The overview screen for the confirmations now appears.
Document Types for Purchase Requisitions

Use
You can use document types to specify and group purchase requisitions more exactly.
The following document types are available for purchase requisitions:

- standard purchase order
- subcontracting
- stock transfer

Prerequisites

- In Customizing for Purchasing under Purchase requisition, you have created your document types in addition to the standard document type NB in the IMG activity Define document types.
- In Customizing for MRP in the IMG activity Define external procurement, you have determined the document type for each MRP group, which you want to use in the material requirements planning.

Features

- The document type is used
  - when generating purchase requisitions in the planning run
  - when converting planned orders into purchase requisitions
- The system displays the document type from the MRP list or stock/requirements list in the detail screen of the purchase requisition. You have no control function in material requirements planning. The system only displays the information.
- The system always generates purchase requisitions for direct procurement with the document type NB for standard purchase order.

💡
You do not normally have to make entries for the document types in Customizing. If you have not defined a document type, the system will always generate purchase requisitions with the document type NB.
BOM Explosion and Determining Dependent Requirements

Implementation Options

The BOM is exploded and the dependent requirements are determined within MRP during the planning run, after the system has performed the procurement quantity calculation, lot-size calculation and scheduling.

The bill of material is exploded for every new procurement proposal for an assembly during the planning run. Dependent requirements, which mean the required quantities, are determined for all the assemblies and components needed to produce the product.

Prerequisites

- You have created a BOM that has a valid period and area (see Period/Area of Validity of BOMs [Page 149]).
- The BOM status is set to active for MRP (see BOM Status [Page 153]).
- The BOM components are relevant for production (see BOM Items Relevant for Production [Page 166]).
- You have maintained a selection ID for the priority of the BOM in Customizing for Bills of Material, in the IMG activity Define order of priority for BOM usages.
  
  If you have created alternative BOMs, you have entered the corresponding indicator for the alternative BOM selection in the Selection method field in the material master (see Multiple BOMs [Page 154]).

If the system is also to re-explode the BOM for existing procurement proposals during the planning run, at least one of the following prerequisites must be fulfilled:

- The quantity or date of the procurement proposal has changed.
- The BOM for the assembly has changed.
- You have entered the indicator 2 for Re-explode BOM in the Planning mode field of the initial screen of the planning run.

Process Flow

1. The system determines the valid BOM that is to be used for the explosion and for determining the dependent requirements (see Determining the Valid BOM [Page 147]).
2. Alternative items and discontinued parts are taken into account within the valid BOM (see Alternative Items [Page 159], Discontinued Parts [Page 163]).
3. Special cases:
   - If you work with variant configuration and you have created a super BOM for the standard product, the system plans the components of the configurable product when the BOM is exploded in the planning run (see BOM Explosion for Variant Configuration [Page 167]).
   - Phantom assemblies are also taken into account when the BOM is exploded (see BOM Explosion with Phantom Assemblies [Page 168]).
BOM Explosion and Determining Dependent Requirements

4. You can define for products with a high number of components that total requirements are to be generated when determining the dependent requirements. You can thus improve system performance during the planning run (see Total Requirements [Page 169]).

5. The system determines the date for the dependent requirements on which the components are to be available for the production (see Determining the Dependent Requirements [Page 171]).

6. The system can determine the issue storage location for the components when the BOM is exploded. The system then displays this issue storage location in the component list for the planned order (see Storage Location Determination in BOM Explosion [Page 172]).

7. Direct procurement and direct production of components are also triggered in the BOM explosion of the planning run (see Direct Procurement [Page 206], Direct Production [Page 201]).

8. If necessary, existing revision levels are taken into account in the BOM explosion (see Linking the Revision Level [Page 174]).
Determining the Valid BOM

Process Flow

1. The system checks which BOM usage in the plant has the highest priority (see BOM Usage [Page 148]).

2. For this usage, the system then checks whether there is a valid BOM for the explosion date (see Period/Area of Validity of BOMs [Page 149]). The explosion date is the planned start date of the planned order.

3. If, for a particular production unit, you want to ensure that the total BOM structure is always exploded using the same explosion date and have assigned a BOM explosion number and fixed key date to the sales order, the planned independent requirement, or the planned order, the system chooses the BOM that is valid for this date (see BOM Explosion Number (Fixed Key Date) [Page 150]).

4. The system checks, whether the chosen BOM has the status active for MRP (see BOM Status [Page 153]).

5. If a multiple BOM exists, the system checks which alternative BOM corresponds to the preconditions of the alternative selection (see Multiple BOMs [Page 154]).
BOM Usage

Use
By means of BOM usage, you can manage separate bills of material for various internal organizational areas (engineering/design, production, costing, and so on).

The main differences in the BOM structure result from the different responsibilities in the various organizational areas, which all process different item data.

Prerequisites
In Customizing for MRP, you have defined a sequence for the possible BOM usages for each plant in the IMG activity Define BOM and routing selection using the BOM selection ID.

Features
The system first searches for a valid BOM or alternative BOM for the BOM usage with the highest priority. If the system does not find a valid BOM or alternative BOM in the selected BOM usage, then the BOM usage with the next-lowest priority is selected. The system then looks for valid BOMs for this BOM usage.
Period/Area of Validity of BOMs

Use

During the planning run the system tries to determine the valid bill of material that is suitable for the planning situation.

Features

Area of Validity

For material requirements planning, the BOM must be maintained in the planning plant. If production is carried out in a different plant from the planning plant, then the BOM must also be maintained in this other plant.

Validity Period

The validity period represents the time period during which the bill of material is valid. This time period is defined by entering a Valid from date and a Valid to date.

However, the bill of material (or alternative BOM) can have various validity periods on the time axis, caused by changes (for example, in the BOM structure). Each change status then has a Valid from date and a Valid to date.

During the planning run, the bill of material is chosen with the validity period in which the order start date of the planned order falls.
BOM Explosion Number (Fixed Key Date)

Use

The system explodes the BOM that is valid on this date.

For multi-level BOM structures, larger time intervals may exist between the explosion dates of the individual assemblies. If BOMs (or alternative BOMs) have been changed in the meantime (for example, exchanging individual components due to new technical drawings, changed production techniques, due to parts to be discontinued etc.) a situation may exist whereby an assembly that is used repeatedly is produced with different BOM structures.

If you want to ensure that for a certain production unit, the BOM structure is always exploded with the same date, you can allocate a BOM explosion number to the planned order (or for make-to-order production it can be directly allocated to the sales order).

Prerequisites

- You have created a BOM explosion number.
- You have entered the BOM explosion number in the sales order, or entered it when creating the planned independent requirements or when manually creating/changing planned orders.
  
  The system can automatically specify the BOM explosion number when entering planned independent requirements or customer independent requirements or when entering the sales order.

Features

By means of the BOM explosion number, you can define a common explosion date (fixed key date) for all BOM levels. BOM explosion is then carried out with this fixed key date for all levels.
BOM Explosion Without Fixed Key Date

BOM Explosion with Fixed Key Date

See also:
BOM Explosion Number (Fixed Key Date)

Assigning a New Key to the BOM Explosion Number [Page 63]
BOM Status

Use

The BOM status specifies whether a bill of material is active or inactive for different organizational areas.

Prerequisites

You have set a BOM status in the header of the BOM, which switches the BOM to active for MRP.

💡

You define the BOM status in Customizing for Production Basic Data in the IMG activity Define BOM status.

Activities

To set the BOM status, starting from the item overview in the BOM, choose 📝.
Multiple BOMs

Use

A multiple BOM groups together several BOMs, which describe different, alternative material compositions for one and the same product.

For multiple BOMs, you must specify which alternative BOM should be selected by the system during the planning run.

Prerequisites

You have determined the procedure to be used for selection for an assembly in the material master (MRP 4 view) in the Selection method field.

Features

Three procedures for selection are supported by the system:

- Selection using order quantity (lot size)
- Selection using explosion date
- Selection using production version
BOM Selection Using Order Quantity

Prerequisites
You have defined the lot size range of an alternative BOM in the BOM header.

Features
The order quantity uses the lot size according to the chosen lot-sizing procedure as a reference.

During the planning run, the system checks whether a valid alternative BOM exists for the order quantity (lot size) in the planned order. The valid alternative is exploded and dependent requirements are created for the components.

If the system does not find a valid or appropriate alternative for the order quantity, an exception message is created.
BOM Selection Using Explosion Date

Prerequisites

- You have set the indicator 1 for Selection by explosion date in the Selection method field for an assembly in the material master (view MRP 4).
- You have entered the assemblies, for which selection using explosion date should take place, in the table for alternative selection using date (see below).

Features

For BOM explosion according to a specific date, you define time intervals for each assembly and different BOMs are assigned to each of these time intervals. During the planning run, the system then checks the time intervals, which have been specified for the assembly and selects the alternative that is valid for the explosion date. The order start date of the planned order is set as the explosion date. The appropriate alternative is exploded and dependent requirements are created for the components.

If the system does not find a valid or an appropriate alternative BOM for the explosion date, it uses the BOM with the appropriate lot size.

Activities

You maintain the table for the selection of alternatives using date as follows:

1. Starting from the MRP menu choose Master data → BOM by date.
   The table for specifying the alternative BOM selection using the date now appears.

2. Enter the necessary parameters for each material whose alternative BOM selection is to be carried out using the date.

3. If you want to allocate several alternative BOMs with different time intervals to a material, you must determine the valid from date for each alternative in the Valid from field.
   The valid from date of the subsequent alternative BOM marks the expiry date of the preceding alternative.

4. Save your entries.
BOM Selection Using Production Version

Prerequisites

- You have set the indicator 2 or 3 for Selection by production version in the Selection method field for the assembly in the material master (view MRP 4).
- You have created one or more production versions for the assembly in the material master (MRP 4 view).

Features

The production version determines the different methods of production according to which material can be produced.

During the planning run, the system checks whether a production version matches the quantity and the date of the planned order. If it finds a valid production version, the BOM with the respective usage and alternative is exploded and dependent requirements are created for the components.

If the system does not find a valid or suitable production version:

- it uses the BOM with the appropriate lot size, if you have set the indicator 2 for Selection by production version.
- it creates an exception message, if you have set the indicator 3 for Selection only by production version.

You also have the option of predefining the production version(s). There are two possibilities:

- Directly allocating a production version to an order
  
  You can manually enter the production version in the planned order. The system then automatically selects the alternative BOM that is specified in this production version for the BOM explosion of the planned order.
- Determining the production version using quota arrangements
  
  In the quota file, you can specify which production versions can be used for materials that are produced in-house and how often (expressed as a percentage) each production version is to be used in production (see Quota Arrangements [Page 137]).

You can find further information on maintaining the production version in the SAP document, LO - Managing Material Master Data.
Determining the Valid BOM Items

Process Flow

When the valid BOM is determined, the system checks the items to see if they require the creation of secondary requirements:

1. If you have maintained alternative items, the dependent requirements of the alternatives are calculated according to the usage probabilities (see Alternative Items [Page 159]).

2. The system checks whether a BOM item is a discontinued material and, if necessary, diverts the requirements to a follow-up material (see Discontinued Parts [Page 163]).

3. In the planning run, dependent requirements are only created for BOM items that are relevant for production. The system copies only these items to the planned order (see BOM Items Relevant for Production [Page 166]).

4. For variant configuration, the BOM that corresponds to the configuration of the sales order is exploded. Thus, the system only plans those components that are to be used in production as specified by the configuration from the super BOM (see BOM Explosion for Variant Configuration [Page 167]).

5. If a BOM item is a phantom assembly, the dependent requirements of the higher-level assembly are directly passed on to the components of the phantom assembly. The phantom assembly itself is still not taken into account (see BOM Explosion with Phantom Assemblies [Page 168]).
**Alternative Items**

**Use**
If you would like to use one or several alternative components in an assembly, you can enter these in the bill of material and combine them by **grouping the alternative items**. These alternative items can then be taken into account when exploding the BOM during the planning run.

**Prerequisites**
- You have entered the materials that can be used as alternatives within an assembly in the BOM as components.
- You have entered the same **grouping key** for all alternative items in the item data in the Alternative item group field, thus combining the alternatives (see below).
- You have entered the **usage probability** on the Alternative Item Data screen. This percentage specifies the probability with which the component will be used for the assembly.

**Features**
The alternative items can be taken into account in MRP according to the defined usage probability or can be defined in the BOM purely for information purposes for the employee.

**Activities**
Proceed as follows to combine components that you would like to use as alternatives into a group:
1. Enter the materials as items in the item overview of the BOM.
2. Double-click on the Item field to call up the item data for the first alternative item.
3. Enter the key for your alternative group in the Alternative item group field in the Basic data and choose Enter.
4. Enter the usage probability for the components. Enter a priority and strategy to define the procedure used for the withdrawal posting for the production order.
Alternative Items in BOM Explosion

Use
The alternative items are to be planned in the planning run with certain usage probabilities.

Prerequisites
In the Alternative item data dialog box in the BOM, you have entered a usage probability for each component that belongs to an alternative item group.

Features
The dependent requirements of the alternative items are calculated according to the usage probabilities.

Example

<table>
<thead>
<tr>
<th>Alternative item</th>
<th>Usage probability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alternative item 1</td>
<td>60 %</td>
</tr>
<tr>
<td>Alternative item 2</td>
<td>30 %</td>
</tr>
<tr>
<td>Alternative item 3</td>
<td>10 %</td>
</tr>
</tbody>
</table>

The dependent requirements are passed on in the amount of 150 pieces. The system uses 90 pieces of alternative item 1, 45 pieces of alternative item 2, and 15 pieces of alternative item 3.
Alternative Items for Information Purposes

Use

With this function, you can specify for a component in the BOM that if a situation should arise with missing parts, then specific alternative components are available that can be used instead.

Prerequisites

- In the Alternative item data dialog box in the BOM, you have entered a usage probability of 100 % for the component that is always to be used.
- You have entered a usage probability of 0 % for the components that can be used if there are missing parts.

Features

No dependent requirements are created in the planning run for the alternative items with the usage probability 0 %. However, if a missing parts situation arises for the main component, the employee in production has access to information on available alternative items that can be used instead.
Withdrawal Posting of Alternative Items

Use
Withdrawal posting is used for components that have been reserved for the production order. The alternative items are taken into account during this process.

Prerequisites
For each alternative item, you have maintained a sequence and a strategy for the withdrawal in the Alternative item data dialog box in the BOM.

The system does not take the strategy into account during MRP.

Features
You can define a withdrawal sequence and several withdrawal strategies for the withdrawal posting of alternative items for the reservation of a production order:

- Manual specification of the withdrawal
  You define manually which material is withdrawn.

- Withdrawal according to usage probability
  The system uses the usage probabilities and the sequence to decide which material to withdraw.

- Withdrawal only with 100% availability of an alternative
  The system looks for the material that is first in the sequence to cover the complete requirement and reserves this material for the withdrawal. The system will only withdraw an alternative if it can completely cover the requirement. The requirement cannot be split among several alternative items.

You can find further information on this in the SAP document PP – Bills of Material.
Discontinued Parts

Use
You can determine in engineering/design that a material is to be replaced by another one at a certain point in time. When replacing a component with another, however, the stock of the old material should be used up before the new one is introduced in order to avoid dead stock.

It may be necessary to replace one part for another if:

- one part is replaced by a more technically advanced part
- an expensive part is replaced by a less expensive part

The task of MRP when discontinuing parts is to reassign the dependent requirements for the component to be discontinued to the follow-up material, once the stock of the part to be discontinued has completely been used up.

The system differentiates whether

- exactly one material is to be replaced by one follow-up material (simple discontinuation), or
- a group of materials is to be replaced by another group of materials (parallel discontinuation).

Prerequisites

- Both the part to be discontinued and the follow-up part must be MRP parts.
- The base unit of measure of the follow-up part must correspond to the base unit of measure of the part to be discontinued
- Both the part to be discontinued and the follow-up part must be either a stock item or a variable-sized item in the bill of materials
- The follow-up part is not a phantom assembly.
- You have defined a main material to be discontinued for parallel discontinuation. When the stocks of this material are used up its dependent requirements and the dependent requirements of the rest of the materials in the group are reassigned.
- You have entered the following data in the material master (MRP 4 view) for the material to be discontinued (in parallel discontinuation: for the main material to be discontinued):
  - Indicator 1 for Single/parallel discontinued part/material
  - Follow-up material
  - Effective-out date
    - In parallel discontinuation, you set the indicator 3 for Dependent parallel discontinued part/material in the material master for materials dependent on the main material to be discontinued.
- In parallel discontinuation, you have defined the link between the parts to be discontinued and the follow-up material in the BOM:
  - All parts to be discontinued and all follow-up materials have been entered in the BOM.
Discontinued Parts

- Parallel discontinued parts have the same discontinuation group. You enter these in the BOM item.
- The follow-up parts are set to the follow-up group. You also enter these in the BOM item. The follow-up group key is set correctly with respect to the discontinuation group.

You can find further information on this in the SAP document PP – Bills of Material.

Features

During the planning run, the system checks the discontinuation indicator and the effective-out date in the material master and reassigns the materials correspondingly. The system reassigns the requirements during the planning run for the discontinued material and not during the BOM explosion. The system reassigns only dependent requirements and dependent reservations.

Reassigning Dependent Requirements

Starting from the effective-out date, no new procurement proposals are created for the material to be discontinued. Once all the stocks of this material have been used up, its dependent requirements are reassigned to the follow-up material. If there is still enough stock of the material to be discontinued to cover a part of the dependent requirements, this stock is used and the rest quantity is reassigned to the follow-up material.

In parallel discontinuation, you use the indicators in the material master and the link in the BOM to instruct the system to discontinue all materials in the group when the stocks of the main material to be discontinued have been used up. How the dependent parts react depends completely on the stock of the main material to be discontinued. These dependent parts are replaced once the stocks of the main material to be discontinued have all been used up. The dependent requirements are then reassigned to the follow-up materials.

Additional Requirements

Additional requirements created after the effective-out date are not reassigned and no new procurement proposals are created for them. The system sets the Uncovered requirement after effective-out date exception message. This applies to the following requirement types:

- Manual reservations
- Independent requirements and forecast requirements
- Sales orders
- Requirements for subcontracting

Safety Stock

The safety stock is not used up after the effective-out date because safety stock should also be maintained after then to cover unplanned requirements such as a requirement for a replacement part.

The system therefore reassigns the dependent requirements to the follow-up material even if safety stock is available. If the stock level drops below the safety stock, the system also creates a procurement proposal for the discontinued material after the effective-out date. The system issues the Receipt after effective-out date exception message for the procurement proposals.

💡

If you want to consume the safety stock, you can set the safety stock to 0 in the material master on the effective-out date.
Fixed Receipts

When discontinuing parts, the system does not include fixed receipts such as order proposals or production orders if they are after the effective-out date. The system issues the *Please cancel* and *Receipt after effective-out date* exception messages.
BOM Items Relevant for Production

Prerequisites
You have flagged the BOM item as relevant for production in the BOM (see below).

Features
In the planning run, dependent requirements are only created for BOM items that are relevant for production. The system copies only these items to the planned order.

Activities
In order to indicate the relevance of an item for production, choose the tab index *Status/Ing text* in the item overview screen of the BOM and select the *Production relevant* field.
BOM Explosion for Variant Configuration

Use

You can create open variants using the function Variant Configuration.

Features

If a finished product contains many variants, you can group these variants together in a standard product. You can group together all possible components in the super BOM of the standard product instead of creating a separate bill of material for every variant. This super BOM contains all the non-variable parts, that is, the parts that are always used, as well as the variant parts, which are configured. You use object dependencies to define under which circumstances which components are used to assemble the finished product.

The standard product is configured in the sales order, that is, you specify which option model of the standard product is to be produced.

The BOM that corresponds to the configuration of the sales order is exploded in material requirements planning. Thus, the system only plans those components that are to be used in production as specified by the configuration.

You can find further information on this in the SAP document PP - Variant Configuration.

Activities

You check the configuration data as follows:

From the Planning Result after the Planning Run

1. You double-click on the corresponding planned order.
   
   The system displays detailed data for the planned order in the Planned order screen area.

2. Choose

   The characteristic value assignment appears.

From the Planned Order or from the Stock/Requirements List

1. Choose Planned order → Change or Planned order → Display
   
   or

   in the stock/requirements list: Position the cursor on the planned order and choose or

   The planned order itself appears.

2. Choose Configuration.

   The characteristic value assignment appears.
BOM Explosion with Phantom Assemblies

Use

The phantom assembly represents a logical grouping of materials. These materials are grouped together from the construction point of view and are all maintained together. From the production point of view, however, these materials are normally not assembled. The phantom assembly is also used as an entry aid.

Prerequisites

You have entered a special procurement key for Phantom assembly in the Special procurement field in the material master (MRP 1 view) for the assembly.

You define special procurement keys in Customizing for MRP in the IMG activity Define special procurement type.

You can combine the Phantom assembly attribute in Customizing with every possible special procurement type. Example: A material, on the one hand, is sold as a spare part from stock to customers and is procured using stock transfer as the special procurement type. The same material, on the other hand, also appears in several BOMs, but is treated as a phantom assembly there.

Features

If a BOM item is a phantom assembly, the dependent requirements of the higher-level assembly are directly passed on to the components of the phantom assembly. The phantom assembly itself is still not taken into account.

If it is necessary, in individual cases, to create dependent requirements and procurement proposals for the phantom assembly during the planning of a material, you can override the Phantom assembly attribute in the BOM. Enter an appropriate indicator for the explosion type in the item screen of the BOM. You maintain the explosion type in Customizing for MRP in the IMG activity Item data → Define explosion types.
Total Requirements

Use
For industries such as the automotive industry, in which large numbers of sales orders for finished products with very many components are planned every day, the performance of the material requirements planning run can be improved greatly by generating total requirements for the components.

Prerequisites

Finished Product
You must be able to produce the finished product through repetitive manufacturing.

- You have set the Repetitive manufacturing indicator in the material master (MRP 4 view) and entered a repetitive manufacturing profile.
- You have selected the indicator for the generation of collective requirements in the repetitive manufacturing profile that you have entered.
- If you want to assign costs to the material and not the sales order, you have created a production cost collector for the material.

Components
- You have set the indicator 2 for Collective requirements in the Individual/collective field in the material master (view MRP 4).

Features
The system does not generate individual requirements for each pegged requirement. It does, however, generate a total requirement for each component, which contains the daily cumulated quantity of all dependent requirements for this component. For example, if 1000 sales orders are planned for one day, the system does not create 1000 individual requirements for the dependent requirement of a particular component, but creates a single total requirement (requirement quantity multiplied by 1000).

An individual requirement for components is generated in addition to the total requirement:
- if the availability check is allowed for the material in the material master
- if you have set the indicator 0 (zero) for the generation of total and individual requirements for the components in the Requirements grouping field in the material master (view MRP 4)
- if the components in the planned order are firmed
Total Requirements

You may not generate total requirements for components that are produced using make-to-order-production. You therefore enter the indicator 1 for Individual requirements in the Individual/collective field in the material master (view MRP 4) for the components.

Displaying the Total Requirements

The total requirements are displayed as an individual MRP element (TotReq) in MRP evaluations. You cannot access pegged requirements for these total requirements.

You can access the components, for which only total requirements have been generated, in a special list in the planned order. To do this, you select Total requirements in the header of the planned order. (This function is only provided if total requirements are available.) In the standard component list, the system only displays the components, for which individual requirements are presented.
Calculating the Dependent Requirements Date

Use
As the components and the assemblies are needed for the production of a higher-level planned order, they must be available by the order start date of this higher-level planned order.

Features
If no lead-time offset has been maintained, the system uses the order start date for the source planned order as the dependent requirements date for the components (see Calculating the Provision Date of the Components [Page 127]).

Distribution of Dependent Requirements Quantity
Use the distribution function if the complete quantity of dependent requirements for a particular component is not needed on the order start date, but is to be delivered throughout the production process (between the order start and order finish dates). The dependent requirements quantity determined from the BOM explosion is then distributed between the order start date and the order finish date.

You define the distribution key for splitting component consumption in the BOM.

You can find further information on adapting scheduling to the operations in the SAP document PP - Routings.

You can find further information on the distribution function in the SAP document PP - Repetitive Manufacturing.

Lead-Time Offset
In situations where orders have long lead times, the calculation of dependent requirements dates can result in components being provided much earlier than they are actually needed in the production process. To avoid this situation, the dependent requirements date of the subordinate components can be rescheduled by the lead-time offset.

You have determined the lead-time offset in the BOM by entering the number of workdays by which the staging of components is to be displaced in the Lead time offset field in the item overview screen.

If you enter a positive value, the dependent requirements date of the component is displaced into the future by this value, starting from the order start date of the assembly’s planned order.

If you enter a negative value, the dependent requirements date will be brought forward.
Storage Location Determination in BOM Explosion

Use

In order for the system to find the issue storage location for components in a BOM explosion in MRP or in a backflush in repetitive manufacturing, you can make the appropriate settings according to the assignment of storage locations in the plant.

Integration

The process flow for the storage location determination described here is the same as the process flow for supply area determination (if you use Kanban), thus only storage location determination is described below.

Prerequisites

- In the BOM for the assembly or for the finished product, you have defined the production storage location for the component in the BOM item.
- If you have not defined a production storage location in the BOM item, you can define in Customizing for MRP or in Customizing for Repetitive Manufacturing which strategy the system is to use to find the issue storage location and from which location the components are to be withdrawn in the BOM explosion. You do this in the IMG activity Define stor.loc./supply area determination for BOM explosion

Features

Production Storage Location in the BOM Item

If you have defined a production storage location in the BOM item for the withdrawal of the components, the system finds it during the BOM explosion and adopts it in the planning run. You can check it in the component overview for the planned order.

No Customizing Strategy, No Production Storage Location in the BOM Item

If you have not entered a production storage location in the BOM item nor defined a strategy in Customizing, the system checks whether the production storage location has been maintained in the material master for the component and uses it as the issue storage location in the BOM explosion.

Customizing Strategy, No Production Storage Location in the BOM Item

If you have determined a strategy in Customizing and if no storage location has been defined, the system reads the MRP group for the assembly and determines the strategy for the storage location determination. The following strategies are available:

- If you set indicator 1 Only components (or no indicator) in Customizing, the system checks to see whether the production storage location has been maintained in the material master of the components and uses this as the issue storage location.
  
  You use this strategy if you always withdraw one particular component from the same storage location.
- If you set indicator 2 Only assembly, the system checks to see whether the proposal issue storage location has been maintained in the production version of the assembly or
finished product. If this has been maintained, the system uses this issue storage location for all components of the BOM for the assembly or finished product.

If no proposal issue storage location has been maintained, the system adopts the receiving storage location of the assembly or finished product. The system then uses the receiving storage location as the issue storage location for the components.

You can define the receiving storage location in the production version of the assembly in the To location field or in the material master of the assembly or finished product in the Production storage location field.

You use this strategy if you work with repetitive manufacturing and all components lie together in one storage location close to the production line where they are required.

- If you set **indicator 3**, the system then proceeds as with indicator 1. If it does not find a storage location, it then proceeds as with indicator 2.
- If you set **indicator 4**, the system then proceeds as with indicator 2. If it does not find a storage location, it then proceeds as with indicator 1.
Linking the Revision Level

Use

Changes to a bill of material, to the material master record, to a standard task list, or to a document, which are made with reference to a change number, can be additionally marked by a revision level.

You can find further information on creating change numbers and revision levels in the SAP document PP – Bills of Material.
Checking the Revision Level in MRP

Use

The system determines which revision level is to be used for production or purchasing for each procurement proposal during the planning run.

For materials produced in-house, the revision level is determined via the explosion date of the planned order. In BOM explosion, the dependent requirements date is used for determining the revision level for the assemblies and components.

For materials procured externally, the revision level is determined via the release date of the purchase requisition or the order start date of the planned order.

The revision level is displayed in a separate column in the MRP list as well as in the stock/requirements list.

Prerequisites

You have maintained revision levels for the material.

Procedure

Checking the Revision Level for the Planned Order and Components

1. Choose Planned order → Change or Planned order → Display
   or
   in the stock/requirements list: Position the cursor on the planned order and choose or .
   The planned order itself appears. The revision level of the planned order is displayed on the Header tab page.

2. Choose Components.
   The component overview appears.

3. Select the required component and choose Extras → For item.
   Additional data for the components, including the revision level, appear.

Checking the Revision Level for the Purchase Requisition

- In Purchasing, choose Requisition → Change or Requisition → Display
  or
- in the stock/requirements list: Position the cursor on the purchase requisition and choose or .

The details screen for the purchase requisition item appears. The revision level is displayed in the screen area entitled MRP data and can be changed in the change mode.
Adapting the Revision Level if Dates Change

Use

If you change the dates of a planned order, the order start date will be moved to another revision level if necessary. In order to make the changes to the revision level effective, you must trigger the BOM explosion for this planned order manually.

Prerequisites

You have maintained revision levels for the material.

Procedure

In the planned order, you choose Edit → Explode BOM.

During the BOM explosion, the system determines the valid revision level using the explosion date of the planned order.
Creation of Exception Messages

Use

Exception messages depend on the transaction being carried out and are meant to inform you of an important or critical event (for example, start date lies in the past, safety stock has been exceeded).

By means of the exception messages, you can easily sort out any materials that you need to reprocess manually. Special search and selection functions are available for this in the evaluations for MRP.

Process Flow

During the planning run, the system recognizes exceptional situations where you usually have to manually reprocess the planning result and it records these situations as exception messages. The system displays the exception messages in the evaluations for MRP.

Exception messages refer to an individual MRP element. If several exception messages occur for one MRP element, the most important ones are stored.
Rescheduling Check

Use
An important group of the exception messages mentioned above are the rescheduling proposals. In the net requirements calculation, the system checks whether warehouse stock or firmed receipts are available in sufficient quantity to cover requirements. If a material shortage exists, the system usually creates a new procurement proposal. The rescheduling check is used to change the dates of already existing firmed receipts not planned on the same day as the requirement to suit the requirement date. For this purpose, the system displays the appropriate exception messages with rescheduling proposals for these firmed receipts to be processed by the MRP controller.

Prerequisites
You have defined the rescheduling parameters in Customizing for MRP:
- per plant in the IMG activity Carry out overall maintenance of plant parameters
- per MRP group in the IMG activity Carry out overall maintenance of MRP groups.

The rescheduling horizon, which defines the period for bringing forward the receipts, and the receipt elements, which should be taken into account in rescheduling, are included in these.

You can also define tolerance values for the creation of exception messages, in Customizing. These values define a time period in which no exception message is to be created, despite the fact that a rescheduling proposal may exist. The MRP controller can thus avoid a situation where too many exception messages are created if a certain buffer has already been planned for scheduling basis dates.

Process Flow
- Bring process forward (reschedule in)
  Within this rescheduling horizon, the net requirements calculation checks whether, after a requirement, a firmed receipt exists, which can be used to cover this requirement. Then the system displays a rescheduling date as well as the exception message Bring process forward for this receipt. The net requirements calculation then uses this receipt and the system will only create another procurement proposal if the receipt quantity is not sufficient to cover the complete requirement. Several firmed receipts can be used to cover one requirement.

  The rescheduling horizon is always calculated from the MRP date.

- Postpone process (reschedule out), or cancel process
  The net requirements calculation checks over the complete time axis whether availability could still be guaranteed without the receipt in question. If this is the case, the system checks whether the receipt planned here could be used to cover a future requirement. If the system can find such a requirement, it then displays a rescheduling date as well as the exception message Postpone process for this receipt.
If the system finds no future requirement, for which the receipt is required, the system displays the exception message *Cancel process.*
Ranges of Coverage in MRP

Use

The range of coverage is the number of days in which a material must still be available to cover requirements.

On the one hand, the work scheduler defines the range of coverage as a planned number of days, so that fluctuations in requirements can be cleared. If necessary, the system creates corresponding procurement proposals.

On the other hand, the system calculates the range of coverage in MRP Evaluations to enable the work scheduler to see how many days' requirements are covered by the material available.

Features

Various procedures for calculating the range of coverage are available in MRP:

- **Calculating the Statistical Range of Coverage [Page 181]**
  You define the minimum, maximum and target range of coverage for particular periods in the range of coverage profile. The system calculates the minimum, maximum and target range of coverage using the defined range of coverage values and the average daily requirements. If the available quantity is below the minimum stock level, the system creates a procurement proposal so that stock can be replenished up to the target stock level. The system thus obtains a dynamic safety stock based on requirements.

- **Safety Time/Actual Range of Coverage [Page 190]**
  You define the safety time/actual range of coverage in the material master as a planned number of days in which the warehouse stock of a material covers requirements without new receipts being taken into account.
  
  The system simulates bringing forward the existing requirements on the time axis by the number of days defined and creates procurement proposals correspondingly. This ensures that the stock of a material is received before the actual requirements date. This enables the warehouse stock to cover requirements even with fluctuations.

- **Days’ Supply and Receipt Days’ Supply [Page 192]**
  The days’ supply and receipt days’ supply indicate how many days the plant stock currently available (in the case of the receipt days’ supply, plant stock plus certain receipts) will be able to cover the existing requirements.
  
  Both types of days’ supply are calculated by the system during the planning run and are displayed in MRP Evaluations.

- **Actual Range of Coverage [Page 194]**
  The actual range of coverage specifies how long the available quantity of a material at a particular date or in a particular period can cover the requirements in subsequent periods. This is specified in number of days.
  
  The system calculates the actual range of coverage during the planning run and displays it in the period totals display in MRP Evaluations and in the planning table for repetitive manufacturing.
Calculating the Statistical Range of Coverage

Implementation Options

Calculating the range of coverage serves to determine a **dynamic safety stock level** based on current requirements. Statistical, in this context, means it is not the actual requirements that are taken into account, but the average daily requirements within a defined period that are calculated by the system.

During the planning run, the system recalculates the dynamic safety stock for each MRP element and this safety stock is then available for planning purposes.

The statistical range of coverage calculation usually refers to the concrete requirements of make-to-stock production. You can therefore only use this for requirements, which the system lists in the **net or gross planning segments** of the MRP list and the stock/requirements list.

Prerequisites

- The system divides up the requirements relatively evenly, that is, there are not any great variations in the requirements within the periods based upon the calculation.

- In Customizing for MRP, you have defined a range of coverage profile in the IMG activity **Define range of coverage profile (Dynamic safety stock)**. There you have determined the parameters for calculating average daily requirements as well as minimum, maximum and target ranges of coverage for different time periods.

To do this, you start from MRP in the SAP Easy Access menu and choose **Environment → Current settings → Define range of coverage profile (Dynamic safety stock)**. You do not therefore need any customizing authorization in order to maintain an appropriate profile.

- You have assigned the range of coverage profile to the material in the material master (**MRP 2 view**).

Process Flow

1. The system calculates the average daily requirements using the parameters defined in the range of coverage profile (see **Calculating the Average Daily Requirements [Page 183]**).

2. The system reads the defined ranges of coverage in the range of coverage profile and calculates the minimum, maximum and target range of coverage (see **Calculating the Minimum, Maximum and Target Stock Level [Page 185]** and **Values of the Statistical Range of Coverage Calculation [Page 189]**). The target stock level represents the safety stock level.

3. The system checks for every MRP element whether the available quantity is below the minimum stock level. If stock falls below the minimum stock level due to a requirement, the system creates a procurement proposal and thus calculates the procurement quantity, so that the available quantity is replenished up to the target stock level (see **Calculating the Dynamic Safety Stock [Page 186]**).
Calculating the Statistical Range of Coverage
Calculating the Average Daily Requirements

Implementation Options

The system uses the calculation of the average daily requirements as the basis for calculating the dynamic safety stock.

Prerequisites

In Customizing for MRP, you have defined the parameters for calculating the average daily requirements in the range of coverage profile itself using the IMG activity Define range of coverage profile (Dynamic safety stock). The individual parameters are:

- **Periods** (month, week or PPC planning calendar period)
  The periods are calendar periods, that is, the system calculates them from the calendar start of the period. A weekly period, for example, is calculated from Monday to Sunday and a month is calculated from the first calendar day to the last calendar day of the month.

- **Number of periods** that are included in calculation of average daily requirements

- **Period length**
  - **Workdays**
    The system defines workdays using the factory calendar.
  - **Calendar days**
    The system defines calendar days using the Gregorian calendar.
  - **Standard days**
    You can specify, for example, that 20 days are to be used for the calculation of the monthly average.

Process Flow

1. The system uses the defined parameters to determine the **number of days** used for calculating the average daily requirements. If the period is defined as a week, the period length as **standard days** (5 days) and the number of periods as 2, the system divides the total of the requirements by 10 days.

2. The system then calculates the **total of the requirements** for this period.

   ![Tip]

   The system takes into account all requirements in the current period, even requirements that lie in the past but are still in the current period. For example, if the planning run is carried out in the middle of the month, then those requirements that were planned at the beginning of the month are also included in the calculation of the average daily requirements.

3. The average daily requirement is calculated using the formula:
   Requirements in the specified number of periods / Number of days within the total period length
Calculating the Average Daily Requirements

With **time-phased materials planning**, the system does not calculate average daily requirements using the number of days defined in the profile. It calculates the average daily requirements using the number of days in the interval between the MRP date and the availability date to the next MRP date.

See also: [Range of Coverage for Time-Phased Materials Planning](#) [Page 35]
Calculating the Minimum, Maximum and Target Stock Level

Prerequisites

In Customizing for MRP, you have defined the ranges of coverage for the individual time periods in the range of coverage profile itself using the IMG activity Define range of coverage profile (Dynamic safety stock).

- You can define the ranges of coverage for up to three time periods, whereby you can maintain different minimum, maximum and target ranges of coverage for each period.

- In addition to the ranges of coverage for the three periods, you can define different ranges of coverage for particular periods. This can be useful when, for example, you have to plan using a higher safety stock level due to increased demand in the months just before Christmas.

Process Flow

1. During the planning run the system checks whether there are any date-specific ranges of coverage on the dates of the MRP elements (requirements, planned orders, and so on). If this is the case, the system uses these different range of coverage values. If there are no date-related range of coverage values on these dates, the system uses the values that you have maintained for the three periods.

2. The system calculates the stock levels for the corresponding time periods using the following formulas:
   - Minimum stock level: average daily requirements * minimum range of coverage
   - Target stock level ( = dynamic safety stock): Average daily requirement * target range of coverage
   - Maximum stock level: average daily requirement * maximum range of coverage
Calculating Dynamic Safety Stock

Process Flow

1. During every planning run, the system checks for every MRP element (requirements, planned orders and so on) whether the available quantity is below the minimum stock level.

2. If stock falls below the minimum stock level due to a requirement, the system creates a procurement proposal and thus calculates the procurement quantity, so that the available quantity is replenished up to the target stock level, that is, the dynamic safety stock.

3. If the maximum stock level is exceeded, the system adjusts the quantities for procurement proposals that are not firmed correspondingly. If the procurement proposal is firmed, the system displays an exception message.

Example

The system determines an average daily requirement of 15 pieces. You have defined a minimum range of coverage of 3 days, a maximum range of coverage of 7 days and a target range of coverage of 5 days.

The system calculates the following:

Minimum stock level = 3 x 15 pieces = 45 pieces
Maximum stock level = 7 x 15 pieces = 105 pieces
Target stock level = 5 x 15 pieces = 75 pieces

The available quantity is 40 pieces and is therefore less than the minimum stock level. Therefore, the system creates a procurement proposal for 35 pieces (= target stock level 75 pieces – actual quantity of 40 pieces) during the planning run.

The system does not plan the dynamic safety stock as a gross quantity but takes it into account in the net requirements calculation. That means that the system then increases only the quantity of an existing planned order when it is necessary due to the availability situation. If sufficient material quantities to cover the safety stock quantity are already in stock, no additional planned order is created.

In the case of time-phased materials planning, the range of coverage is calculated differently to the method described here. For information, see Range of Coverage for Time-Phased Materials Planning [Page 35]
Example for Calculating Statistical Range of Coverage

Example Data for Average Daily Requirement

<table>
<thead>
<tr>
<th>Requirement for 1st period</th>
<th>1000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirement for 2nd period</td>
<td>2000</td>
</tr>
<tr>
<td>Calendar period</td>
<td>Week</td>
</tr>
<tr>
<td>Period length</td>
<td>Standard days (5 days)</td>
</tr>
<tr>
<td>Number of periods</td>
<td>2</td>
</tr>
</tbody>
</table>

Example Data for Determining the Range of Coverage

<table>
<thead>
<tr>
<th>Target range of coverage for period 1</th>
<th>2 days</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period 1</td>
<td>2 weeks</td>
</tr>
<tr>
<td>Target range of coverage for period 2</td>
<td>4 days</td>
</tr>
<tr>
<td>Period 2</td>
<td>3 weeks</td>
</tr>
</tbody>
</table>

Calculation

- Calculation of the average daily requirements:
  \[(1000 + 2000)/(2*5) = 3000/10 = 300\]

- Calculating dynamic safety stock:
  \[
  \text{Average requirement} \times \text{range of coverage in period 1} \\
  300 \times 2 = 600 \\
  \text{Average requirement} \times \text{range of coverage in period 2} \\
  300 \times 4 = 1200
  \]

Result

For the first two weeks starting from the MRP date, a safety stock level of 600 pieces is planned.
For the following three weeks, a safety stock level of 1200 pieces is planned.
Results of the Statistical Range of Coverage Calculation

Use
You can check the values calculated by the system in MRP Evaluations.

Prerequisites
- In Customizing for MRP, you have defined a range of coverage profile in the IMG activity Define range of coverage profile (Dynamic safety stock).
- You have assigned the range of coverage profile to the material in the material master (MRP 2 view).
- You have completed a planning run.

Features

MRP Evaluations
You can check the calculated values in the stock/requirements list or in the MRP list in the period totals display. The period totals display appears, if you choose in the stock/requirements list or in the MRP list.

The system displays the following data:
- Statistical range of coverage
- Target range of coverage
- Minimum range of coverage
- Maximum range of coverage
- Average daily requirements
- Target stock level (dynamic safety stock)
- Minimum stock level
- Maximum stock level

Planning table for Repetitive Manufacturing
When using the planning table for repetitive manufacturing, you can also check particular values by proceeding as follows: Starting from the planning table, choose View → Range of coverage:
- Target stock level (dynamic safety stock)
- Minimum stock level
- Maximum stock level
- Statistical range of coverage
### Values of the Statistical Range of Coverage

<table>
<thead>
<tr>
<th>Value</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average daily requirement</td>
<td>Requirements in the specified number of periods/Number of days within the total period length</td>
</tr>
<tr>
<td>Statistical range of coverage</td>
<td>Available quantity at the respective date/Average daily requirements</td>
</tr>
<tr>
<td></td>
<td>The statistical range of coverage then corresponds to the target range of coverage if no requirements shortage or excess requirements exist.</td>
</tr>
<tr>
<td>Minimum, maximum and target range of coverage</td>
<td>You determine an interval for the calculation of the safety stock level with the minimum and maximum range of coverage. The system checks whether the statistical range of coverage is below the minimum range of coverage. If this is the case, the system recalculates the safety stock quantity in the next planning run using the target range of coverage. If the maximum range of coverage is exceeded, the system will display an exception message.</td>
</tr>
<tr>
<td>Minimum stock level</td>
<td>Average daily requirements * minimum range of coverage</td>
</tr>
<tr>
<td>Maximum stock level</td>
<td>Average daily requirements * maximum range of coverage</td>
</tr>
<tr>
<td>Target stock level</td>
<td>Average daily requirements * target range of coverage</td>
</tr>
</tbody>
</table>
Safety Time / Actual Range of Coverage

Use

The safety time / actual range of coverage ensures that the planned warehouse stock covers the requirements of a defined number of days. It therefore serves as a time float and thus works alongside the safety stock, which acts as quantity float.

Prerequisites

- You have set the Safety time indicator in the material master (MRP 2 view).
- You have entered the actual range of coverage in the Safety time/actual range of coverage field in the material master (MRP 2 view).
- If you want to use a different actual range of coverage in addition to this one for particular periods:

  In Customizing for MRP, you have defined a period profile in the IMG activity Define period profile for safety time/actual range of coverage and assigned this to the material in the material master.

  To do this, you start from MRP in the SAP Easy Access menu and choose Environment → Current settings → Define period profile for safety time/actual range of coverage. You do not therefore need any customizing authorization in order to maintain an appropriate profile.

Features

Safety Time / Actual Range of Coverage

The system simulates bringing the requirements forward by the number of days entered and the planning for the receipts, which are created for these requirements in the planning run, is also brought forward by this number of days. Using the safety time indicator, you can control whether receipts are only to be brought forward for planned independent requirements (planned independent requirements and customer requirements) or for all requirements.

The work scheduler defines the safety time / actual range of coverage as 2 days. A requirement exists for January 31st. During the planning run, the system simulates bringing the requirements date forward by 2 days and generates a planned order with finish date January 29th. However, the actual requirements date (January 31st) does not change.

The disadvantage of this procedure is that a procurement element is created for each requirement. The system only summarizes the procurement quantities necessary for the requirements into a procurement element if you work with weekly lot sizes or monthly lot sizes.
Safety Time / Actual Range of Coverage for Time-Phased Materials Planning

Time-phased materials planning is based on the interval between the MRP date and the availability date of the next MRP date. By using the actual range of coverage, the number of days defined as the actual range of coverage is added to this availability date. Time-phased materials planning is then carried out for the changed period.

Period Profile for Safety Time / Actual Range of Coverage

In certain periods, it may be necessary for you to plan using a different range of coverage from the one that you have defined in the material master. In order to smooth out seasonal fluctuations, you can use the period profile for any freely definable period of time to define a different actual range of coverage from the one that you have defined in the material master. You can thus, for example, set in the period profile that a higher range of coverage than in normal months should be used to cope with increased demand in the months leading up to Christmas.

During the planning run, the system checks whether you have assigned a period profile to the material and whether the requirements date falls in one of the periods that are defined in the profile. If that is the case, the system calculates using the actual range of coverage from the period profile. If that is not the case, the system uses the actual range of coverage from the material master.
Days’ Supply and Receipt Days’ Supply

Use
The days’ supply of a material indicates how long a material will cover requirements if you only take current plant stock into account.

The receipt days’ supply of a material indicates how many days the stock will last if stock that you are certain to receive is also taken into account. You can define two different receipt days’ supplies. You can thus define, for example, that with receipt days’ supply 1, all possible receipt elements are to be taken into account, whereas with receipt days’ supply 2, only the absolutely certain receipt elements, such as shipping notifications and production orders, are taken into account.

By using these range of coverage types, the work scheduler is able to see whether any further action is required for a material.

Integration
The system calculates the days’ supplies in every planning run and every time the current stock/requirements list is called up.

The system displays both of these types of days’ supply in the planning results, in the material overviews in collective access and in the header details in the MRP list and the current stock/requirements list.

In the collective display of the MRP list, you can use these key figures to select MRP lists.

Prerequisites
You can define the receipt elements that are to be taken into account for the receipt days’ supply 1 and 2 in the IMG activity Define receipt elements for the receipt days’ supply in Customizing for MRP.

Features
Defining the Receipt Elements for the Receipt Days' Supplies
In Customizing, you define the receipt elements that the system is to take into account when calculating the receipt days’ supply 1 and 2.

In the case of in-house production, you have the choice between production/process orders and firmed planned orders and as of Release 4.5A assigned planned orders. Assigned planned orders are planned orders that have been assigned a production version. In repetitive manufacturing, this corresponds to the manufacturing of a particular production line.

Calculating Days’ Supply and Receipt Days’ Supply
For calculating the days’ supply and receipt days’ supply, you define in the Safety stock field in Customizing whether the system is to use the safety stock or the actually available stock to determine the number of days that a material will cover requirements.

If the safety stock is to be taken into account, the system calculates the number of days until the stock level falls below the safety stock level. If only the actually available stock is to be taken into account, the system calculates the number of days until the stock level falls below 0.
Days' Supply and Receipt Days' Supply
Actual Range of Coverage

Use
The actual range of coverage specifies how long the available quantity of a material at a particular date or in a particular period can cover the requirements in subsequent periods. This is specified in number of days.

Integration
The system calculates the actual range of coverage both during the planning run and in the stock/requirements list. It can then be displayed in the Period totals display in the MRP list or in the stock/requirements list.

The system also displays the actual range of coverage in the planning table for repetitive manufacturing.

Features
The actual range of coverage is calculated for all periods that are displayed in the Period totals display. The available quantity on the particular date is used to carry out the calculation. This provides the work scheduler with an overview of the ranges of coverage in the future.

In contrast, the days’ supply only displays the current situation as it is calculated using the current available quantity.
Special Planning Processes

Use

You use special planning processes,

- if you do not want to plan on a plant level, but either on a multi-plant level or only for a particular part of a plant
- if you want to work with special procurement types.

Features

Special planning processes include

- subcontracting
- direct production
- direct procurement
- storage location MRP
- planning with MRP areas
- multi-plant/site planning
- requirements grouping for individual project planning
Subcontracting

Use
In subcontracting, the vendor is provided with materials (components), which he uses to produce the finished product.

Integration

- From the point of view of materials planning, subcontracting is initiated by the special procurement key Subcontracting. The special procurement key is allocated to the finished product or the assembly in the material master (MRP 2 view) (see also Procurement Type and Special Procurement Type [Page 135]).

- In order to plan specific material requirements for each individual subcontractor, you can use MRP areas. You can thereby create an individual MRP area for every subcontractor (see Planning for Components to be Provided in Subcontracting [Page 242]).

You can find further information on subcontracting in the SAP document MM – Inventory Management under Subcontracting [Ext].
Subcontracting Procedure

Prerequisites

- You have set the special procurement key Subcontracting in the material master (MRP 2 view) for the finished product or assembly that is to be produced by the subcontractor.

- You have entered the subcontractor in the source list or in the quota arrangement for this assembly. If you do not use quota arrangements, you have to set the Record relevant to MRP indicator in the MRP column of the source list.

- You have set the Scheduling info record/agreement indicator in Customizing for MRP in the IMG activity Define external procurement.

Process Flow

1. If a requirement exists for the finished product or assembly, the planning run generates a purchase requisition with item category L (subcontracting) or a planned order with special procurement Subcontracting. This planned order is converted into a purchase requisition with item category L.

   You can see the item category or the special procurement type when you display the MRP element in the stock/requirements list or in the MRP list.

2. At the same time, the system explodes the BOM for the finished product or the assembly. Dependent requirements for the components are generated at finished product level either at the start date of the planned order or at the release date of the purchase requisition.

   These dependent requirements are included in the net requirements calculation as special dependent requirements (MRP element SubReq). However, if you make changes to quantities or dates, you can do so in the same way as for normal dependent requirements.

3. The system then determines the source of supply, that is, the subcontractor, using the source list or quota arrangement and source list (see also Determining the Source of Supply for External Procurement [Page 139]).
Material Requirements Planning (PP-MRP)

Subcontracting with Production Version

Subcontracting with Production Version

Use

If an assembly is produced by different subcontractors or produced in-house with different BOMs, the system is to take this into account during the BOM explosion in the planning run.

Prerequisites

- You have entered the special procurement key Subcontracting in the material master (MRP 2 view) of the assembly.
- You have created a production version in the material master (MRP 4 view) of the assembly, in which you have entered the alternative BOM relevant to the subcontractor/vendor.
- You have entered this production version in the purchasing info record for the subcontractor.
- You have entered the subcontractor in the source list or in the quota arrangement for this assembly. If you do not use quota arrangements, you have to set the Record relevant to MRP indicator in the MRP column of the source list.
- You have set the Scheduling info record/agreement indicator in Customizing for MRP in the IMG activity Define external procurement.

Integration

You can find the transactions for maintaining info records and the source list in the Purchasing menu, under Master data.

Features

- Material requirements planning adopts the production version from the subcontractor’s purchasing info record and explodes the corresponding alternative BOM that is defined in the production version. This also applies to planned orders and purchase requisitions.

  !

  The production version from the subcontractor purchasing record has a higher priority than the production version from the quota arrangement.

- In Purchasing, when assigning the source of supply, the production version is copied from the subcontractor info record into the purchase requisition or purchase order and is used for selection in the BOM.
- Production versions that you have entered in the quota arrangement are taken into account in MRP and Purchasing.
Planning Components to be Provided

Use
The net requirements calculation for components to be provided in subcontracting takes into account that the **provision stock** can only be used to cover the corresponding **requirement of material provided**. The provision stock that is already available from a subcontractor (vendor) can only therefore be used to cover the requirements of material provided at this subcontractor. The system uses only the **stock that has not been assigned to a subcontractor** as **unrestricted-use stock** to cover all requirements.

Integration
If you carry out **MRP with MRP areas**, you can define an MRP area for each individual subcontractor and thus plan the components to be provided separately for each subcontractor (see **Planning for Components to be Provided in Subcontracting** [Page 242], **Example for Planning with MRP Areas** [Page 220]).

Features

Subcontractor Segments
The system displays the provision stocks and requirements in additional **segments for subcontracting** in the MRP list or stock/requirements list. A separate planning segment is created for each subcontractor (vendor) for which stocks or requirements for material provided exist.

The system displays the **provision stock and requirements of material provided** (MRP element SubReq) for a subcontractor in the segment for subcontracting. This display only serves for **information**, as the actual planning only takes place in the net requirements segment.

The system displays requirements for material provided for a subcontractor without existing provision stock in the segment for subcontracting and displays and plans the requirements in the net requirements segment.

The system also includes subcontracting third party orders and subcontracting third party requisitions in the subcontracting segment.

Planning in the Net Requirements Segment
In the net requirements segment, the system calculates the **difference between stock already provided and requirements for material provided**.

The system does not include requirements of materials provided by a subcontractor (vendor) that are already covered by existing stocks at the subcontractor's plant in the net requirements calculation. The system therefore does not display these requirements in the net requirements segment.

The system displays and plans requirements for material provided that are not covered by provision stocks in the net requirements segment. You can display the total requirement quantity and the open quantity still to be provided for a requirement of material provided (SubReq) by double-clicking on the requirement of material provided.
Planning Components to be Provided

Manually Processing Components to be Provided

If you change the planned order or the purchase requisition of the finished product manually, these changes are automatically transferred to the components to be provided. The dependent requirements of the components to be provided are adjusted. You can also change or delete the dependent requirements manually.

Further Processing Options in Inventory Management

In Inventory Management, you must post the transfer posting of unrestricted-use stock to the provision stock of the subcontractor (stock with vendor) for the material components. This posting is independent from a purchase order.

The subcontractor dependent requirements for the components are not changed by this transfer posting.

The system only reduces the provision stock of the subcontractor for the components and reduces the subcontractor dependent requirements for the components once the goods receipt for the product has been posted.

⚠️

During a partial goods receipt, the subcontractor dependent requirements are reduced proportionally.

You can find further information on subcontracting in the SAP document *MM – Inventory Management* under Subcontracting [Ext.].
Direct Production

Use

If you do not use direct production, no link exists between the planned orders/production orders within the BOM structure. This means that the production order is scheduled individually and costs are dealt with individually for every assembly and component (with the exception of make-to-order production - here you can jointly consider the costs for several production levels). Once production is finished, the goods receipt for these components is posted in the warehouse so that goods issue of the components can be carried out for the production order of the superior assembly.

In contrast, the aim of direct production is to jointly regard scheduling and costing procedures for finished products, assemblies and components within a BOM structure.

The components that are produced directly are connected with each other in a multi-level collective order by entering the respective superior and leading planned order or production order. The collective order can be scheduled together and the costs incurred for the collective order can also be dealt with together (see Costs in Collective Orders [Ext.]).

A further advantage of direct production is the simplified process: Components that are produced directly are not placed in stock and are consumed directly by the superior production order. No manual goods receipt/issue postings are necessary. These postings are increasingly executed automatically during the confirmation of an operation in a production order.

Direct production does not take into account available plant stock.

Prerequisites

- If you want to use direct production for a particular component all the time, you have entered the special procurement key for direct production in the material master for the component (MRP 2 view).

- If you want to use direct procurement for a particular BOM only, you have entered the special procurement key for direct procurement in the corresponding BOM item in the MRP data area. This entry overwrites the entry in the material master.

If you have activated direct production in the material master, you can switch off direct production for a particular BOM, if you deactivate direct production in the MRP data area of the corresponding BOM item under Explosion type. This entry overwrites the entry in the material master.

Features

Direct production is always triggered in the planning run.

- A special indicator is set internally for dependent requirements of the components that are produced directly. This passes on the relevant information for direct production to MRP. During the planning of these components, the system creates corresponding planned orders for direct production for these dependent requirements. The system displays
Material Requirements Planning (PP-MRP)

Direct Production

dependent requirements and planned orders for direct production in a separate direct production segment in the MRP list and the stock/requirements list.

- When the planned order for the finished product is converted into a production order, all planned orders for subordinate components that are to be produced directly are automatically converted into production orders.

- The system adapts planned orders for direct production to changes in date and quantity of the superior assembly, even if they are firmed, so that the consistency of the collective order is kept. Manual changes are reversed.

  When firmed purchase requisitions for direct production are changed, the system automatically sends the MRP controller a mail with the data for the change (see Message Transmission in Direct Production [Page 204]).

You can find further information on the direct production in the SAP document Collective Orders [Ext].
Planned Orders for Direct Production

Use
The system creates planned orders for direct production during planning for components in the collective order that are produced directly.

Features
Every planned order for direct production contains the number of the superior planned order as well as the number of the leading planned order (tab index Assignment, screen area Direct production).

- The requirement to be produced directly comes from the superior planned order.
- The leading planned order is the planned order at the head of the collective order.

The entry for the superior and leading planned order is purely informative. If you double-click on the number, the display for the respective planned order appears.

💡

After conversion into production orders, the respective superior and leading production order is also entered in the direct production orders.

⚠️

You can change planned orders for direct production manually, but such changes are not advised, as they lead to inconsistencies and are overwritten by the next planning run. Only change fields that are not critical, for example, where you add or delete a component, and then convert the planned order immediately.
Message Transmission in Direct ProductionUse

If a planned order for direct production, which has been changed manually and is therefore firmsed, is changed or deleted by the next planning run, the MRP controller responsible must be notified of the change as soon as possible. The MRP controller receives an e-mail with the information about the change automatically.

Prerequisites

- You have set the Message indicator in Customizing for MRP in Settings for direct procurement.
- You have set the control parameters for e-mail message transmission in Maintain e-mail partner for direct production.

Features

The system sends an e-mail if a planned order for direct production is changed or deleted or if the BOM had to be re-exploded.
Customizing Settings for Direct Production

Use
You can implement a multi-plant collective order with production in another plant using the special procurement key.

Integration
In Customizing for MRP, you have maintained the special procurement key in the IMG activity Define special procurement type (see also Procurement Type and Special Procurement Type [Page 135]).

Features
In Customizing, the system creates a special procurement key for direct production as standard. The special procurement key contains the procurement type E for in-house production and the Direct production field is selected.

You can create a further special procurement key by setting the special procurement type P for Production in alternative plant as well as entering the production plant in addition to making the direct production settings. The settings work in addition to each other and do not block each other. This is how you create a multi-plant collective order.

A material is to always be produced in an alternative plant (plant 0002) and simultaneously be produced directly as a BOM component.

During the planning, the system creates a planned order for direct production for the material when there is a requirement in plant 0001. In plant 0002, the BOM is exploded and dependent requirements are created. When the system converts the superior planned order into a production order, the planned order for direct production for the material in plant 0001 is also converted automatically into a production order. The dependent requirement in plant 0002 is converted into a dependent reservation and production of the components in plant 0002 is initiated.

If the material is simultaneously sold to customers from the warehouse, for example, as a spare part, it is also produced in plant 0002. The setting for direct production is not valid in this case, as the material is a finished product and not a BOM component.
Direct Procurement

Use

Using the direct procurement procedure, you can order BOM components for a planned order directly instead of via the warehouse.

Direct procurement is also possible in connection with make-to-order production and engineer-to-order production.

There are two alternative processes:

- using the special procurement key Direct procurement
  This process is like the direct production process.

- using the item category Non-stock item.

We recommend the process using the special procurement key.

Prerequisites

- For the plant and/or for an MRP group, you have defined when the direct procurement is to be triggered. In Customizing for MRP, you have set the indicator in the Direct procurement field of the IMG activity Settings for direct procurement as follows:
  - Indicator 1 or 3 (these are identical), if direct procurement is to be triggered during MRP
  - Indicator 2 or blank (these are identical), if direct procurement is only to be triggered after the conversion or creation of a production order.

Process Using the Special Procurement Key for Direct Procurement

- You have set the item type stock item for the components in the BOM, which are to be procured directly.

- If you want to use direct procurement for a particular component all the time, you have entered the special procurement key for direct procurement in the material master for the component (MRP 2 view).

- If you want to use direct procurement for a particular BOM only, you have entered the special procurement key for direct procurement in the corresponding BOM item in the MRP data area. This entry overwrites the entry in the material master.

If you have activated direct procurement in the material master, you can switch off direct procurement for a particular BOM, if you deactivate direct procurement in the MRP data area of the corresponding BOM item under Explosion type. This entry overwrites the entry in the material master.
Process Using the Item Category for Non-Stock Item.

- You have set the item type non-stock item for the components in the BOM that are to be procured directly. You have also entered an item number and a detailed long text for the BOM item.

  This is the only possible process for materials without a material master.

Features

The system automatically triggers direct procurement at the selected time.

- In the planning run, the system does not create dependent requirements for materials without a material master, but does create purchase requisitions directly for them. The system thereby copies the BOM long text into the purchase requisition. The system does not display the materials in the MRP list or stock/requirement list, because they do not have a material number and the system can only display materials with material numbers in these lists.

  You set the copying of the long text for the BOM item in Customizing for Purchasing in the IMG activity Define text types and copying rules.

- For materials with a material master, MRP creates dependent requirements and (according to the creation indicator for the planning run) planned orders for direct procurement or purchase requisitions for direct procurement. The system displays these in a separate direct procurement segment in the MRP list and the stock/requirements list.

- When the planned order for the finished product is converted into a production order, all planned orders for subordinate components that are to be procured directly are automatically converted into purchase requisitions.

- The system adapts planned orders for direct procurement and purchase requisitions for direct procurement to changes in date and quantity of the superior assembly, even if they are firmed, so that inconsistencies in planning are avoided. Manual changes are reversed.

  When firmed purchase requisitions for direct procurement are changed, the system automatically sends the buyer a mail with the data for the change (see Message Transmission in Direct Production [Page 211]).

  You can only make restricted changes to purchase requisitions for direct procurement. Changes to quantities and dates are not possible.
Copying the BOM Long Text

Use
In the planning run, the system creates a purchase requisition directly for non-stock items without a material master. The system thereby copies the BOM long text into the purchase requisition.

Prerequisites
- The component does not have a material master record and is set in the BOM as a non-stock item in the Item category field.
- You have entered a long text in the BOM item.

Procedure
1. From Customizing for Purchasing, choose the IMG activity Define text types and copying rules.
   The screen for maintaining the text types now appears.
2. Choose New entries.
3. Enter a text ID for the text type and enter BOM Item text as the meaning.
4. Select the line with the newly created text type and double-click in the left screen area on Links.
   The screen for maintaining the text links for the selected text type now appears.
5. Choose New entries.
6. Enter a sequence number and choose BOM as source object and BOM item text material BOM as the source text.
7. Save the text link and text type.
   You see the newly created text type, when you choose Goto → Texts → Text overview in the item overview or the item details of the purchase requisition.

⚠️

The Customizing for text types is cross-client. The Customizing for links is dependent upon the client.
Account Assignment for Direct Procurement Purchase Requisitions

Use

Purchase requisitions, which are created by the system during direct procurement, bypass the warehouse and are set with the account assignment category Unknown. (The account assignment category U is set in Customizing as a default value in the SAP Standard System.)

In make-to-order planning and individual project planning too, the system sets the purchase requisitions for direct procurement with the account assignment category Unknown. The system does not pass on the account assignment for the sales order or the project to the purchase requisition for direct procurement.

Features

If the planned order that caused a purchase requisition for direct procurement is converted into a production order, then the purchase requisition is automatically reassigned to the production order account. If the purchase order does not have to be created until the production order exists, then the purchase order is also automatically assigned to the production order account.

If, due to deadlines, you have to order before the production order exists, then you have to manually assign the purchase order to a service cost center account. Here, you must select an item category that allows account assignment to cost center and that leaves the goods receipt non-valuated.

If the production order still does not exist when the invoice is received, the costs remain with the service cost center. Otherwise, you must manually change the account assignment from the service cost center to the production order when posting the invoice receipt.

Activities

You see the number of the respective production order, if you display the account assignment of the purchase requisition for direct procurement. To do this, proceed as follows:

1. Starting from the Purchasing menu, select Purchase requisition → Display.
2. Enter the purchase requisition number and choose ✓. The item overview of the purchase requisition now appears.
3. Position the cursor on the required item and choose 📊 Account assignment. The account assignment screen for the item appears. In the Order field, you will find the number of the superior production order.
Planned Orders for Direct Procurement

Use

The system creates planned orders for direct procurement during planning for components that are procured directly. Depending on which creation indicator for purchase requisitions you have set in the initial screen for the planning run, the system chooses between the following procedures:

- if you have set indicator 1 (*Purchase requisitions only*), the system does not create any planned orders for direct procurement.
- if you have set indicator 2 (*Purchase requisitions in opening period*), the system only creates planned orders for direct procurement after the opening period.
- if you have set indicator 3 (*Planned orders*), the system only creates planned orders for direct procurement.

Features

Every planned order for direct procurement contains the number of the *superior planned order* (tab index *Assignment*, screen area *Direct procurement*). The requirement to be procured directly comes from the superior planned order.

The entry for the superior planned order is purely informative. If you double-click on the number, the display for the planned order appears.

⚠️

You can change planned orders for direct procurement manually, but such changes are not advised, as they lead to inconsistencies and are overwritten by the next planning run. You should only change fields that are not critical, for example, where you add or delete a component, and then convert the planned order immediately.
Message Transmission in Direct Procurement

Use
If the source planned order or requirement is changed or deleted during the next planning run, this also affects the purchase requisition for direct procurement. The buyer responsible must be notified of the change as soon as possible. The buyer receives automatically an e-mail with the information about the change.

Prerequisites
- You have set the Message indicator in Customizing for MRP in Settings for direct procurement.
- You have set the control parameters for e-mail message transmission in Maintain e-mail partner for direct procurement.

Features
A mail is sent when a purchase requisition for direct procurement has been changed or deleted and if this purchase requisition had already been fixed or if purchase orders already exist for this purchase requisition. The buyer receives a detailed long text.
Customizing Settings for Direct Procurement

Use

By using the special procurement key, you can combine direct procurement with other special procurement types. The material will then be planned differently, depending on whether it is planned as a BOM item or as a finished product.

Integration

In Customizing for MRP, you have maintained the special procurement key in the IMG activity Define special procurement type (see also Procurement Type and Special Procurement Type [Page 135]).

Features

In Customizing, the system creates a special procurement key for direct procurement as standard. The special procurement key contains the procurement type F for external procurement and the Direct procurement field is selected.

You can create a further special procurement key by setting one of the special procurement types K for Consignment, L for Subcontracting or U for Stock transfer in addition to making the direct procurement settings. The indicators are not, however, coactive, but work alternatively depending on the context.

This enables the following:

If the material is planned as a BOM component, it is procured directly at the vendor. If, however, the material is planned as a finished product, because, for example, it is sold to customers as a spare part directly from the warehouse, it is not directly procured, but is procured using the special procurement type that you have entered.

⚠️

Direct procurement is normally executed as direct procurement at vendor. Direct procurement using consignment, subcontracting or stock transfer is not possible.
Storage Location MRP

Use

Material requirements planning is usually carried out at plant level. This means that the system adds together stocks from all of the individual storage locations, with the exception of individual customer stock, to determine total plant stock. It may be necessary to exclude storage location stock from the plant's MRP run, or you may want to plan certain stocks separately.

- A warehouse is geographically too far away from the production location that is planned with the storage location MRP.
- The stock of a storage location is only available for service and not for production.

Integration

If you plan several storage locations together or also want to plan storage locations using MRP, you can plan with MRP areas [Page 217].

Features

The following options are available:

- The storage location is to be planned separately. Fundamentally, separate storage location MRP is carried out using consumption-based planning. In this case, you must also define a reorder level and a replenishment quantity (fixed lot size) at storage location level. In so doing, it is possible to monitor this storage location's stock automatically, and if the stock level should fall below the reorder level the storage location is also replenished automatically.

  In the planning run, stock that lies in this storage location, and which is planned separately, is not contained in the available stock at plant level.

  If a receipt element (planned order, purchase requisition, purchase order, production order, and so on) or an issue element (reservation, sales order) refers to either a storage location that is excluded from the planning run or one that is planned separately these elements are not taken into account at plant level.

  Reservations and sales orders, which are planned in a storage location for which MRP is carried out separately, are not included when calculating plant stock. The net requirements calculation for these requirements is restricted to this storage location.

- The storage location is excluded from the planning run. In this case, the storage location's stock is not contained in the available stock at plant level, nor is it included in the planning run. The exclusion of storage location stock is only relevant to the planning run. You can, however, still make withdrawals from this stock.
Planning Storage Location Stock Separately

Use
You can plan storage locations separately, that is, storage location stock separately from plant stock.

Prerequisites
You have maintained the following entries for the storage location (Storage location MRP screen area) in the material master (MRP 4 view):

- You have set the Storage location stock planned separately indicator as the MRP indicator.
- You have defined a reorder level and a replenishment quantity (fixed lot size).
- You must also decide which type of procurement is to be used for this storage location:
  - stock transfer from storage location to storage location in a plant
  - stock transfer from another plant
  - external procurement directly to the storage location
  - in-house production directly to the storage location
  - production in an alternative plant
  - procurement on a consignment basis

For procurement from storage location to storage location of a plant, you only have to enter the MRP indicator, the reorder level and the replenishment level.

All other procurement types are defined using the field, Special procurement type, storage location.

💡

No special procurement keys are included in the standard system for procurement types External procurement directly to storage location and Internal procurement directly to storage location. Create these procurement types in Customizing for MRP. For more information refer to the Define special procurement types chapter in the Implementation Guide.

Features
During a planning run, the system compares the reorder level of storage locations to be planned separately with the stock of this storage location. If available storage location stock falls below the reorder level, a receipt element is created amounting to the replenishment quantity or, if necessary, for a multiple of the replenishment quantity.

According to the procurement type selected for the storage location, the receipt can take the form of a purchase requisition, a planned order, a schedule line and so on and directly refers to this storage location.

The system takes quota arrangements and the source list into account when creating a purchase requisition or a schedule line.
The source list can refer to a contract or a delivery schedule.

- If the source list refers to a delivery schedule, the system will only take the delivery schedule if the storage location recorded in it is the same storage location for which storage location MRP was defined in the material master record.
- If the source list refers to a contract, the system will only take the contract if the storage location recorded in it is the same as the one for which storage location MRP was defined in the material master record.

If you have chosen Stock transfer within a plant as procurement type for the storage location, the system creates a stock transfer reservation. This is regarded as a receipt at storage location level and as an issue at plant level.

The following diagram illustrates the procedure for stock transfer within a plant:

For storage location X, the reorder level was set to 50 pieces. Since stock at the storage location X (30) has fallen below the reorder level, a stock transfer reservation amounting to the fixed lot size (50) was created. At the same time, this stock transfer reservation produced an issue at plant level for the same amount.

**See also:**

Reorder Point Planning [Page 25]
Excluding a Storage Location from MRP

Use
You can exclude a storage location from MRP at plant level.

Prerequisites
You have set the MRP indicator for Storage location stock excluded from MRP for the storage location (Storage location MRP screen area) in the material master (MRP 4 view).

Features
- The available warehouse stock at plant level is reduced by the stock in the storage locations that are to be planned separately. You can, however, still make withdrawals from this stock.
- **No net requirements calculation** is carried out for these storage locations to be planned separately.
MRP Area

Definition

The MRP area represents an organizational unit for which material requirements planning is carried out independently.

Basically, there are three types of MRP area:

- Plant MRP Area
  
  The plant MRP area initially contains the plant together with all its storage locations and stock with subcontractors.

  When you have defined MRP areas for storage locations and for subcontractors and you have assigned the materials, the plant MRP area is reduced by exactly this number of subcontractors and storage locations. This is because they are now to be planned separately.

- MRP Areas for Storage Locations

  You can define an MRP area that consists of a particular storage location, by creating an MRP area and assigning the storage location to it. Material requirements for this storage location are then planned separately from the rest of the plant.

  You can also group several storage locations into one MRP area, by creating an MRP area and assigning the storage locations to it. These storage locations are then planned together.

  A storage location of a plant may be assigned to only one MRP area.

- MRP Areas for Subcontractors

  You can also define an MRP area for each subcontractor.

  A subcontractor may be assigned to only one MRP area. An MRP area of the subcontractor type may also only contain one subcontractor.

The following graphic shows an example of how a plant can be divided after the implementation of MRP areas:
Use

- You can carry out MRP specifically for the determined MRP areas. This enables you to carry out **differentiated material requirements planning**. The requester can be, for example, the production on a particular assembly line or a subcontract order.

- The MRP area allows you to have specific control over the staging and procurement of important parts produced in-house and purchased parts for each **shop floor area**. You can, however, also plan the provision of components for the individual **subcontractors**.

- MRP areas of the **storage location or subcontractor type** are only suitable for:
  - components that are planned and produced **for stock**
  - finished products that are planned and produced **for stock**. By assigning a storage location in a sales order or by entering an MRP area when creating the planned independent requirements, you can define whether a material is planned in the plant MRP area or in the MRP area of the storage location.

- Finished products and important assemblies intended for **make-to-order or engineer-to-order production** are always planned in the **plant MRP area**.

- The planning run takes into account the planning with MRP areas as follows:
  - If you do not enter a separate scope of planning, the system plans the whole plant, that is, all MRP areas in the plant, during the **total planning run**. If you want to carry out a total planning run for a particular MRP area only, you must specify the required MRP area in the scope of planning.
  - During **single-item, multi-level planning**, the system plans the selected material in the MRP area entered. In addition, the system takes into account planning file entries from other MRP areas, for example, if the material is to be procured using stock transfer.
  - During **single-item, single-level planning**, the system plans the selected material in the MRP area entered only.

Structure

- You define the **MRP areas** in Customizing for MRP. You can thereby assign the following to an MRP area:
  - **one or more storage locations** (example: you want to carry out planning for a particular assembly line and therefore assign a production storage location to the MRP area)
MRP Area

- a subcontractor.

You assign the various MRP areas to the materials in the material master. For this, you create an MRP area segment for a material for every MRP area, in which it is used. In this MRP area segment, you can define MRP parameters such as, for example, the lot size or MRP type. This allows you to plan the material differently in the MRP area from how you plan it in the plant MRP area.

MRP with MRP areas for the material is not activated until the material has been assigned to an MRP area. If you have not assigned a material to an MRP area, that is, you have not created an MRP area segment in the material master, the material will continue to be planned in the plant MRP area only. If you have assigned an MRP area to it, the system can plan it in the plant MRP area and in the assigned MRP area.

Integration

- You can carry out material requirements planning for MRP areas using all MRP procedures and all lot-sizing procedures.

- You can also carry out an independent material forecast for MRP areas using your own parameters.

- The material consumption values are updated separately for each MRP area.

- A separate ATP check is carried out for each MRP area.

  If several storage locations belong to an MRP area, the system can also carry out a check at two levels, that is, at storage location level and at MRP area level.
Examples for Planning with MRP Areas

MRP at Plant Level

During MRP at plant level, the various requirements are combined in the planning run and procurement elements are created for these pegged requirements with unknown sources.

MRP at Plant Level

![Diagram showing MRP at Plant Level](image)

MRP for MRP Areas

Example: Assembly Area

Material requirements planning for each MRP area allows you to have specific control over the staging and procurement of parts produced in-house and purchased parts for each shop floor and assembly area. If, for example, you define an MRP area for the production storage location of an assembly line, the system plans the material requirements for the assembly line separately from all other requirements (see Planning Components for a Production Line [Page 241]).
Example: Subcontractor

You can also carry out planning for components to be provided in subcontracting using an MRP area by defining an MRP area for every subcontractor and assigning the components to be provided to the MRP area of the subcontractor. You therefore plan the requirements to be provided for these components for one subcontractor separately from all other requirements (see Planning for Components to be Provided in Subcontracting [Page 242]).

In the following graphic, each subcontractor corresponds to an MRP area.
Examples for Planning with MRP Areas

Depending on the requirements situation, the system creates either stock transfer reservations from the plant to the stock of material provided of the subcontractor or it creates purchase requisitions within subcontracting/third-party order processing, according to the special procurement key settings.

Stock Transfer Procedure

![Stock Transfer Diagram]

Procedure for Third-Party Order Processing in Subcontracting

![Third-Party Order Processing Diagram]
Implementing MRP Areas

Implementation Options

The main reason for you to implement MRP areas is if you would like to plan materials, which are required in different shop floor areas, storage locations or by subcontractors, separately from one another.

As soon as you have activated materials requirements planning with MRP areas, this type of MRP is active at client level, that is, MRP will be carried out in this way in all plants.

Material requirements planning with MRP areas cannot be reversed.

Process Flow

You can implement material requirements planning with MRP areas in three steps:

1. You convert the existing planning file entries at plant level to planning file entries at MRP area level.
   During the conversion, the system creates a plant MRP area for every plant as a background job. This, however, will not affect your planning. The processes in material requirements planning and the planning results remain unaffected.

   The conversion is also useful even if you do not work with MRP areas, but still have to plan for several plants, as the new planning file improves system performance during the planning run.

2. You activate MRP with MRP areas in Customizing for MRP. This causes the MRP area field to appear in the applications of MRP and in related areas. When you enter the plant number, the system automatically fills the field with the number of the plant MRP area. The number of the plant MRP area is the same as the plant number.
   This does not affect the planning run as the plant MRP area still corresponds to the present plant.

3. You define an MRP area, for example, for a storage location. You then assign the materials that are to be planned for this storage location, by creating an MRP area segment in the material master.
   Materials requirement planning for this storage location is then carried out separately. The storage location stock is no longer included in the available stock of the plant MRP area. The receipt and issue elements of this storage location (MRP area) are also not taken into account in the plant MRP area. They are only taken into account in the MRP area of the storage location.

If you have already worked with storage location MRP [Page 213] the system still carries out storage location MRP even after the activation of MRP areas. You need to decide in principle whether you want to continue using storage location MRP or whether you want to create MRP areas for the storage locations that are planned...
Implementing MRP Areas

separately. It is not possible to simultaneously plan a material using storage location MRP and an MRP area for the same storage location.

If you decide to use MRP areas, you should then try to convert all storage locations that are planned separately to MRP areas in one step. Before you assign the material to an MRP area, you must remove the MRP indicator, which is located in the material master at the storage location organizational level (view MRP 4) in the screen area Storage location MRP.

Even if you have defined MRP areas in Customizing, the system plans the materials in the plant MRP area until you assign the MRP areas to the materials.

Only the assignment of one or more MRP areas to a material, by creating MRP area segments in the material master, actually cause changes in the material requirements planning.
Preparing for Material Requirements Planning with MRP Areas

Implementation Options
This process describes which master data you must maintain in order to be able to carry out material requirements planning at MRP area level.

Process Flow
1. **Convert Planning File Entries** (Customizing)
   
   You convert the existing planning file entries at plant level to planning file entries at MRP area level. To convert the planning file entries, you use the report that you trigger in Customizing for MRP in the IMG activity *Convert planning file entries for MRP areas*.

   The system creates a new planning file and MRP areas for the existing plants. These MRP areas, however, do not affect how material requirements are planned. The number of the plant MRP area is identical to the plant number and therefore has four digits.

   ![Warning]

   You cannot create plant MRP areas manually. The plant MRP areas are only created automatically by the conversion report (see *Converting the Planning File Entries* [Page 228]).

2. **Activate MRP** (Customizing)
   
   In the IMG activity *Activate MRP for MRP areas*, set the *MRP area active* indicator. This activates material requirements planning with MRP areas at client level. The *MRP area* field appears for selection in the MRP applications.

   ![Warning]

   Material requirements planning with MRP areas **cannot be reversed**.

3. **Create MRP Areas** (Customizing)
   
   In the IMG activity *Define MRP areas*, you create the MRP areas for every plant, for which you would like to carry out material requirements planning separately.

   When creating an MRP area, enter:

   - Number of the MRP area. The number must have at least five digits, so that there is no overlapping with the plant MRP area.
   - Description of the MRP area.
   - MRP area type
   - Receiving storage location (must belong to the MRP area)

   Finally, you assign the storage locations or the subcontractors to the MRP areas.

   There are three different types of MRP area:

   - **Type 01 for Plant**
Preparing for Material Requirements Planning with MRP Areas

The plant MRP area initially contains the plant together with all its storage locations and stock with subcontractors. The plant MRP area is created automatically when you convert the existing planning file entries to planning file entries for MRP areas.

When you have defined MRP areas for storage locations and for subcontractors and you have assigned the materials, the plant MRP area is reduced by exactly this number of subcontractors and storage locations, as they are now to be planned separately.

- **Type 02 for Storage Locations**
  
  You choose this type for MRP areas that consist of one or more storage locations. A storage location can only be assigned to one MRP area.

- **Type 03 for Subcontractors**
  
  You choose this type if you would like to define an MRP area for a subcontractor. You can only assign one subcontractor to an MRP area of the type subcontractor. You cannot assign the same subcontractor to another MRP area.

4. **Assign MRP Areas to Materials**

You assign the MRP areas to the materials by creating an MRP area segment for each MRP area in the material master. You can assign several MRP areas to one material (see [MRP Area Segments in the Material Master](Page 231)).

MRP with MRP areas for the material is not activated until an MRP area has been assigned to a material. If you have not assigned an MRP area to a material, that is, you have not created an MRP area segment in the material master, the material will continue to be planned in the plant MRP area only. If you have assigned an MRP area to the material, the system can plan it in the plant MRP area and in the assigned MRP area.

You can display an overview for all materials in an MRP area. To do this, you go into Customizing for MRP and choose the IMG activity Define MRP areas. Call up an MRP area by double-clicking and choose Material overview for MRP area.

5. **Check Storage Locations**
Preparing for Material Requirements Planning with MRP Areas

If you have already entered a storage location in the BOM (BOM item), in the work center (supply area) or in the production version, you should check whether this storage location is the storage location for the MRP area that you have assigned in the material master.

⚠️

The materials are assigned to an MRP area via the storage location that the system determines during the planning run. You should therefore check the storage locations that you have maintained in the material master. The storage location in the material master must be a storage location for the MRP area, for which you have created an MRP area segment in the material master. You can therefore ensure that material requirements planning will be carried out for the correct MRP area (see Determining and Assigning Storage Locations to the MRP Area [Page 238]).
Converting the Planning File Entries

Use
You must convert the existing planning file (table MDVM) to the new planning file (table DBVM) in order to be able to use MRP areas in materials requirements planning.

The conversion is also useful even if you do not work with MRP areas, but still have to plan for several plants, as the new planning file improves system performance during the planning run.

Features
The planning file entries are converted using a report which you can start in Customizing for MRP in the IMG activity Convert planning file entries for MRP areas. The following functions are carried out with the report:

- During the conversion, the system creates a plant MRP area for every plant.
- The existing planning file entries are copied from the planning file used up to now into the new planning file.
- The system deletes the planning file that had been used up to now after the conversion has taken place.
- At client level, the indicator Planning file entries for MRP area converted is set in a system table. This indicator causes material requirements planning to be carried out using planning file entries at MRP area level from this point onwards.

The report also converts the individual customer planning file entries at plant level to individual customer planning file entries at MRP area level.

Activities
Start the conversion report.
Planning File Entries for MRP Areas

Use
In order for material requirements planning to be carried out for an MRP area material, an entry must exist for the material in the planning file. If changes are relevant to MRP, the system must set a planning file entry.

Prerequisites
You have converted the planning file entries at plant level to planning file entries at MRP area level.

Features
Creating/ Changing / Deleting Records in the Planning File
- If you assign a material to a new MRP area in the material master record, a new record is written in the planning file for this assignment.
- If you change settings in the MRP area for a material that are relevant to MRP, for example, the MRP type, lot-sizing procedure and so on, the corresponding record in the planning file is changed, that is, the system sets a planning file entry for the MRP area material.

Setting a Planning File Entry
If you change MRP elements, the system checks the Plant, Storage location and Vendor (subcontractor) fields and determines the MRP area affected according to the MRP area assignment in the material master and the settings in Customizing. The system then sets a planning file entry for the material at MRP area level in the planning file.

During this process, the system decides whether the planning file entry has to be set for just one MRP area or for all MRP areas.

- If you change a purchase requisition, the system determines the MRP area affected and sets the planning file entry for just the MRP area affected for the material.
- If you change the BOM of a material, the system sets the planning file entries for all MRP areas of the material, as a change in the BOM has an effect on all MRP areas that are assigned to the material.

Activities
- Displaying planning file entries for MRP areas
  Starting from the MRP menu, choose Planning → Planning file entry → Display and enter the MRP area.
- Creating a planning file entry manually
  In general, the system automatically sets the planning file entries. In exceptional cases, however, it may be useful to create a planning file entry manually.
Planning File Entries for MRP Areas

Starting from the MRP menu, choose Planning → Planning file entry → Create and enter the material number and MRP area.
MRP Area Segments in the Material Master

Use

In order to be able to assign a material to an MRP area, you have to **create the MRP area segment for this MRP area** in the material master.

![Tip]

MRP with MRP areas for the material is not activated until an MRP area has been assigned to a material. If you have not assigned an MRP area to a material, that is, you have not created an MRP area segment in the material master, the material will continue to be planned in the plant MRP area only. If you have assigned an MRP area to the material, the system can plan it in the plant MRP area and in the assigned MRP area.

Prerequisites

You have defined the MRP areas in Customizing for MRP.

Features

- You can assign a material to one or more MRP areas by creating a segment for each MRP area.
- In the following screens, for each MRP area, you can enter individual **MRP and forecast parameters** that are different from those defined in the material master at plant level:
  - **MRP 1**
    Here, you can enter an MRP group and define the data required for the MRP procedure and lot-size calculation.
  - **MRP 2**
    Here, you can define procurement data, that is, the special procurement key and the storage location in which the goods are to be received, in addition to an individual planning calendar and, if necessary, data for the net requirements calculation.
  - **Forecast**
    Here, you can enter the [Forecast Parameters](Ext) if you want to forecast for the material in this MRP area. This is also possible if you do not forecast at plant level.
  - **Consumption values**
    Here, you can enter historical [Consumption Values](Ext) for a material in an MRP area if you use forecast-based planning for the MRP area.
- You can delete the assignment of a material to an MRP area in the material master as long as no postings exist in that MRP area for the material. To do this, place the cursor on the MRP area in the *Overview: MRP areas* dialog box and choose *Delete*. 

MRP Area Segments in the Material Master

Activities

You can copy the MRP data of a plant segment or the MRP data of an existing MRP area segment when you create an MRP area segment for a material. To create by copying, proceed as follows:

1. In the material master (view MRP 1, screen area MRP areas), choose the function key MRP areas.
   
   The Overview: Display MRP areas dialog box appears.

2. Choose .
   
   The Copy with reference dialog box appears.

3. Choose whether you wish to use the plant-level MRP data or the MRP data of an existing MRP area segment. If necessary, enter the number of the MRP area, from which you want to copy the MRP data.

4. Enter the MRP area, for which you wish to create the MRP area segment, in the Destination MRP area field and choose Copy.
   
   The new MRP area segment is created and displayed in the overview list.

5. Select the MRP area and choose .

6. Check the MRP and forecast parameters that were copied and carry out any necessary changes.

7. Choose Adopt.
   
   The Overview: MRP areas screen appears.

8. Choose Continue again and save the material master.

💡 You can display an overview for all materials in an MRP area. To do this, you go into Customizing for MRP and choose the IMG activity Define MRP areas. Call up an MRP area by double-clicking and choose Material overview for MRP area.

💡 The system logs changes to the MRP area segments. You can display the change log by choosing Display change documents in the overview list for the assigned MRP areas. In the document overview, you can display the details for the selected document by choosing .
Maintenance of Mass Data

Use

When using MRP with MRP areas, it can be necessary to assign a material to a large number of MRP areas. That is the case, for example, with spare part storage for customer service technicians, when a material is available in many cars and every car is planned as an individual MRP area.

Features

SAP provides six function modules (function group MD_MGD1), with which you can program your own mass transactions. The function modules are integrated in the example report RMMDDIBE.

These function modules include:

- **Copy with plant or MRP area template (MD_MRP_LEVEL_CREATE_AS_COPY)**
  You create new MRP area segments by copying the plant MRP data or by copying an existing MRP segment.

- **Creation with MRP/forecast profile (MD_MRP_LEVEL_CREATE_PROFILE)**
  You create MRP area segments by assigning an MRP profile or a forecast profile, both of which are records of previously defined standard information that have been saved as a profile.

- **Creation with data (MD_MRP_LEVEL_CREATE_DATA)**
  You create a new MRP area segment by entering concrete MRP or forecast data.

- **Change with MRP/forecast profile (MD_MRP_LEVEL_CHANGE_PROFILE)**
  You change existing MRP area segments by assigning an MRP profile or a forecast profile.

- **Change with data (MD_MRP_LEVEL_CHANGE_DATA)**
  You change existing MRP area segments by entering concrete MRP or forecast data.

- **Set deletion indicator (MD_MRP_LEVEL_CHANGE_DELETION)**
  You set or delete the deletion flag for MRP area segments.

⚠️

The report only serves as an example and will not be maintained or enhanced by SAP.

Activities

You call up the example report RMMDDIBE as follows:

Choose System → Services → Reporting and enter the report name.

You can save the result of the report and call it up for checking using the transaction SLG1.
Planning Material Requirements Planning with MRP Areas

Implementation Options
This process describes how to proceed to carry out material requirements planning with MRP areas.

Prerequisites
- You have converted the existing planning file entries at plant level to planning file entries at MRP area level.
- You have activated MRP for MRP areas in Customizing.
- You have defined the MRP areas in Customizing.
- You have assigned the MRP areas to the materials in the material master.

See also:
Preparing for Material Requirements Planning with MRP Areas [Page 225]

Process Flow
1. You create the independent requirements of a material for an MRP area. To do this, the following options are available:
   - In Demand Management, you can create the Planned Independent Requirements [Ext.] of the materials for each MRP area. However, this is only possible if you use the make-to-stock production planning strategy.
   - You can create a sales order and specify a storage location. This customer requirement is assigned to an MRP area using this storage location.
   - You can also carry out material requirements planning for the individual MRP areas based on forecast requirements. You can carry out the material forecast for each MRP area of a material separately.

   ![Tip]

   With finished products or important assemblies that are planned using planning strategies, such as the planning strategy Planning without final assembly, you enter independent requirements at plant MRP area level, as make-to-order production is planned at plant MRP area level.

2. You plan material requirements. During total planning with the planning unit plant, the system plans the MRP areas (if they exist) for each material one after the other and then plans the rest of the plant.

   You can, however, start a total planning run specifically for one or more particular MRP areas. For this, you must maintain the scope of planning correspondingly in the IMG activity Define scope of planning for total planning in Customizing for MRP.

3. You evaluate the results of the planning run. In the MRP list and in the current stock/requirements list, you can specifically display and process the planning results of a material for each individual MRP area.
In the collective display of MRP lists or current stock/requirements lists, you can specifically select materials for one MRP area or for all MRP areas of a plant. However, the segregated lists are always calculated for each MRP area.

If you choose the evaluation *Situation - prod.grp*, you are provided with a complete overview of all MRP areas of a material. This is, however, only possible if you have defined the material as a product group.
Material Requirements Planning with MRP Areas

Implementation Options

This process contains technical information on how the planning run works with MRP areas. The process is to a great extent the same as the planning run at plant level.

Process Flow

1. The system checks in the planning file whether a planning file entry exists for the material in the MRP area that is to be planned.

2. The system calculates net requirements for the material in the MRP area. During this calculation, the system checks whether the requirements that exist for the MRP area can be covered by the available stock in the MRP area and the planned receipts for the MRP area. If there is a shortage of stock, the system creates a procurement proposal for the MRP area.

3. The system calculates procurement quantities. If you have defined a lot-sizing procedure in the MRP area segment of the material master, the system calculates using this lot-sizing procedure.

4. The system carries out scheduling using the parameters defined in the MRP data of the material master.

5. The system determines the type of procurement proposal for the MRP area on the basis of the procurement type that is defined in the material master (see also Determining the Procurement Proposal [Page 134]). You can also have Delivery Schedules [Page 240] created for the MRP area of a material.

If you have defined a different special procurement type in the MRP area segment, the system creates the corresponding procurement proposal, for example, stock transport requisitions for the special procurement Stock transfer from plant to plant.

With the special procurement keys, which are entered into the MRP area segment, the material requirements planning for the MRP area only takes into account the settings for special procurement types that do not refer to the BOM explosion.

The settings for stock transfer are taken into consideration, for example, in contrast to the special procurement key Phantom assembly, which refers to the BOM explosion.

6. For every procurement proposal for an assembly, the system explodes the BOM and determines the dependent requirements.

In order for the system to be able to determine requirements at MRP area level, you must ensure that the storage location determined during the planning run is the same as the storage location that is defined in the MRP area (see Determining and Assigning Storage Locations to the MRP Area [Page 238]).

If you have entered an MRP group in the MRP area segment, the system uses the parameters that are defined in the MRP group during the planning run. The only exceptions to this are: the strategy group, the parameters for the consumption mode
and period of adjustment and the checking rule for dependent requirements in the case of the availability check. Even if you have defined these parameters in the MRP group, the system still uses the parameters from the MRP data of the material master.
Determining and Assigning Storage Locations to the MRP Area

Use
You assign goods receipt and issue elements to an MRP area using the receiving storage location in the case of receipt elements, and using the issuing storage location in the case of the issue elements.

Prerequisites
- You have defined the MRP areas in Customizing for MRP.
- You have assigned the MRP areas to the materials in the material master.
- You have defined the issuing storage location for the components.
- You have defined the receiving storage location for the assemblies.

Features

Assigning the Receipts and Issue Elements to an MRP Area
The receipt elements (planned orders, purchase requisitions and so on) are assigned using the receiving storage location, which the system determines during the planning run. The receiving storage location is displayed in the MRP list or the stock/requirements list in the column Storage location or it is displayed in the procurement element itself, for example, in the header data of a planned order. The system checks whether the receiving storage location that has been determined belongs to the MRP area. If this is the case, the system assigns the receipt element to the MRP area.

The issue elements (planned independent requirements, sales orders, dependent requirements, reservations) are assigned via the issuing storage location, which the system determines during the planning run. The issuing storage location is displayed in the MRP list or the current stock/requirements list in the column Storage location as well as in the component list of the planned order.

If the system is unable to determine a storage location, the system assigns the receipt or issue element to the plant MRP area.

Determining the Storage Location for Receipt Elements
You can maintain the receiving storage location for a material on various screens in the system:
- as receiving storage location for repetitive manufacturing in the production version
- either as production storage location (in-house production) or as external procurement storage location (external procurement) in the MRP area segment of the material master or in the material master itself
- as receiving storage location in Customizing for MRP in the IMG activity Define MRP areas

The system determines the storage location as follows:
1. First of all, the system checks whether a valid production version has been created. If this is the case, the system copies the receiving storage location from the production version into the receipt element. If this storage location belongs to an MRP area that has been assigned to a material, the system assigns the receipt element to the MRP area. If the storage location that has been determined belongs to the plant MRP area, the system assigns the receipt element to the plant MRP area. If this storage location does not belong to an MRP area that has been assigned to a material, nor to a plant MRP area, the system ignores the storage location.

Example 1: (Assembly with two Production Versions)

An assembly is assigned to two MRP areas of the storage location type and can be manufactured on two different production lines (line 1 and 2). You have therefore created two production versions for the assembly:

- version 1 with production line 1 and the receiving storage location 0001
- version 2 with production line 2 and the receiving storage location 0002

You have defined one MRP area each for both storage locations and you have created the MRP area segments in the material master.

During the planning run, the system determines the production version on the basis of its settings that is valid for the procurement proposal, for example, production version 1. In doing so, the system assigns the receipt element to the MRP area of the storage location 1.

Example 2: (Assembly with one Production Version)

An assembly with two different MRP areas is manufactured on a production line. You have therefore only created one production version. In this case, you are not allowed to maintain storage locations in the production version, as otherwise it would always be assigned to the same MRP area.

2. If a production version does not exist, the system checks whether you have defined a storage location in the MRP area segment (either a production storage location for in-house production or an external procurement storage location for external procurement). If this is the case the system adopts this storage location.

3. If you have not maintained any of these storage locations, the system adopts the receiving storage location, which you entered for the MRP area in Customizing in the IMG activity Define MRP areas.

Determining the Storage Location for Issue Elements

The system determines the storage location for the issue of components during the BOM explosion in the planning run. The system proceeds as described in Storage Location Determination in BOM Explosion [Page 172].

The storage location found determines the assignment to the MRP area.
Determine Source of Supply for Delivery Schedules for MRP Areas

Use
If delivery schedules for an MRP area are to be created during the planning run, the system must determine a valid vendor or a valid delivery schedule.

You create delivery schedules and use message management by making entries in the source list.

Prerequisites
- You have created a Scheduling agreement for each MRP area of a material.
- You have entered a receiving storage location in the scheduling agreement, which belongs to the MRP area.

⚠️
You are only allowed to create one scheduling agreement for each vendor and receiving storage location.

- You have created an individual item for each scheduling agreement in the source list of the material.
- You have set the MRP indicator to 2 for Record relevant to MRP. Sched. lines generated automatically in the source list for each scheduling agreement item.

Features
A delivery schedule is assigned to an MRP area using the storage location that is entered in the scheduling agreement.

The system reads the source list for every material during the planning run. The system attempts to determine a valid vendor whose storage location belongs to the MRP area. If the system finds a valid scheduling agreement, it creates a delivery schedule for the MRP area of the material.

⚠️
There is only one quota agreement for each material and plant. When planning at MRP area level, only quota arrangement items are adopted that have a storage location, which belongs to the MRP area.

Activities
You can maintain the scheduling agreement in the Purchasing task level menu: Outline agreement → Scheduling agreement → Create → Vendor known.

You can maintain the source list in the Purchasing task level menu by choosing, Master data → Source list → Maintain.
Planning Components for a Production Line (Example)

You can use MRP areas to plan the procurement and staging of components on a particular production line. If, for example, you define an MRP area for the production storage location of an assembly line, the system plans the material requirements for the assembly line separately from all other requirements.

Example Data

- Assembly A is produced on production line 1. Components B and C, which are procured externally, are necessary for the production and are withdrawn from storage location 0001.

Prerequisites

- You create an MRP area of the storage location type for storage location 0001 in Customizing for MRP. You assign the MRP area to storage location 0001.
- You assign this MRP area to the components B and C in the respective material master records by creating an MRP area segment. You enter storage location 0001 in the Storage loc. for EP field in the MRP area segment, as this is also to be the receiving storage location for the components.
- You create a production version for production line 1 in the material master for assembly A. In this production version, you enter storage location 0001 as the issue storage location for the components.

Planning Procedure

In the planning run, the system calculates the dependent requirements for components B and C and determines the issuing storage location 0001 using the production version. This allows the dependent requirements to be assigned to the MRP area for storage location 0001.

When the system determines the procurement elements for B and C, it reads the external procurement storage location and uses this as the receiving storage location. This is also storage location 0001 so the procurement elements are assigned to the MRP area for storage location 0001.

You can use this procedure to selectively plan the components that you require on the production line.

If you do not work with production versions, you can also enter the issue storage location for the components in the BOM, in the work center using the supply area, or in the Issue stor. location field in the MRP data of the material master.
Planning for Components to be Provided in Subcontracting

Use
Using the MRP area, you can plan the provision of components for individual subcontractors separately from the usual requirements (see also Subcontracting [Page 196]).

Prerequisites
- You have created an MRP area for the subcontractor X in Customizing and have entered the vendor number of the subcontractor there.
- You have assigned the components to be provided to the MRP area for the subcontractor X by creating an MRP area segment in the material master record of the components to be provided.
- You have entered the special procurement key Stock Transfer from Plant to MRP Area [Page 247] or the special procurement key for external procurement in the MRP area segment, if you directly procure the components to be provided using subcontracting/third-party purchase requisitions.
- You have entered the special procurement key for subcontracting in the material master of the assembly that the subcontractor produces.
- You have created a source list entry for the assembly that the subcontractor produces. In this, you have entered the subcontractor as a fixed vendor and have set the indicator 1 for relevant to MRP in the MRP field (see also Determining Source of Supply for External Procurement [Page 139]).

Features
During the planning run, the system explodes the BOM of the assembly to be manufactured and determines the requirements for components that are to be provided to the subcontractor X. The dependent requirements of the components to be provided are only assigned to the MRP area of the subcontractor when the system can determine the subcontractor as the source of supply for the assembly. The source of supply is determined using the source list.

Depending on the requirements situation and the settings entered, the system creates either
- stock transfer reservations from the plant to the provision stock of the subcontractor (see Stock Transfer of Components to be Provided [Page 243]) or
- planned orders or purchase requisitions within the subcontracting/third-party order processing (see Subcontracting/Third-Party Order Processing [Page 244]).
Stock Transfer of Components to be Provided

Use

You can procure the components that you provide to a subcontractor for the production of an assembly, by transferring stock from a plant to the MRP area of the subcontractor.

Prerequisites

- You have created an MRP area for the subcontractor X in Customizing and have entered the vendor number of the subcontractor there.
- You have assigned the components to be provided to the MRP area for the subcontractor X by creating an MRP area segment in the material master record of the components to be provided.
- You have entered a special procurement key for Stock Transfer from Plant to MRP Area [Page 247] in the MRP area segment.
- You have entered the special procurement key for subcontracting in the material master of the assembly that the subcontractor produces.
- You have created a source list entry for the assembly that the subcontractor produces. In this, you have entered the subcontractor as a fixed vendor and have set the indicator 1 for relevant to MRP in the MRP field (see also Determining Source of Supply for External Procurement [Page 139]).

Features

During the planning run, the system determines the subcontractor X as the vendor for the assembly using the source list and creates a purchase requisition for the assembly.

The BOM of the assembly is then exploded. The dependent requirements of the components to be provided are assigned to the MRP area of the subcontractor X.

Due to the special procurement key in the MRP area segment of the components to be provided, the system determines that the components are to be procured by means of stock transfer from the plant to the MRP area. A stock transfer reservation is created in this situation. This type of reservation is the movement type 541.

Using the evaluation SC Stock Monitoring for Vendor (transaction ME2O), you can display the reservations of the components to be provided and post the goods movement.
Subcontracting/Third-Party Order Processing

Use
If you plan for the components to be provided for a subcontractor with an MRP area of the subcontractor type and the components to be provided are procured externally, you can process the procurement of these components using subcontracting/third-party orders.

This type of processing has the advantage that the required components to be provided are delivered directly from the vendor, from whom you order this material, to the subcontractor.

Prerequisites
- In Customizing for MRP, you have created a special procurement key for External procurement with delivery directly to the subcontractor. To do so, you enter an F for External procurement in the procurement type field. This special procurement key is the special procurement key 20 for External procurement in the standard system.
- In the material master records of the components, you have created the MRP area segment for the MRP area of the subcontractor and assigned the special procurement key to it.
- You have entered the special procurement key for subcontracting in the material master of the assembly that the subcontractor produces.
- You have created a source list entry for the assembly that the subcontractor produces. In this, you have entered the subcontractor as a fixed vendor and have set the indicator 1 for relevant to MRP in the MRP field (see also Determining Source of Supply for External Procurement [Page 139]).
Features

During the planning run, the system determines the subcontractor X as the vendor for the assembly using the source list and creates a purchase requisition for the assembly.

The BOM of the assembly is exploded. The dependent requirements of the components to be provided are assigned to the MRP area of the subcontractor X.

The system creates one or several purchase requisitions (depending on lot size) for the dependent requirements, which you can convert to purchase orders. These purchase orders are subcontracting/third-party orders.

When you display a subcontracting/third-party order, you will see the subcontractor’s address in the space for the delivery address. The SC stock indicator X for stock with subcontractor is set. The item type and account assignment type fields do not contain any values.

Activities

The components to be provided are delivered directly to the subcontractor. The goods receipt is posted to the stock with subcontractor.

When the subcontractor has delivered the finished assembly, the goods receipt is posted to the subcontract order. The stock with subcontractor and the reservations are then reduced.
Multi-Level Subcontracting (Example)

You can also use MRP areas to plan multi-level subcontracting.

Example Data
You order assembly 1 at subcontractor X. Subcontractor X needs assembly 2 for the production, which subcontractor X obtains from subcontractor Z. Subcontractor Z needs the component 3 to be provided, which you provide directly.

Prerequisites

- You have entered the special procurement key for subcontracting in the material master of the assembly 1 that the subcontractor produces.

- You have created a source list entry for the assembly 1 that the subcontractor produces. In this, you have entered the subcontractor as a fixed vendor and have set the indicator 1 for relevant to MRP in the MRP field.

- You have defined a subcontractor type of MRP area, in which you have entered subcontractor X. You have assigned this MRP area to the material assembly 2, by creating an MRP area segment for subcontractor X in the material master for assembly 2. You have entered the special procurement key for subcontracting in the MRP data for the MRP area segment.

- You have defined an additional subcontractor type of MRP area, in which you have entered subcontractor Z. You have assigned this MRP area to the component to be provided 3, by creating an MRP area segment for subcontractor Z in the material master for component to be provided 3. You have entered a special procurement key for Stock Transfer from Plant to MRP Area [Page 247] in the MRP area segment.

Planning Procedure

During the planning run, the system determines subcontractor X as the vendor for assembly 1 using the source list entry and creates a subcontract purchase requisition for assembly 1. Subsequently, the bill of material for assembly 1 is exploded. The dependent requirements of assembly 2 are assigned to the MRP area of subcontractor X.

The system generates a subcontractor-planned order (or purchase requisition or delivery schedule) to cover the dependent requirements for assembly 2. The system then explodes the bill of material for assembly 2 and generates dependent requirements for the component to be provided 3. These dependent requirements are assigned to the MRP area of subcontractor Z.

Due to the special procurement key in the MRP area segment of the component to be provided 3, the system determines that the component is to be procured using stock transfer from the plant to the MRP area of subcontractor Z.
Stock Transfer from Plant to MRP Area

Use

- If you want to plan material requirements for a storage location separately, you can create an MRP area for this storage location. You can then procure materials that are planned for this MRP area using Stock transfer from plant to MRP area.

- If you plan components to be provided for a subcontractor using an MRP area of the subcontractor type, you can also procure the components to be provided using Stock transfer from plant to MRP area.

Integration

The process is the same as for Storage Location MRP [Page 214]. In contrast to the storage location MRP, you can use all MRP procedures and are not limited to the reorder point planning procedure.

Prerequisites

- In Customizing for MRP, you have created the special procurement key for Stock transfer from plant to MRP area for the plant in which the MRP area is located. You have defined the following parameters:
  - Procurement type: F for External procurement
  - Special procurement: U for Stock transfer
  - Plant: Number of plant, to which the MRP area belongs.

- In the material master, you have created the MRP area segment and assigned the special procurement key Stock transfer from plant to MRP area.
Stock Transfer from Plant to MRP Area

Features

During MRP, the system generates a stock transfer reservation for the material in the MRP area and a material reservation in the plant MRP area.

The external procurement storage location that you have entered in the MRP area segment of the material master is used as the receiving storage location. If you have not maintained this field, the system uses the receiving storage location that you entered for the MRP area in Customizing.

The actual procurement is processed by the plant. With stock transfer to the MRP area, you carry out the transfer posting for the material with reference to the reservation.
ATP Check with MRP Areas

Use
As soon as you have activated material requirements planning with MRP areas, the ATP check is also activated at MRP area level. This replaces the existing plant with the MRP area. If a material had been checked at plant level up to now, it is now checked at MRP area level.

If you have not yet defined any MRP areas, the plant then corresponds to the plant MRP area. The availability check is then carried out in the plant MRP area.

Integration
The ATP check at MRP area level runs in the same way as the general ATP check.

Prerequisites
In Customizing for MRP in the IMG activity Define availability check for components → Determine check, you have defined per checking rule whether the ATP check is to be carried out with or without storage location check.

Features
The receipt and issue elements are dynamically assigned to the correct MRP area using the receiving and issue storage locations and are settled against the available stock in the MRP area. Like the ATP check at plant level, there are two different options:

- ATP check with storage location check
- ATP check without storage location check, that is, multi-site check

ATP without Storage Location Check
If you have not set the system to carry out a storage location check, it will only carry out a single-level ATP check at MRP area level.

The MRP area of the receipt and issue elements to be taken into consideration is dynamically determined by the receiving storage location, the issue storage location, the MRP area segment in the material master and the Customizing settings for the MRP area. However, only the storage location information is required for the determination of the suitable MRP area. The ATP check is only carried out within the MRP area.

The spare part A is assigned to the MRP area of the storage location 0002 and 0003. A sales order is created for the spare part and the storage location 0002 is entered.

If you have not set the storage location check, the ATP check is only carried out for the material A in the MRP areas of the storage locations 0002/0003. No check against storage location 0002 is carried out.
ATP Check with MRP Areas

If you do not enter a storage location in the sales order, the sales order belongs to the plant MRP area and the ATP check, in this case, is carried out in the plant MRP area.

ATP Check with Storage Location Check

If you have set the storage location check, the system carries out a **double-level** ATP check:

- In the first step, the system determines the available quantity in the **storage location**.
- In second step, the system determines the available quantity in the **MRP area**.

The system then takes the **smaller of the two quantities** as the result.

The spare part A is assigned to the MRP area of the storage location 0002 and 0003. A sales order is created for the spare part and the storage location 0002 is entered.

- In the first step, the system carries out the ATP check in the storage location 0002. During this check, the system determines all receipts and issues of the storage location 0002 and calculates the available quantity.

- In the second step, the ATP check is carried out in the MRP area of the storage locations 0002/0003. During this check, the system determines all receipts and issues of the storage locations 0002 and 0003 and calculates the available quantity.

  The smaller of the two quantities is taken as the result of the ATP check.

**See also:**

*Availability Check According to ATP Logic [Page 447]*

*Availability Check: Organizational Levels [Page 449]*
Multi-Plant/Site Planning

Use

Using multi-plant planning, you can carry out material requirements planning for various plants centrally. This planning procedure facilitates the production of a product in another plant and it also guarantees a smooth flow of materials between different plants.

Integration

- In MRP, multi-plant planning is carried out by means of special procurement keys. You assign the special procurement key to the material in the material master.

- In Customizing for MRP, you define the special procurement key in the IMG activity Define special procurement type (see also Procurement Type and Special Procurement Type [Page 135]). You define the special procurement key at the material level according to plant, procurement type and special procurement.

  If required, you can also use the indicators Phantom item, Direct production, Direct procurement and Withdrawal from alternative plant to control the treatment of the material as a component during the BOM explosion.

A material appears in several BOMs as a component because it is installed in finished products in in-house production. As such, it is procured from an alternative plant.

The same material, on the other hand, is also sold from stock to customers, who need the material as, for example, a replacement part. In this case, the material cannot be procured by withdrawing it from an alternative plant. If a material shortage occurs after you have entered a customer requirement, a stock transfer purchase requisition is created in the planning run.

You can do this in the SAP system by creating a special procurement key for a withdrawal from an alternative plant and by entering a U for stock transfer in the Special procurement key and by entering the plant from which the material is to be transferred (see also Customizing Settings for Multi-Plant/Site Planning [Page 260]).

- Materials that are included in multi-plant planning must have a material master in all plants concerned.

When carrying out the planning run you must pay attention to the chronological planning sequence of the various plants: plan the receiving plants first and then the supplying or production plants.

If special procurement keys for stock transfer that refer to each other have been created for a material at two plants, after having carried out the planning run for both plants, you must carry it out again for the first plant.

Features

You can use the following multi-plant procedures:
Multi-Plant/Site Planning

- Stock transfer from plant to plant or from plant to MRP area
- Production in alternative plant
- Withdrawal from alternative plant
Stock Transfer from Plant to Plant

Implementation Options

Within the stock transfer procedure, goods are produced and delivered within a company. The plant that is to receive the goods (receiving plant) orders the goods internally from another plant that is in a position to deliver the goods (issuing plant). The dependent requirements for the components to be transferred are determined in the receiving plant.

You use the stock transfer procedure, if two plants are located far away from each other, as the transport of materials to be transferred is taken into account in MRP with this type of procedure.

You can also transfer the stock manually using stock transport requisitions, orders and delivery schedules. You can find further information in the SAP document Managing Special Stocks and Special Forms of Procurement in Materials Management under Stock Transfer Using Stock Transport Orders [Ext.].

In addition to stock transfer from plant to plant there is stock transfer from plant to MRP area, which you can use, for example, in subcontracting. You can find further information under Stock Transfer from Plant to MRP Area [Page 247].

Prerequisites

- You have maintained a special procurement key for stock transfer in Customizing for MRP, in the IMG activity Define special procurement type and you have entered the delivering plant there.
- You have assigned this special procurement key to the material in the material master of the receiving plant (MRP 2 view).
- You have created a material master for the material in the issuing plant.

Process Flow

The following example demonstrates the stock transfer procedure in MRP:
Stock Transfer from Plant to Plant

A material in plant 0001 has the special procurement key *Stock transfer* with issuing plant 0002. This defines that the material is to be procured from plant 0002.

1. First you plan material requirements in the receiving plant 0001 and then in the issuing plant 0002.
2. On detecting a shortage in plant 0001, the system automatically creates a planned order for stock transfer or a stock transport requisition in plant 0001 and a release order for the planned order or purchase requisition in plant 0002.
   
   The date of the release order in plant 0002 is determined during scheduling.

3. In plant 0001, you convert the stock transport requisition into a stock transport order. When doing this, the release order in plant 0002 is automatically converted into a purchase order.
   
   If the planning run in plant 0001 has firstly created a planned order for stock transfer, you must convert this into a purchase requisition and then convert this into a purchase order.

4. The material is procured and managed as stock in the issuing plant.

5. When transferring stock, the following postings are necessary:
   
   The removal from storage of the ordered quantity in plant 0002 is carried out by a transfer posting with reference to the purchase order.
   
   The movement type in this case is *Transfer posting → Plant to plant → To stock in transit*. Stock in transit is the quantity of a material which was withdrawn from the warehouse of the issuing plant but which has not yet been received by the receiving plant.
   
   In the receiving plant, you post a goods receipt for the stock transfer order on receipt of the goods. The stock in transit is then placed in the warehouse of plant 0001.
Planned Orders for Stock Transfer

**Use**

With the special procurement type *Stock transfer*, it can be useful to create **planned orders for stock transfer** at an earlier planning stage rather than stock transport requisitions.

**Prerequisites**

You have entered the indicator 3 for **planned orders** as the creation indicator for purchase requisitions (*Create purchase requisition* field) in the initial screen of the planning run.

**Features**

In this case, the planning run creates planned orders for stock transfer instead of stock transport requisitions.

Planned orders for stock transfer can be converted into stock transport requisitions or into schedule lines.

The document type of planned orders for stock transfer is NB in the standard system and can be changed, for example, to UB, during a conversion.

💡

In the case of cross-company code stock transfers, the document type NB must be used in the standard system.
Withdrawal from Alternative Plant

Implementation Options

You can specify for an assembly that the components required to build the assembly are to be withdrawn from a different plant from the planning plant (that is, the issuing plant). Dependent requirements for these components are directly created in the issuing plant. You can use withdrawal from alternative plant for both components produced in-house and procured externally. A special procurement key is defined for both procedures.

This procedure provides an alternative to using stock transport orders and is especially useful when plants are close together.

Prerequisites

- In Customizing for MRP, in the IMG activity Define special procurement type, you have maintained a special procurement key for Withdrawal from alternative plant and you have entered the issuing plant there.
- You have assigned the component, which is to be withdrawn from an alternative plant, to this special procurement key in the material master of the planning plant (MRP 2 view).
- In the withdrawal plant, you have created a material master for the component to be withdrawn.

Process Flow

The following example shows the steps involved in withdrawing material from another plant:

An assembly in plant 0001 contains two components. Component 2 in plant 0001 has the special procurement key Withdrawal from alternative plant with the issuing plant 0002. This defines that this component is to be withdrawn from plant 0002. Therefore, when producing the assembly in plant 0001, component 2 is withdrawn from the plant 0002 but the other components are withdrawn from plant 0001.
1. You carry out the planning run in the planning plant, that is, in plant 0001. During the planning run, the system creates a planned order for the assembly in plant 0001, if this is necessary.

2. The system creates a dependent requirement for component 2 in plant 0001. A dependent requirement is created in the issuing plant, that is, in plant 0002, for the component 2 with the special procurement Withdrawal from alternative plant.

3. When the planned order for the assembly is converted into a production order, the dependent requirements of the components are automatically converted into dependent reservations. The withdrawal for the production order is carried out in plant 0001 for the component 1 and in plant 0002 for component 2.
Production in Alternative Plant

Implementation Options

You can define that a particular product is to be produced in an alternative plant (that is, the production plant) from the planning plant. The planning of the product is carried out in the planning plant but it is actually produced in the production plant. The product's BOM is created in the production plant.

Prerequisites

- In Customizing for MRP, in the IMG activity Define special procurement type, you have maintained a special procurement key for production in an alternative plant and you have entered the different production plant there.
- You have assigned this special procurement key to the assembly in the material master of the planning plant (MRP 2 view).
- You have created a material master for the material in the production plant.

Process Flow

The following graphic shows the steps involved in producing material in another plant:

1. You first plan material requirements in the planning plant. During the planning run, the system creates a planned order for the assembly in the planning plant, if this is necessary.

   The following is to be taken into account for the scheduling of the planned orders in the planning plant:
   - The system uses the in-house production times and scheduling margin key entered in the material master record for the planning plant to determine the basic dates.
   - If MRP is carried out using lead time scheduling via the routing, the routing and scheduling margin key in the production plant are the basis of the production date calculation in.
   - If you have defined that the basic dates are to be adjusted for the production dates in lead time scheduling (Customizing, IMG activity Define scheduling parameters for planned orders) the system calculates the basic date by adding the production finish date and the float after production. The system uses the production start date minus float
before production as the order start date. The system determines the float before production and the float after production from the scheduling margin key in the material master record for the production plant.

2. You plan material requirements in the production plant. The system explodes the BOM for the assembly in the production plant and determines the dependent requirements.

3. You convert the planned order in the planning plant into a production order.

4. The dependent requirements in the production plant are converted into a dependent reservation and production of the components in the production plant is initiated.

5. When creating the goods receipt for the production order, the stock in the planning plant is increased.
Customizing Settings for Multi-Plant/Site Planning

Use

By using the special procurement key, you can combine settings for multi-plant planning with other special procurement types. The material will then be planned differently, depending on whether it is planned as a BOM item or as a finished product.

Integration

In Customizing for MRP, you have maintained the special procurement key in the IMG activity Define special procurement type [Ext.] (see also Procurement Type and Special Procurement Type [Page 135]).

Features

In Customizing, the system creates special procurement keys for the following multi-plant procedures as standard.

- stock transfer
- production in alternative plant
- withdrawal from alternative plant

You can also use the control indicator to define how a material should be treated as a component in the BOM explosion. The following options are available:

- **Phantom item**: a material, which is used as a component in a BOM, is treated as a phantom assembly [Page 168] during the BOM explosion regardless of the type of special procurement that is defined. You can combine the Phantom item attribute with every special procurement type.

- **Direct production**: a material, which is used as a component in a BOM, is to be procured using direct production [Page 201]. Direct production can be combined with the special procurement type Production in alternative plant.

- **Direct procurement**: a material, which is used as a component in a BOM, is to be procured using direct procurement [Page 206]. Direct procurement can be combined with the special procurement types Stock transfer, Consignment and Subcontracting.

- **Withdrawal from alternative plant**: a material, which is used as a component in a BOM, is procured using withdrawal from an alternative plant, if there is a dependent requirement, regardless of the type of special procurement that is defined. You can combine the withdrawal from an alternative plant with every special procurement type.

These additional possibilities are only useful, if a material, which can be ordered directly by customers and be used as a BOM component in in-house production, is procured or treated differently in each case. For a material, that is to be treated the same in both cases, for example, is to always be procured using stock transfer, it is sufficient to use the special procurement key Stock transfer as before.

💡 You can only use the special procurement key Withdrawal from alternative plant for materials that only have dependent requirements, that is, no independent
requirements. Once a material also has independent requirements, as the material is also sold directly to customers, you must enter the special procurement key for *Withdrawal from alternative plant* and, in addition, the special procurement type *Stock transfer*.

💡

If you combine the special procurement key *Direct production* with the special procurement type *Production in alternative plant*, the settings work coactively. This is how you create a multi-plant collective order (see also Customizing Settings for Direct Production [Page 205]).
Requirements Grouping for Individual Project Planning

Use

Requirements grouping is a planning procedure for projects within material requirements planning.

Requirements grouping for individual project planning enables you to group material requirements that are caused by WBS elements within a project or also cross-project, and plan and procure them together. This enables you to save costs.

Requirements grouping is possible only for operative WBS elements.

Prerequisites

You are using the component Project system for the processing of projects.

Integration

Basically, there are three procedures for planning material requirements in projects in the SAP System:

- **Individual project planning**
  
  The system only plans individual requirements. Materials that are required for a project (WBS element) are specifically planned for the project and are procured with reference to the WBS element. The materials in the individual project stock of the WBS element are managed and settled separately from the normal stock. Goods issue only takes place with reference to the WBS element.

  This procedure is used to plan finished products and important assemblies.

- **Requirements grouping for individual project planning using grouping WBS elements**
  
  The material requirements for different WBS elements are combined and jointly planned and procured. If you combine the WBS elements within a project to one grouping WBS element, you will have real individual project stock.

  If you use cross-project requirements grouping, the ordering parties must give their consent that the assemblies and components are planned and procured using this procedure.

- **Planning collective requirements (Make-to-stock production)**
  
  You can plan and procure materials at subordinate BOM levels that are required in all projects, independently of WBS elements, using make-to-stock production. During the planning run, the system calculates the total requirements of a material in a plant. The material is procured without reference to a WBS element.

  These materials are managed in the plant stock and are available for all projects.
Requirements Grouping for Individual Project Planning

Features

The requirements grouping for the materials of different WBS elements are carried out by using one or more grouping WBS elements.

- If you would like to group requirements of WBS elements within a project, the Automatic Requirements Grouping [Page 273] function is available. With this procedure, all requirements are combined into one grouping WBS element of the project. This has the advantage that you have “real” individual project stock, or project definition stock, for the whole project.

- In cross-project requirements grouping you assign the WBS element to one or more grouping WBS elements. The grouping WBS elements thereby have a grouping function.

You group all WBS elements of projects from the private sector into one grouping WBS element and combine all WBS elements from the public sector into another grouping WBS element and plan each together.

Requirements grouping in individual project planning has the following features:

- It combines several WBS elements into one grouping WBS element for the planning.

- It plans material requirements that have been caused by WBS elements, together on the basis of the grouping WBS element.

- Material requirements planning creates procurement elements (planned orders, purchase requisitions) that are assigned to the account of the grouping WBS element.

- In MRP evaluations, an individual MRP segment is managed for each grouping WBS element.

- You manage individual project stock for each grouping WBS element. All materials that are required by the WBS elements belonging to the grouping WBS element are included in this stock.

- The materials in the project stock of the grouping WBS element are available for every WBS element that is assigned to the grouping WBS element.

- The complete procurement costs are incurred by the grouping WBS element. The costs are posted to the network activity with the withdrawal of the procured material for production. During the procurement phase, no costs are visible for the WBS elements, which have
Requirements Grouping for Individual Project Planning

caused the requirements. It is not until the withdrawal, that the procurement costs are assigned to the appropriate WBS element.
Grouping WBS element

Definition

A Grouping WBS element is a WBS element that has valued project stock on which the requirements from several WBS elements are grouped together for materials requirement planning (MRP).

Use

You determine that a WBS element is a grouping WBS element by making the following settings for the Grouping WBS element field on the WBS element detail screen (on the Basic data tab page in the standard system):

- If this WBS element is to be the grouping WBS element for all components assigned to the WBS elements that have been assigned to this grouping WBS element, enter Grouping WBS element for all materials (1).

- If the material components assigned to a WBS element are to have different grouping WBS elements, enter Grouping WBS element for selected MRP groups (2). This could be the case, for instance, if you want to plan electrical and mechanical parts separately. The valid grouping WBS element is then selected on the basis of the MRP group and plant of the material.

Integration

If you have set the Automatic requirements grouping indicator in the project definition of a project, only one grouping WBS element is allowed in the project. In this case the first WBS element on level 1 is suggested as the grouping element. You must then have defined the WBS element as Grouping WBS element for all materials (1).
Preparing Requirements Grouping

Implementation Options

This process describes the sequence of preparations necessary in order to be able to use requirements grouping for planning projects, in addition to the master data that you have to maintain.

Prerequisites

For period lot sizes, such as MB (monthly lot size), you have set the indicator to 2 for Lot size as in planning horizon in the MTO lot size field, in Customizing for MRP, in the IMG activity Check lot-sizing procedure.

This causes the system to actually use the monthly lot size in the lot-size calculation for MRP in individual project planning, if you have entered MB into the material master. If you have not set this indicator, the planning run then creates a procurement proposal with lot-for-lot order quantity for every requirement in the segment of the MRP element.

Process Flow

1. You define how the individual materials are to be planned: with individual project planning, with requirements grouping, or as collective requirements in plant stock.

2. You create MRP groups [Page 289] for the materials. To do this, you choose the IMG activity Maintain all MRP areas in Customizing for MRP.

3. You select the MRP groups, for which you want to activate requirements grouping. For this, set the Grouping indicator in the IMG activity Activate requirements grouping for individual project planning in Customizing for MRP.

4. You maintain the MRP data in the material master records:
   - For the materials, which are meant for individual project planning such as finished products, you assign an MRP group, for which requirements grouping has not been activated.
   - For the materials, which are to be planned with requirements grouping, you assign an MRP group, for which requirements grouping has been activated. Enter a period lot size as the lot size, such as, for example, MB (monthly lot size) so that MRP combines the requirements of a material in a period according to the selected lot size strategy and creates a procurement proposal in the segment of the grouping WBS element.
   - For materials that are managed in the plant stock and are planned together, set the indicator to 2 for collective requirements only in the Individual/coll. field.

5. You create the BOMs for the finished product and assemblies. You use the material BOM for this.

6. You create a project definition for a grouping WBS element and select the Valuated stock field in it. For the project definition, you create a WBS element, for which you set the indicator 1 or 2 in the Grouping WBS element field.

7. You create a project definition and the appropriate WBS elements for the sales orders.
8. You create a network for each project, assign the project definition and a WBS element to the network and enter the necessary activities. You assign the required materials to the network operations.

9. You combine the WBS elements, whose materials are to be planned using requirements grouping, to a grouping WBS element. To do this, you assign the WBS elements to a grouping WBS element.

10. If a grouping WBS element is not to be used for all materials but rather for particular materials, you have to maintain the grouping WBS element's area of validity. You do this by entering the plant when assigning the MRP groups.

You can find further information on WBS elements and networks in the SAP document PS – Project System under Work Breakdown Structure (WBS) [Ext.] and Network [Ext.].
Create Project Definition and WBS Element for Grouping Element

Prerequisites
You have created a project profile in Customizing for Project System.

Procedure
1. Starting from the SAP menu, choose Logistics → Project system → Basic data → Project → Project builder.
2. Choose Project.
   The initial screen for the project builder now appears.
3. Enter a project definition and a project profile.
4. Choose
   The screen for the maintenance of the project definition now appears.
5. Enter the description for the project definition and the necessary basic data.
6. Choose the Control data tab page. Enter the control data. Select the Valuated stock field.
7. Choose
   The overview screen for WBS elements now appears.
8. Enter the WBS element, the description, and so on.
9. Select the WBS element and choose
   The maintenance screen for WBS elements now appears.
10. Enter the indicator 1 in the Grouping WBS element field, if you would like to use this grouping WBS element for requirements grouping of all materials.
    Enter the indicator 2 if you would only like to use the WBS element for materials with selected MRP groups. In this case, you have to create further grouping WBS elements.
11. Choose
    The overview screen for WBS elements appears again.
12. Save your entries.
Assigning WBS Elements to a Grouping WBS Element

Prerequisites

- You have created a grouping WBS element.
- You have created WBS element for the projects.

Procedure

Starting from the SAP menu, choose Logistics → Project system → Material → Planning → Requirements grouping → Assign WBS elements individually or Assign WBS elements using list.
Assigning MRP Groups to a Grouping WBS Element

**Use**

You define the area of validity for a grouping WBS element by assigning the MRP groups, for which the grouping WBS element is to be used, to the grouping WBS element.

**Prerequisites**

- You have created valid MRP groups and assigned the materials.
- You have created grouping WBS elements and have entered the indicator 2 the Grouping WBS element field.

**Procedure**

Starting from the SAP menu, choose **Logistics → Project system → Material → Planning → Requirements grouping → Assign MRP groups**.
Planning Material Requirements with Requirements Grouping

Implementation Options

There are several options for grouping requirements of materials that are assigned to different WBS elements. The option you choose depends on the business and organizational prerequisites.

The following options are available:

- Automatic Requirements Grouping Within a Project [Page 273]
- Multi-Plant Requirements Grouping with a Grouping WBS Element [Page 274]
- Multi-Plant Requirements Grouping with Several Grouping WBS Elements [Page 275]
- Requirements Grouping with a Grouping WBS Element for Each Plant [Page 277]
- Requirements Grouping with Several Grouping WBS Elements for Each Plant [Page 279]
- Requirements Grouping with Hierarchically Structured Grouping WBS Elements [Page 281]

Prerequisites

- You have defined that a material is to be planned using requirements grouping by entering the appropriate MRP group in the material master.
- You have entered a period lot-size, for example, MB for monthly lot size, in the material master.
- You have assigned the WBS elements to one or several grouping WBS elements [Page 265].
- If necessary, you have assigned a grouping WBS element to a plant and an MRP group.

Process Flow

Fundamentally, the planning run for the six different options are the same. The different planning results depend on the settings made in the master data.

1. The system checks for a material whether requirements grouping has been activated for the MRP group entered in the material master.
   - If requirements grouping has not been activated for the MRP group and the Individual/coll. indicator in the material master has been set to 1, the material is planned using individual project planning. In this case, material requirements planning creates procurement proposals that are assigned to the account of the WBS element that has caused the requirements.
   - If you have set the Individual/coll. indicator in the material master to 2, the material is planned at plant level and managed in the plant stock, irrespective of the MRP group settings.

2. If you have activated MRP for the MRP group entered, the system groups the requirements for the material. The system determines the assigned grouping WBS element for the WBS elements that have caused the individual requirements.
Planning Material Requirements with Requirements Grouping

If the system is unable to determine a valid grouping WBS element, individual project planning is carried out for the WBS element that caused the requirements. In this case, material requirements planning creates procurement proposals that are assigned to the account of the WBS element that has caused the requirements.

3. The individual requirements are combined for the grouping WBS element. The system creates procurement proposals (planned orders, purchase requisitions) to cover these requirements. These planned orders/purchase requisitions are assigned to the account of the grouping WBS element.

4. In MRP Evaluations, you can view the individual segments for a material that the system created for a grouping WBS element. The requirements (these are usually reservations, that have been caused by networks) and the procurement elements are displayed in the individual segment.
Automatic Requirements Grouping Within a Project

Use

You use this procedure if you would like to group the material requirements within a project and jointly plan and procure them, without having to make lots of changes to the master data.

It is not possible to group across projects using this procedure, that is, only the material requirements of the WBS element that belong to the project can be planned together.

Prerequisites

- You have defined that a material is to be planned using requirements grouping by entering the appropriate MRP group in the material master.
- You have entered a period lot-size, for example, MB for monthly lot size, in the material master.
- You have set the indicator automatic requirements grouping in the project definition (tab page Control data).

Features

The individual WBS elements within a project definition are assigned to one single grouping WBS element that belongs to the same project. The system uses the first WBS element on the highest level of the work breakdown structure as the grouping WBS element. All remaining WBS elements of the project are automatically assigned to this grouping WBS element.

Every material that is assigned to the project using networks and is allowed to be planned with requirements grouping, is planned with the highest WBS element of the work breakdown structure (this is the grouping WBS element of the project).

Material requirements planning groups the requirements and creates procurement elements that are assigned to the account of the WBS element.
Multi-Plant Requirements Grouping with Single Grouping Element

Use

You use this procedure if you would like to combine the requirements for all materials using a single grouping WBS element [Page 265]. At the same time, you can use this grouping WBS element in all plants.

Prerequisites

- You have defined that a material is to be planned using requirements grouping by entering the appropriate MRP group in the material master.
- You have entered a period lot-size, for example, MB for monthly lot size, in the material master.
- You have created a specific grouping WBS element and have entered the indicator 1 in the Grouping WBS element field.
- You have selected the Valuated stock field in the project definitions of the WBS elements and the grouping WBS elements (tab page Control data).
- You have ensured that all WBS elements, whose material requirements are to be grouped, belong to the same controlling area.
- You have assigned the WBS elements, whose material requirements are to be grouped, to the grouping WBS element (see also Assigning WBS Elements to a Grouping WBS Element [Page 269]).

Features

In material requirements planning, every material that is allowed to be planned with requirements grouping is planned with the grouping WBS element. The individual requirements that are caused by the WBS elements are combined and the system creates a procurement element, which is assigned to the account of the grouping WBS element, for every material.

In MRP evaluations, an individual MRP segment is displayed for the grouping WBS element.

⚠️

If there are material requirements that are caused by a WBS element, such as, for example, reservations, and this WBS element has not been assigned to the grouping WBS element, the system then carries out individual project planning. The material is planned for the WBS element and procured with reference to the WBS element.
Multi-Plant Requirements Grouping with Grouping WBS Elements

Use
You use this procedure if you would like to combine material requirements using several grouping WBS elements [Page 265]. At the same time, you can use these grouping WBS elements in all plants.

The use of several grouping WBS elements makes sense if you want to form different groups across plants.

Certain WBS elements of sales orders from Europe are to be assigned to the grouping WBS element 1 in all plants and certain WBS elements of sales orders from USA are to be assigned to the grouping WBS element 2 in all plants.

Prerequisites

- You have defined that a material is to be planned using requirements grouping by entering the appropriate MRP group in the material master.
- You have entered a period lot-size, for example MB for monthly lot size, in the material master.
- You have created several grouping WBS elements and have entered the indicator 1 the grouping WBS element field for them.
- You have selected the Valuated stock field in the project definitions of the WBS elements and the grouping WBS elements (tab page Control data).
- You have assigned the WBS elements, whose material requirements are to be grouped, specifically to one of the grouping WBS elements (see Assigning WBS Elements to a Grouping WBS Element [Page 269]).

Features

In material requirements planning, every material that is allowed to be planned with requirements grouping, is planned with the grouping WBS element that has been assigned the WBS element, which has caused the material requirement.

Example Data

- Material A is allowed to be planned with requirements grouping.
- Material A is assigned to the WBS elements E1, E2 and E3 in the networks.
- You assign the WBS elements E1 and E2 to the grouping WBS element D1. You assign the WBS element E3 to the grouping WBS element D2.

MRP Procedure
The requirements for material A that have been caused by WBS elements E1 and E2 are combined using the grouping WBS element D1. To cover these requirements, the system creates
Multi-Plant Requirements Grouping with Grouping WBS Elements

a procurement element (planned order or purchase requisition) that is assigned to the account of the grouping WBS element D1.

The requirements for material A that have been caused by WBS element E3 are combined using the grouping WBS element D2. The procurement element is assigned to the grouping WBS element D2.

In MRP Evaluations, the two grouping segments for the WBS elements D1 and D2 are displayed with the corresponding requirements and receipt elements for material A.
Requirements Grouping with a Grouping WBS Element for Each Plant

Use

You use this procedure if you want to combine all materials requirements of a plant using a single grouping WBS element. You have to create an individual grouping WBS element for each plant if you want to group requirements for other plants.

Prerequisites

- You have defined that a material is to be planned using requirements grouping by entering the appropriate MRP group in the material master.
- You have entered a period lot-size, for example MB for monthly lot size, in the material master.
- You have created a grouping WBS element for each plant and have entered the indicator 2 in the grouping WBS element field.
- You have selected the valued stock field in the project definitions of the WBS elements and the grouping WBS elements (tab index Profile).
- You have assigned the MRP groups of a plant, for which requirements grouping is activated, to the grouping WBS element of the same plant. Example: All MRP groups in plant 1 that are relevant to requirements grouping are assigned to the grouping WBS element of plant 1 (see Assigning MRP Groups to a Grouping WBS Element).
- You have assigned the WBS elements of a plant, whose material requirements are to be combined, to the grouping WBS element (see also, Assigning WBS Elements to a Grouping WBS Element).

Features

In material requirements planning, every material in plant 1 that is allowed to be planned with requirements grouping is planned with the grouping WBS element for plant 1. A prerequisite for this is that the WBS element, which caused the requirement, is assigned to the grouping WBS element and at the same time, the MRP group is assigned to the grouping WBS element.

⚠️ If you have not assigned the WBS element, which has caused the material requirement, to the grouping WBS element, individual project planning is carried out for the material with reference to the WBS element. The procurement element is then assigned to the account of the WBS element.

💡 When planning an assembly across plants, for example, procured using stock transfer or production in an alternative plant, the dependent requirements are in the planning plant (plant 1) and in the delivering plant/production plant (plant 2). If you have only assigned the grouping WBS element in plant 1, which has been assigned the WBS element of the assembly, to the MRP group in plant 1, then only the requirements in plant 1 are planned with the grouping WBS element from plant 1, as
Requirements Grouping with a Grouping WBS Element for Each Plant

plant 2 is unable to determine an assignment for the requirements. In this case, you also have to assign the WBS element from plant 1 to the grouping WBS element of plant 2.
Requirements Grouping with Grouping WBS Elements for Each Plant

Use

You use this procedure if you would like to group material requirements of different WBS elements in a plant using several grouping WBS elements [Page 265].

This is useful, for example, if you want to group WBS elements in a plant according to certain criteria. You can thus group the WBS elements according to specific criteria and plan the material requirements accordingly in every plant.

In plant 1, all WBS elements from projects with ordering parties from the public sector are to be assigned to grouping WBS element 1 and all WBS elements from projects with ordering parties from the private sector to grouping WBS element 2.

Prerequisites

- You have defined that a material is to be planned using requirements grouping by entering the appropriate MRP group in the material master.
- You have entered a period lot-size, for example, MB for monthly lot size, in the material master.
- You have created several grouping WBS elements and have entered the indicator 2 the grouping WBS element field for them.

If you would like to group the WBS elements according to two criteria, such as ordering parties from the public sector/ private sector, you create one grouping WBS element for each grouping criterion in the plant.

- You have selected the Valuated stock field in the project definitions of the WBS elements and the grouping WBS elements (tab page Control data).
- You have assigned the MRP groups to every grouping WBS element, for which the grouping WBS element is to be used (see Assigning MRP Groups to a Grouping WBS Element [Page 270]).
- You have assigned the WBS elements, whose material requirements are to be grouped, specifically to one of the grouping WBS elements (see Assigning WBS Elements to a Grouping WBS Element [Page 269]).

Features

In material requirements planning, every material in a plant that is allowed to be planned with requirements grouping, is planned with the grouping WBS element that has been assigned the WBS element, which has caused the material requirement. However, this is only possible if you have assigned the MRP groups of the material to the grouping WBS element.
Requirements Grouping with Grouping WBS Elements for Each Plant

Example

- Assembly A in plant 1 (the MRP group 1 is entered in the material master) is assigned to the WBS elements E1, E2 and E3 in the networks.
- You assign the WBS elements E1 and E2 to the grouping WBS element D1. You assign the WBS element E3 to the grouping WBS element D2.
- You have assigned the grouping WBS elements D1 and D2 to the combination plant1/MRP group 1.

MRP Procedure

The system combines the requirements of the assembly A, which are caused by the WBS elements E1 and E2, and creates a procurement element for these requirements that is assigned to the account of the grouping WBS element.

The system calculates the requirements of the assembly A, which are caused by the WBS elements E3, and creates a procurement element for these requirements that is assigned to the account of the grouping WBS element D2.

⚠️

If you have not assigned the WBS element, which has caused the material requirement, to the grouping WBS element, individual project planning is carried out for the material with reference to the WBS element. The procurement element is then assigned to the account of the WBS element.

💡

When planning an assembly across plants, that is, for example procured using stock transfer or production in an alternative plant, the dependent requirements are in the planning plant (plant 1) and in the delivering plant/production plant (plant 2). If you have only assigned the grouping WBS element in plant 1, which has been assigned the WBS element of the assembly, to the MRP group in plant 1, then only the requirements in plant 1 are planned with the grouping WBS element from plant 1. This is because plant 2 is unable to determine an assignment for the requirements. In this case, you also have to assign the WBS element from plant 1 to the grouping WBS element of plant 2.
Grouping with Hierarchically Structured Grouping WBS Elements

Use
You use this procedure if you would like to have several grouping criteria, that is, several grouping WBS elements [Page 265], in a plant to group requirements. The grouping WBS elements are hierarchically structured in this procedure.

Prerequisites

- You have defined that a material is to be planned using requirements grouping by entering the appropriate MRP group in the material master.
- You have entered a period lot-size, for example, MB for monthly lot size, in the material master.
- You have created several grouping WBS elements and have entered the indicator 2 the grouping WBS element field for them.

If you would like to group the WBS elements according to two criteria, for example, ordering parties from the public sector/ private sector, you create one grouping WBS element for each grouping criterion in the plant.

- You have selected the Valuated stock field in the project definitions of the WBS elements and the grouping WBS elements (tab page Control data).
- You have assigned the MRP groups to every grouping WBS element, for which the grouping WBS element is to be used (see Assigning MRP Groups to a Grouping WBS Element [Page 270]).
- You have assigned the WBS elements, whose material requirements are to be grouped, specifically to one of the grouping WBS elements (see Assigning WBS Elements to a Grouping WBS Element [Page 269]).
- You have assigned the grouping WBS elements at lower levels of the hierarchy to the grouping WBS elements at the higher levels of the hierarchy.

Features
In MRP, a material that is allowed to be planned with requirements grouping is planned:

- with the grouping WBS element that has been assigned to the WBS element, which has caused the material requirement, or
- with the grouping WBS element that is assigned to the dependent requirement (that is determined during the BOM explosion).

Example
You can imagine the material requirements planning of a project in the form of a pyramid. At the top is the finished product that is planned with the individual WBS element.
Grouping with Hierarchically Structured Grouping WBS Elements

The lower levels of the hierarchy represent the hierarchy of the grouping WBS elements. Every level simultaneously represents a BOM level. The lowest level represents the lowest BOM level with raw materials that are planned without reference to the grouping WBS elements as collective requirements and are managed in the plant stock.

The following illustration shows the hierarchical structure of grouping WBS elements in a plant. Every grouping WBS element has been created for a particular grouping criterion:

**Grouping WBS Elements**

The **grouping WBS elements 1 to 6** correspond to the following grouping criteria:

- Grouping WBS element 1 corresponds to domestic orders from the government
- Grouping WBS element 2 corresponds to domestic orders from the private sector
- Grouping WBS element 3 corresponds to orders from France
- Grouping WBS element 4 corresponds to grouping of domestic orders
- Grouping WBS element 5 corresponds to grouping of orders from Europe except for domestic orders.
- Grouping WBS element 6 corresponds to grouping of all orders from Europe, including domestic orders.

**WBS Elements**

The following **WBS elements** have been created in different projects: WBS 1.1, WBS 1.2, WBS 2.1, WBS 2.2

**Assignments Between WBS Elements and Grouping WBS Elements**

You must maintain the following **assignments between WBS elements and grouping WBS elements**:

<table>
<thead>
<tr>
<th>Grouping WBS el. 1</th>
<th>Grouping WBS el. 2</th>
<th>Grouping WBS el. 3</th>
<th>Grouping WBS el. 4</th>
<th>Grouping WBS el. 5</th>
<th>Grouping WBS el. 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>WBS 1.1</td>
<td>WBS 2.1</td>
<td>WBS 2.2</td>
<td>WBS 1.1</td>
<td>WBS 2.2</td>
<td>WBS 1.1</td>
</tr>
</tbody>
</table>
### Assigning the Materials to Grouping WBS Elements in MRP

The finished product is not allowed to be planned with requirements grouping. It is therefore planned with the **WBS element**.

The assembly underneath the finished product is planned with the **grouping WBS element 1, 2 or 3**, if its MRP group has been assigned to the grouping WBS elements and the WBS elements, which have caused the requirements, have been correctly assigned.

The materials in the BOM levels underneath this assembly, on the other hand, are planned with the **grouping WBS elements that are correspondingly lower in the hierarchy**, if the MRP groups are assigned to the grouping WBS elements and the WBS elements are assigned as displayed in the table. Important raw materials in the example above are planned with grouping WBS element 6. This also applies if the raw material is used for the final assembly and therefore a dependent requirement is at the highest BOM level.

Materials from the lowest BOM level (usually less important raw materials) are not planned using requirements grouping but rather as **collective requirements**.

---

#### Table: Grouping with Hierarchically Structured Grouping WBS Elements

<table>
<thead>
<tr>
<th>WBS 1.2</th>
<th>WBS 1.2</th>
<th>Grouping WBS el. 3</th>
<th>WBS 1.2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>WBS 2.1</td>
<td></td>
<td>WBS 2.1</td>
</tr>
<tr>
<td></td>
<td>Grouping WBS el. 1</td>
<td></td>
<td>WBS 2.2</td>
</tr>
<tr>
<td></td>
<td>Grouping WBS el. 2</td>
<td></td>
<td>Grouping WBS el. 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Grouping WBS el. 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Grouping WBS el. 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Grouping WBS el. 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Grouping WBS el. 5</td>
</tr>
</tbody>
</table>
Carrying Out the Planning Run (PP-MRP-PR)

Implementation Options

You use the Planning execution (PP-MRP-PR) component for planning material requirements for all materials or assemblies whose requirements or stock situation has changed.

To do this, you start a planning run.

Features

- You can execute a planning run
  - for a plant, several plants, an MRP area, several MRP areas or a combination of these (total planning)
  - for a single material or product group (single-item planning).

- The following functions are provided:
  - Total planning
  - Single-item, single-level planning
  - Multi-level single-item planning
  - Interactive planning
  - Multi-level, make-to-order production
  - Individual project planning
    You can find information on individual project planning in the SAP documentation for the Project System.

- In consumption-based planning, total planning and single-item planning are only executed on a single level.

- Interactive planning is not useful in long-term planning and is therefore not supported by this function.

- Using certain control parameters, you can determine how the planning run is to be executed.
Control Parameters for the Planning Run

Use
Various control parameters are available for the total planning procedure and for single-item planning, which you can set in the initial screen of the planning run.

You use these parameters to determine how the planning run is to be executed and which results are to be produced.

Features
The control parameters include:

- **Planning run type**
  You can choose whether all materials are to be planned or only those with MRP relevant changes.

- **Creation indicator for procurement proposals for materials that are procured externally**
  You can choose whether planned orders, purchase requisitions or schedule lines should be created for materials that are procured externally.

- **Creation indicator for MRP lists**
  You can define whether MRP lists are to be created.

- **Planning mode**
  You can determine how the system is to deal with procurement proposals (planned orders, purchase requisitions, scheduling agreement lines) from the last planning run, which are not yet firmed, in the next planning run.

- **Scheduling**
  You can choose basic date calculation or lead time scheduling.
Planning Run Type in the Initial Screen

Use

You use the planning run type (*Processing key* indicator in the initial screen of the planning run) to determine which materials are to be planned.

Features

There are three different planning run types:

- **During regenerative planning**, all materials are planned for a plant. This makes sense when you are carrying out the planning run for the first time as well as later during production if data consistency cannot be guaranteed due to technical error.

  The disadvantage of regenerative planning is the fact that the system has to deal with high capacity loads because all materials are planned, including materials, which may not be affected by the planning run.

- To overcome this disadvantage, it makes sense during production to carry out the planning run using the **net change planning** procedure. The only materials that are included in the planning run are those, which have undergone a change relevant to MRP since the last planning run, for example, because of warehouse issues or sales orders, changes to the BOM and so on.

  The net change planning procedure makes it possible for you to execute the planning run in short intervals, for example, in daily intervals. You can thus always work with the most up-to-date planning result.

- You can use **net change planning in the planning horizon** to shorten the MRP planning run even further. The system then only plans materials that have undergone a change relevant to MRP **within the planning horizon**. In order to also plan changes outside of the planning horizon, you must execute the net change planning run in greater time intervals.

  You define the planning horizon per plant or per MRP group in Customizing for MRP in the IMG activity *Define planning horizon*. The planning horizon should be at least long enough to cover the period when sales orders are received. It must also accommodate delivery periods and the total lead times of the materials.

  In single-item planning, you can only choose between net change planning and net change planning in the planning horizon. Regenerative planning is not useful, because the material has already been defined and does not have to be determined after the evaluation of the planning file.

The system automatically flags the materials that have undergone a change relevant to MRP with a corresponding **planning file entry** in the **planning file** (see also *Checking the Planning File* [Page 67] and *Planning Run Type* [Page 69]).
Creation Indicator

Use
The creation indicators (Create purchase requisitions, schedule lines and create MRP list indicators) define the following: whether planned orders, purchase requisitions or schedule lines should be created for materials procured externally

- whether MRP lists are to be created or not.

Features

Creation Indicator for Purchase Requisitions
You use this creation indicator to control whether purchase requisitions rather than planned orders are to be created for materials that are procured externally. The following options are available:

- planned orders only
- purchase requisitions only
- purchase requisitions within the opening period and planned orders outside of the opening period.

When you select this indicator, the system creates purchase requisitions instead of planned orders when it determines an opening date that is before the date of the planning run.

The opening period for the planned order represents the number of workdays that are subtracted from the order start date in order to determine the order opening date. This period serves as a time float, which is available for the MRP controller when converting a planned order into a purchase requisition.

You define the opening period for the planned order in Customizing for MRP in the IMG activity Define floats (scheduling margin key) and assign it to the material in the Scheduling margin key field (MRP 2 view) in the material master.

Creation Indicator for Schedule Lines
You use this creation indicator to control whether schedule lines are to be directly created for materials that are procured externally. The following options are available:

- no schedule lines
- only schedule lines
- schedule lines within the opening period and purchase requisitions outside of the opening period.

So that schedule lines can be generated automatically by the planning run, the following prerequisites must be met:

- You have created a scheduling agreement for the material.
- For the material, there is a valid entry relevant to MRP in the source list.

For more information, see Determining Source of Supply for External Procurement [Page 139].
Creation Indicator

**Creation Indicator for MRP Lists**

Using this creation indicator, you determine whether the result of the planning run is to be stored in the form of MRP lists. These MRP lists can be evaluated after the planning run according to various aspects. The following options are available:

- no MRP lists
- always MRP lists
- MRP lists only in certain exceptional situations that are documented in exception messages.

You determine for which exception messages the system is to create MRP lists in Customizing for MRP in the IMG activity *Define and group exception messages.*

💡

Even if you do not save any MRP lists, the procurement proposals generated by the system are stored in the database. You then process the results of the planning run by means of the stock/requirements list instead of the MRP list.
Creation Indicators in the Initial Screen and the MRP Group

Use
You can maintain creation indicators in two places:

- in the initial screen of the planning run
- in the MRP group.

Maintaining them in the MRP group is useful, if planning for each plant is not specific enough for your purposes and you would like to assign control parameters that differ from the control parameters defined for the plant to certain material groups.

You define the creation indicators for MRP groups in Customizing for MRP in the IMG activity Define creation indicator. You then assign the materials in the material master (MRP 1 view) to the MRP group.

Features
Single-item planning and total planning take into account the settings for the MRP groups using different logic:

- **Logic Used in Total Planning**
  The creation indicators that you enter manually at the start of a planning run are only defaults. They are only valid, if the SAP system does not find a creation indicator for the MRP group.

  ![Tip](https://example.com/tip-icon.png)

  You can maintain an additional plant-specific entry for the creation indicator for delivery schedule lines. When a plant-specific entry exists, the following applies:

  - The system checks first whether the material has been assigned to an MRP group, for which the creation indicators have been maintained.
  - If this is not the case, it checks whether there is a plant-specific entry.
  - If this is also not the case, it uses the creation indicator from the initial screen.

- **Logic Used in Single-Item Planning**
  In single-item planning, only the settings from the initial screen of the planning run are used. The Customizing settings for the MRP group have no effect.
Use

The planning mode (Planning mode indicator in the initial screen of the planning run) controls how the system is to deal with procurement proposals (planned orders, purchase requisitions, scheduling agreement lines) from the last planning run, which are not yet firmed, in the next planning run. Firmed procurement proposals remain unchanged.

The planning mode is set automatically in the planning file. However, you can overwrite it in the initial screen of each planning run.

By choosing the correct planning mode, you avoid planning materials twice and thereby optimize system performance.

Features

The following options are available:

- **adapt existing planning data** (planning mode 1)
- **re-explode BOM after change to BOM** (planning mode 2)
- **delete planning data** and recreate procurement proposals (planning mode 3)

For more information on planning modes, refer to Planning Mode [Page 71].

The planning mode set in the planning file for a material can be overruled by the planning mode in the initial screen of the planning run. The following applies to this: For planning a particular material the planning mode that has the highest numerical value takes priority. Planning mode 2 (re-explode BOM) thus takes priority over planning mode 1 (adapt planning data), planning mode 3 (delete and recreate planning data) takes priority over planning mode 1 (adapt planning data) and planning mode 2 (re-explode BOM).

It is usually sufficient to set planning mode 1 in the initial screen of the planning run. If you have to plan a material with another planning mode, the system then sets the corresponding planning file entry in the planning file. The system evaluates this in the planning run.

💡

It is important to set the planning run to planning mode 2 or 3 in the initial screen if changes have been made in Customizing or the routing, because no planning file entries are created automatically for the materials affected by these changes.
Scheduling Control in the Initial Screen

Use

You use the Scheduling indicator in the initial screen of the planning run to determine exactly how planned orders for materials that are produced in-house are to be scheduled. The indicator is relevant for all planned orders that are new or have been changed or have had their BOM reexploded.

Features

The following options are available:

- determination of basic dates (planned dates)
- lead time scheduling.

Lead time scheduling calculates the precise start and finish dates for production. The system only creates capacity requirements if lead time scheduling has been carried out.

For more information, see Scheduling [Page 114].

⚠️

The system continues to use lead time scheduling for planned orders that have already undergone lead time scheduling. This is even applies if you choose basic date determination in the initial screen.

💡

In consumption-based planning, the determination of basic dates is normally used as it deals with materials that are procured externally.
Total Planning

Use

Total planning covers the planning of all the materials that are relevant for requirements planning and includes the BOM explosion for materials with a bill of material.

You can use total planning for a single plant or you can use the scope of planning to control whether the total planning run is executed on a multi-plant level

- for several plants
- for one MRP area
- for several MRP areas
- for a combination of plants and MRP areas.

Prerequisites

Only for multi-plant planning with scope of planning:

- You have grouped together the plants or alternatively the MRP areas, which are to be planned together, in Customizing for MRP in the IMG activity Define scope of planning for total planning.

- In Customizing for MRP, you have made the necessary settings for Parallel processing [Page 297] in the IMG activity Define parallel processing in MRP.

Features

Defining the Scope of Planning

- You can define different scope of planning groups in Customizing.
- You specify the sequence of the individual MRP units (plants or MRP areas) for each scope of planning by entering a counter. This counter defines the sequence in which the MRP units are to be planned.
- You can enter as many plants as you like in the scope of planning.
- If you have activated material requirements planning with MRP areas, the entry of a plant thus includes all the MRP areas of this plant. During the planning run, the MRP areas of a plant are always planned in the following sequence: plant MRP area, storage location MRP area, subcontractor MRP area.
- You can, however, also enter one or several MRP areas in the scope of planning and thus restrict the total planning run to these MRP areas.

Executing the Total Planning Run for the Scope of Planning

You can execute total planning with scope of planning either online or as a background job.

💡

The planning run always has to be started with parallel processing.
With stock transfer or production in alternative plant, the system creates the corresponding planning file entries in the alternative plant. If the alternative plant is included in the scope of planning, the system continues to plan the materials in the alternative plant. If the alternative plant is not included in the scope of planning or if you plan for a single plant without entering a scope of planning, the system does not plan in the alternative plant.
Carry Out Total Planning Online

1. Starting from the MRP node, choose Planning → Total planning → Online.

   This takes you to the initial screen for the total planning run.

2. Enter the plant, for which you want to carry out the total planning, or enter the number of the scope of planning.

3. Specify the control parameters you desire (see Control Parameters for the Planning Run [Page 285]).

   The creation indicator for purchase requisitions is only valid if the MRP group does not override it. The creation indicator for scheduling agreement schedule lines is only valid if the MRP group or the plant entry in Customizing does not override it (see Creation Indicators in the Initial Screen and the MRP Group [Page 289]).

   If you want to save the parameters set in the initial screen, for the following total planning, choose Settings → Save. The parameters saved become the default for each following planning run.

4. If you work with scope of planning, set the indicator for Parallel processing.

5. Choose .

   The system displays the long texts explaining the settings selected.

6. Check the settings and choose again.

Result

The system carries out total planning for the plant selected or for the scope of planning you have defined. The individual plants or MRP areas are planned in the sequence defined.

When you have completed the planning run you receive statistics with information on the scope of planning, exceptional situations and terminations. You can also see how much time is required for the planning run in total and for planning the individual materials.

To limit the scope of these statistics you can set the number of materials used, in Customizing for MRP under Activate runtime statistics.

   If you carry out the total planning in the background, you can print these statistics.

If you have selected the field Display material list in the initial screen of the planning run, the list of the materials planned is displayed above the statistics. If you position the cursor on a specific material in the list and choose MRP list or Stock/requirements list, this takes you directly to the appropriate list and from there you can test the planning result.
**Execute Total Planning in Background Mode**

1. Starting from the Material Requirements Planning node, choose *Planning → Total planning → As background job.*
   The *Total planning: Variants* screen appears.

2. Choose ![Create variant](image).
   The variant contains the control parameters for the total planning run.

3. Enter a name for the variant and choose ![Create](image).
   The system displays the *Variants: change screen assignment* dialog box. The system recommends the *BATCH structure for MRP run screen.*

4. Choose ![Continue](image).
   The recommendation is copied and this takes you to the initial screen for the total planning run.

5. Enter the control parameters that the system is to use during the total planning run (see *Control Parameters for the Planning Run [Page 285]*) and, if you work with scope of planning, select the *Parallel processing* field.

6. Choose ![Attributes](image).
   The *ABAP: Save Attributes of Variant XXX:* screen appears.

7. Enter a description for the variant in the *Description* field and choose ![Attributes](image).
   This takes you to the initial screen for the total planning run again.

8. Choose *Variants → Exit.*
   The *Total planning: Variants* screen appears again.

9. Position the cursor on the variant and choose *Schedule job.*
   The *Total Planning Scheduling: Start Time* screen appears.

10. You define whether the variant created is to be scheduled just once or periodically.

**Result**

If you choose *Schedule once*, the planning run is carried out once on the date that you have specified and with the control parameters that you defined in the variant.

If you choose *Schedule periodically*, the total planning run is repeated at regular intervals.

💡 If you run the total planning run in background mode, you can print out the protocol and the resulting statistics.
**User Exit: Material Selection for the Total Planning Run**

**Use**

You can use this user exit, which is predefined by SAP, to restrict the **total planning run to certain materials** that fulfill freely definable criteria. For example, you can thus determine that

- only materials planned using MRP or
- only materials for a particular MRP controller or
- only materials procured externally or in-house

are to be planned.

**Prerequisites**

- You have defined the key and descriptive text for the user exit in Customizing for MRP in the IMG activity *User exit: Material selection for planning run.*
- You have activated the user exit within the framework of the SAP enhancement concept. The name of the **enhancement** is **M61X0001**.

**Features**

The system calls up the user exit for every material, after the corresponding planning file entry and the data in the material master has been read. Using the user exit, you can exclude the material from the planning. The planning file entry remains unchanged.

**Activities**

Enter the key for the user exit and, if necessary, a corresponding parameter in the initial screen of the total planning run.
Parallel Processing

Use

Using parallel processing functions, you can significantly shorten the runtime of the total planning run. For parallel processing, you can also choose to use various sessions on one server or to use various servers.

Prerequisites

In Customizing for MRP, you have made the necessary settings for parallel processing in the IMG activity Define parallel processing in MRP, that means, you have defined the corresponding destinations (application servers) with the number of sessions available.

Features

Parallel processing is carried out on the basis of the low-level code logic:

A package of a size to be determined is distributed per RFC (Remote Function Call) to the individual server/tasks. Once a task has completed processing one package, the next package of the same size is processed. Once a low-level code is completed, the finished tasks must wait until the last package is also complete in order to avoid inconsistencies. Then the next low-level code is processed package by package.

You can use parallel processing for the total planning run online as well as a background job. It is activated in the initial screen.
Carrying Out Single-Item, Single-Level Planning

Use

Single-item planning only involves the planning of one individual material. Single-level means that the BOM is not exploded and that, therefore, only the level directly below the material is planned.

Procedure

1. Starting from the MRP node, choose Planning → Single-item planning, single-level.
   This takes you to the initial screen for single-level single-item planning.
2. Enter the material number, for which you want to carry out single-item planning, and also the plant or planning area, in which you want to plan.
3. Specify the control parameters you desire (see Control Parameters for the Planning Run [Page 285]).
   In single-item planning the creation indicators in the initial screen overwrite the creation indicators in the MRP group (see Creation Indicators in the Initial Screen and the MRP Group [Page 289]).
   If you want to save the parameters set in the initial screen, for the following planning, choose Settings → Save. The parameters saved become the default for each following planning.
4. Choose ✔.
   The system displays the long texts explaining the settings selected.
5. Check the settings and choose ✔ again.

Result

Single-level single-item planning is carried out for the material selected.

If you select the Display results before they are saved field in the initial screen, the planning result is displayed and you can still make changes before you save it to the database. For more information, see Working with the Planning Result [Page 303].
Single-Item, Multi-Level Planning

Use
In single-item, multi-level planning the BOM is exploded and dependent requirements are generated for assemblies and components. To cover the dependent requirements, these components are also planned. If the components also have BOMs, these are also exploded and the components are planned. This process is repeated until all levels of the BOM are exploded and planned.

If there are components in the BOM that are procured by stock transfer or production in another plant, then in single-item, multi-level planning the other plant is used for further planning.

Features
For single-item, multi-level planning you have the following options:

- **Without an interactive check of the planning result**
  In the planning run, the planning results are automatically written to the database.
  However, you can check the result for all planned materials directly after the planning. Select the field Display material list in the initial screen of the planning run. The system then issues a material list, from which you can call up the planning result for each material. If you make changes to the planning result of a material, you can repeat the planning for all dependent materials directly from the planning result. For more information, see Working with the Material List [Page 302].

- **With an interactive check of the planning result per material**
  The results are only written to the database if you have checked and (if necessary) changed them. There are two procedures for this:

  - **Planning with display of results**
    The planning with a display of results occurs if you have selected the field Display results before they are saved. Here, the materials to be planned are displayed as breakpoints and you can control at which materials the planning is stopped. The planning result is displayed for as many breakpoints as you want and is used for continuing the planning. The changes have an immediate effect on the following planning. For more information, see Working with the Planning Result [Page 303].

  - **Planning in simulation mode**
    When planning in simulation mode, all materials of a BOM are planned completely in the main memory, without the planning results being written to the database. The planning result can be tested for each material. Problems in lower-level BOM levels are displayed on a higher-level or on the finished-product level and can be corrected immediately. Only after saving is the total planning result written to the database. For more information, see Simulation Mode [Page 307] and Plan in Simulation Mode [Page 308].
Starting Single-Item, Multi-Level Planning

6. Starting from the MRP node, choose Planning → Single-item, multi-level.
   
   This takes you to the initial screen for single-item, multi-level planning.

7. Enter the material number, for which you want to carry out single-item planning, and also the plant or planning area, in which you want to plan.
   
   If you want to plan for a product group, whose members are materials, enter the material number of the product group in the field Material and select the field Product group. The product group is then broken down by the planning. All members of the product group are planned, the relevant BOMs are exploded and the assemblies and components are planned.

8. Specify the control parameters you desire for MRP (see Control Parameters for the Planning Run [Page 285]).
   
   In single-item planning the creation indicators in the initial screen overwrite the creation indicators in the MRP group (see Creation Indicators in the Initial Screen and the MRP Group [Page 289]).

   If you want to save the parameters set in the initial screen, for the following planning, choose Settings → Save. The parameters saved become the default for each following planning run.

9. Specify the control parameters for the process.
   
   – **Display results before saving**
     
     If you select this field, the planning result is displayed and you can still make changes before you save it to the database. For more information, see Working with the Planning Result [Page 303].
   
   – **Plan unchanged components**
     
     If you select this field, those components from existing and unchanged receipt elements are also planned.
     
     In particular, all components from fixed receipt elements (such as planned orders, production orders, scheduling agreement schedule lines) are also planned.

     With one material on any BOM level only fixed receipt elements are available, and these receipt elements are sufficient to cover requirements. If you reschedule one of these fixed receipt elements and if, after this change, the stock/requirements situation is still balanced, and there is no material shortage, the standard single-item, multi-level planning run no longer plans the lower-level assemblies and components. The rescheduling is forwarded to the dependent requirements or dependent reservations of the assemblies and components. The receipt elements for these requirements are not adjusted, however. The next total planning run automatically plans the assemblies and components again. If you select the field Also plan...
unchanged components in the multi-level single-item planning, you can also plan the assemblies and components directly.

This indicator is not relevant for consumption-based materials, as these are not planned with single-item, multi-level planning.

- **Display material list**
  If you select this field you can call up a list of all materials planned from the runtime statistics, after planning (see [Working with the Material List](Page 302)).

- **Simulation mode**
  If you select this field, the single-item, multi-level planning is carried out in simulation mode. All planning results are stored in the main memory and problems of lower-level BOM levels are visible on finished-product level (see [Simulation Mode](Page 307) and [Plan in Simulation Mode](Page 308)).

5. Choose ✅.

   The system displays the long texts explaining the settings selected.

6. Check the settings and choose ✅ again.

**Result**

Single-item, multi-level planning is carried out for the material selected.

If you have not made any other settings in the control parameters, only the runtime statistics are displayed.

If you have selected *Display results before saving*, the planning result is displayed and can be used. After saving the planning result, the runtime statistics are displayed.

If you have selected *Display material list*, the runtime statistics are displayed and so is the button *Materials*. With this button you can call up the material list and make changes to the planning result, which you have already saved.

If you have selected *Simulation mode*, the material list is displayed and from here you can test the planning result for all materials before saving. After saving the planning result, the runtime statistics are displayed.
Working with the Material List

Use

You can use the material list directly after the planning run to

- check which materials have been planned. For this, you can use various sort and search functions. You can find further information on this under Sorting Materials in Material Lists [Page 324] and Searching for Information [Page 328].

- call up the saved planning result for the individual materials and make changes (see Working with the Planning Result [Page 303]). When you save these changes, the system passes them on to the dependent materials.

Prerequisites

You have selected the Display material list field in the initial screen for the single-item, multi-level planning run and started the planning run.

Procedure

1. Double-click on the required material.
   
   The system displays the planning result for this material. It cannot be changed.

2. Choose 🍂.
   
   You can now change the planning result.

3. Process the planning result as desired.
   
   For more information about the processing options, see Working with the Planning Result [Page 303] under Procedure.

4. Choose 🍂.
   
   The changes are immediately passed on to the dependent materials.
Working with the Planning Result

Use
The planning result display allows you to adjust and test the result.

Prerequisites
You have either:
- selected the field Display results before they are saved in the initial screen of the single-item, multi-level planning run and started the planning run
- or started the interactive planning run.

Procedure

<table>
<thead>
<tr>
<th>Function</th>
<th>How to call up function</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide and show header details for the material</td>
<td>📊, 📊</td>
<td>The header details point to various tab pages for master data and movement data for the material selected. You define the sequence of the tab pages in Customizing for MRP under Define Screen Sequence for Header Details.</td>
</tr>
<tr>
<td>Enter or display material memo</td>
<td>📊</td>
<td>Next to the symbol for the material memo the name and date of the last change are displayed.</td>
</tr>
<tr>
<td>Display the exception message</td>
<td>Position the cursor on the exception message and choose 📊</td>
<td></td>
</tr>
<tr>
<td>Display additional data for the MRP element.</td>
<td>📊 Next to the MRP element</td>
<td></td>
</tr>
<tr>
<td>Activate period totals display</td>
<td>📊</td>
<td></td>
</tr>
</tbody>
</table>
| Change procurement proposal                   | Double-click the procurement proposal | In the lower section of the screen is an area with the data of the procurement proposal selected and here you can make your changes. Copy the changes with 📊.  
The procurement proposal is firmed automatically. Firmed procurement proposals are not adjusted in the planning run. Note also the firming logic of the master production scheduling (see Firming Type [Page 446]). |
## Material Requirements Planning (PP-MRP)

### Working with the Planning Result

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reschedule procurement proposal</td>
<td>Position the cursor on the procurement proposal and choose ![icon]. If the system issues a rescheduling proposal for the procurement proposal, the procurement proposal is automatically rescheduled to this date. If the system does not issue a rescheduling proposal, a dialog box appears in which you can enter the MRP date desired.</td>
</tr>
<tr>
<td>Add procurement proposal</td>
<td>![icon] Procurement proposal. After you have defined the type of procurement proposal, you can enter the relevant data in the lower section of the screen. If you choose Enter, the stock/requirements situation changed by the procurement proposal is visible immediately. Transfer the data with ![icon].</td>
</tr>
<tr>
<td>Delete procurement proposal</td>
<td>Position the cursor on the procurement proposal and choose ![icon].</td>
</tr>
<tr>
<td>Add/change production order</td>
<td>![icon] Production order or ![icon]. This function is only available in single-level single-item planning and in interactive planning.</td>
</tr>
</tbody>
</table>
| Change or add components of a planned order | Double-click the planned order and choose Goto → Maintain material components or Enter material components. This takes you to the component processing. Here, you can:  
  - change requirement quantities or dates directly  
  - call up the detail data for the components in the lower screen area, by double-clicking the components.  
  - add new components via Detailed entry or Collective entry. |
| Explode BOM again             | Double-click the planned order and choose Goto → Explode BOM. The BOM is exploded again and the component processing appears.                                                                                                     |
| Check availability of the components of a planned order | Double-click the planned order and choose Goto → Check availability                                                                                                                                                    |
## Working with the Planning Result

<table>
<thead>
<tr>
<th>Plan capacity for material</th>
<th>Double-click the planned order and choose Goto → Capacity planning → Capacity leveling → Material view</th>
<th>The indicator for scheduling in the initial screen of planning must be set so that lead time scheduling is carried out. For further information on capacity planning see the SAP document PP-Capacity planning.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan capacity for planned order</td>
<td>Double-click the planned order and choose Goto → Capacity planning → Capacity leveling → Order view.</td>
<td>See above</td>
</tr>
<tr>
<td>Print planning result</td>
<td>![Print icon]</td>
<td></td>
</tr>
</tbody>
</table>
Planning with/without Stopping Points

Use

You can display and edit the planning result of all or some of the components and assemblies of the material, before you save the complete planning result. You can edit at every BOM level.

This function is not available, if you call up and change a material's planning result from the material list. The materials are then passed on directly to the dependent materials and the planning is saved without further stopping points.

Prerequisites

You have completed processing the planning result of the header material.

Procedure

1. Choose .

   The system displays the dialog box Next stopping point. The system displays the next possible stopping point, that means the next assembly or component where the planning run can be stopped.

2. The following options are available:

   – If you want to stop the planning run at the material displayed, choose Plan up until stopping point and then Continue.

     The planning result for the selected component now appears.

   – If you want to stop at a different stopping point to the one that the system proposed, choose Determine new breakpoint.

     A list of components for the next BOM level to be planned appears. Select a material. The system displays the dialog box Next stopping point again. Choose Continue.

     The planning result for the selected component now appears.

   – If you do not require any further stopping points, choose Proceed without stopping and Continue.

Result

Once the last level has been planned, the result of multi-level planning is automatically saved and the system displays the runtime statistics for the planning run.

From the statistics, you receive information on the scope of planning, exception messages and terminations. You are also informed of how much time was required for the total planning run as well as how long it took to plan each individual material.
Simulation Mode

Use
Single-item, multi-level planning in simulative mode enables you to check the results during the planning run and to make adjustments. In contrast to planning with the parameter Display results before saving, the system displays problems with lower-level assemblies or with components on a higher-level or on the finished-product level and these can be solved immediately.

Prerequisites
You have selected the Simulation mode field in the initial screen for the single-item, multi-level planning run and started the planning run.

Features
- All the materials in a BOM structure are planned top-down.
- All changes are saved in the main memory. The results are not entered in the database until after changes are saved.
- For problems with dates such as order dates in the past, the system sets an exception message in the planned order of the higher-level material or in the planned order of the finished product and displays the delay. If there is a delay, the system displays the total number of days that a planned order is delayed due to a problem with a lower-level assembly or component. The system displays this information in two additional columns in the planning result of the finished product.

  If the start date of an assembly for a finished product is 3 days in the past and the start date of the component that is installed in the assembly is 5 days in the past, the system displays a delay time of 8 days in the planning result of the finished product.

- Evaluation functions such as the order report and the pegging function enable you to quickly find the procurement element causing the delay or the exception message.
- You can change the relevant procurement elements and repeat the planning run for the next lower level of the BOM. The system then automatically firms the changed MRP elements.
Plan in Simulation Mode

1. In the material list: Choose 📋 and then 🌐 Selected results.
   - The system displays the planning result for the header material where you can make changes to the material. You can call up the planning result for the next material (component) by choosing 🌐.
   - Double-click on a material in the material list to access the planning result of an individual material.

2. Check the planning result for the header material.
   - The system displays two additional columns in the planning result: the Exception lower level column and the Delay column.
   - In the Exception at lower level column, the system displays the numbers of the exception messages that appear for the MRP elements in lower BOM levels. The system displays the number of days an MRP element is delayed in the Delay column.

3. Position the cursor on the exception message that interests you and choose 🌐.
   - The system displays the descriptive text for the exception message in the status line. To access further information about the message, double-click the status line.

4. Position the cursor on the MRP element with the exception message and choose 🌐.
   - The dialog box Order structure of MRP element appears.

5. Choose 🌐.
   - In the dialog box, the system displays all MRP elements belonging to the lower-level components with the exception messages that belong to them.

6. Position the cursor on the MRP element that you want to change and choose 🌐.
   - The planning result for the selected component now appears. The system also displays the details for the selected MRP element in the lower screen area so that you can make changes.

7. Change the MRP element, if necessary.

8. Choose 🌐 in the lower screen area.
   - The system transfers the changed data. The changed MRP element is firmed automatically.

9. Choose 🌐.
   - The system executes the planning run for the changed material and the lower BOM levels again.

10. Repeat steps 3 to 9 until you are satisfied with the planning results for all BOM levels.

11. Choose 🌐.
    - Your planning results are saved in the database. If you exit this transaction without saving, your planning results are lost.
Interactive Planning

Use

Interactive planning is a single-level simulative planning. It enables you to check the planning result particularly carefully and to carry out fine tuning. It is particularly suitable for materials for which a thorough check is necessary, and above all for master schedule items (see also Master Production Scheduling [Page 20]).

Features

In interactive planning the system first of all displays the stock/requirements list, but does not plan it directly. From this stock/requirements list you can trigger the planning and simulation functions manually.

With interactive planning you have the following possibilities:

- You can enter procurement proposals for materials procured in-house or externally.
- You can change or reschedule procurement proposals entered in the planning run.
- After each change you can carry out a rescheduling check and the planning (net and lot-size calculation).

All the changes are simulative first of all and are only written to the database after saving.

Activities

1. Starting from the MPS node choose Master schedule items → Single-item, interactive or from the MRP node choose Planning → Single-item, interactive.
   
   This takes you to the initial screen for interactive planning.

2. Enter the data required, as described in Single-Item, Single-Level Planning [Page 298].
   
   The stock/requirements list display appears. The system has not yet carried out the planning.

3. Choose .
   
   The planning is carried out and the system takes you to the planning result. This planning result only exists in the main memory and is not saved on the database.

4. Deal with the planning result as desired.
   
   For more information, see Working with the Planning Result [Page 303].
   
   With you can also check the rescheduling.

5. Run the planning again with .

6. Repeat steps 4 and 5 as often as necessary.

7. When you are satisfied with the planning result, save your data.
   
   The planning result is saved to the database.
Multi-Level, Sales Order Planning

Use

With multi-level, sales order planning you can plan a sales order item, for which the strategy Make-to-order production is entered in the material master, over several production levels.

Features

- Here, the system does not plan all requirements as in single-item, multi-level planning run, but instead, it plans only those of the sales order item selected across all BOM levels. Therefore you can then check the planning result for the sales order item across all BOM levels and can also make any necessary corrections during the planning run.

- An individual customer segment is created for the sales order item at every BOM level that is relevant to make-to-order, in the MRP list and the stock/requirements list. The quantities required for the sales order item are maintained and settled as sales order stock.

- In the standard R/3 System, the lot-for-lot order quantity is used for make-to-order production. If necessary, you can go into Customizing for MRP under Check lot-sizing procedure and choose another lot-sizing procedure.

- As event-based MRP, sales order planning can be triggered automatically on entering or changing a sales order item. To be able to do this you must select the field in Customizing for Sales and Distribution under Define requirements classes.

Activities

10. Starting from the MRP node, choose Planning → Single-item, sales order.
   The initial screen for sales order planning, multi-level appears.

11. Enter the number of the sales order and the number of the sales order item.

12. Enter the control parameters required, as described in Control Parameters for the Planning Run [Page 285] and Single-Item, Multi-Level Planning [Page 299] and start the planning run.
   For further information on processing the result see Working with the Material List [Page 302] and Working with the Planning Result [Page 303].
Evaluating the Planning Run (PP-MRP-PE)

Implementation Options

During the planning run, the system analyzes the requirements that exist for the planned materials and creates procurement elements that cover these requirements. The evaluations in the PP-MRP-PE component display all receipt and issue elements for a material in the form of a table and enable you to gain a quick overview of the stock/requirements situation for the material as well as to branch into the editing function for the MRP elements for this material.

Features

The following evaluations are available for analyzing the planning result:

- MRP list
- stock/requirements list
- planning result (corresponds to the MRP list with individual evaluation layout)
- planning situation (corresponds to the stock/requirements list with individual evaluation layout)
- planning table for repetitive manufacturing
MRP List and Stock/Requirements List

Definition of the MRP List

The system creates MRP lists during the planning run according to how you set the creation indicator. These lists contain the planning result for the material. The MRP list always displays the stock/requirements situation at the time of the last planning run and it also provides a work basis for the MRP controller. Changes that are made after the planning date are not taken into consideration, so the list is static.

MRP lists are stored in the system until they are either deleted manually or replaced by new lists from a subsequent planning run.

Stock/Requirements List

In the stock/requirements list, the most up-to-date stock and requirements situation is displayed.

The main difference between the MRP list and the stock/requirements list is that each time the stock/requirements list is called up, the system selects the various MRP elements and displays the most up-to-date situation. You thus always see the current availability situation of the material in the stock/requirements list. Changes that are made after the planning date are displayed directly, so the list is therefore dynamic.

Stock/requirements lists are not saved in a fixed state in the system, but are subject to change and only exist in the working memory.

Comparison

- The screen layout of both lists is basically the same.
- The system automatically runs the rescheduling check directly when both lists are created and puts forward rescheduling proposals.
- The number of exception messages displayed in each list is roughly the same. The only difference lies in the fact that, due to the nature of the list, no exception messages can occur for newly planned MRP elements in the stock/requirements list.
- Directly after the planning run, both lists contain the same information. As soon as a change relevant to MRP is made, the system updates the information in the stock/requirements list.
- As stock/requirements lists are subject to change, they cannot be set with a processing indicator.

Structure

Each MRP list is divided into a header and items.

Material data, such as the material number, the plant, and MRP parameters, is recorded in the MRP list header.

The items, on the other hand, contain information on the individual MRP elements (planned orders, purchase orders, reservations, sales orders, and so on). These are grouped by MRP data into individual planning segments. The beginning of each new planning segment is highlighted. The system carries out the net requirements calculation for each segment separately.
Planning Segments

The following segments are individually displayed and individually planned:

- **Net segment**
  Consists of that part of the list for which the net requirements calculation in planning was carried out on plant level.

- **Gross segment**
  Groups together the gross requirements and the corresponding procurement proposals for gross requirements planning.

- **Storage location segment**
  For every separately planned storage location or for every location, which is not included in MRP.

- **Individual customer segment**

- **Individual project segment**

- **Segment for planning without final assembly**
  Displays the requirements that are planned without final assembly. This means that their procurement is triggered by the incoming sales orders and non-convertible planned sales orders with the order type VP.

- **Segment for direct production planning**

- **Segment for direct procurement planning**

- **Direct production segment**

- **Direct procurement segment**

- **Segment for the provision of material for subcontracting**
Material Requirements Planning

Implementation Options

You use this process, if you are an MRP controller in a medium-sized company and are responsible for the whole of the material requirements planning process and material availability. After a normal MRP run, you check the stock/requirements situation for the planned materials, make necessary changes and save the availability of the materials for the next days.

Prerequisites

- You have completed an MRP run.
- You have configured the lists as you want (for example, a material tree, display of total replenishment lead-time).
  
  See Configuring Access to the Lists [Page 363]
- You have configured the material tree as you want (for example, the materials in the tree are to be grouped according to processing indicator).
  
  See Select Fields in the Tree [Page 365], Sort/Group Fields in the Tree [Page 367]
- You have configured the traffic lights as you want (for example, all materials with dates in the past as well as all materials with terminations are to have a red traffic light).
  
  See Define Traffic Lights [Page 376]

Process Flow

1. You choose collective access to the MRP lists (MD06) from the role-based menu for the MRP controller or from the personal favorites.

2. In the screen for collective access, you select your own materials according to MRP controller and plant and enter that you only want to see materials with new exceptions. The material list appears.

  See Using Collective Access for MRP Lists [Page 320]

3. In the material list, find the materials that have priority for processing with red traffic lights.

  See Searching for Information [Page 328]

4. You copy these materials to the worklist tree. At this point, all of your materials are in the group of materials with unprocessed MRP lists.

  See Material Tree [Page 364]

5. You call up the corresponding MRP list by double-clicking on the material in the tree and check which exception messages for this material have occurred during the total replenishment lead-time.

6. You double-click on every critical MRP element to call up the dialog window with the details for the MRP element. From the dialog window, you access the screen for processing the MRP element and, if necessary, change the dates or quantities after consulting the workshop, customers or vendors. The system then automatically firms the MRP elements, which you have changed manually.

  See Working with Individual MRP Elements [Page 340]
Material Requirements Planning

7. You check, if necessary, the result of the manual changes in the stock/requirements list. For critical quantity changes, you execute, if necessary, a new single-item planning run directly from the MRP list. You can use flexible transaction calls for this.

   See Flexible Transaction Calls [Page 370]

8. If necessary, you convert individual planned orders into production orders and individual purchase requisitions and thereby trigger the production or procurement. (A collective transaction for the conversion of a larger number of MRP elements is available.)

   See Working with Individual MRP Elements [Page 340]

9. Once you have completed the processing of a list, you set the processing indicator. The system automatically moves the material with the processed MRP list in the worklist tree to the group of materials with processed MRP lists.

   See Working with Whole Lists [Page 342]

10. You continue processing the MRP lists until the system has moved all materials in the worklist tree to the group of materials with processed MRP lists.

**Result**

The stock/requirements situation for your materials is cleared again.
Material Information

Implementation Options

- As a production scheduler, buyer, sales executive or MRP controller, you want to access information on the stock/requirements situation of a material and then gain an overview of the development of stock and requirements in the coming week. (1)

- As a production scheduler, you want to gain an overview of the MRP elements for in-house production (planned orders, production orders, process orders, maintenance orders, dependent reservations) or of the MRP elements for a particular production line. (2)

- As a buyer, you want to check which purchase orders and purchase requisitions exist for a material for a particular vendor. (3)

- As a sales executive, you are only interested in the current sales orders for a particular customer for a material. (4)

- In the case of make-to-order production (strategy group 10), sales orders do not increase requirements quantities, because the emphasis of this strategy lies on the smoothing of the demand program. As an MRP controller, you are interested in available quantities on the basis of sales orders that have actually been received and not on the basis of the planned independent requirements. You therefore want the planned independent requirements to be displayed, but do not want to change the available quantity. (5)

- As an MRP controller, you want to be informed about the requirements of bulk materials or materials that are planned using consumption-based planning in order to check whether these requirements occur continually. The system should also occasionally display and, if necessary, settle reservations and dependent requirements for these materials. (6)

Process Flow

11. You choose individual or collective access to the stock/requirements list (MD04/MD07) from the role-based menu for the MRP controller or from the personal favorites.


12. You can use numerous methods of displaying further information for each material. (Scenario 1)

   See Individual Line Display [Page 336], Display of Period Totals [Page 339]

13. If you want to display particular MRP elements but do not want to influence the available quantity calculation, choose a suitable display filter. This limits the display to the MRP elements that are currently of interest to you. (Scenarios 2-4)

   See Filtering Information [Page 330]

14. If you want to display particular MRP elements and want to define whether or not these are to be included in the available quantity calculation, choose a suitable selection rule. This allows you to have a new business view of the data. (Scenarios 5, 6)

   See Filtering Information [Page 330]

15. If you want to always work with a particular display filter or a particular selection rule, you can configure the list so that the display filter and selection rule are fixed settings.
Material Information

See Configuring Access to the Lists [Page 363]
Using Individual Access for Lists

Use
You want to display the stock/requirements situation for a particular material in the MRP list or the stock/requirements list.

Prerequisites
- You have run MRP using single-item planning or total planning.
- For MRP lists only, you have entered in the control parameters for the planning run, that the system should create MRP lists.

Procedure
1. From the MRP menu or the MPS menu, choose the menu path Evaluations → MRP list - material or Evaluations → Stock/reqmts list.
   The system displays the initial screen for the respective list.
2. Enter the following data:
   - the material number of the material, for which you want to call up the list
   - the corresponding plant
   - (if MRP areas have been activated on a client basis) the corresponding MRP area
3. If required, choose a display filter and/or a selection rule (see Filtering Information [Page 330]).
   You define display filters and selection rules in Customizing for MRP in the IMG activity Define display filter and Display selection rule.
   You can only use selection rules for the stock/requirements list.
4. Choose ✔.
   The system displays the descriptions of the chosen settings.
5. Check the settings and choose ✔ again.

Result
The system displays the chosen list.
Using Collective Access for MRP Lists

Use
You want to display the stock/requirements situation for a series of materials in the MRP list.

Prerequisites
- You have run MRP for the materials using single-item planning or total planning.
- You have entered in the control parameters for the planning run that the system should create MRP lists.

Procedure
2. From the MRP or MPS menu, select Evaluations → MRP list collective display.
   You now branch into the collective access screen.
2. In collective access:
   - Enter the plant and one of the following parameters: MRP controller, product group, class or vendor.
     If you do not enter any further selection criteria, the system selects all the materials assigned to this MRP controller, to this product group or to this vendor in the respective plant.
   - If the work with MRP areas is activated for a single client, you enter either the plant (= all MRP areas including the plant MRP area) or only one particular MRP area, and, in addition, either the MRP controller, the product group or the vendor.
     If you do not enter any further selection criteria, the system selects all the materials assigned to this MRP controller, to this product group or to this vendor in the selected MRP area or in all MRP areas. Materials that are assigned to five MRP areas are displayed, where applicable, with five MRP lists.
3. If required, enter further selection criteria.
   - Date: for example, all MRP lists that were created or processed within the last two weeks, or MRP lists for all materials with insufficient stock for the next two weeks.
   - Exception groups: for example, MRP lists for all materials for which the planning run was terminated (exception group 8).
   - Processing indicator: for example, all MRP lists that have not yet been processed.
   - Material data: for example, MRP lists for all materials that are procured externally.
4. If required, choose a display filter (see Filtering Information [Page 330]).
   For example, a display filter that only displays the planned orders for the next two weeks in the stock/requirements list for the materials assigned to a selected MRP controller.

💡 You can save all selection parameters by choosing the menu path Settings → Save. They are then predefined the next time that you access the transaction.
6. Choose 🎈.
   The system displays long texts that describe the chosen settings.

7. Check the settings and choose 🎈 again.

**Result**

The material list appears. This includes all the materials that fulfill your selection criteria (see Sorting Material Lists [Page 324], Creating Worklists [Page 326]).

💡 In the material list, you can display the ranges of coverage and the stock values using graphics and you can do this for more than one material at the same time (see Graphic Display [Page 344], Graphic Display of Lists [Page 346]).
Using Collective Access for Stock/Requirements Lists

Use
You want to display the stock/requirements situation for a series of materials in the stock/requirements list.

Prerequisites
You have run MRP for the materials using single-item planning or total planning.

Procedure

3. From the MRP or MPS menu, select Evaluations → Stock/requirements list collective display. You now branch into the collective access screen.

2. In collective access:
   - Enter the plant and one of the following parameters: MRP controller, product group, class, vendor and production line. In practice, the emphasis lies on the selection by MRP controller.
     If you do not enter any further selection criteria, the system selects all the materials assigned to this MRP controller (or the chosen selection) in the respective plant.
   - If the work with MRP areas is activated for a single client, you enter either the plant (= all MRP areas including the plant MRP area) or only one particular MRP area, and, in addition, one of the parameters MRP controller, product group, class, vendor or production line. In practice, the emphasis lies on the selection by MRP controller.
     If you do not enter any further selection criteria, the system selects all the materials assigned to this MRP controller (or the chosen selection) in the selected MRP area or in all MRP areas. Materials that are assigned to five MRP areas are displayed, where applicable, with five stock/requirements lists.

3. If required, enter further selection criteria.
   - Material data: for example, stock/requirements lists for all materials that are procured externally.
   - File entries for MRP: for example, stock/requirements lists for all materials with a file entry in the planning file.

4. Choose whether the stock/requirements lists should be created in the background first.
   If you select the Set up lists in background field, the lists are created, and the traffic lights, the calculated ranges of coverage and exception messages for the materials are shown in the material list that the system subsequently displays. As the creation of the lists can take a long time, the system displays a confirmation prompt if more than 25 materials are involved.
   If you do not select the field, the lists are not created, and the system displays them without traffic lights, with a calculated range of coverage of 0, and without exception messages in the material list that the system subsequently displays. In this case, the calculation of values in the lists only takes place when the materials are accessed individually.
5. If required, choose a display filter and/or a selection rule (see Filtering Information [Page 330]).

For example, a display filter that only displays the planned orders for the next two weeks in the stock/requirements list for the materials assigned to a selected MRP controller.

You define display filters and selection rules in Customizing for MRP in the IMG activity Define display filter and Display selection rule.

8. Choose .

The system displays the descriptions of the chosen settings.

9. Check the settings and choose again.

Result

The material list appears. This includes all the materials that fulfill your selection criteria (see Sorting Material Lists [Page 324], Creating Worklists [Page 326]).

In the material list, you can display the ranges of coverage and the stock values using graphics and you can do this for more than one material at the same time (see Graphic Display [Page 344], Graphic Display of Lists [Page 346]).
Sorting Material Lists

Verwendung

You can determine that the materials that are in the material list after collective access to the MRP list or stock/requirements list are sorted according to certain criteria. For example, you want to sort the materials alphabetically according to material number.

Prerequisites

You have entered the required selection criteria in the collective access to the MRP list or stock/requirements list and have called up the material list of all the materials that correspond to these criteria.

Procedure

1. Choose 

   The system displays the Sort dialog box.

2. Enter the sequence number by which you want to sort the materials in the material list next to each field.

   You want to sort the Traffic light, Planning plant, MRP area and Material fields in this sequence. Enter:

<table>
<thead>
<tr>
<th>Field</th>
<th>Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traffic light</td>
<td>1</td>
</tr>
<tr>
<td>Planning plant</td>
<td>2</td>
</tr>
<tr>
<td>MRP area</td>
<td>3</td>
</tr>
<tr>
<td>Material</td>
<td>4</td>
</tr>
</tbody>
</table>

   You want to change the defined sequence so that the material is first. Enter the following change:

   | Material | 1 |

   The remaining fields are resorted automatically when you confirm the entry with ENTER.

3. Select the Descending field if you want to sort in descending order.

   A descending sort is only recommended for the following fields:

   - Traffic light
     Materials with red traffic lights, which means those whose processing has priority, are displayed first (red is the highest value, green the lowest).

   - List created (only stock/requirements lists)
     Materials for which a list has been created are displayed first (list created is the highest value, list not created is the lowest value).
Range of coverage

Materials with the highest days' supply, which means those with high stock levels, are displayed first (highest days' supply is the highest value, lowest days' supply the lowest).

Exception group

Materials with the most exception messages in this group are displayed first (the most exception messages per group is the highest value, the least exception messages the lowest).

4. Choose Execute sort to activate the settings for the current display, or to save them permanently.

Result

The materials in the material list are sorted and grouped according to the selected fields.
Creating Worklists

Use
You want the system to create a **worklist of particular materials in the material list.**

Prerequisites
You have entered the required selection criteria in the collective access to the MRP list or stock/requirements list and have called up the material list of all the materials that correspond to these criteria.

The material list includes the following for each material: traffic light, ranges of coverage, the number of exception messages per exception group, the current plant stock, and various other material data.

Procedure
1. In the material list, select the materials for which you want to display the MRP lists or stock/requirements lists:
   - individual materials by clicking on the line
   - all materials by using 
   - a block of materials by clicking on the first and last line and then choose 

   ![Tip]
   You can find the required materials in two ways:
   - with the search function in the material list using . For example, you search for all the materials with stocks that are sufficient for less than two weeks.
   - by sorting the material list using . For example, you sort the material list so that all materials for which an opening date in the past was determined (exception group 1) are displayed first.

2. To access the appropriate list, double-click the first material or choose 

   **Selected stock/requirements lists** or **Selected MRP lists.**

   The system displays the list for the first material.

3. Choose **Show material tree.**

Result
The system displays all the materials that you selected in the material list in a worklist tree on the left-hand side of the screen. Double-click the appropriate material in this tree, or choose and , to change from list to list.
Working with the Lists

Use
The MRP list and the stock/requirements list offer a wide range of information about material availability.

Prerequisites
You have called up the MRP list or the stock/requirements list for a material.

Features
You can show material data, choose between different views, filter information, access information from Customizing settings or from other applications, change between materials as required, and branch to many other transactions.

As for all other tables, you can use the mouse to adjust the sequence and width of all the columns that are displayed as standard in the lists. You can save these settings as display variants by choosing in the upper right-hand corner of the screen beside the table. Please note that this does not include additional columns that the system only displays when they have contents.
Searching for Information

Use
By using this function, you search specifically for particular materials or for particular information for a material.

Prerequisites
- You are in the material list, the MRP list, or the stock/requirements list.
- For searching in the tree: you have displayed the material tree in the form of a worklist tree.

Features

Searching in the Material List or in the Worklist Tree
- Search in the materials (according to name, range of coverage, exceptions, traffic lights and, in the material list for the MRP lists also according to processing indicator)
- Search according to exceptions (in the material list for the MRP lists, also according to new/old exceptions)
  The system only displays the exception messages that actually appear in the materials from the material list or from the worklist tree. The system also displays how often each exception message appears.
- Search according to MRP elements
If you are in the material list, the system selects the materials, which it has found, and goes through the list until the first material that it has found is at the top. If you choose , the system goes through the list until the next material that it has found is at the top.

If you are in the worklist tree, the tree is shortened so that it only includes the materials that meet the search criteria.

💡 If you, as the MRP controller, are looking for materials with new exceptions in the material list for the MRP lists, the system selects all materials that had new, unprocessed exception situations in the last planning run. If you are searching for materials with unprocessed MRP lists, the system selects all materials, for which you have not yet set a processing indicator.

Search in the Lists
- Search according to exceptions
- Search according to segments
- Search according to MRP elements
The system goes through the list until the first element that it has found is on the second line. If you choose , the system goes through the material list until the first element that it has found is displayed on the second line.
Activities
Run the required search.

- In the material list or segregated lists: choose 🔍.
- In the worklist tree: choose 🔍 in the application toolbar directly above the tree.
Filtering Information

Use

- You can use selection rules to define which MRP elements and which stocks are included in the quantity and stock calculation. You hereby define your own business views.
- You can use display filters to define which MRP elements and MRP segments are displayed. This enables you to reduce the information displayed to a clear selection.

You define display filters and selection rules in Customizing for MRP in the IMG activity Define display filter and Display selection rule.

You can only use selection rules for the stock/requirements list, but not for the MRP list.

Prerequisites

You have accessed the initial screen or the main screen of the MRP list or the stock/requirements list.

Features

- A selection rule consists of particular time information, MRP elements and stocks that are grouped together in a rule, which controls the selection (or import) of the data in the stock/requirements list and the planning table for Repetitive Manufacturing:
  - The system only displays MRP elements in the period that is defined in the selection horizon.
  - The system only displays the MRP elements that are selected in the selection rule.
  - Of the MRP elements displayed, the system only takes those indicated as affecting availability in the selection rule into consideration for the calculation of the quantity available and the ranges of coverage.
  - The system only takes the stocks defined in the selection rule into consideration to calculate the unrestricted-use stock.
    This creates a new business view of the data in the lists.

- A display filter consists of particular time information, MRP elements, and MRP segments grouped in a filter that controls the display of the MRP list and the stock/requirements list.
  - The system only displays MRP elements in the period that is defined in the display horizon.
  - The system only displays segments in this period that are selected in the display filter.
  - Within these segments, the system only displays MRP elements that are selected in the display filter and that, if necessary, correspond to particular additional selections (for example, customer, vendor, storage location).
    The data in the lists is thus reduced to a clear selection.
In contrast to selection rules, the calculation of the quantity available and the ranges of coverage is not influenced by display filters.

- You can define the **selection horizon** for the selection rule as well as the **display horizon** and the **additional selections** for the display filter in two ways:
  - company-specific in Customizing
  - user-specific in the respective analysis list

**Activities**

1. Select the *With filter* field (initial screen) or choose (main screen) in order to show the *Display filter* and *Selection rule* fields.
2. Select a display filter and/or a selection rule.
3. Choose * and, if necessary, enter a display horizon for the display filter or a selection horizon for the selection rule, which means a period to which you want to limit the display.
4. Choose * and, if necessary, enter additional selections for the display filter, for example if you want to see MRP elements for a particular vendor or a particular customer.

If you always work with a particular display filter and/or selection rule, choose . The system displays the *Settings* dialog box. Use this to define that this display filter or selection rule should always be activated when you access the lists.
Working with List Header and Material Tree

Use

The list header contains material data from the material master and displays, if necessary, which display filter and which selection rule are active.

In the material tree, you can put together a worklist from the materials that are currently of interest to you.

Prerequisites

You have called up the MRP list or the stock/requirements list for a material.

Procedure

<table>
<thead>
<tr>
<th>Function</th>
<th>How to call up function</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide and show header details for the material</td>
<td>![icon] ![icon]</td>
<td>The header details point to various tab pages for master data and movement data for the material selected. Which tab pages are displayed depends on the MRP type. This enables you to display different data for consumption-based and requirement-based materials. There is a special tab page for the MRP list that shows, amongst other things, that exception messages exist for the chosen material. You define the tab page sequence in Customizing for MRP in the IMG activity Define screen sequence for header details.</td>
</tr>
<tr>
<td>Choose a further unit</td>
<td>Unit field</td>
<td>If different units of measure have been maintained for a material, for example, unit of issue in the warehouse and order unit for purchasing, you can display the lists for this material in two different units of measure at the same time. The system then displays the Receipt/requirement and Available quantity columns twice.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Calculate proportion quantities (only in stock/requirements lists)</td>
<td>For <strong>active ingredient management</strong> only: the system calculates the active ingredient quantity (proportion quantity) from the physical quantity in the proportion unit. To do this, the system reads the actual conversion factor of the batch information. If no batch information is available, it uses the planned conversion factor. The system then displays the <em>Receipt/requirement</em> and <em>Available quantity</em> columns twice. You can find further information on active ingredient management in the SAP document <em>Batch Management</em> under <a href="Ext.">Batch Specific Units of Measure</a></td>
<td></td>
</tr>
<tr>
<td>Display inventory correction factor (only in stock/requirements lists)</td>
<td>For <strong>active ingredient management</strong> only: you can check which inventory correction factor the system has used to calculate stocks. You can find further information on the inventory correction factor in the SAP document <em>Batch Management</em> under <a href="Ext.">Calculating the Inventory Correction Factor</a></td>
<td></td>
</tr>
<tr>
<td>Enter or display material memo</td>
<td>Next to the symbol for the material memo the name and date of the last change are displayed. Material memos are valid for both types of list.</td>
<td></td>
</tr>
<tr>
<td>Set processing indicator (only for MRP lists)</td>
<td>During the next planning run, the exception messages for this material are no longer considered to be new exceptions. This function is also supported in the material list.</td>
<td></td>
</tr>
<tr>
<td>Show and hide material tree</td>
<td><strong>Show/hide material tree</strong></td>
<td></td>
</tr>
<tr>
<td>In the material tree: switch between the worklist tree, the order tree and the product group tree</td>
<td></td>
<td></td>
</tr>
<tr>
<td>In the material tree: select fields in the tree</td>
<td>See [Select Fields in the Tree](Page 365)</td>
<td></td>
</tr>
<tr>
<td>In the material tree: sort and group fields in the tree</td>
<td>See [Sort/Group Fields in the Tree](Page 367)</td>
<td></td>
</tr>
<tr>
<td>In the material tree: define column widths</td>
<td>Change column width using the mouse The column width is lost when you leave the list.</td>
<td></td>
</tr>
</tbody>
</table>
### Working with List Header and Material Tree

<table>
<thead>
<tr>
<th>In the material tree: define column sequence</th>
<th>Drag &amp; Drop the column headers</th>
<th>The column sequence is lost when you leave the list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display material list</td>
<td>![Icon]</td>
<td>See <a href="#">Creating Worklists</a> [Page 326]</td>
</tr>
<tr>
<td>Activate and deactivate display filter and selection rule</td>
<td>![Icon]</td>
<td>See <a href="#">Filtering Information</a> [Page 330]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You define display filters and selection rules in Customizing for MRP in the IMG activity Define display filter and Display selection rule.</td>
</tr>
</tbody>
</table>
**Individual Line Display**

**Use**
All MRP elements are listed individually in an individual line display. With this type of display, you can determine exactly which MRP elements currently have a material shortage.

**Prerequisites**
- You have called up the MRP list or the stock/requirements list for a material.
- You are in the individual line display. Choose if you are still in the period totals display.

**Features**
If you use the global settings, the system displays the following columns for the items:
- Planning date
- MRP element data (short description, number, item, and so on)
- Rescheduling date
- Exception message key
- Receipt and requirements quantities, if necessary in two different units
- Available quantity (planned warehouse stock), if necessary in two different units

By scrolling with the mouse in the section of the screen to the right of the MRP element column, you can also display the following columns: Start/release date, Opening date.

If the corresponding data is available, the system also displays the following columns: Scrap, Production version, Receiving plant, Issuing plant, Stock in transit, Storage location, BOM explosion number, Revision level.

The system only displays the Stock in transit column if you use stock transfer between two plants and only displays it in the receiving plant. The stock in transit is the quantity that is in transport to the receiving plant.

If the corresponding data is available, you can access the customer and vendor columns (Debitor/customer name or Creditor/vendor name) via pushbuttons.
# Individual Line Display

<table>
<thead>
<tr>
<th>Function</th>
<th>Starting the function</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch between period totals display and individual line display</td>
<td>[ ]</td>
<td>If the individual/collective indicator for a material has been set in the MRP data of the material master so that collective requirements can be created, and if there are several dependent requirements for a material for one day, these dependent requirements can be grouped to a collective requirement. The collective requirements are indicated by the [ ] icon, and the number of grouped dependent requirements is displayed. You can expand or collapse either individual or all collective requirements.</td>
</tr>
<tr>
<td>Sorting the individual segments by date of the first requirement or by segment number.</td>
<td>Date, No.</td>
<td></td>
</tr>
<tr>
<td>Display requirements individually or collectively</td>
<td>[ ]</td>
<td>Only for purchasing elements: display goods receipt date or availability date as requirements or receipt date. The availability date is the date resulting from the addition of goods receipt processing time to the goods receipt date, which means the date on which the material is actually available for planning. The availability date is, therefore, after the goods receipt.</td>
</tr>
<tr>
<td>Only for purchasing elements: display goods receipt date or availability date as requirements or receipt date</td>
<td>GR, AV</td>
<td>The requirements are brought forward by the number of days that are defined in the safety time. You define the safety time in the MRP data for the material master (see also Safety Time/Actual Range of Coverage [Page 190]).</td>
</tr>
<tr>
<td>Activate and deactivate safety time</td>
<td>ST on, ST off</td>
<td></td>
</tr>
<tr>
<td>Show and hide total replenishment lead time</td>
<td>On, Off</td>
<td>The system displays the total replenishment lead-time in the list in a separate row. This makes it clear up to which date the replenishment of materials is critical. You define the total replenishment lead-time in the MRP data for the material master.</td>
</tr>
<tr>
<td>Show and hide customer data</td>
<td>Customer</td>
<td>The system displays the Customer and Customer name columns, with customer numbers and customer names, for materials that are procured for a sales order.</td>
</tr>
<tr>
<td>Show and hide vendor data</td>
<td>Vendor</td>
<td>The system displays the <em>Vendor</em> and <em>Vendor name</em> columns, with the vendor name and number, for materials that are procured externally.</td>
</tr>
</tbody>
</table>
Display of Period Totals

Use

MRP elements are grouped by period for the period totals display. This type of display provides you with a faster overview of the development of material availability over time.

Prerequisites

- You have called up the MRP list or the stock/requirements list for a material.
- You are in the period totals display. Choose if you are still in the individual line display.

Features

The daily, weekly, or monthly display is offered as standard. If you have made appropriate settings in Customizing, you can display by accounting period, planning calendar, or by individual period splits.

You define the period display in Customizing for MRP in the IMG activity Define period display for period totals.

The system displays the following columns:

- Planned independent requirement
- Requirement (customer requirements and reservations)
- Receipts (procurement proposals)
- Available quantity
- Actual range of coverage

When there are several procurement proposals for a material within the same period, the system displays cumulative quantities.

If range of coverage profiles have been defined in Customizing, and you have assigned a range of coverage profile to the material in the material master, the system displays additional range of coverage columns (see also Calculating the Statistical Range of Coverage [Page 181]).
# Display of Period Totals

<table>
<thead>
<tr>
<th>Function</th>
<th>Starting the function</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch between individual line display and period totals display</td>
<td>![icon] ![icon]</td>
<td></td>
</tr>
</tbody>
</table>
| Set individual split or planning calendar | ![icon] | See [Configuring Access to the Lists][Page 363]  
You define individual splits and the planning calendar in Customizing for MRP in the IMG activities Maintain planning calendar and Define individual period split for period totals. |
| Display alternative period value | Choose tab index | |
| Set period value, which should be displayed in the foreground as a standard when the function is chosen | ![icon] | See [Configuring Access to the Lists][Page 363] |
| Display individual MRP elements for a period | Double-click on period or click ![icon] | The display is in the form of a split screen. The periods are listed in the top part of the screen. The selected period is highlighted. The system displays the MRP elements, which belong to the selected period in the lower part of the screen. The display in this area of the screen corresponds to that of the individual line display. |
Working with Individual MRP Elements

Use
You have numerous possibilities for accessing information and processing functions for individual MRP elements. You can thus recognize material shortage situations quickly and rectify these by, for example, changing dates or quantities in an MRP element.

Prerequisites
- You have called up the MRP list or the stock/requirements list for a material.
- You are in the individual line display. Choose if you are still in the period totals display.
- If required, you have positioned the cursor on the MRP element, with which you want to work.

Procedure

<table>
<thead>
<tr>
<th>Function</th>
<th>Starting the function</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display information for exception messages</td>
<td>Double-click on the message number of the message text</td>
<td>In the respective list, you access the descriptive text for a message number in the status line by double-clicking the number of the exception message. To access further information about the message, double-click the status line. In the details dialog box for an MRP element, you access further information about an exception message by double-clicking the exception message.</td>
</tr>
<tr>
<td>Display details for an MRP element</td>
<td>Double-click on MRP element or click once and choose</td>
<td>The system gives you additional information about the selected MRP element in a detail dialog box. For a planned order, for example, you are given the order number, order quantity, basic dates, and the two most important exception messages that occurred during the planning run. You can also access the planned order yourself and change quantities or dates convert the planned order directly into a production order create your own link to planned order processing by using (see Define User-Specific Transaction Calls per MRP Element [Page 373])</td>
</tr>
</tbody>
</table>
### Working with Individual MRP Elements

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set manual firming date</td>
<td><strong>Edit → Set firming date</strong></td>
</tr>
<tr>
<td></td>
<td>The manual firming date lengthens, if necessary, the planning time fence (see also Manual Firming Date [Page 445]). This function is only supported in the stock/requirements list.</td>
</tr>
<tr>
<td>Display order report for an MRP element</td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td>In an order report for a planned order, for example, the system determines and displays the dependent requirements with their planned receipt elements. This gives you an overview of the status for all BOM levels, which enables you to recognize possible bottlenecks in material availability much faster.</td>
</tr>
<tr>
<td>Display order tree for an MRP element</td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td>The system shows the order tree in the left section of the screen or you switch to the order tree from the material tree. In the order tree, the system displays all BOM items from the multi-level BOM hierarchically.</td>
</tr>
<tr>
<td>Display pegged requirements for the MRP element</td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
</tbody>
</table>
|                                             | When you display the pegged requirements for a dependent requirement for a raw material, for example, you can trace:  
|                                             |  
|                                             | • which requirements caused the dependent requirement  
|                                             | • which independent requirements, especially sales orders, are endangered by the loss or change in date or quantity of a procurement proposal for this raw material. |
## Working with Whole Lists

### Use

Functions that are relevant for whole lists are, for example, printing, deleting, and setting the processing indicator.

### Prerequisites

You have called up the MRP list or the stock/requirements list for a material.

### Procedure

<table>
<thead>
<tr>
<th>Function</th>
<th>How to call up function</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicate MRP lists as processed or as unprocessed (also possible in material list)</td>
<td>Switch between (unprocessed) and (processed)</td>
<td>The quick-info for the icon displays the date when the MRP list was processed. During the next planning run, the exception messages for a material with a processed MRP list are no longer considered to be new exceptions. You can use the processing indicator in collective access for the MRP lists as a selection criterion.</td>
</tr>
<tr>
<td>Enter or display material memo</td>
<td></td>
<td>Next to the symbol for the material memo the name and date of the last change are displayed. Material memos are valid for a material in all lists.</td>
</tr>
<tr>
<td>Display documents for the material (only appears if documents are available)</td>
<td></td>
<td>Only in the stock/requirements list: The system displays a list of all documents that you have assigned to the material in the material master. When you select a document, the system displays it in an internal or external viewer. You determine the selection of the viewer in Customizing for document management in the IMG activity Define workstation application. You can find further information about the internal viewer under Viewer for Displaying Original Files [Ext.].</td>
</tr>
<tr>
<td>Display stock statistics</td>
<td>Goto → Stock statistics</td>
<td>By using , you receive an apportionment of the cumulative receipts/issues quantities for each field of the stock statistics.</td>
</tr>
<tr>
<td>Display sales statistics</td>
<td>Goto → Sales statistics</td>
<td></td>
</tr>
</tbody>
</table>

*Material Requirements Planning (PP-MRP)*

SAP AG

Working with Whole Lists

342 April 2001
### Working with Whole Lists

<table>
<thead>
<tr>
<th>Task</th>
<th>Menu Path</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reorganize MRP lists</td>
<td><strong>MRP</strong> → <strong>Environment</strong> → <strong>Reorganize MRP lists</strong></td>
<td>The MRP lists that are no longer required are deleted from the database. You can also reach this function via MPS.</td>
</tr>
<tr>
<td>Delete MRP lists manually</td>
<td><strong>MRP list</strong> → <strong>Delete</strong></td>
<td>MRP lists that have not been deleted manually are stored in the system until they are replaced by new lists from a subsequent planning run.</td>
</tr>
<tr>
<td>Display ATP quantity</td>
<td><strong>Environment</strong> → <strong>ATP quantities</strong></td>
<td>The availability overview appears (see Availability Overview [Page 455]). You can set a default checking rule for the calculation of ATP quantities in your personal settings (see Settings [Page 361]).</td>
</tr>
</tbody>
</table>
Graphical Display

Use
Information in the MRP list and the stock/requirements list always refers to a **concrete point in time**: for the MRP list, to the time of the last planning run; for the stock/requirements list, to the time of the transaction call.

You can now use the graphical display to display the **change in the stock situation** for one or more materials over a period of time.

The graphical display has the following advantages:
- You can see outliers (for large procurement quantities or shortage situations) quicker.
- You can compare materials with each other directly.

Integration
The graphical display can be accessed through the collective access to the MRP list or to the stock/requirements list in the respective material list. It cannot be accessed in the individual lists.

Prerequisites
- You have selected the collective access to the MRP list or the stock/requirements list and are now in the material list for the materials selected.
- System administration: you have set up the corresponding authorization for all users, who should have access to the stock value display:
  - authorization object M_MTDI_ORG (organizational levels for material requirements planning)
  - authorization field MDAKT (activity types in materials planning)
  - fixed value W (MRP: stock value display in the collective access graphic).

  ![Note](Note.png) In the standard SAP System, the authorization for displaying stock values is not activated.
- In the material master (*Accounting view*), you have defined a moving price or a standard price for the materials, for which you want to display stock values graphically.

Features
- Displaying the **Range of Coverage**
  The system displays the **actual range of coverage** that is calculated in the MRP list and stock/requirements list in the daily period totals display. As this calculation is only correct to the day, the system enters every value at the end of the day at midnight. The curve begins with the day of the first change involving stocks.

  The x-axis represents **time**. As standard, the system displays a period of 12 calendar weeks (84 days) starting from the current date. You can, however, select a user-defined period.
The y-axis represents the **actual range of coverage** in days. As standard, the system displays a period from +20 to -20 days. You can, however, select a user-defined period. Values from outside of the period selected are not displayed.

- **Displaying the Stock Value**
  
The system displays the value that results from multiplying the sum of the **available quantity and the safety stock** by the **moving price** or the **standard price** from the material master. The available quantity is the quantity that is calculated in the MRP list and stock/requirements list in the daily period totals display. As this calculation is only correct to the day, the system enters every value at the end of the day at midnight.

  The stock values are given in the currency for the material that is selected first in the material list. If the values for the other materials are in different currencies, these are automatically converted into this currency.

  The x-axis represents **time**. As standard, the system displays a period of 12 calendar weeks (84 days) starting from the current date. You can, however, select a user-defined period.

  The y-axis represents the **value** of the material in the respective national currency. The scale of the y-axis is determined by the maximum value of the materials to be entered and cannot be changed.

  You need an appropriate **authorization** in order to **display stock values**.

  The graphical display of stock values only represents guide values and does not take into account that – depending on price conditions or contractual agreements – every goods movement can be valuated theoretically with another price.

  The system can display **up to ten materials** simultaneously. You can define a user-specific setting for the number of materials that can be displayed. As standard, the system displays up to five materials simultaneously.
Graphical Display of Lists

1. In the material list, select a material or several materials.
2. Choose [function].

In the lower screen area, the system displays the graphic for the materials selected.

<table>
<thead>
<tr>
<th>Function</th>
<th>How to call up function</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch to ranges of coverage graphic</td>
<td>[Ranges of coverage]</td>
<td>You need an appropriate authorization in order to display stock values.</td>
</tr>
<tr>
<td>Switch to stock value graphic</td>
<td>[Stock value]</td>
<td>You can define simultaneously and the scope of values for the two axes (for the stock value graphic, only the scope of value for the time axis). These settings apply to both the range of coverage graphic and the stock value graphic. You save the user settings by choosing [function]. By choosing Basic settings, you return to the standard values. You also save the background color for the graphic. You can save different background colors for the range of coverage graphic and the stock value graphic.</td>
</tr>
<tr>
<td>Define user settings</td>
<td></td>
<td>You can define a user-specific setting for the number of materials that can be displayed simultaneously. As standard, the system displays up to five materials simultaneously. If you select 13 materials in the material list, the system groups these in the graphic thus: 1-5, 6-10, 11-13.</td>
</tr>
<tr>
<td>Scroll forward to the graphic for the last group of materials</td>
<td>[function]</td>
<td>If you select other materials in the material list and want to display them in a graphic, you do not need to close the current graphic, but can simply refresh it.</td>
</tr>
</tbody>
</table>
### Graphical Display of Lists

<table>
<thead>
<tr>
<th>Make settings for graphic</th>
<th>Context menu (click on the graphic with right mouse button) or double click on the individual areas of the graphic</th>
<th>The graphic settings are user-specific. For example, you can adjust the colors, the line type, the line width and the axes. You can save only the background color using the dialog box for user settings. You can find further information on graphic settings in the SAP document Business Graphics [Ext.] unter Business Graphics. This documentation is only available in English.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print graphic</td>
<td><img src="image" alt="Print icon" /></td>
<td></td>
</tr>
<tr>
<td>Close graphic</td>
<td><img src="image" alt="Close icon" /></td>
<td></td>
</tr>
</tbody>
</table>
Mail Connection

Use
You can use the mail connection function to send a mail quickly and easily from the MRP list and the stock/requirements list to business partners. This is useful, for example, if exception situations have appeared in the result of the planning run and you want to inform the relevant business partner in writing immediately.

Prerequisites
- System administration: You have set up the SAP System so that external e-mails can be sent and have entered the e-mail addresses for external recipients in the system (for vendors and customers in the vendor master).
- In Customizing for MRP, you have entered a mail recipient (individual recipient or recipient group) for the MRP controller in the IMG activity Define MRP controller.

Features

External E-mail
You can send e-mails to the following external recipients:

- to the vendor, who is assigned to the material in the source list and is flagged as relevant to MRP
  This function is particularly useful with single-source vendors. If several vendors are entered in the source list, the mail addresses of all the vendors, who are flagged as MRP-relevant, appear in the send screen and you can delete any that you do not require.
  You set up this function as a general, flexible transaction call.
- to the vendors entered in a purchase requisition, purchase order or schedule lines
  You set up this function as a flexible transaction call for each of these MRP elements.
- to the customer in a sales order
  You set up this function as a flexible transaction call for the MRP element sales order.

Internal SAP Mail
You can also send a mail to the MRP controller for a material using the internal SAP mail function.
You can choose whether you want to send the mail to an individual recipient or to a recipient group.
You can send a mail to the MRP controller without triggering a workflow. As standard, this function can be accessed using or by choosing Goto → Send mail.
You can also integrate the sending of the mail into a workflow (see Workflow for Mail to MRP Controller [Page 352]). The recipient then receives a work item with the stock/requirements list for the material selected. The recipient must call up the list and close the work item explicitly in order to delete it from the mail inbox. If you send the mail to a recipient group, just one recipient needs to call up the list and close the work item. You set up this function as a general, flexible transaction call.
General Features

The system copies certain parameters directly into the mail and these are internal, and if available, external material number, plant and e-mail address of the recipient or the internal user (if entered in the system). In the case of external e-mail, the system also copies the respective MRP element number. The system does not include the MRP list or stock/requirements list automatically (exception: workflow variant for the mail to the MRP controller).

If you want to send the mail directly to just one MRP controller and include the MRP list or stock/requirements list automatically, you can use the function for variable printing. When using variable printing, the data is displayed in the form of a list that can be processed and printed. A separate mail function also appears, which you can use to send this print list.

You can enter a title, add free text, change the recipient and attach files manually.

See also:
Flexible Transaction Calls [Page 370]
Set up and Start Mail Connection

Procedure

Set up Mail Connection per MRP Element
1. Double-click on the required MRP element (purchase requisition/purchase order/schedule lines or sales order).
   A detail dialog box appears with additional information for the MRP element selected.
2. Choose 🌐.
   The system displays an overview of all the transaction calls that you have already defined for this MRP element.
3. Choose New entries.
4. Enter the required transaction, a pushbutton text or alternatively a combination of icons and icon texts as well as, if necessary, an info text. The following transactions are available:
   - transaction MDM2: for e-mail to the vendor entered in a purchase requisition, purchase order or schedule lines
   - transaction MDM3: for e-mail to the customer in a sales order
5. Enter a navigation number.
6. Save your entries.
   The e-mail connection can be accessed immediately using a pushbutton in the detail dialog box for the MRP element selected. If you use this pushbutton to send the mail, the system checks which customer or which vendor is entered in the MRP element selected and displays this e-mail address in the send screen.

See also:
Transaction Calls per MRP Element [Page 373].

Set up General Mail Connection
1. Choose Environment → Own favorites → Maintain.
2. The system displays an overview of all existing transaction calls.
3. Choose New entries.
4. Enter the required transaction, a menu text or a combination of icons and icon texts as well as, if necessary, an info text. The following transactions are available:
   - transaction MDM1: for e-mail to the vendor from the source list
   - transaction MDM5: for mail to the MRP controller with integration into a workflow (see Workflow for Mail to MRP Controller [Page 352])
5. Enter a navigation number.
6. Save your entries.
   The mail connection can be accessed immediately using a pushbutton in the application toolbar above the respective list.
See also:
Define General Transaction Calls [Page 371]
Workflow for Mail to MRP Controller

Implementation Options

If you integrate the sending of a mail to an MRP controller into a workflow, the system also sends the stock/requirements list automatically and you can be sure that the recipient actually accesses and checks the list.

Prerequisites

- You have set up the permitted users for the workflow in Customizing for MRP in the IMG activity Activate workflow for mail to MRP controller. If you define the workflow tasks as general tasks, all system users can execute the function.
- In Customizing for MRP, you have entered a mail recipient (individual recipient or recipient group) for the MRP controller in the IMG activity Define MRP controller.
- You have set up the sending of the mail per workflow as a general transaction call.

Process Flow

1. You access the sending of a mail to the MRP controller for each workflow by choosing a pushbutton (in the application toolbar above the respective list) or by choosing Environment → Own favorites.
2. You change the mail and save it.
3. The recipient receives a work item in the workflow inbox (SAP menü → Office → Work center → Inbox → Workflow).
4. The recipient opens the work item. It is possible to display:
   - the mail itself
   - the stock/requirements list
   - the material master as an attachment
5. The recipient closes the work item. The work item disappears from the workflow inbox.

💡

If you send the mail to a recipient group, the work item disappears from the inbox of each individual as soon as one person has accessed and closed the work item.
Comparing MRP List and Stock/Requirements List

Use
The MRP list displays the result of the last planning run. Changes that have occurred between planning runs are ignored in the MRP list.

In contrast to this, the system displays all changes in stock, receipts and issues, which have currently occurred, in the stock/requirements list.

By using the MRP list and stock/requirements list comparison you can compare these two evaluations with each other. This means that you can compare the situation at the time of the last planning run with the current stock/requirements situation.

Prerequisites
You have accessed the MRP list or the stock/requirements list.

Procedure

- From the MRP list, choose Goto → Stock/requirements list comparison.
- From the stock/requirements list, choose Goto → MRP list comparison.

Result
You now branch into the comparison screen for both lists.

The system displays the date of the last planning run in the Comparison screen area.

In the Period totals screen area, the system shows the planning result in the period totals display. There are two of each column, that is, one for each list type. They can be told apart optically.

By choosing Stock/requirements list, you branch into the period totals display of the stock/requirements list and by choosing MRP list, you branch into the MRP list.

By double-clicking on a period, you call up the individual line display for the selected period in the lower part of the screen. The system lists all the MRP elements for this period individually.
Checking the Capacity Situation

Procedure

1. Choose Goto → Capacity situation.
   
   The Settings for capacity planning dialog box now appears.

2. Select the required planning type and the period value for capacity planning and, if necessary, choose a period of examination. Choose .
   
   You now branch into the screen for capacity leveling (material view).
   
   For the whole material, the capacity leveling relates to one work center and one capacity category (machine or person) as well as the capacity unit (for example, hours) from the work center.

In this material view of capacity leveling, the same display and processing functions are available as in the order view, that means the view that carries out capacity leveling for just one chosen planned order. For more information, see Working with Capacity Leveling [Page 415].

The following functions are also available:

Display all Planned Orders for a Material and Execute Capacity Leveling

Choose Planned orders for material.

The Planned orders dialog box appears with a list of all planned orders.

Position the cursor on the required planned order and choose Choose.

In the Planned order screen area, you can change the dates or quantity of the planned order selected. The system plans the order again immediately.

Access Capacity Planning Table

Choose Planning table.

The system displays the capacity planning table.

The capacity planning table allows operation-oriented dispatching.
Printing Individual Lists

Prerequisites
You are in the material list, the MRP list, or the stock/requirements list.

Procedure

Standard Print (Only in the Lists)
Choose \texttt{Print} or the menu path List $\rightarrow$ Print, and enter the necessary print settings.

A standard version of the lists is printed. This standard version does not necessarily correspond to the settings that you have made for the screen.

Variable Print

1. Choose \texttt{Print} (material list) or List $\rightarrow$ Variable print (individual lists).
   The system displays a printable and changeable list, which corresponds exactly to the settings that you have entered on the screen. In this list, you can sort and filter information, define column sequence and column width and, if required, save the settings in display variants. You can find further information on this under ABAP List Viewer in the introduction to the SAP System in the SAP Library.

2. Start printing from this list by choosing \texttt{Print}.
Printing Several MRP Lists

Printing Several MRP Lists

Printing Online

1. Starting from the MRP or MPS menu, select Evaluations → Print MRP list.
   
   The selection screen for printing MRP lists appears.

2. Enter the required selection parameters (see Using Collective Access for MRP Lists [Page 320]).

3. Choose 🔄.
   
   You now branch into the print parameters screen.

4. Enter the necessary print parameters.

5. Choose Continue.

   The system creates the print request.

Printing in the Background

1. Starting from the SAP Easy Access menu, select System → Services → Background job → Define job.

   The initial screen for defining background jobs appears.

2. In the Job field enter the program name RMDLDR00.

3. Enter a priority in the Job class field.


   The Start date values screen appears.

5. Enter the required start date.

6. Save your entries on this screen.

7. Choose 🔄 Step.

   You now branch into the Create step 0 screen.

8. Choose ABAP program.

9. In the Name field enter the program name RMDLDR00 again.

10. Choose a program variant in the Variant field by using F4.

    The selection parameters for printing MRP lists are defined in the variant.

    If no variant has been created, contact your system administrator.

11. Save your entries on this screen.

12. Choose Job → Save to save the whole job.

    The system creates the background job.
Navigation Between Information

Use
There are numerous possibilities for displaying information for a material or for Customizing from the MRP list or stock/requirements list quickly and easily, for calling up other materials or branching into other transactions. You can thus set up your work station around the MRP list or the stock/requirement list so that all of your activities can be executed from there and you do not have to leave the transaction.

Prerequisites
You have called up the MRP list or the stock/requirements list for a material.

Procedure

<table>
<thead>
<tr>
<th>Function</th>
<th>Starting the function</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access to lists for the same material in different plants/MPR areas.</td>
<td>F4 possible entries help on the Plant or MRP area field</td>
<td>The system only proposes the plants or MRP areas in which the material is actually available. If the material is not available in any other plant, the fields are not ready for input. The material in the new plant or MRP area is directly added to the material tree.</td>
</tr>
<tr>
<td>Access to lists for other materials</td>
<td>Double-click on a material in the material tree or overwrite the material number in the list header and confirm with Enter</td>
<td>If necessary, the new material is added directly to the material tree.</td>
</tr>
</tbody>
</table>
### Navigation Between Information

<table>
<thead>
<tr>
<th>Display Customizing settings</th>
<th>Double-click on the fields</th>
<th>Double-click the <em>Lot size</em> entry field, for example, in the header details for the material, to branch directly to Customizing for lot sizes. The system displays the appropriate information, but you are not able to make any changes. You must have the corresponding authorization to display tables. Further entry fields that branch to Customizing are, for example, <em>MRP type</em>, <em>Coverage profile</em>, <em>MRP controller</em>, <em>Special procurement</em>, and <em>Strategy group</em>. The <em>Display horizon and selection rule</em> fields also branch to Customizing. You activate these by double-clicking on the field label itself after you have set a display horizon or selection rule. Fields that you can double-click are highlighted.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display data from other applications (material master and so on)</td>
<td>Double-click on the fields</td>
<td>Double-click a material number to branch to the material master without exiting the transaction. Further fields from which you can branch to applications are, for example, <em>Vendor</em> (vendor master) and <em>Customer</em> (customer master). Fields that you can double-click are highlighted.</td>
</tr>
<tr>
<td>Use fixed branches to other transactions.</td>
<td>Environment</td>
<td>Environment → Navigation profile → Assign You assign yourself a company-specific navigation profile that corresponds to your user role and provides you with a fixed record of general transaction calls and transaction calls per MRP element. You define navigation profiles in Customizing for MRP in the IMG activity Define navigation profiles.</td>
</tr>
<tr>
<td>Use fixed branches for a navigation profile</td>
<td>Environment</td>
<td>You assign yourself a company-specific navigation profile that corresponds to your user role and provides you with a fixed record of general transaction calls and transaction calls per MRP element.</td>
</tr>
<tr>
<td>Create user-specific branches to other transactions</td>
<td>See Define User-Specific General Transaction Calls [Page 371] and Define User-Specific Transaction Calls per MRP Element [Page 373]</td>
<td></td>
</tr>
</tbody>
</table>
User-Specific Configuration of the Lists

Use

You have numerous possibilities for selecting and formatting the data in the MRP list and the stock/requirements list. Working with the lists is thus more flexible and simpler, and system performance is enhanced.

Prerequisites

You have called up the MRP list or the stock/requirements list for a material.

Features

- Definition of settings to access the lists
  
  You define which settings are activated as standard when you access the MRP list and the stock/requirements list (material tree, header details, filter, company-specific navigation profile, period totals display, and so on) and select a filter, navigation profile, and period split, as required. You can save the settings (see Configuring Access to the Lists [Page 363]).

- Navigation between materials in the material tree
  
  - Double-click on a material in the material tree to directly access the list for the chosen material.
  
  - You can switch the material tree between the worklist tree, the order tree and the product group tree.

- You select which information is displayed in the material tree, sort/group the materials displayed as you require, and save the settings (see Material Tree [Page 364], Select Fields in the Tree [Page 365], Sort/Group Fields in the Tree [Page 367]).

- Definition of user-specific transaction calls
  
  You enhance the company-specific navigation profiles, which are available to all users, by adding user-specific transaction calls for the transactions to which you want to branch from the lists. As with the company-specific navigation profiles, you can use general transaction calls, which means that they refer to the material, and specific transaction calls, which refer to individual MRP elements (see Flexible Transaction Calls [Page 370], Define User-Specific General Transaction Calls [Page 371], Define User-Specific Transaction Calls per MRP Element [Page 373]).

- Configuration of the columns in the lists
  
  You adapt the sequence and width of all the columns that are displayed as standard to your needs. You do this with the mouse and save the settings in display variants, using in the upper part of the screen, on the right-hand side of the table. This does not include additional columns that the system only displays when they have contents. You can find further information on this under Table Settings in the introduction to the SAP System in the SAP Library.

- Saving selection parameters for the collective access to the MRP list
User-Specific Configuration of the Lists

In the collective access to the MRP list, you save the settings for selecting data and limiting the selection (see Using Collective Access for MRP Lists [Page 320]).

- Definition of traffic light values

  The system displays the material with particular traffic light values (red, yellow, green) in the material lists for the collective access and in the worklist tree. Red traffic lights next to certain materials indicate immediately that these materials are critical and urgently need to be processed. The traffic light display is controlled by ranges of coverage and exception groups. You change the standard settings for traffic light values according to your needs and save them (see Define Traffic Lights [Page 376]).

- Definition of print settings

  Before you print material lists and individual lists, the system displays a list, which you can print and edit. In this list, you sort and filter information, define column sequence and column width and save the settings in display variants. You can find further information on this under ABAP List Viewer in the introduction to the SAP System in the SAP Library.
Settings

Use
You have numerous possibilities to control the selection and format of data in the MRP list and the stock/requirements list so that your own work with the lists is supported to an optimum.

You always want to work with a particular preselected filter, or you always want to display the header details for a material and the material tree.

Features
In the Settings dialog box, you are provided with the following settings on various tab pages:

- Display of header details for the material (see Working with List Header and Material Tree [Page 332])
- Display of the material tree (see Material Tree [Page 364])
- Sort for the individual segments (see Individual Line Display [Page 336])
- Activation of the individual segments (see Individual Line Display [Page 336])
- Display of period totals (see Display of Period Totals [Page 339])
  You define the activation of the period totals display and select a particular period value, which means Days, Weeks or Months. If you have made corresponding settings in Customizing, you can also select Posting periods, Individual split or Planning calendar. The period value that you select determines which tab page is preferred in the period totals display and is therefore displayed in the foreground.
  If you want to preset the period values planning calendar or individual split, certain standard settings in Customizing determine which planning calendar or which individual split is activated. You can overwrite these standard settings by selecting different values.
- Definition of requirement/receipt date (see Individual Line Display [Page 336])
- Activation of the safety time (see Individual Line Display [Page 336])
- Display of total replenishment lead-time (see Individual Line Display [Page 336])
- Activation and selection of display filter and selection rule (see Filtering Information [Page 330])
- Selection of the unit of measure
  You define that calculations in the lists are not based on the base unit of measure, but are based on the order unit or the unit of issue, for example. The setting refers to the first of the two possible units in which the receipts or requirements, and the quantity available, can be displayed.
  All materials for which this alternative unit of measure is maintained are then displayed with the selected unit. The system also uses this unit for calculations in the detail dialog boxes for the individual MRP elements.
- Selection of the checking rule for the ATP display
Settings

You define by which validation rule the availability check (or the missing parts check in inventory management) is carried out (see also Availability Check According to ATP Logic [Page 447], Availability Check for Components in the Planned Order [Page 417]).

If you select a checking rule here, it is copied to the initial screen for the availability overview. If you then choose the menu path Environment → ATP quantities and branch to the availability overview, the system skips the initial screen.

- Assignment of company-specific navigation profiles (see Flexible Transaction Calls [Page 370]).
Configuring Access to the Lists

Prerequisites

- You have called up the MRP list or the stock/requirements list for a material.  

  The settings are valid for both types of list.

- You have defined the required settings in Customizing for MRP for:
  
  - screen sequence of the header details (IMG activity *Define screen sequence for header details*)
  
  - individual splits and planning calendar (IMG activity *Define individual period split for period totals, Define period display for period totals and Maintain planning calendar*)
  
  - display filter and selection rule (IMG activity *Define display filter and Define selection rule*)
  
  - Navigation profile (IMG activity *Define navigation profile*)
  
  - Checking rule (IMG activity *Define availability check for components*)

Procedure

1. Choose 

   The system displays the *Settings* dialog box.

   When you access the dialog box, it shows the settings activated in the selected list and not those that you saved last.

2. Select the required settings on the different tab pages.

3. If required, choose a display filter, selection rule, company-specific navigation profile, and period split using F4.

4. Choose 

   to activate the settings for the current display, or 

   to save them permanently.

   Choose *Basic settings* to always return to the standard settings provided by SAP.

Result

The settings are copied to the display and, if you have saved them, are activated every time you access the lists.
Material Tree

Use
The material tree is a structure tree, which you can display on the left-hand side of the MRP list and the stock/requirements list. The system includes certain materials in the material tree automatically:

- all the materials that you have selected in the material list during collective access to the MRP list or the stock/requirements list
- all the materials, for which you call up an MRP list or a stock/requirements list during a working session.

When you leave the transaction, the selection of materials is lost.

Features
You can switch the tree between:

- worklist tree (all materials that you have processed in the respective transaction calls, or all materials that you selected in the material list)
- order tree (all assemblies or components for a selected MRP element according to the order report)
- product group tree (all materials and sub-product groups of a product group, only for access to the lists via product group)

Double-click a material in the material tree to branch directly to the corresponding MRP or stock/requirements list.
Select Fields in the Tree

Use
You can define which fields are shown in the material tree and in which sequence they are arranged.

You can carry out the definition of the fields and their sequence, independently of each other, in the following applications:

- MRP list for operational planning
- MRP list for long-term planning
- Stock/requirements list for operational planning
- Stock/requirements list for long-term planning

Prerequisites
- You have called up the MRP list or the stock/requirements list for a material.
- You have displayed the material tree.

Procedure
4. Choose the menu path...
The system displays the Define fields and sequence dialog box.
5. Enter a sequence number next to each field that you want to be displayed in the tree.

You want to display the Processed MRP lists, Traffic light, Material, MRP area, Material description fields in this sequence. Enter:

<table>
<thead>
<tr>
<th>Processed MRP lists</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traffic light</td>
<td>2</td>
</tr>
<tr>
<td>Material</td>
<td>3</td>
</tr>
<tr>
<td>MRP area</td>
<td>4</td>
</tr>
<tr>
<td>Material description</td>
<td>5</td>
</tr>
</tbody>
</table>

You want to change the defined sequence so that the traffic light is first. Enter the following change:

| Traffic light | 1 |

The remaining fields are resorted automatically when you confirm the entry with Enter.

6. Choose Copy settings to activate the settings for the current display, or to save them permanently.
Select Fields in the Tree

**Result**

The system displays the selected fields in the defined sequence in the material tree.

💡

You can change the sequence of the fields in the current display by moving the relevant column header to a new position using the mouse.
Sort/Group Fields in the Tree

Use
You can define that the materials in the tree are sorted.

You require the system to display materials with red traffic lights or materials for which you have not yet processed the MRP list at the top.

You can also define grouping.

You want to display material with red traffic lights first and to group by traffic light values. You then have a hierarchy in which you can expand and collapse the substructure with the appropriate materials for each of the three traffic light values. The display in the tree is thus clearer and more flexible.

You can carry out grouping and sorting of the fields independently of each other in the following applications:

- MRP list for operational planning
- MRP list for long-term planning
- Stock/requirements list for operational planning
- Stock/requirements list for long-term planning

Prerequisites
- You have called up the MRP list or the stock/requirements list for a material.
- You have displayed the material tree.
- You have defined which fields are displayed in the tree.

Procedure
7. Choose ☰.

The system displays the Group/sort dialog box.

8. Enter the sequence number by which you want to sort the materials in the material tree next to each field.

You want to sort the Processed MRP lists, Traffic light, Material, MRP area and Material description fields in this sequence. Enter:

<table>
<thead>
<tr>
<th>Field</th>
<th>Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processed MRP lists</td>
<td>1</td>
</tr>
<tr>
<td>Traffic light</td>
<td>2</td>
</tr>
</tbody>
</table>
Material Requirements Planning (PP-MRP)

Sort/Group Fields in the Tree

<table>
<thead>
<tr>
<th>Field</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material</td>
<td>3</td>
</tr>
<tr>
<td>MRP area</td>
<td>4</td>
</tr>
<tr>
<td>Material description</td>
<td>5</td>
</tr>
</tbody>
</table>

You want to change the defined sequence so that the traffic light is first. Enter the following change:

Traffic light | 1

The remaining fields are resorted automatically when you confirm the entry with Enter.

9. Select the *Descending* field if you want to sort in descending order.

A descending sort is only recommended for the following fields:

*Traffic light*

Materials with red traffic lights, which means those whose processing has priority, are displayed first (red is the highest value, green the lowest).

*List created* (only stock/requirements lists)

Materials for which a list has been created are displayed first (list created is the highest value, list not created is the lowest value).

*Range of coverage*

Materials with the highest days’ supply, which means those with high stock levels, are displayed first (highest days’ supply is the highest value, lowest days' supply the lowest).

*Exception group*

Materials with the most exception messages in this group are displayed first (the most exception messages per group is the highest value, the least exception messages the lowest).

10. Select the *Group* field when materials in the material tree that have the same value in a particular field, a red traffic light for example, are to be grouped and arranged in that order.

Group and sort are coactive. Fields that you want to group must be at the top of the sort.

You want to sort as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Priority (sort)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning plant</td>
<td>1</td>
</tr>
<tr>
<td>Material type</td>
<td>2</td>
</tr>
<tr>
<td>ABC indicator</td>
<td>3</td>
</tr>
</tbody>
</table>

You want to group by material type within the sort. For this sort, you can not set the group indicator for material type alone. You must either group additionally by
planning plant or change the sort so that the material type has the highest priority within the sort.

The correct setting is:

<table>
<thead>
<tr>
<th>Field</th>
<th>Group</th>
<th>Priority (sort)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning plant</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Material type</td>
<td>X</td>
<td>2</td>
</tr>
<tr>
<td>ABC indicator</td>
<td></td>
<td>3</td>
</tr>
</tbody>
</table>

or

<table>
<thead>
<tr>
<th>Field</th>
<th>Group</th>
<th>Priority (sort)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material type</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Planning plant</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>ABC indicator</td>
<td></td>
<td>3</td>
</tr>
</tbody>
</table>

11. Choose *Execute sort* to activate the settings for the current display, or [ ] to save them permanently.

**Result**

The materials in the material tree are sorted and grouped by the selected fields.
Flexible Transaction Calls

Use
You can define your own transaction calls for the MRP list and stock/requirements list. These transactions are subsequently displayed in the menu or as pushbuttons with icons and texts, so that you can access them without leaving the list display.

Features
You can use two types of transaction calls:

- **General transaction calls**
- **Transaction calls per MRP element**

You can define an unlimited number of transaction calls. However, the display is limited to five general transaction calls and two transaction calls per MRP element. The system displays the first five or the first two transaction calls that are valid for the respective context.

You can also assign yourself a company-specific navigation profile that corresponds to your user role, under the menu path Environment → Navigation profile → Assign. You then have direct access to a fixed record of general transaction calls and transaction calls per MRP element without having to define the branches yourself.

You define navigation profiles in Customizing for MRP in the IMG activity Define navigation profiles.
Define General Transaction Calls

Use

General transaction calls are valid for all materials. Example: Display BOM, display planning file entries.

Prerequisites

You have called up the MRP list or the stock/requirements list for a material.

Procedure

1. Choose Environment → Own favorites → Maintain.
   
   The system displays an overview of all existing transaction calls.

2. Choose New entries.

3. Choose Examples.

   The system displays a list of popular transaction calls that are available in the standard SAP System. The examples are defined in Customizing in navigation profile SAP0000000.

4. Select the required transaction call.

   The predefined parameters for the selected transaction call are copied to the screen. The predefined parameters can include the menu text, icon, icon text, quick info text, predefined parameters for fields in the initial screen, restrictions, and the application area. The menu text is displayed in the menu, under Environment, and a pushbutton with the icon and the text is shown in the application toolbar.

   You can test the new branch by using the menu entry or the pushbutton.

5. Change the navigation number so that it matches your own numbering system.

   The navigation number controls which of the transaction calls that have been created are offered as a branch and in which sequence in the respective transaction.

   If there are more than five valid transaction calls for the material displayed, which means transaction calls for which the material corresponds to the defined conditions, the system displays the five with the lowest sequence number.

6. Save the transaction call.

Result

The transaction call is immediately available in the MRP list and the stock/requirements list. The defined menu text is displayed in the menu, under Environment → Own favorites. In addition, a pushbutton with an icon and text is displayed.

💡

The link is only available when the material whose list is displayed corresponds to the defined conditions. Example: A link that is only valid for in-house produced materials (procurement type E) is not displayed for externally procured materials.
Define General Transaction Calls

You are not dependent on the examples provided. You can define new transaction calls according to your requirements.
Transaction Calls per MRP Element

Use
Transaction calls per MRP element are valid, for example, for production orders only, or for purchase requisitions only. Example of transaction call for purchase requirement: Release purchase requirement.

Prerequisites
- You have called up the MRP list or the stock/requirements list for a material.
- You have accessed the Details dialog box for an MRP element, by double-clicking on the MRP element.

Procedure
7. Choose .  
The system displays an overview of all the transaction calls for this MRP element.
8. Choose New entries.
9. Choose Examples.
   
The system displays a list of popular transaction calls that are available in the standard SAP System.
   
   Examples are available for the MRP elements purchase requisition, purchase order, production order, process order, sales order stock, and project stock.
10. Select the required transaction call.
    
The system displays the predefined parameters for the selected transaction call (pushbutton text, icon, icon text, quick info text, predefined parameters for fields in the initial screen, restrictions, application area). A pushbutton with icon and text is displayed on the screen.
    
You can use this pushbutton to test the new link.
11. Change the navigation number so that it matches your own numbering system.
    
The navigation number controls which of the transaction calls that have been created are offered as a branch and in which sequence in the respective transaction.
    
If there are more than two transaction calls for the MRP element in the defined application area (operational planning or long-term planning), the system displays the two with the lowest sequence numbers.
12. Save the transaction call.

Result
The transaction call is immediately available as a pushbutton in the detail dialog box for this MRP element.
You are not dependent on the examples provided. You can define new transaction calls according to your requirements.
Traffic Lights

Use

Materials are indicated with red, yellow, and green traffic lights in the material tree and in the material lists for the MRP list and for the stock/requirements list.

The traffic light values (red, yellow, green) indicate how urgently materials need to be processed. Red traffic lights immediately indicate that the appropriate materials are critical and urgently need to be processed.

Integration

The traffic light display is controlled by ranges of coverage and exception groups. As standard, a red traffic light is displayed when the days’ supply, receipt days’ supply 1, or receipt days’ supply 2 are less than or equal to zero, or when an exception message for group 8 is displayed. You can change and save these settings on a user-specific basis under the menu path Settings → Define traffic light.

For more information on these ranges of coverage, see Days’ Supply and Receipt Days’ Supply [Page 192].

⚠️ Do not mistake traffic lights for the processing indicator!
Define Traffic Lights

Use

Use the exception groups to define under which conditions materials are indicated by red, yellow, or green traffic lights. Example: You want all materials, whose dates lie in the past, to be indicated by a red traffic light.

The definition of traffic lights applies to both types of list.

Prerequisites

- You have accessed the material list in collective access, or the MRP list or stock/requirements list for a material.
- In case of individual lists: you have displayed the material tree.

Procedure

1. Choose .
   
The system displays the Define traffic light dialog box.

2. Enter the number of workdays for the parameters Days' supply, 1st receipt days' supply and 2nd receipt days' supply, and under which circumstances the materials are to be displayed with red, yellow, and green traffic lights.

   You want the traffic light to be red when the days' supply for a material is <= 0, yellow when the days' supply is > 0 and <= 10 days, and green when the days' supply is > 10 days.

   Enter:

<table>
<thead>
<tr>
<th>Days' supply</th>
<th>Red</th>
<th>Yellow</th>
<th>Green</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0</td>
<td>10</td>
<td>999.9</td>
</tr>
</tbody>
</table>

3. Use the exception groups to define under which conditions materials are indicated by red, yellow, or green traffic lights.

   You want materials with exception messages in exception group 4 to be indicated by a yellow traffic light and materials with exception messages in exception group 5 to be indicated by a red traffic light.

   Choose:

<table>
<thead>
<tr>
<th>Exception group 4</th>
<th>Red</th>
<th>Yellow</th>
<th>Green</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exception group 5</th>
<th>Red</th>
<th>Yellow</th>
<th>Green</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Define Traffic Lights

4. Choose ✅ to activate the settings for the current display, or ❌ to save them permanently.

**Result**

The system sets the traffic light for the material after taking the settings for all the ranges of coverage and all the exception groups into consideration.

A material with a days' supply of 12 days would be indicated by a green traffic light if the settings above were entered. However, if there was an exception in exception group 5 and exception group 5 was indicated by red, the material would be indicated by a red traffic light.
Report RMDMRPLIST: Displaying Planning Data over the Internet

Use
You can use the report RMDMRPLIST to enable your external vendors to display particular planning data over the Internet. The vendor logs on to your system over the Internet and can access an overview of the planning data for a selection of materials. The vendor does not need to have a SAP System. The vendor can thus get an overview of the orders that you, as the manufacturer, have scheduled for the vendor in the near future, and can adjust planning accordingly.

Prerequisites
You have set up a user for each vendor in your system and allocated the user to the vendor in the user maintenance function over References.

Features
The planning data that can be displayed deals generally with the data that is saved as the planning run result in the MRP list. The system displays this data simultaneously in one long list for all the materials selected. You can expand or collapse the sub-lists within the whole list.

Which of the available data can be displayed depends on whether there is only one vendor (single-sourcing) or several vendors (multi-sourcing) for a material.

- **Single-sourcing**: the system displays all requirements and receipt elements, which are assigned to the respective vendor, for the materials selected.
- **Multi-sourcing**: the system does not display requirements and available quantities, but only the receipt elements, which are assigned to the respective vendor, for the materials selected. The system displays the receipt elements for other vendors but only on an anonymous basis.

The system also displays:
- both the internal and external material number
- ranges of coverage
- rescheduling proposals
- exception messages in text form

The vendor can sort the list with the data displayed as required, change the layout and total the receipts and requirements values.

Activities

Create Variant for the Report

1. Do not enter a vendor. If the external vendor logs on to your system and starts the report, the system automatically uses the vendor that is entered in the user master record.

2. Choose the display filter SAP_ALL for single-source materials and the display filter SAP_LIF1, SAP_LIF2 or SAP_LIF3 for multi-source materials. These filters are included in
the standard system. You can, however, define your own filters (IMG activity Define display filter in Customizing for MRP).

3. If you do not want the vendor to see information about rival vendors, choose Only single-source materials.

4. If you do not want information that the MRP controller has not yet checked and released to be displayed, choose Only processed MRP lists.

5. Enter a plant (required entry field).

6. Hide at least the Vendor, Single-source display filter and Multi-source display filter fields and better still, all the fields in the group boxes View and Organizational unit. If you want the vendor to be able to enter further selections within the variant, these fields remain hidden from the vendor. SAP recommends, however, that the system administrator enters all the variants and that you do not grant the vendor access.

**Insert the Report in a Role**

1. Create a role for all or a group of external vendors who are to be handled in the same way (transaction pfcg, documentation for the maintenance of roles is included in the transaction itself) or choose an existing role that is suitable.

   As standard, the report is delivered with the Role for vendors SAP_MM_PUR_SUPPLIER_LOGISTICS.

2. Insert the report together with a variant into the role. SAP recommends that you select the Skip selection screen field. The vendor then jumps straight to the list of results when starting the report and cannot enter any personal selections.

3. Enter the vendors as the users for the role.
Planning Result and Planning Situation

**Use**

The **planning result** displays the result of the last planning run (as in the **MRP list**). The **planning situation** takes all changes in stock, receipts and issues that occur between planning runs into account (as in the **stock/requirements list**). They are different to the lists mentioned in that you set up a **special evaluation layout** for the formatting of the data in the planning result and planning situation. This layout defines which receipt and issue elements are displayed at which level of aggregation.

**Features**

You can work either with the SAP standard layouts or define your own individual layouts. You define evaluation layouts in Customizing for MPS in the IMG activities **Define hierarchy elements**, **Define evaluation profiles** and **Define layout**.

The use of evaluation layouts is not just restricted to MPS, but can be used generally in MRP.

**Structure of Evaluations**

The evaluations consist of a header and the evaluation matrix.

- The **evaluation header** contains the material data (for example, material number, material description, plant, unit of measure). By choosing **View → Header → Detailed header**, you can display additional material data.

- The **evaluation matrix** contains the individual hierarchy and MRP elements, classified consecutively.

  The hierarchy elements determine the structure of the evaluation. They specify under which heading and in which order the MRP elements are grouped together. This means, for example, that receipts can be subdivided into receipts produced in-house and receipts procured externally. In this example, "Receipts" represents the top level of the hierarchy and "receipts produced in-house" and "receipts procured externally" represent subordinate levels.

  The planning data is displayed in a planning matrix: the lines represent the hierarchy and MRP elements and the columns represent the periods of the display. The points of intersection represent the (cumulated) receipts or issues in the corresponding periods.

**See also:**

[MRP List and Stock/Requirements List](#) [Page 313]
Using Individual Access for Planning Result/Planning Situation

1. From the MRP or MPS node, choose **Evaluations → Planning result or Planning situation material.**
   The system displays the initial screen for the respective evaluation.

2. Enter the **material**, the **plant**, (if MRP areas have been activated on a client basis) the **MRP area** and the **layout**.

3. Choose twice.
   The system displays the overview screen for the evaluation selected.
## Working with Planning Result and Planning Situation

In the display of the planning result or the planning situation, you have the following processing options:

<table>
<thead>
<tr>
<th>Function</th>
<th>How to call up function</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open and close hierarchy elements</td>
<td>Click on an element that is highlighted in color</td>
<td>The level directly below the element is opened or closed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On the lowest level, a detail dialog box with a list of all related MRP elements appears.</td>
</tr>
<tr>
<td>Display MRP elements for a particular period</td>
<td>Click on a period that is highlighted in color (column header)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can scroll through columns or pages.</td>
</tr>
<tr>
<td>Change the period display</td>
<td>View → Time axis → &lt;required period&gt;</td>
<td>As standard, the evaluation is displayed in monthly periods.</td>
</tr>
<tr>
<td>Change unit of measure used for display</td>
<td>View → Unit → Unit of measure</td>
<td>In the SAP Standard System, the quantities of the MRP elements in the display are displayed in the base unit of measure. If you have maintained alternative units of measure in the material master (for example output or order unit) or if the unit of measure can be converted into another unit (for example kilo into tons), the elements can also be displayed in these alternative units of measure.</td>
</tr>
<tr>
<td>Choose value display instead of quantity display</td>
<td>View → Unit → Valuation price</td>
<td>By choosing View → Unit → Price unit, you can select other price types and currencies.</td>
</tr>
<tr>
<td>Display MRP segments</td>
<td>Edit → Choose segment</td>
<td>The system displays data only for the segment selected. The system shows which segment it is in the header of the evaluation.</td>
</tr>
<tr>
<td>Display and change MRP element</td>
<td>Click on the MRP element and then ⏯️ or ⏯️ in the detail dialog box</td>
<td></td>
</tr>
<tr>
<td>Convert MRP element</td>
<td>Click on the MRP element and then the appropriate function in the detail dialog box</td>
<td></td>
</tr>
</tbody>
</table>
### Working with Planning Result and Planning Situation

<table>
<thead>
<tr>
<th>Action</th>
<th>Instructions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display pegged requirements or order report</td>
<td>Click on the MRP element and then or in the detail dialog box</td>
<td>For more information, see Pegged Requirements [Page 394] and Order Report [Page 398].</td>
</tr>
<tr>
<td>Display warehouse stock (only for planning situation)</td>
<td>Goto → Warehouse stock</td>
<td></td>
</tr>
<tr>
<td>Display the composition of a hierarchy element</td>
<td>Position the cursor next to a hierarchy element, and choose Goto → Evaluation Profile.</td>
<td>A list of MRP elements that belong to the hierarchy element selected appears.</td>
</tr>
<tr>
<td>Save the evaluation layout</td>
<td>Planning situation or Planning result → Save layout</td>
<td>If you defined an individual period split in Customizing, you can enter this period split here. The same layout appears again the next time that you access the evaluation.</td>
</tr>
<tr>
<td>Set processing indicator for planning result</td>
<td>Edit → Mark as processed</td>
<td>The processing indicator is not visible in the planning result itself.</td>
</tr>
<tr>
<td>Delete planning result</td>
<td>Planning result → Delete document</td>
<td>If you do not delete the planning result manually, it remains in the system until a new planning result is created by a subsequent planning run.</td>
</tr>
<tr>
<td>Print evaluation</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Using Collective Access for Planning Result

1. From the MRP or MPS menu, select Evaluations → Planning result collective display.
   
   You now branch into the collective access screen.

2. In collective access:
   - Enter the plant and one of the parameters MRP controller or product group.
     
     If you do not enter any further selection criteria, the system selects all the materials assigned to this MRP controller or this product group in the respective plant.
   - If the work with MRP areas is activated for a single client: you enter either the plant (= all MRP areas including the plant MRP area) or only one particular MRP area, and, in addition, either the MRP controller or product group.
     
     If you do not enter any further selection criteria, the system selects all the materials assigned to this MRP controller or this product group in the selected MRP area or in all MRP areas. Materials that are assigned to five MRP areas are displayed, where applicable, with five MRP lists.

3. If required, enter further selection criteria.
   - Date: for example, all MRP lists that were created or processed within the last two weeks, or MRP lists for all materials with insufficient stock for the next two weeks.
   - Exception groups: for example, MRP lists for all materials for which the planning run was terminated (exception group 8).
   - Processing indicator: for example, all MRP lists that have not yet been processed.
   - Procurement: for example, MRP lists for all materials that are procured externally.

4. Enter the layout.

5. Choose twice.
   
   The material list appears. This contains all the materials that fulfilled your selection criteria.

6. Select one or more materials and choose Selected MRP lists.
   
   You now branch into the overview screen of the first planning result.
Using Collective Access for Planning Situation

1. From the MRP or MPS menu, select Evaluations → Planning situation product group.
   The initial screen for the product group evaluation appears.

2. Enter the product group, the plant and the required layout.

3. Choose twice.
   The planning situation for the chosen product group now appears.

4. You have the following processing options:

<table>
<thead>
<tr>
<th>Function</th>
<th>How to call up function</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the values for the individual product group members for a hierarchy element</td>
<td>Click on the hierarchy element</td>
<td></td>
</tr>
<tr>
<td>Display data for individual product group members</td>
<td>Goto → Product group</td>
<td>A dialog box appears displaying the product group members.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the members are product groups themselves, you can access more details for the product group.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>By clicking on product group member, you can access the planning situation for this material.</td>
</tr>
<tr>
<td>Display material description for the product group members</td>
<td>View → Product group members → Material description</td>
<td></td>
</tr>
</tbody>
</table>
Planning Situation According to DRP

Use
In the planning situation according to DRP (DRP = Distribution Resource Planning), you can see per plant which receipts and requirements have been scheduled in this plant and which receipts and requirements go from this plant to other plants. Here, receipts and requirements from/into other plants are recorded as external or internal receipts and issues.

Features
In the DRP evaluation, the system displays the internal or external receipts and issues:

- External means issues to the customers or receipts from vendors.
- For stock transfers from/to in-house plants, the system displays the transfer quantity from each plant individually.
- For in-house production in your own plant (that is, the plant with which you accessed the evaluation), the production quantities are displayed as receipts with this plant key.

You can plan both external requirements (that means customer requirements) and internal requirements (strategy Planning at assembly level). Depending on the strategy, a planned independent requirement is valid as an external requirement or as a requirement in the in-house plant.

Unplanned requirements are always considered as requirements from the in-house plant.

Activities
Start the evaluation as described in Using Individual Access for Planning Result/Planning Situation [Page 381]. In addition, select the DRP evaluation field in the initial screen.
Compare Planning Result and Planning Situation

Use
By comparing the planning result and the planning situation, you can compare the situation after the last planning run with the stock/requirements situation.

Features
In this comparison, you can
- display both evaluations parallel to each other in one screen. The data is delimited using color.
- display only the planning result or only the planning situation
- display the differences in quantity between the planning result and the planning situation

Activities
Start the evaluation as described in Using Individual Access for Planning Result/Planning Situation [Page 381]. In addition, select the Comparison with planning result or Comparison with planning situation field in the initial screen.
Access Multi-Plant Planning Situation

Use

You can compare and check the planning situation for materials whose material master record is created in different plants using the multi-plant planning situation.

Procedure

1. Starting from the MRP or MPS menu, select Evaluations → Planning situation all plants.
   The initial screen of the evaluation appears.
2. Enter the material and layout and choose twice.
   The overview screen for the multi-plant planning situation now appears.
3. The following processing functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>How to call up function</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the data for the individual plants in a hierarchy element</td>
<td>Click on the hierarchy element</td>
<td></td>
</tr>
<tr>
<td>Display the planning situation for an individual plant</td>
<td>Goto → Plants</td>
<td>A dialog box appears displaying the individual plants. By clicking on a plant, you can display the planning situation for this plant.</td>
</tr>
<tr>
<td>Access the plant description for the plants</td>
<td>View → Plants → Plant description</td>
<td></td>
</tr>
</tbody>
</table>
Cross-System Planning Situation (CA-BFA)

Use

You can use this business process when you have maintained a material in several systems, that is to say cross-client, and wish to evaluate the planning for this material on a cross-system basis.

The evaluation shows the planning situation based on the data in the stock/requirements lists in the systems involved. You can design the display of the planning situation using an individual user layout and, for example, display information on MRP elements, production orders, purchase orders, sales orders, reservations, and warehouse stocks.

You can only process an MRP element in the system in which it is available as the original. Processing directly from the planning situation is not possible.

If necessary, the business process can be used in the company in combination with distributed Sales & Operations Planning (SOP).

Integration

Functions in the central SAP system:

- Creation and maintenance of master data for the relevant material
- Definition of the logical system and the required layout of the evaluation in Customizing
- Creation of planned independent requirements and customer requirements for the material
- Start of the evaluation

Functions in the decentralized SAP systems:

- Creation and maintenance of master data for the relevant material
- Creation of planned independent requirements and customer requirements for the material
- Start of the evaluation
Data Flow
All system involved must be maintained within a logical system by the user. The user can then start the evaluation from the SAP system in which the logical system is maintained (central system). The system sequentially checks whether the data for the specified material exists in another plant in the logical system. If this is the case, the data form the last MRP run is sent to the called SAP system by a Remote Function Call (RFC), and this system then displays the cross-system planning situation in the user-defined layout.
Procedure: Cross-System Planning Situation

Purpose
This process describes how you evaluate the MRP run for a material that is maintained in several systems, which means cross-group.

Prerequisites
- You have given your plants unique descriptions across all systems
- It is known which plant is managed in which system in your customer model
- You have set the authorization to display MRP in all the systems involved

Customizing
- In Customizing, you have created a layout that defines which information is displayed in which hierarchy. You create the layout using the Customizing menu path Production → Master Planning → Master Production Scheduling → Evaluation → Define Layout
- You have set up a logical system in Customizing and assigned the dummy message type PRODPL to the logical partner system in the partner profile. This assignment is used to determine the target system and to transfer the data by means of synchronized RFC.
  - You define the logical system under Basic Components → Distribution (ALE) → Sending and Receiving Systems → Define Logical System.
  - You define the partner profile under Basic Components → Distribution (ALE) → Modelling and Implementing Business Processes → Partner Profiles and Time of Processing.

Process flow
1. When you start the evaluation, the system uses the customer distribution model to check which plants are in which logical SAP System.
2. The system checks in each plant whether the material involved exists. When this is the case, the MRP data required is requested by means of synchronized Remote Function Calls (RFCs).
3. If the system that is calling cannot access the required information (when no access authorization exists, for example), it logs an error, which you can display.
4. The planning situation is displayed on the screen. The report contains all MRP elements that are defined in the specified evaluation layout, for example production orders, purchase orders, sales orders, reservations, and warehouse stocks.
Material Requirements Planning (PP-MRP)

Procedure: Cross-System Planning Situation

Logical system

Central system

- Evaluation of logical system
- Evaluation of logical system
- Evaluation of logical system
- Evaluation of logical system

Decentralized systems 1..n

- Determine plants in logical system
- Check whether matl maintained in plant
- Access the requirements
- Send date for planning situation

Customer distribution model
Customer distribution model
Stock/requirements list or planning situation
Evaluate the Cross-System Planning Situation

1. To carry out the evaluation for a master schedule item, from the MPS menu, choose
   *Evaluations* → *Situat. - all plants.*

   To carry out the evaluation for a different material, from the Material Requirements
   Planning menu, choose *Evaluations* → *Situat. - all plants.*

   The *Cross-Plant Evaluation* initial screen appears.

2. Enter the name of the material that you wish to display the planning situation for.

3. Choose an evaluation layout.

4. Select the *Distributed systems* indicator and choose *Enter twice.*

5. The system carries out the cross-system evaluation for all plants and then displays the
   overview screen of the chosen evaluation layout. The overview screen consists of a
   header and the evaluation matrix.

6. Click the desired MRP element to expand or collapse the display of the aggregation
   level.

7. Choose *Back* to exit the evaluation.
Pegged Requirements

Use
You can use the Pegged requirements function to retrace from any BOM level

- which requirements are the source of which procurement proposals
- which independent requirements (especially sales orders) are affected if a procurement proposal is cancelled or a date or quantity is changed on a lower level.

Features
For the MRP element selected, you can display:

- just the pegged requirement(s) on the highest BOM level
  The system displays the requirements quantity and the input quantity for each requirement. The input quantity is the portion of the MRP element that is required to cover the displayed requirement. The input quantity is displayed in the base unit of measure of the material.

- the order route; that means all the requirements and replenishment elements that lie between the pegged requirement and the MRP element

If an MRP element contains a quantity that was not caused by a requirement from a higher level, the system displays this quantity separately. Quantities without source arise, if more is produced than is required because of a rounding value for the lot size or a fixed lot size or if procurement proposals have been scheduled manually.
Access Pegged Requirements

1. Starting from the MRP node, choose *Evaluations* → *Pegged requirements*.

2. Enter the number of the MRP element (and the item number if it is a purchase requisition, purchase order or schedule lines), for which you want to view the pegged requirements and choose 📈.

   You now branch into the pegged requirements screen.

   You can access the pegged requirements **directly from the MRP list or the stock/requirements list**, by positioning the cursor on the required MRP element and choosing 📈.

3. You have the following processing options:

<table>
<thead>
<tr>
<th>Function</th>
<th>How to call up function</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display order route</td>
<td>Position the cursor on the requirement and choose <em>Order route</em>.</td>
<td>The system displays the exact route from the requirement displayed to the MRP element over all BOM levels. The system displays a list of all the source MRP elements.</td>
</tr>
<tr>
<td>Display the material text</td>
<td><em>View</em> → <em>Material number/text</em></td>
<td>The system displays the material text instead of the material number in the requirements line.</td>
</tr>
<tr>
<td>Access stock/requirements list for material of pegged requirement</td>
<td>Position the cursor on the pegged requirement you are interested in and select <em>Details</em> → <em>Stock/requirements</em>.</td>
<td></td>
</tr>
<tr>
<td>Display and change MRP element</td>
<td>📝 or 🎨</td>
<td></td>
</tr>
<tr>
<td>Convert MRP element</td>
<td>corresponding function under <em>Details</em></td>
<td></td>
</tr>
<tr>
<td>Access material memo</td>
<td>📝</td>
<td></td>
</tr>
<tr>
<td>Access graphic</td>
<td>🎨</td>
<td>A network graphic appears in a separate window. You can shrink or enlarge the graphic, access screens for processing individual MRP elements, print the graphic and so on.</td>
</tr>
<tr>
<td>Print pegged requirements</td>
<td>📍</td>
<td></td>
</tr>
</tbody>
</table>
Example for Pegged Requirements

The quantities displayed in italics represent the quantities that flow from the procurement proposal to the pegged requirement.

Initial Situation
- Product with 3 BOM levels.
- Each material is planned using the exact lot-sizing procedure.
- 3 requirements (sales orders or planned independent requirements) are created for the finished product, each one for 1000 pieces (1), (2), (3).
- Planning creates 3 procurement proposals for the semi-finished product and the raw material, each for 1000 pieces or kg
- Displacements occur due to the receipt of 500 pieces for the semi-finished product and the raw material.

Procurement Proposal to be Examined
The procurement proposal (17) is to be examined.

Source
The three requirements (1), (2), (3) are the sources.

Order route
- For the sales order (1) the route to the order is as follows:
  (1) → (4) → (7) → (12) → (14) → (17)
• For the sales order (2) there are two routes to the order:
  (2) → (5) → (8) → (12) → (14) → (17)
  (2) → (5) → (9) → (13) → (15) → (17)

Requirements quantities
The requirements quantities for requirements (1), (2), (3) are all 1000 pieces.

Input quantities
The quantities 250, 500 and 250 kg are required for the finished product.
Order Report

Use
You use the Order report function to access an overview of the status of all BOM levels for an order.

This overview helps you to recognize any problems in the production or procurement of assemblies and components early in the process. You can also, for example, check the progress of production for a particular sales order or whether there is a shortage or problems meeting deadlines for any components on any BOM level.

Features
You can access the order report for the following types of order:

- **Sales orders**
- **Production orders** (also collective orders and process orders)
- **Planned orders**
- **Project definitions** or **WBS elements**

For every order, the system determines which receipt elements have been scheduled:

<table>
<thead>
<tr>
<th>Order Type</th>
<th>Receipt Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned orders</td>
<td>Subordinate dependent requirements</td>
</tr>
<tr>
<td>Production orders, collective orders, process orders</td>
<td>Reservations</td>
</tr>
<tr>
<td>Purchase orders and purchase requisitions for subcontracting</td>
<td>Reservations</td>
</tr>
<tr>
<td>Stock transport orders and stock transport requisitions</td>
<td>Release orders in other plant</td>
</tr>
<tr>
<td>Stock transport reservations</td>
<td>Issue reservations in other plant</td>
</tr>
</tbody>
</table>

The system can carry out the availability check in two ways:

- **using the receipts date**
  
The receipt elements are sorted according to the MRP availability date. The first requirement is then covered by the first receipt. This logic corresponds to the calculation of the available quantity in the stock/requirements list.

- **according to ATP logic**
  
Only the receipt elements that lie before the requirements date are included in the calculation. Firmed receipts with a rescheduling proposal that lies after the requirement are not included in the calculation.
Access Order Report

3. Starting from the MRP node, choose Evaluations → Order report.

4. Enter the number of the MRP element (and the item number if it is a sales order), for which you want to view the order report and choose .

   The order report appears. In the case of a sales order, the sales order number and the accompanying procurement proposals are displayed. In the case of a planned order and a production order the corresponding order number is displayed.

   The receipt elements are highlighted in color. Thus, you can recognize whether problem situations exist for the lower BOM levels. You can check the significance of the colors by selecting View → Color legend:

   - **White**: the requirement is covered by warehouse stock at the highest level, which can be withdrawn immediately for the order.
   - **Green**: receipt elements were created for lower BOM levels. There is, however, no exception situation.
   - **Red**: exception situations exist on lower BOM levels.
   - **No color**: the receipt element cannot be exploded further.

   ![Icon](image) If you have not entered an item number for a sales order, a list of all items for the sales order now appears. Select the one that you require.

   ![Icon](image)

   You can access the order report directly from the MRP list or the stock/requirements list, by positioning the cursor on the required MRP element and choosing .

3. You have the following processing options:

<table>
<thead>
<tr>
<th>Function</th>
<th>How to call up function</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display only receipt elements that have an exception situation</td>
<td>To error</td>
<td>The system displays an overview of all BOM levels where date and quantity problems exist.</td>
</tr>
<tr>
<td>Display all receipt elements</td>
<td>To error or All</td>
<td>The system displays an overview of all BOM levels where receipt elements are scheduled.</td>
</tr>
</tbody>
</table>
## Access Order Report

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
</table>
| Display only the BOM level directly below the order level. | Click on the receipt element  

- In the case of very large BOMs: choose **Mode for opening → Dual-level**. When you click on the receipt element, a list of the components appears. The components are highlighted in color so that you can recognize the problem components immediately.  
- In the case of BOMs with few components: choose **Mode for opening → Single-level**. When you click on the receipt element, the system opens all the components with receipt elements immediately. |
| Display the long text for the exception message | Click on the exception message number  

The system displays the long text for the exception message in the status line. |
| Access stock/requirements list for component   | Position the cursor on the component and choose **Details → Stock/requirements**                                                                                                                                 |
| Display and change MRP element                | **Edit** or **Create**                                                                                                                           |
| Convert MRP element                           | corresponding function under **Details**                                                                                                          |
| Access material memo                          | **Material Memo**                                                                                                                               |
| Access graphic                                | A network graphic appears in a separate window. You can shrink or enlarge the graphic, access screens for processing individual MRP elements, print the graphic and so on. |
| Display receipt elements in total quantity or required quantity | Edit → Complete receipt quantities or Quantity needed | The display differentiates
- whether the receipt quantities for the components are only checked for the amount required to cover the dependent requirements for the production of the order or
- whether the system checks the total quantity of dependent requirements that was created for a BOM level

Example:
An order is scheduled for 50 pieces. As the components are frequently used, a dependent requirement from another material for 50 pieces is added. Therefore, 100 pieces in total must be available for this BOM level.

Check for required quantity: a warehouse stock of 50 pieces would be sufficient. The system would indicate that there are no problems on this particular BOM level.

Check for complete receipts quantity: the total quantity would have to be in stock or scheduled, so that the system could indicate that there are no problems on this particular BOM level.
Planning Table

Use
You can use the planning table for Repetitive Manufacturing as an evaluation and planning instrument for planned and production orders. This is useful if your production is organized as repetitive or continuous manufacturing.

Prerequisites
You have created a production version for the materials that you want to process in the planning table.

Integration
You can use the planning table in addition to MRP. In the planning table the system displays all the planned orders and production orders that are generated in MRP, and you can process them in the planning table.

Features
Planning and controlling for repetitive and continuous manufacturing is usually period and quantity oriented. The planning table is therefore based on periods and provides an overview of materials and production lines by period and quantity.

It contains functions for
- planning production quantities
- determining the current capacity load of the production line
- checking the availability situation of the products
- distributing production quantities between shifts

You can find further information about the planning table in the SAP documentation for Repetitive Manufacturing.
Procurement Proposal (PP-MRP-PP)

Implementation Options

The system creates procurement proposals automatically during the planning run. They specify when inward stock movement should be made and the quantity of stock that is expected.

Integration

<table>
<thead>
<tr>
<th>To</th>
<th>you require the additional components</th>
</tr>
</thead>
<tbody>
<tr>
<td>convert planned orders</td>
<td>Material Master (LO-MD-MM)</td>
</tr>
<tr>
<td>convert planned orders into production orders</td>
<td>Production Orders (PP-SFC), Routing (PP-BD-RTG)</td>
</tr>
<tr>
<td>convert planned orders into process orders</td>
<td>Production Planning for Process Industries (PP-PI)</td>
</tr>
<tr>
<td>convert purchase requisitions into purchase orders</td>
<td>Purchasing (MM-PUR)</td>
</tr>
<tr>
<td>execute capacity leveling</td>
<td>Capacity Planning (PP-CRP)</td>
</tr>
</tbody>
</table>

Features

The procurement proposals include:

- **planned orders** (for materials that are procured externally or produced in-house)
- **purchase requisitions** (for materials that are procured externally)
- **schedule lines** (for materials that are procured externally and for which a source list entry and a scheduling agreement already exist)

Planned orders and purchase requisitions are internal planned elements that can be changed, rescheduled or deleted at any time.

In contrast, delivery schedules are fixed receipt elements, which must be followed. They therefore only belong to the procurement proposals in a broader sense (see Determining the Procurement Proposal [Page 134]).

The creation indicators in the initial screen of the planning run determine which procurement proposals are created during the planning run (see Creation Indicator [Page 287]).
Planned Order

Definition

A planned order is sent to a plant and is an MRP request for the procurement of a particular material at a determined time. It specifies when the inward material movement should be made and the quantity of material that is expected.

A planned order has the following characteristics:

- It is a procurement proposal in MRP for requirements coverage, that is, an internal planning element. It is not binding and does not therefore trigger procurement directly, but serves for planning purposes.
- It can be changed or deleted at any time (exceptions: planned orders for direct production and for direct procurement).
- Whether a material will later be produced in-house or procured externally is left open.
- For materials produced in-house, it represents the pegged requirement for dependent requirements and can be used in the capacity calculation.
- For materials produced in-house, it specifies the basic dates for production.

Planned orders are converted into production orders for in-house production and into purchase requisitions for external procurement. In contrast to planned orders, production orders and purchase requisitions are fixed receipt elements, which commit to the procurement.

Use

Automatic Creation of Planned Orders

During the planning run, the system automatically calculates the materials to be procured as well as the requirements quantity and date. The system then creates the corresponding planned order.

The system also explodes the BOM for materials that are produced in-house and uses the BOM components as material components for the planned order. The system creates a corresponding dependent requirement for these components. If the quantity or the date of the planned order changes or if the bill of material changes, the bill of material is re-explored in the next planning run and the dependent requirements of the material components are adjusted accordingly.

You can determine in Customizing for MRP in the IMG activity Define consumption mode and period of adjustment that no planned orders are to be created within a particular period of time for planned independent requirements, for which no firmed receipt elements or firmed procurement proposals exist. The system then creates planned orders for customer requirements only. You can determine this for each plant or for each MRP group.
Manual Creation of Planned Orders

You can also create planned orders manually. For this, you determine which material should be procured, the quantity of material to be procured, the date it should be available and whether it is to be procured externally or internally.

If you create or change a planned order manually, you can also explode the BOM manually and adjust the material components.

Structure

The planned order consists of

- order data (quantities, dates, account assignment, material data, procurement data and so on)
- component overview (see also Process Components in Planned Order [Page 411]).
Display Planned Order

Use
You can display planned orders using the individual display or using the collective display.

Procedure

Individual Display
1. Starting from the MRP node, choose Planned order → Display → Individual display.
   The initial screen for the individual display appears.
2. Enter the number of the corresponding planned order and choose .
   The detail screen for the planned order appears.

Collective Display
In the collective display, the system displays all of the planned orders corresponding to your selection criteria collectively, for example, all the planned orders of a particular MRP controller.
1. Starting from the MRP node, choose Planned order → Display → Collective display.
   The initial screen for the collective display appears.
   You can search for planned orders by MRP controller, material, production version, production line or WBS element.
   For example, the following is based on the option of searching for planned orders by MRP controller.
2. Select MRP controller and choose Find.
   The system displays a dialog box.
3. Enter the Plant and the MRP controller.
   If you want to narrow the selection down further, enter a date up until which planned orders are to be displayed.
4. Choose .
   The system displays a list of all the planned orders that fulfill your selection criteria.
   From this list, you have various options for processing the planned orders:

<table>
<thead>
<tr>
<th>Function</th>
<th>How to call up function</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display planned order</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change planned order</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Display Planned Order

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete planned order</td>
<td>![Trash Can] In a dialog box, you must confirm the deletion of the planned orders once again.</td>
</tr>
<tr>
<td>Display pegged</td>
<td>![Pegging Tool] For more information, see Pegged Requirements [Page 394].</td>
</tr>
<tr>
<td>requirements</td>
<td></td>
</tr>
<tr>
<td>Display order report</td>
<td>![Order Report] For more information, see Order Report [Page 398].</td>
</tr>
<tr>
<td>Sort list</td>
<td>![Sort] Before pressing the button, position the cursor on the column that you wish to use to sort the list.</td>
</tr>
<tr>
<td>Convert planned order</td>
<td>![Convert] Convert to production order, Convert to purchase requisition, Convert to process order. You can find further information on this under Conversion of Planned Orders [Page 431] and Converting Planned Orders into Purchase Requisitions [Page 433].</td>
</tr>
</tbody>
</table>

If you change or convert planned orders from this list, the system displays the planned order as firm (X in the Firming column).
Create Planned Order Manually

Use
As a rule, planned orders are generated automatically during a planning run. However, it may be necessary to create planned orders manually, for example, if you want to procure materials independently from requirements.

Procedure
1. Starting from the Material Requirements Planning node, choose Planned order → Create.
   The initial screen for creating a planned order now appears.
2. Enter a planned order profile.
   The planned order profile determines, amongst other things, the order type, the procurement type, and the special procurement type of the planned order.
3. If necessary, also enter the number of a planned order, from which you want to copy data.
   All data from this planned order is copied into the new planned order. You can overwrite this data.
4. Choose .
   The detail screen for the planned order appears.
   The system sets the order type and special procurement type automatically according to the planned order profile. You cannot change these fields.
5. Enter data as required.
   It is sufficient to enter just the order finish date or the order start date. The system then calculates the missing date automatically using the scheduling data.
6. Choose .
   The system calculates missing dates and enters them. If a goods receipt processing time has been entered in the material master record for this material, it is set as the default value in the GR processing time field. You can change this value or, if the field is blank, enter a value. This entry has no effect on the value in the material master.
   The planning plant is transferred automatically as the production plant.
   The following indicators are set as default values:
   - The planned order is automatically flagged as convertible in the Conversion indicator field. This enables the later conversion to a production order for in-house production, or to a purchase requisition for external procurement.
   - As you manually created the planned order, it is automatically flagged as firmed in the Firming screen area. Firmed planned orders are not changed by the system in a subsequent planning run.
7. If required, enter further parameters:
Create Planned Order Manually

- BOM explosion number
- Production version
  You can enter the production version directly in the Production version field. If you use the quota arrangement system, you can display which production version is to be used next according to the quota arrangement. To do this, select Edit → Assign version.
- Sales order or WBS element, for planned orders that are assigned to the sales order account or to the project account
  For this, choose the tab index Assignment.

8. Choose Components.
   The component overview appears. The system explodes the BOM and copies the BOM items into the planned order as components automatically.

9. Bearbeiten Sie ggf. If necessary, process the components for the planned order (see Process Components in Planned Order [Page 411]).

10. Choose and save the planned order.
Change Planned Order

Use

Changes to existing planned orders can be necessary, for example, if the planned order in question is firmed, but then receives a rescheduling proposal during the planning run.

Procedure

1. Starting from the Material Requirements Planning node, choose Planned order → Change.
   The initial screen for changing a planned order now appears.
2. Enter the number of the planned order to be changed and choose ✅.
   The detail screen for changing a planned order now appears.
3. Make the changes necessary.
4. Save the changes.

💡

If you change a planned order, it is then regarded as firmed for the planning run, (as is a planned order that is created manually). Thus, it will not be changed automatically during subsequent planning runs.
Process Components in Planned Order

Procedure

Choose Components.

The component overview for the planned order material appears. The system displays the component processing status that was saved last. If you have recreated the planned order, the system explodes the BOM and copies the BOM items generated into the planned order as components.

Changing Components

1. Double-click on a component.

The system displays the material number, plant and item number for the component selected in the lower screen area. The system displays additional information according to the item category. You can take the item category from the item category column. You can take the item category from the Item category column.

<table>
<thead>
<tr>
<th>Item Category</th>
<th>Displayed/Processible Information</th>
</tr>
</thead>
</table>
| Stock item      | • Requirement quantity and unit of measure, requirements date  
|                 | • Firming indicator  
|                 | If you set the firming indicator for a component, the quantity of the component is firmed and, thus, will not be changed during the planning run. It can only be changed manually.  
|                 | • Distribution key  
|                 | The distribution key defines which calculation rule is to be used for dividing the dependent requirement for the component into partial quantities, if not all of the total quantity has to be available for the start of production. You can use to view the chronological distribution of the partial quantities.  
|                 | • Latest requirement date  
|                 | The latest requirement date sets a limit for the period allowed for the distribution of partial quantities.  
|                 | • By selecting , you can access the additional data of the component (long text, scrap data, other data).  
|                 | • By choosing Availability check, you can access the availability check for the component.  
|                 | • If a long text has been created for a component, you can access this by choosing . |

| Non-stock item  | • Requirement quantity and unit of measure, requirements date, firming indicator (see above)  
|                 | • By choosing Procurement, you access a dialog box with the additional data for direct procurement. If a purchase requisition or planned order for direct procurement has not yet been created by the planning run for the non-stock item, you receive a corresponding message in the status line. |
### Process Components in Planned Order

<table>
<thead>
<tr>
<th>Variable-sized item</th>
<th>Requirement quantity and unit of measure, requirements date, firming indicator, distribution key, latest requirement date (see above)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>By selecting <img src="image1.png" alt="image" />, you can access the additional data of the component (long text, scrap data, other data).</td>
</tr>
<tr>
<td></td>
<td>By choosing <em>Availability check</em>, you can access the availability check for the component.</td>
</tr>
<tr>
<td></td>
<td>By choosing <em>Sizes</em>, you access a dialog box with the corresponding data.</td>
</tr>
<tr>
<td>Text item</td>
<td>In the <em>Texts</em> area, the system displays the entered long texts.</td>
</tr>
<tr>
<td>Phantom assembly</td>
<td>The requirements for a phantom assembly are passed on to the components as dependent requirements. Therefore, in the upper part of the screen, the system displays the components of the phantom assembly as well as the phantom assembly itself.</td>
</tr>
<tr>
<td></td>
<td>Requirement quantity and unit of measure, requirements date, firming indicator, distribution key, latest requirement date (see above)</td>
</tr>
<tr>
<td></td>
<td>By selecting <img src="image2.png" alt="image" />, you can access the additional data of the component (long text, scrap data, other data).</td>
</tr>
<tr>
<td></td>
<td>By choosing <em>From stock</em>, you can have the system create a dependent requirement for a phantom assembly itself that is kept in stock and not directly for the components. You thereby deactivate the <em>Phantom assembly</em> special procurement for this planned order. A dialog box appears where you can enter the issue quantity. If you withdraw the complete quantity the system will only display the phantom assembly in the component overview. The components disappear. If you withdraw a partial quantity, the system adapts the quantities for the phantom assembly and for the components correspondingly.</td>
</tr>
</tbody>
</table>

2. Access the next item with ![image](image3.png) and process it.

You access the previous item with ![image](image4.png). By choosing *Component overview*, you close the screen area for processing components and return to the component overview.

**Creating Components**

You can create a storage location item or a variable-sized item.

- **Collective Entry**
  
  Using the collective entry option, you can create several new components at the same time. For each component, a line exists in which you can enter the material number, the requirement quantity and the requirements date. Choose *Collective entry* for this.

- **Detail Entry**
  
  In the detailed entry screen, you can enter detailed data for an individual component. Choose *Detail entry*.

  In the lower part of the screen, a section is displayed where you can enter the following data for the new component: material number, requirement quantity and unit of measure, requirements date, firming indicator, distribution key, latest requirement date.
If the new component should be a stock item and not a variable-size item, choose Variable-size data. A dialog box appears where you can enter the corresponding data.

Deleting Components

Select the component that you want to delete and choose Edit → Delete.
The selected component is deleted.

Retrieving Deleted Components

Choose Goto → Display deleted entries.
Select the required components and choose.
The system displays the deleted components in the component overview again.

If you create components in the components processing screen manually, these new components will be overwritten when you then manually explode the BOM. The manually created components are thus deleted again. You can retrieve these deleted components by following the steps described above.

Displaying Documents for the Header Material and for the Components

1. Choose.

In the left screen area, the system displays a structure tree with the components for the planned order. If you work with phantom assemblies, the system displays the phantom assemblies and their components hierarchically. You can thus get an overview of the structure of the planned order quickly.

2. Click with the right mouse button on the header material or on a component in the tree.

If you have assigned documents to the material (either in the material master or, if the material is used as a BOM item, in BOM maintainence), a list of all the documents assigned appears.


The system displays the document in an internal or external viewer. You determine the selection of the viewer in Customizing for document management in the IMG activity Define workstation application.

You can find further information about the internal viewer under Viewer for Displaying Original Files [Ext.].

Choose in the structure tree and then Enter, if you have deleted or created components and want to update the structure tree correspondingly.
Execute Capacity Leveling in Planned Order

Prerequisites
You have created a planned order or accessed a planned order in order to change or display it and are in the main screen of the planned order.

Procedure
1. Choose Goto → Capacity leveling.
   The Settings for capacity planning dialog box now appears.
2. Select the required planning type and the period value for capacity planning and, if necessary, choose a period of examination. Choose .
   The system executes the lead time scheduling and calculates the capacity requirements using the parameters, that you have set in Customizing for MRP in the IMG activity Define scheduling parameters for planned orders.

⚠️
If errors occurred during scheduling, the system displays an overview of the scheduling errors relating to the planned order. In the scheduling log, you can check the details of the scheduling errors.

Result
You now branch into the screen for capacity leveling (order view).
For the planned order selected, the capacity leveling relates to one work center and one capacity category (machine or person) as well as the capacity unit (for example, hours) from the work center. The system displays the following data:
- Order number, order quantity and basic dates
- Available capacity
- Overall capacity requirements at the selected work center
- Capacity requirements for the material
- Capacity requirement for the planned order selected
Capacity loads caused by the planned order selected are highlighted.
Working with Capacity Leveling

Prerequisites
You are in the main screen for capacity leveling.

Procedure

Selecting Capacities (Work Centers and Capacity Categories)
1. Choose Capacities.
   The system displays the Capacities dialog box. It displays all work centers and capacity categories (person or machine) that form the basis for the capacity requirement of the material. The system displays the maximum load for every capacity category. Any overload is highlighted.

2. Position the cursor on the required capacity category and choose Choose.
   You can scroll between the individual capacities using and .

Check Capacity Overload

Choose Overload.

The Capacities with overload dialog box with a list of all periods in which the respective capacity is overloaded appears.

As standard, a capacity is overloaded if the load is bigger or equal to 100%, that is, the same as or larger than the available capacity. You can, however, also set your own user-defined percentage values:

1. Choose Settings in the dialog box Capacities with overload.
   The Settings for overload display dialog box appears.

2. Enter the required percentage in the Maximum capacity load field and, if necessary, limit the period in which the system should execute an overload check. Choose .
   The system carries out the overload check using the changed values.

Displaying Pegged Capacity Requirements in Detail

You can display,

- which orders are responsible for the total capacity requirement in a particular period. To do this, place the cursor in the column Overall on the appropriate period and choose Display pegged requirements.

- which orders are responsible for the capacity requirement for a material in a particular period. To do this, place the cursor in the column Material on the appropriate period and choose Display pegged requirements.

The system displays the orders generating the requirements in the lower section of the screen.
You can display the scheduling data for these orders. To do this, position the cursor on the required planned order and choose Edit → Scheduling data.

Planning Capacity

In the Planned order screen area, you can change the dates or quantity of the planned order selected. The system plans the order again immediately.
Availability Check for Components in the Planned Order

Use

You can check whether the quantity available for components in the planned order is sufficient to produce the planned order quantity on time.

Features

The system checks availability for planned orders only on request, that is, the planning run does not automatically check availability.

You can carry out the availability check

- for a single planned order
- as a Collective Availability Check [Page 425] for a selection of planned orders.

You can choose between two types of availability check:

- Availability Check According to ATP Logic [Page 418]
- Availability Check Against Planned Independent Requirements [Page 419].

You can see the type of availability check that was last carried out in the header of the planned order in the field entitled, Type of AvC.

You can carry out the availability check as often as you want with the following limitations:

- If you check according to ATP logic, you can repeat this check as often as you want. However, you cannot then check against planned independent requirements immediately afterwards. If you want to check against planned independent requirements after having first checked with ATP logic, you must first reset the check with ATP logic.
- If you check against planned independent requirements, you can repeat this check as often as you want. In this case, you can also directly change to the check according to ATP logic. Therefore, you do not have to reset the results of the availability check first.

💡

You can switch off the availability check for certain materials. This is especially useful for materials that you know are always available in stock, such as screws. To make sure that these materials are not included in the check, you can set the indicator No check in the material master (view MRP 3) in the field Availability check.
Availability Check According to ATP Logic in Planned Order

Use

In the check according to ATP logic, the system checks whether the dependent requirements of each component in a planned order are covered by specific receipt and issue elements or by stock.

Prerequisites

- **Checking group**
  
  You have assigned a checking group to the materials to be checked in the material master (MRP 3 view, Availability check field).

- **Checking rule**
  
  You have set a checking rule for the plant in Customizing for MRP in Maintain all plant parameters. You can also assign a checking rule directly to the material using the MRP group.

  The system determines the Scope of the Availability Check [Page 451], that is, the receipts, issues and stocks that are to be included in the availability check depending on the combination of the checking group and the checking rule.

- In Customizing for MRP under Define availability check for components → MRP group, you have determined whether the ATP check is to per MRP group following the logic of full or partial confirmation.

Features

The availability check is dynamic and uses the ATP logic, that is, each time you carry out the check, the system recalculates the current situation. If a quantity can be confirmed for the requirement date, the system enters precisely this quantity as the confirmed quantity in the dependent requirements and the ATP quantity for the components is reduced by the confirmed quantity. Therefore, in the next availability check, dependent requirements can only be confirmed for the amount of the remaining ATP quantity.

The result of the availability check for the components is displayed in the planned order header in the fields Confirmed quantity and Order confirmation date.

Activities

To check availability according to the ATP logic, select Components ATP in the header data screen of the planned order.

Availability Check Against Planned Independent Requirements

Use

In the check against planned independent requirements, the system only checks the dependent requirement quantities against the open planned independent requirements created for the components. Therefore, neither the ATP quantity nor the receipts or stocks are included in this availability check.

This type of availability check is most useful:

- if assembly planning (in the standard system, planning strategy 70) or phantom assembly planning (in the standard system, planning strategy 59) is used to plan the components
- if the availability situation is required at short notice and the results from this check are precise enough.

Prerequisites

- Checking group

You have assigned a checking group to the materials to be checked in the material master (MRP 3 view, Availability check field). With this checking group, the check can be made against planned independent requirements.

These settings for the checking groups are made in Customizing for Sales/Distribution or Production control under Define checking group, in the field Relevancy of check against planned independent requirements.

The following options are available for setting the checking group:

- **No check against planned independent requirements**
  
  You cannot check against planned independent requirements. However, the material can still be included in the availability check according to ATP logic.

- **Always check the material against planned independent requirements**
  
  You can check against planned independent requirements. Simultaneously, the material can still be included in the availability check according to ATP logic.

- **Only check the material against planned independent requirements if the material is a phantom assembly**
  
  The system can only check against planned independent requirements when dealing with phantom assemblies (special procurement key, Phantom assembly). Simultaneously, the material can still be included in the availability check according to ATP logic.

💡

In the availability check against planned independent requirements, the checking group does **not** control the scope of the check as it is only carried out against planned independent requirements.

- **Consumption mode/Consumption period**

  *Add any relevant details here.*
Availability Check Against Planned Independent Requirements

You must maintain the following indicators in the material master record to determine the period in which planned independent requirements are allowed to be consumed by dependent requirements.

- Consumption mode, that is, the direction of the consumption. You can determine whether planned independent requirements can be consumed in the past and/or in the future.
- Consumption period, that is, the length of the period (either in the past or in the future) during which planned independent requirements are allowed to be consumed.

Features

The system uses the open planned independent requirements quantity at component level to determine a confirmed quantity and this quantity is copied to the planned order header in the Confirmed quantity field. As opposed to the availability check according to ATP logic, however, the confirmed quantity is not recorded in the dependent requirements. The planned independent requirements of the components are not consumed by the confirmed quantity but by the complete dependent requirements quantity. In following availability checks, the system can confirm quantities only for the amount of planned independent requirements that have not yet been consumed.

In the availability check against planned independent requirements, the following dates/quantities are not calculated:
- partial confirmation date
- partial confirmation date/quantity

Activities

To check availability against planned independent requirements, select Edit → Components ATP in the header data screen of the planned order.

Availability Overview of the Components

Definition
The availability overview of the components shows the availability situation of all components of a planned order. It is the result of the availability check.

Integration
You can view the availability of the components for both types of availability check.
- the availability check according to ATP logic
- the availability check against planned independent requirements
Each type of availability check is displayed in a different color.

Structure
Individual Component Data
The components checked are categorized in three groups:
- available components
- missing parts and
- components with faulty check.
Each group is displayed in a different color. You can check the significance of the colors by selecting View → Color legend. If you only want to see the missing parts, select View → Check result → Only missing parts.
A number of fields (which you can change as necessary) are displayed per component, for example, material number, material short text, plant, storage location, requirements quantity, confirmed quantity and so on. You can add or remove fields and change the display sequence. To do so, choose View → Select fields.
The most important fields for the availability check are listed below:
- Requirement quantity
  The dependent requirements quantity resulting from the explosion of the BOM.
- Requirements date
  The date on which the components have to be available - this is usually the order start date of the planned order.
- Confirmed quantity
  Maximum quantity available on the requirement date according to the check of all components. Depending on the Customizing settings (Availability check for components → MRP group) it is calculated according to the logic of partial confirmation. With the logic of partial confirmation, the component with the lowest degree of availability determines the confirmed quantity of all components. With the logic of full confirmation the total available quantity is confirmed for all components.
Availability Overview of the Components

When you save the result of the check, this quantity is copied to the planned order as the confirmed quantity.

- **Confirmation date**
  Earliest date, on which the total requirement quantity is available per component. If the requirement component is not fully available at any time, it is given the number sequence 99.99.9999 as confirmed date.

- **ATP quantity** (only calculated in the check according to ATP logic)
  Receipt quantity of the receipt quantity of component available on the requirements date. This quantity may be greater than the confirmed quantity as it is often the case that some components are completely available on the requirements date but others are only partially available.

**General Data**

In the header of the availability overview, the system displays the following general data:

- **Number of checked components**
- **Number of missing parts**
- **Total confirmation date** (only calculated in the check according to ATP logic)
  This is the date on which the complete requirement quantity is available including the in-house production time of the header material. This date is copied to the planned order as the order confirmation date on saving the results of the availability check. The total confirmation date depends on the following:
   - If the quantity required can be completely confirmed for the requirement date, the total confirmation date corresponds to the order finish date of the planned order.
   - If the quantity required cannot be completely confirmed for the requirement date, as not every component can be available in sufficient quantity by this date, then the total confirmation date corresponds to the date of the last material to be completely available plus the in-house production time of the header material.
   - If one of the components is not available in sufficient quantity by the requirement date and if this component cannot be made completely available for any later date, then the system cannot calculate a total confirmation date.

- **Partial confirmation date/quantity** (only calculated in the check according to ATP logic)
  The ‘partial confirmation date’ is displayed along with the partial confirmation quantity when the components are not completely available by the requirement date, however, a partial quantity is available on a later date (before the total confirmation date). Thus, this partial confirmation date represents the next point in time when a partial delivery can be made. Dates and quantities are based on the component with the least partial available quantity.

**Activities**

For information purposes, you can check the detailed date proposals per component. To do so, select the required component and choose . Depending on the type of check you have carried out (ATP logic or check against planned independent requirements), you receive the following data:
Check According to ATP Logic

A dialog box with a list of the individual confirmation dates and quantities appears. From here you can:

- Check the scope of the availability check, that is, check which stock, goods receipts and issues are included in the check (see also Scope of the Availability Check [Page 451]).
- Access the availability overview for the material, with ATP quantities (see also Availability Overview [Page 455]).

  In the availability overview the currently checked dependent requirement is displayed as a simulative dependent requirement, as it has not yet been saved in the database.

Check Against Planned Independent Requirements

The system displays the total requirements.

The system displays the planned independent requirements as well as the dependent requirements that were assigned (that is, consumed) for the components selected. As the dependent requirements have not yet been saved in the database, they are displayed as simulative dependent requirements.
Resetting the Availability Check

To reset the results of the availability check and thus the confirmation on dependent requirements level, proceed as follows:

In the header of the planned order, select, Edit → Reset component availability.

The system then resets the Confirmed quantity and the Order confirmation date for the dependent requirements.
Collective Availability Check for Components in Planned Orders

Use

In the collective availability check you can check whether the components required are available for several planned orders simultaneously. This is particularly useful if you want to convert several planned orders simultaneously, for example, and you want to check beforehand if and by when the components are available.

Integration

Just like the individual check in the planned order, you can carry out the collective availability check according to ATP logic or against planned independent requirements.

💡

In assembly orders the availability check does not update the sales order.

You can find further information on the availability check under Availability Check for the Components in Planned Order. [Page 417].

Prerequisites

- To be able to carry out the collective availability check, you need a profile order view. In the standard system the profile order view 000001 is used. The profile controls the formatting of the overview list with the planned orders selected (field selection, field sequence).

- For the missing parts/component list, a profile is also used in the standard system: profile component view 000001. The profile component view controls the formatting of the component list (field selection, field sequence).

You can create your own profile in Customizing for MRP, under Carry out collective availability check, or you can copy and change the profile 000001.

Features

You can carry out the collective availability check in two ways:

- in the foreground
- in the background
Check the Collective Availability in the Foreground

Procedure

1. Starting from the node in Material Requirements Planning choose Planned order → Collective avail. check.
   The system displays the initial screen for the collective availability check.
   The system proposes standard profiles for the order lists and component lists.

2. Enter a user profile if you do not want to create the order list or component list as a standard list.

3. Enter the selection criteria for the planned orders and choose 
   If you enter an MRP controller, for example, the system selects all planned orders for this MRP controller.
   The overview of the selected planned orders appears.

4. Select the planned orders for which you want to check the availability of the components and choose 
   The system displays the dialog box for the collective availability check.
   The parameters for the availability check have already been selected. If you want to change these, choose and select the relevant parameters in the dialog box (see Check Mode for Collective Availability Check [Page 428]).

5. Choose to start the check.
   The system displays the results in the planned order overview list.

6. To display the components of a planned order, select the planned orders and choose 
   Missing parts. The missing parts view of the selected planned orders now appears.
   With All components or Only missing parts you can change between different views.

7. Choose 
   The overview of the selected planned orders appears again.

8. If necessary, change the dates of the planned orders for which components are not available until a later date. To do so, access the planned orders individually from the overview list and change them. Check the availability for the changed planned orders.

Result

The data calculated in the availability check is automatically saved to the database.
Check the Collective Availability in the Background

Use
You use the collective availability check in the background if you have large amounts of data to process and do not want to impair system performance. You can run the check over night and see the results the following morning in printed form.

Procedure
1. Starting from the node in Material Requirements Planning choose Planned order → Collective avail. check.
   - The system displays the initial screen for the collective availability check.
   - The system proposes standard profiles for the order lists and component lists.
2. Enter a user profile if you do not want to create the order list or component list as a standard list.
3. Enter your selection criteria for the planned orders.
   - If you enter an MRP controller, for example, the system selects all planned orders for this MRP controller.
4. To do this, select Show check mode.
   - The system displays the field for defining the check mode in the lower section of the screen.
5. Make the desired settings for the check mode (see Check Mode for the Collective Availability Check. [Page 428]).
6. Select Program → Execute in background.
   - The dialog box for entering the background print parameters appears.
7. Enter the printer parameters if the system does not propose them and choose ✅.
   - The system displays the dialog box Start date values.
8. Plan the print request and choose ✅.
   - The system saves the background job. You return to the initial screen for the collective availability check.

Result
The list is printed at the time chosen.
Check Mode for Collective Availability Check

Use
You can define how the collective availability check for the components is to be carried out. To do so, choose Check mode on the collective availability check screen.

Features
The necessary selections are already set by the system when you call the transaction. However, you can change these. The following options are available:

- **Resetting the availability data**
  The following data of all selected planned orders can be deleted before the check is carried out:
  - confirmed quantity in the material components
  - the total confirmation date in the planned order header
  - the confirmed quantity in the planned order header

- **Checking availability**
  You have three options for carrying out the collective availability check:
  - If you select Individual, the availability is checked for each material, depending on the settings in the check group. If the check group is set, for example, so that the material is always checked against planned independent requirements, then this check is carried out.
  - If you select ATP, the availability check is an ATP check for all materials, independent of the settings in the check group.
  - If you select Forecast check, the availability check is against planned independent requirements for all materials. However, you cannot use this check if you have defined No check against planned independent requirements.

- **Firming planned orders**
  You can define that the planned orders, for which there are components available, are firmed after the availability check. This is also possible if the planned orders cannot be fully confirmed.

Firmed planned orders can no longer be changed by the planning run. In addition, the components are also firmed, that is the BOM is not exploded again in the next planning run.
Results of the Collective Availability Check

Use

The results of the availability check are displayed in the planned orders overview list. You can change to the missing parts list to display the missing parts for each planned order.

Features

Planned Orders Overview List

The following data is used as the result of the collective availability check when using the standard profile:

- **Result key**
  - Total result of availability check for the planned order:
  - 01: order can be fully confirmed
  - 02: order cannot be fully confirmed
  - 08: order was locked by another user and has not been checked
  - 09: order could not be checked

- **Confirmation factor**
  - Relationship between the confirmed order quantity and the order quantity.

- **Confirmation difference**
  - Difference in workdays between the planned order finish date and the confirmed order finish date of the order.

- **Confirmed quantity** of the order

- **Total confirmation date** of the order
  - Date on which the full quantity can be delivered. The date is only calculated in the ATP check.

In the planned orders overview list you have the following processing options:

- Changing the planned orders
- User-specific sorting of the planned orders
- Changing the field selection in the list
- Displaying all fields for a planned order
- Saving the list as a PC file.

Missing Parts/Component List

You can display the missing components in a list, for the planned orders that you have selected. To do so, select Missing parts in the planned orders overview list. The missing parts view of the selected planned orders appears.

You can change between different views by using All components or Only missing parts.
Results of the Collective Availability Check

If you work with the standard profile, the missing parts/components list contains the following fields:

- item number
- material number
- material short text
- plant
- storage location
- batch
- requirement quantity
- confirmed quantity
- requirements date

Selection of Other Fields in the Component List

In the missing parts/components list you have the following processing options:

- Changing the field selection in the list
- Displaying all fields for a component.
Conversion of Planned Orders

Use
Planned orders as internal planning elements only serve for planning purposes and do not trigger any procurement themselves. The system only triggers procurement, once these are converted into fixed receipt elements.

Integration
You have two options for converting the planned orders:

- over the MRP menu
- over the MRP list or the stock/requirements list.

  If you double-click on a planned order in the respective list, a dialog box with details for the planned order and the different options for conversion appears.

Features
The planned orders are converted as follows:

<table>
<thead>
<tr>
<th>Manufacturing Type</th>
<th>Conversion Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discrete manufacturing, external procurement</td>
<td>Planned order → <strong>Purchase requisition</strong></td>
</tr>
<tr>
<td></td>
<td>The purchase requisition is then converted into a purchase order by Purchasing.</td>
</tr>
<tr>
<td></td>
<td>It is only a fixed receipt element, once it is converted into a purchase order.</td>
</tr>
<tr>
<td></td>
<td>For more information, see [Converting Planned Orders into Purchase Requisitions](Page 433).</td>
</tr>
<tr>
<td>Discrete manufacturing, in-house production</td>
<td>Planned order → <strong>Production order</strong></td>
</tr>
<tr>
<td></td>
<td>For more information, refer to <a href="Ext.">PP-Production Orders</a> under</td>
</tr>
<tr>
<td></td>
<td>Planned Order Conversions [Ext.]</td>
</tr>
<tr>
<td></td>
<td>Converting an Individual Planned Order [Ext.]</td>
</tr>
<tr>
<td></td>
<td>Executing Collective Conversion of Planned Orders [Ext.]</td>
</tr>
<tr>
<td></td>
<td>Partial Conversion of Planned Orders [Ext.]</td>
</tr>
<tr>
<td></td>
<td>Partially Converting a Planned Order [Ext.]</td>
</tr>
<tr>
<td>Process manufacturing</td>
<td>Planned order → <strong>Process order</strong></td>
</tr>
<tr>
<td></td>
<td>For more information, refer to <a href="Ext.">PP-Production Planning-Process Industries</a></td>
</tr>
<tr>
<td></td>
<td>Converting Planned Order Collectively [Ext.]</td>
</tr>
<tr>
<td></td>
<td>Converting Planned Orders Individually [Ext.]</td>
</tr>
<tr>
<td></td>
<td>Partially Converting Planned Orders [Ext.]</td>
</tr>
</tbody>
</table>

The following options are available:

- **Individual conversion** (single planned order, also as a partial conversion)
- **Collective conversion** (several planned orders simultaneously)
Conversion of Planned Orders
Converting Planned Orders into Purchase Requisitions

Use

If the start date of a planned order lies in the opening period (see Creation Indicator [Page 287]), you must arrange the procurement. For materials procured externally, you should convert the planned order into a purchase requisition.

In exceptional cases, you can also convert planned orders into purchase requisitions for materials produced in-house. This is then useful if there are capacity bottlenecks and only part of the procurement quantity can be produced in-house and the rest must be procured using purchase orders. In this case, the material type must allow both in-house production and external procurement.

The following options are available:

- **Individual conversion** (individual planned order)
  You can convert the total planned order quantity or just part of it. Partial conversion is useful if the requirements situation has changed or you want to produce part of the planned order in-house.

- **Collective conversion** (several planned orders)
  Collective conversion is also possible as a background job.

All purchase requisitions that were created as described above are firmed automatically. They are no longer changed by the system in subsequent planning runs.

Procedure

**Total Conversion or Partial Conversion of Individual Planned Order**

1. Starting from the MRP node, choose Planned order → Convert to purchase requisition → Individual conversion.

   The initial screen for the individual conversion of planned orders now appears.

2. Enter the number of the planned order you would like to convert into a purchase requisition and choose Enter.

   The detail screen for the individual conversion of planned orders now appears.

   The first part of the screen displays the data of the planned order and the second part of the screen shows the data of the purchase requisition. This data is partly drawn from the planned order and partly from the material master. If necessary, you can overwrite this data.

3. Enter data as required.

4. In the case of partial conversion only: in the Converted quantity field the system automatically proposes the planned order quantity. Overwrite this value with the quantity that is actually to be converted and transferred to the purchase requisition and choose Enter.

   The system displays the message Planned order only partially converted.
Converting Planned Orders into Purchase Requisitions

The Planned order quantity is automatically reduced to the remaining quantity. You can correct or delete the planned order quantity. If you delete the planned order quantity, the system automatically deletes the planned order during conversion.

5. Save your entries.
   The planned order is converted totally or partially into a production order.

Collective Conversion Online

1. Starting from the MRP node, choose Planned order → Convert to purchase requisition → Collective conversion.
   The initial screen for the collective conversion of planned orders now appears.
2. Enter the MRP controller number and the plant.
3. Limit the selection further, if necessary, using the opening date and the procurement type.
4. Choose .
   The system displays a list of all the planned orders that fulfill the selection criteria.
5. Select the required planned orders.
6. Choose Convert online or Do not convert online.
   With Convert online, the system displays the screen for individual conversion once again before the conversion for each planned order and gives you the opportunity to edit it.
   With Do not convert online, the system converts the planned orders selected directly into purchase requisitions.
   If necessary information is missing for creating a purchase requisition, the system interrupts the conversion procedure and displays the screen for individual conversion. You can then add the missing data here. If you choose Enter, the system continues with the conversion.

To avoid the interruption of the conversion procedure, you can predefine default data for the purchase requisition. To do this, choose Goto → Purchase requisition default data and enter the required data. This data applies to all purchase requisitions created in the conversion.

Collective Conversion as a Background Job

Collective conversion as a background job is particularly useful, if you have set the planning run so that purchase requisitions are created directly within the opening period and planned orders are created outside of the opening period. These planned orders must be converted into purchase requisitions on time. You can do this using conversion as a background job.

1. Starting from the MRP node, choose Planned order → Convert to purchase requisition → In background.
   The display of available variants appears.
2. Choose variants, and enter your variants.
3. Enter the necessary attributes for the variants.
4. Schedule the variants.
The system converts the planned orders into purchase requisitions automatically on the dates entered.
Mass Changes of Planned Orders (Action Control)

Use
You can use this function to execute one or more actions for a large number of planned orders simultaneously. This is possible both within the SAP System and over an interface from an external assembly control system.

Features
SAP supplies the function module MD_SET_ACTION_PLAF for action control. This function module includes the following actions:
- Explode BOM
- Explode BOM, check availability
- Check availability, only explode BOM in the case of a requirement
- Check availability, do not explode BOM
- Reset availability
- Change planned order data
- Schedule planned order
- Delete planned order
- Confirm planned order (in repetitive manufacturing)
- Firm planned order data
- Firm planned order components
- Print component overview

In connection with an action, you can always change planned order data, for example; order quantity, dates or production version.

The function module also enables you to program further customer-specific actions.
- You can execute the actions for several planned orders simultaneously.
- You can create action chains, that means, have the system execute several actions in a single operation.

Activities
1. Define your own actions and program a report that includes these actions. As an example of this, the transaction MDAC Execute action for planned order (MRP → Planned order → Execute action) is available.

⚠️ In this example action, you can use actions only for individual planned orders. Nor can you form action chains, only simple action transitions are possible.
2. Determine an action key and action controls in Customizing for MRP in the IMG activities Define action key and Define action control. An action key describes the actions that can be executed for a planned order. Action controls determine which actions are allowed and in which sequence they are to be executed.

3. Assign the key for the respective action control to the materials in the material master (MRP 4 view).
Firming Procurement Proposals

Use

The system adapts the quantities and dates of procurement proposals that are created automatically in the planning run to suit the requirements situation if the situation has changed in the next planning run. If you want to prevent the system from adapting them automatically, you can firm the procurement proposals. Firmed procurement proposals are no longer changed by the planning run. They can only be changed manually.

You can firm all types of procurement proposals:

- planned orders
- purchase requisitions
- Delivery schedules (schedule lines).

💡

The system flags firmed procurement proposals with a star in the stock/requirements list and the MRP list.

Features

**Firming by Manual Changes**

Procurement proposals that have been created or changed manually are given a firming indicator automatically by the system. You can cancel the firming by deleting the firming indicator at any time. You can also set the firming indicator manually, without changing the procurement proposal.

**Firming with the Planning Time Fence**

Order proposals that lie within a defined planning time fence are firmed for the planning run if they are set to an MRP type with the appropriate firming type. The firming indicator is not set and they are only firm as long as they lie within the planning time fence.

For schedule lines in the planning time fence, you can firm only the quantities that have already been transferred and not the current quantities. Transferred schedule lines are schedule lines that have been sent to the vendor by telecommunications and have been confirmed.

**Firming with the Manual Firming Date**

The manual firming date lengthens, if necessary, the planning time fence up to the date entered. This has the advantage over the planning time fence that you can firm procurement proposals for materials with an MRP type that contains no firming type.

**Display and Change the Firming Indicator**

- Planned orders and purchase requisitions

You can display the firming indicator for planned orders and purchase requisitions when you access the detail dialog box for a procurement proposal by double-clicking on the procurement proposal in the stock/requirements list or MRP list. You can change the
firming indicator by choosing 📊 in the detail dialog box and accessing the screen for the respective procurement proposal.

- **Delivery schedules (schedule lines).**
  You can **display** the firming indicator for schedule lines by positioning the cursor on the schedule lines in the stock/requirements list or MRP list and choosing 📊. The screen for the schedule lines appears. You cannot, however, change the firming indicator there. You can only **change** it from the planning result. To do this, double-click on the schedule lines in the planning result.
Firming Planned Order Data and Components

Use
Firmed planned orders are no longer changed by the planning run. They can only be changed manually.

Features
You can firm just the planned order data or the planned order data together with the planned order components.

Firming Planned Order Data
The system proposes the firming indicator automatically when you add or change a planned order manually or when you schedule planned orders in the graphical planning table. If you do not want to firm the planned order, you can cancel this indicator.

If the planned order is firmed, the system can no longer adapt the quantities and dates of the planned order material. It can, however, adapt the components of the planned order material if the BOM has changed.

💡
In the MPS menu, there is a collective transaction for firming planned orders. Starting from the MPS node, choose Planned order → Firm.

Firming Components
Any manual changes that you make to the date or the quantity in the planned order are automatically passed on to the components by the system. If you want to ensure that no further automatic changes can be made to the components of the planned order material, you can set the firming indicator for components when processing the planned order. You can then no longer re-explode the BOM in the planning run.

The firming indicator is automatically proposed by the system when you manually change or create material components in the processing function of planned orders.

You can only firm particular individual components. The set the indicator for this in the screen for processing components.

💡
The indicator for firming all components can only then be set if the planned order data is also firmed.

See also:
Process Components in Planned Order [Page 411]
Reorganizing Firmed Planned Orders

Use
Firmed planned orders are subject to normal firming logic; that means, the system does not delete them automatically during the planning run when they are no longer needed. You can, however, define a roll forward period. The system then deletes all firmed planned orders that lie before the roll forward period automatically. The master plan is thus updated.

Prerequisites
- In Customizing for MRP or MPS in the IMG activity Define planning time fence and roll forward period, you have defined a roll forward period per plant or per MRP group.
- If you define it per MRP group, you have assigned the corresponding MRP group to the material in the material master.
- You have assigned an MRP type, which allows the deletion of firmed planned orders, to the material in the material master.
Planning Time Fence

Use

You can protect procurement proposals from any automatic changes to master schedule items in the near future by using the planning time fence. Within the planning time fence, the system does not automatically change procurement proposals during the planning run. That is particularly useful for MPS.

You can define the planning time fence either material-specific or per MRP group. The material-specific setting overwrites the MRP group setting.

All procurement proposal types are firmed within the planning time fence:

- planned orders
- purchase requisitions
- Delivery schedules (schedule lines).

Prerequisites

- You have entered a planning time fence:
  - either on a material-specific basis in the material master
  - or in Customizing for MRP or MPS in the IMG activity Define planning time fence and roll forward period.

  When specifying the planning time fence, you should bear in mind the maximum lead time of the materials.

- You have defined MRP types with a firming type [Page 446] in Customizing for MRP or MPS in the IMG activity Check MRP types. The firming type determines how the procurement proposals are firmed and scheduled.

- You have assigned an MRP type with firming type to the material in the material master.

Features

Outside of the planning time fence, procurement proposals are created as usual in the planning run. When these procurement proposals move into the planning time fence, they are firmed automatically depending on the setting of the firming type.

The system always calculates the end date of the planning time fence dynamically starting from the planning date.
Planning Time Fence for Transmitted Schedule Lines Only

Use
You can define that only quantities that have already been sent using message transmission and not current quantities are firmed for schedule lines that move into the planning time fence.

Prerequisites
- In Customizing for MRP, you have set the appropriate indicator in the IMG activity Indicator: Only firm transmitted schedule lines for each MRP group.
- You have maintained a planning time fence (see Planning Time Fence [Page 442]).

Features
Only quantities that have already been transmitted are firmed.

Background
The schedule lines are transmitted to the vendors using messages in Purchasing for the quantity that is recorded in the stock/requirements list at the time of transmission.

According to normal firming logic, schedule lines that lie outside the planning time fence at the moment and whose quantity has been changed in the planning run due to a change in requirements are also firmed (for the changed quantity) as soon as they move into the planning time fence.

If the Firm printed lines indicator is set, the following applies for these schedule lines:
- If you have not yet confirmed the current quantity by sending it to the vendor using message transmission, the system does not firm the current quantity within the planning time fence but firms the quantity that was sent to the vendor in the last message transmission.
  - If the current quantity is higher than the one that was transmitted last time, the system firms the smaller quantity that has already been transmitted. For the shortage quantity, a further schedule line is created and displaced to the end of the planning time fence.
  - If the current quantity is less than the one that was transmitted last time, the system firms the greater quantity that has already been transmitted.
- If no message has been sent to the vendor at all, no schedule lines are firmed in the planning time fence and instead, they are displaced to the end of the planning time fence.

This ensures that no unchecked quantities are firmed and transmitted.

💡
The message transmission is a Purchasing function. It can be found in the Purchasing menu under, Outline agreement → Scheduling agreement → Messages → Print/transmit.
A schedule line for 100 pieces is transmitted to the vendor from the MRP controller in week 1. The schedule line is still outside of the planning time fence.

The quantity is reduced to 80 pieces in the planning run in week 2. The MRP controller does not transmit the change.

The schedule line moves into the planning time fence in week 3. As the Firm printed lines indicator is set, the system does not firm the changed quantity of 80 pieces, but the old and already transmitted quantity of 100 pieces.
Manual Firming Date

Use
You can protect procurement proposals from any automatic changes to master schedule items in the planning run in the near future by using the manual firming date. The system does not change procurement proposals automatically up to this date.

You define the manual firming date on a material-specific basis in the following places:
- stock/requirements list
- planning result
- interactive planning

You can firm all types of procurement proposals with the manual firming date:
- planned orders
- purchase requisitions
- schedule lines

Features
The following applies to the firming type:
- Materials without a firming type or with firming type 1 or 2 (see Firming type [Page 446]): the system firms all procurement proposals, for which the order finish date is before this date.
- Materials with firming type 3 or 4: procurement proposals are not firmed automatically, even if the order finish date is before the manual firming date.

If you have defined a planning time fence, the following applies:
- If the manual firming date is before the end of the planning time fence, the planning time fence is used.
- If the manual firming date is after the end of the planning time fence, the planning time fence is extended up to this date.
Firming Type

Use
The firming type determines how procurement proposals are to be firmed and scheduled within the planning time fence during the planning run.

Integration
You have defined the firming type in Customizing for MRP or MPS in the IMG activity Check MRP types.

Features
The following firming types are available:

- **firming type 0**
  The system *does not firm* procurement proposals automatically.

- **firming type 1**
  Procurement proposals that move into the planning time fence are *firmed automatically*, as soon as their date lies at least one day before the end date of the planning time fence. The date of new procurement proposals that are created in the planning time fence is displaced to the **end of the planning time fence**. These new procurement proposals are not firmed.

- **firming type 2**
  Procurement proposals that move into the planning time fence are *firmed automatically*, as soon as their date lies at least one day before the end date of the planning time fence. The system does not create any new procurement proposals within the planning time fence; that means, the system does not balance the shortage situation in the planning time fence.

- **firming type 3**
  Procurement proposals that move into the planning time fence are *not firmed automatically* by the system. All procurement proposals that are necessary for requirements coverage are displaced to the **end of the planning time fence**.

- **firming type 4**
  Procurement proposals that move into the planning time fence are *not firmed automatically* by the system. The system does not create any new procurement proposals within the planning time fence; that means, the system does not balance the shortage situation in the planning time fence.
Availability Check According to ATP Logic

Implementation Options

During the material availability check, the system makes sure that requirements are covered by stock or by planned receipts. You can therefore recognize at an early date, for example, when creating the sales order, whether a material will be available for the requirements date or whether you have to make extra planning arrangements to guarantee material availability. Using the material availability check contributes towards increasing the accuracy of planning and the service level for creating sales orders as well as for the internal production process.

Integration

The availability check using ATP logic is a cross-application component. It can be accessed from the business application areas listed below:

- **Sales and distribution (SD-SLS)**
  You can check whether the material is available on the desired delivery date when creating sales orders and also when creating delivery notes.

- **Planned order processing**
  You can execute the availability check for the components of a planned order. This may be necessary when converting the planned order into a production order or beforehand, if you want to make sure that the necessary material components are available for the production of the finished product.

- **Production order processing (PP-SFC)**
  When processing production orders, you can check whether the necessary material components are available for production of the finished product.

- **Inventory management (MM-IM)**
  When creating or changing reservations as well as at goods issue, you can use the availability check to ensure that a goods movement will not jeopardize the availability situation of other issue elements already created and checked in the system. A missing parts check can be run at goods receipt.

Features

During the ATP quantity calculation, the system checks that all issues are covered by existing receipts and whether quantities are left over to cover new issues. These quantities that have not yet been assigned constitute the ATP quantity.

The calculation proceeds as follows:

- The receipts (warehouse stock, planned orders, purchase requisitions) are dynamically allocated to the issues (customer requirements, planned independent requirements, reservations), which lie directly after them on the time axis. The calculation is carried out in such a way that the issue is allocated to the receipt that lies nearest to it and that still has a positive ATP quantity.

- If the ATP quantity of this receipt does not cover the issue then the system will search for and check the next nearest receipt (always in a backwards direction) for a positive ATP quantity, which will then also be allocated to the issue.
Availability Check According to ATP Logic

- If receipts do not cover the issue, you must then decide whether you reduce the requirements quantity as necessary or whether you move the requirements date so that requirements coverage can be reached again.

As well as the availability check according to ATP logic there is also:

- the availability check against planned independent requirements
- [Availability Check Against Allocations [Ext.]]
Availability Check: Organizational Levels

Features

The availability is checked at different levels depending on the issue element. If, for example, an issue only involves one plant, you can limit the stocks, receipts and issues to be included in the check to plant level. If, however, the issue refers to a batch or a storage location, then the storage location or batch stocks must also be taken into account.

Availability Check at Plant Level

Example:

<table>
<thead>
<tr>
<th></th>
<th>Quantity Received</th>
<th>Issue Quantity</th>
<th>ATP Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plant Stock</td>
<td>1000 pc.</td>
<td></td>
<td>300 pc.</td>
</tr>
<tr>
<td>Receipt 1</td>
<td>500 pc.</td>
<td>1200 pc.</td>
<td>0 pc.</td>
</tr>
<tr>
<td>Issue 1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The ATP quantity calculation results in the following:

Requirement 1 amounting to 1200 pieces can be completely covered. Receipt 1, 500 pieces, is used up completely and the remaining 700 pieces are issued by plant stock, leaving the plant stock quantity at 300 pieces. The plant stock can provide an ATP quantity of 300 pieces for future requirements.

Availability Check at Storage Location Level

Example:

<table>
<thead>
<tr>
<th></th>
<th>Quantity Received</th>
<th>Issue Quantity</th>
<th>ATP Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plant stock</td>
<td>1000 pc.</td>
<td>300 pc.</td>
<td></td>
</tr>
<tr>
<td>Receipt 1</td>
<td>500 pc.</td>
<td>0 pc.</td>
<td></td>
</tr>
<tr>
<td>Issue 1</td>
<td></td>
<td>1200 pc.</td>
<td></td>
</tr>
<tr>
<td>Storage 1</td>
<td>800 pc.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue 2</td>
<td>500 pc.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Storage 2</td>
<td>200 pc.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Plant stock (1000 pieces) is made up of the stock from storage location 1 (800 pieces) and the stock from storage location 2 (200 pieces). Requirement 2 in amounting to 500 pieces is to be
Availability Check: Organizational Levels

withdrawn from storage location 1. This storage location currently contains 800 pieces. However, requirement 2 cannot be completely confirmed at plant level as only 300 pieces are available. Therefore only 300 pieces are confirmed for requirement 2. If the system confirmed the full requirement quantity, the availability of the confirmed issue 1, for which the issue storage location has not been specified and which draws on plant stock, would be jeopardized as it would be short of 200 pieces.

If the storage location is excluded from planning or if it is planned separately, then there is no longer the need for an additional check at plant level since stock from this storage location is not contained in plant stock.

If a storage location is excluded from planning or if it is planned separately, the check cannot be activated without a storage location (see Scope of the Availability Check [Page 451]).

Availability Check at Batch Level

If only one batch is entered, the check is carried out on two levels, first against the batch and then against the plant stock.

If a batch and a storage location are entered, the check is carried out on four levels, first against the batch storage location, then against the batch, the storage location and the plant stock.

Just as with the check on storage location level, the organization level with the lowest ATP quantity determines the result of the check.

Availability Check for Individual Customer Stocks and Project Stocks

Individual customer stocks and project stocks are maintained separately in the system and are not contained in plant stock. If an issue is made from individual customer stock or project stock, the availability is checked only for this particular customer stock. A two-level check does not take place.
Scope of the Availability Check

Use

It may be necessary for each individual application area to include different stocks, receipts and issues in the availability check. This is possible as each application area can define its own scope for the availability check independently of each other. The scope of the availability check determines the stocks included in the availability check on the one hand and the various receipt and issue elements to be used to calculate the available quantity on the other.

The scope of the availability check is defined in Customizing.

Features

Scope of Check

- The stocks that can be potentially included in the availability check are:
  - safety stock
  - stock in transfer
  - inspection stock
  - blocked stock
  - restricted-use stock
  - subcontracting stock

- The receipt and issue elements that can be potentially included in the availability check are:
  - purchase orders
  - purchase requisitions
  - dependent requirements
  - reservations
  - purchasing requirements, such as sales orders
  - delivery notes
  - shipping notifications
  - dependent reservations
  - call requirements
  - planned orders
  - production orders

- You can also set the following for the scope of the check:
  - that the replenishment lead time is not included (see Availability Check With or Without Replenishment Lead Time [Page 453]).
  - that the availability check is not carried out on storage location level
Scope of the Availability Check

- whether requirements with receipts from the past and/or future are confirmed
- that the missing parts check on goods receipt is carried out within a specific checking period.

Scope of Availability Check:

The scope of the availability check is defined by the following parameters:

- **Checking group**
- **Checking rule**

A checking group can contain several checking rules. The combination of checking group and checking rule determines the scope (such as the stocks, receipts and issues to be included) of the availability check for each business operation.

In Customizing, each application area defines a checking rule for each business operation for which the check is to be carried out and assigns the appropriate checking groups to the individual checking rules. The scope of the availability check is determined by each combination of checking group and checking rule.

The checking group collects all the checking rules for each material for all application areas. If different checking rules are required for each business operation, several checking groups can be defined each containing different checking rules.

The checking group is assigned to the material in the material master record. Thus, the system automatically finds the checking rule valid for each operation and thus the scope of the availability check to be used for the check.

Using different combinations of checking rule and checking group means on the one hand that you can define the scope of the availability check differently for different business application areas or for different business operations. On the other hand, one indicator in the material master record (checking group) is all that is required to determine all the individual checking rules of the application areas for the material.

💡

You achieve maximum safety for material availability if each of the individual application areas uses the same checking rule.
Availability Check With or Without Replenishment Lead Time

Use

In Customizing, you define whether the availability for a combination of checking group and checking rule is checked with or without the replenishment lead time.

The replenishment lead time is the time necessary to provide a material either by in-house production or by external procurement:

- For **external procurement**, the replenishment lead time consists of the purchasing department processing time, planned delivery time, and goods receipt processing time - in the same way as for forward scheduling in MRP. The ATP check only includes the **planned delivery time**.

- For **in-house production**, the system checks whether the total lead time is maintained in the material master (MRP 2 view). This is the estimated production time for a material, including all production levels from raw material procurement to final assembly.
  - If the total replenishment time is maintained then this is included in the ATP check.
  - If only the in-house production time is maintained and not this total replenishment time, then the in-house production time is included in the ATP check.
  - If the total replenishment time and the in-house production time are maintained, then the total replenishment lead time is included in the ATP check.

All times are specified in number of days. The only exception is the planned delivery time; this is specified in calendar days.

Features

You can choose whether or not the replenishment lead time is taken into consideration in the availability check:

- If the **replenishment lead time** is taken into consideration, it has the following consequences:
  - The availability is checked only for requirements within the replenishment lead time. Requirements outside the replenishment lead time are considered to be available as the system assumes that these materials can be provided by planning within the replenishment lead time.

  If you do not want to work with infinite quantities, you can use the **Availability Check Against Allocations [Ext.]**.

  - If a requirement cannot be covered by receipts, the end of the replenishment lead time is the earliest date that the material can be confirmed.

- If the **replenishment lead time** is not taken into consideration, the availability is checked for each requirement time without taking the replenishment lead time into consideration.
Availability Check With or Without Replenishment Lead Time
Availability Overview

Use
The availability overview enables you to see the ATP situation for a particular material in a defined plant. The availability check is run using a selected checking rule. You cannot change the displayed data.

Integration
You can call up the availability overview using the transaction CO09 or from the relevant application component. Starting from the MRP menu you find the availability overview by choosing Environment → Availability overview.

Prerequisites
You have maintained the checking group in the material master and the application-specific checking rule in Customizing.

Features
Starting the Function
If MRP areas are active, you can enter an MRP area and thereby restrict the availability check to this MRP area.

By entering a sales order item, a WBS element or a customer, you can display the availability overview on the level of sales order stock, project stock, customer consignment or returnable packaging stock.

If you have set the With requirements quantities indicator in the initial screen, the check does not take into account the confirmed quantities, but it does take into account the requirements quantities. This enables you to simulate the creation mode whilst checking requirements, which have ATP groups with the cumulation type 2 or 3.

Availability Overview Screen
The Availability Overview screen is divided into three sections:
- In the upper section, the system displays information about the check.
- In the middle section, there is an aggregated display of product availability on a plant level. By using this, you can determine quickly whether there is a material shortage.
- In the lower section, the system displays the daily availability situation of the selected material in a plant according to the scope of check. For each date and MRP element, the system displays a totals requirement with a receipt quantity (for stocks and receipts) or a requirement quantity, a committed quantity (only for requirements) and a cumulated ATP quantity. The system uses negative indicators to display the requirements. The data is sorted chronologically and starts with the plant section (if no special stocks are displayed). If necessary, the storage location section, batch section and batch storage location section follow.
Working with the Availability Overview

Aggregation and Disaggregation Functions

<table>
<thead>
<tr>
<th>Choose …</th>
<th>if you …</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Refresh Icon]</td>
<td>want to call up the display again</td>
</tr>
<tr>
<td>![Aggregation Icon]</td>
<td>want to use the daily, weekly, or monthly display for totals</td>
</tr>
<tr>
<td>![Stock Icon]</td>
<td>want to display all single records (with document information)</td>
</tr>
<tr>
<td>![Stock Icon]</td>
<td>want to display just one availability situation on a stock management level</td>
</tr>
<tr>
<td>![Stock Icon]</td>
<td>do not want to display just one availability situation on a stock management level</td>
</tr>
<tr>
<td>![Totals records Icon]</td>
<td>want to display totals records that are aggregated on a daily basis</td>
</tr>
<tr>
<td>![Totals records Icon]</td>
<td>want to display the document files as single records. For each date and MRP element, the system divides a totals requirement up into single records with a receipt quantity (for stocks and receipts) or a requirement quantity, a committed quantity (only for requirements) and a cumulated ATP quantity and displays them.</td>
</tr>
<tr>
<td>![Scope of check Icon]</td>
<td>want to display details for the settings that you have made in the scope of check.</td>
</tr>
</tbody>
</table>

The aggregation and disaggregation functions have an affect on all displayed elements. If you select individual lines in the display, the corresponding function only has an affect on these.

Additional Filtering Functions

<table>
<thead>
<tr>
<th>Choose …</th>
<th>if you …</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings → Only SD requirements</td>
<td>only want to display sales requirements</td>
</tr>
<tr>
<td>Settings → Reservations for production orders</td>
<td>want to display only reservations for production orders (dependent reservations)</td>
</tr>
<tr>
<td>Settings → Total display</td>
<td>want to reset the display filter</td>
</tr>
</tbody>
</table>

These filter functions only restrict the scope of the displayed documents and not the scope of the check.

Functions for Single Records

<table>
<thead>
<tr>
<th>Choose …</th>
<th>if you …</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment → MRP element</td>
<td>want to display further details for a document</td>
</tr>
</tbody>
</table>
### Working with the Availability Overview

<table>
<thead>
<tr>
<th>Environment → Pegged requirements</th>
<th>want to display the pegged requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment → Order report</td>
<td>want to display the order report</td>
</tr>
<tr>
<td>![Stock Icon] Stock</td>
<td>want to display all single records (with document information)</td>
</tr>
<tr>
<td>![Stock Icon] Stock</td>
<td>want to display just one availability situation on a stock management level</td>
</tr>
</tbody>
</table>
Backorder Processing

Use

In the backorder processing function, you are given a list of receipts and issues for a particular material that are relevant for the availability check. Missing parts occur if a requirement (sales order, reservation, and so on) could not be confirmed or could only be partially confirmed in the availability check according to ATP logic; the confirmed quantity is less than the requirements quantity.

Material shortages may occur for one of the following reasons:

- The quantity of a sales order cannot or can only partially be delivered on the required date. Therefore, the sales order has not been confirmed.
- The desired delivery date of a sales order lies outside the replenishment lead time. Therefore it is confirmed, but the quantities have not yet been procured.
- A dependent reservation has not yet been confirmed.

Prerequisites

You are recommended to set a missing-parts checking rule in Customizing for MRP in Maintain all plant parameters → Checking rule backorder updating.

Features

- Open requirements can be reconfirmed, for example, if stock has increased since the last availability check, if a new receipt has been made, and so on.
- Quantities that have already been confirmed can be redistributed whereby the quantities of confirmed requirements may be either partially or completely reduced and then allocated to an alternative more urgent requirement.

You can define the following replenishment elements:

- Sales orders
- Dependent reservations
- Stock transport purchase requisition
- Stock transport order
Process Backorders

Procedure

Access Backorder Processing

1. Call up the backorder processing.
   
   You can call up the backorder processing using the transaction CO06 or from the relevant application component. Starting from the MRP menu you find the backorder processing by choosing Environment → Backorder processing → Material.
   
   The system calls up the initial screen for processing backorders.

2. Enter the material number of the material to be processed as well as the plant and choose.
   
   The system checks availability according to ATP logic. Use the Scope of the check to display the control parameters of the availability check.
   
   The system calls the overview of backorder processing. In this screen, the system displays the plant stock or the storage location stock, the open sales orders or the dependent reservations and the scheduled receipt elements.
   
   The texts for the receipt and issue elements correspond to the texts that appear in the MRP list. The various stocks (individual customer stock, and so on) and the storage locations are displayed and managed in separate segments.

Processing Sales Orders

The system highlights sales orders or customer requirements that have not yet been completely confirmed or for which no receipt has yet been scheduled. The missing parts are displayed in the column Requirement/receipt.

1. Double-click the sales order or customer requirement, which is to be confirmed.

   In the lower part of the screen, the system displays the detailed data of the selected sales order for the selected date.
   
   The following data is displayed in detail:

   - **Open quantity**
     
     Total requirement quantity of the sales order or the customer requirement.
   
   - **Material availability date**
     
     Date by which sufficient quantities of the item must be available.
   
   - **Total confirmed quantity**
     
     Quantity that has been confirmed (in sales order management when creating the sales order or in backorder processing).
   
   - **Confirmed quantity**
     
     In this field you can enter the quantity that is to be allocated (that is, confirmed) in backorder processing.
   
   - **ATP quantity**
Process Backorders

Quantity which can be used when planning open requirement quantities.

2. Enter the quantity which, according to the ATP quantity, you can allocate to the requirements in the Confirmed quantity field.

   Use 📊 to display the detailed data of the sales order.

3. Choose 🌟 to transfer the quantity confirmed.

4. Save your entries.

   🕵️

   You can process backorders for sales orders only for materials for which you have set the indicator Individual requirements in the material master record (MRP 3 view, Availability check field).

Dependent reservations, stock transfer requisitions and stock transfer orders are processed at the same time.

💡

To do this, choose Settings → Only SD requirements. From the sales and distribution point of view, backorder processing can also be set in such a way that only the requirements necessary for SD are displayed as missing parts. From the sales and distribution point of view, backorder processing can also be set in such a way that only the requirements necessary for SD are displayed as missing parts. To do this, choose Settings → Only order reservations.